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This guide is designed to give you information to help you get started managing your customers in Sage 50.
Much of the information in this guide will not apply for users of Sage 50 First Accounting. Also, if you are using Sage 50 Quantum
Accounting or one of the Sage 50 Premium Accounting industry versions such as Sage 50 Manufacturing Accounting or Sage 50
Distribution Accounting, you may have additional functionality that is not covered in this guide.
You can refer to help within your version of Sage 50 for additional information about managing your customers in Sage 50.

Getting Started
Activate Sage 50
Please activate your copy of Sage 50 soon after installing the program. If you are installing the product on a network, you should
activate the product on the server before installing on the workstations. Activation is very important because it ensures you receive
timely program updates, upgrade offers, exciting new product information, payroll tax service information, customer support
options, and a variety of other benefits.

Note: You can use Sage 50 for a limited number of times before you must activate.
To activate Sage 50:
1. Go to Help>Sage 50 Activation .
2. Click Activate Online Now.
3. If you are new to Sage 50, you may be prompted to fill out a short form before activating.
Activation takes place over the Internet. What do I do if I don't have an Internet connection?
If you do not have an Internet connection, you will have the option to manually activate after you have reached the limit of
times you can use Sage 50 without activating.
You can activate two versions of Sage 50 on the same computer. Tell me more about this. If you have already activated one
version of Sage 50, you can update this activation or activate another version. Learn more about these options.

What do you want to do next?
Update existing Sage 50 activation information for your computer
l
Activate two versions of Sage 50 on your computer
l
Read the Getting Started overview
l
Set up a new company
l

Sage 50 Activation Information
To enter or update your Sage 50 activation information, go to the Help menu and choose Sage 50 Activation.
Activation takes place over the Internet. However, if you have reached the limit of times you can use Sage 50 without activating and
cannot connect to the Internet, you will have the option to manually activate.

Note: You will only get this activation screen if you cannot connect to the Internet and must manually activate Sage 50.
How to enter your Sage 50 activation information if you have to manually activate
1. Enter your customer ID and activation key. If you downloaded the product, the activation key is shown on the Sage Download
Notification email. Otherwise, to obtain a customer ID and activation key, do one of the following:
Visit Sage 50's Web site. After completing a short questionnaire, you will be provided an activation key.
Call Sage 50 toll free at one of the following numbers, depending on which program you have purchased:
Sage 50 Complete Accounting and Sage 50 Premium Accounting: 1-800-840-7329
Sage 50 Quantum Accounting: 1-888-573-0319
If you are located outside the United States, please call 770-492-6333 .
Please have your serial number, as well as your name, company address, and telephone number available before speaking
with a Sage 50 Customer Service representative. The Customer Service representative will then give you an activation key.

2. Enter an optional Recommender ID. This is the individual or company that recommended Sage 50 to you. Click the link if you
need to look up the ID.

3. When you are finished, click Activate.

Important: Write down your Sage 50 serial number, customer ID, and activation key and keep them in a safe place in case you
ever need to reinstall the product.
You can activate two versions of Sage 50 on the same computer. Tell me more about this. If you have already activated one
version of Sage 50, you can update this activation or activate another version. Learn more about these options.
Activation is very important because it ensures you receive timely program updates, upgrade offers, exciting new product
information, payroll tax service information, customer support options, and a variety of other benefits.
If you do not want to activate Sage 50, select Activate Later to close this window. You will not be able to use Sage 50 without
activating it.

What do you want to do next?
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Update existing Sage 50 activation information for your computer
l
Activate a new copy of Sage 50
l
Read the Getting Started overview
l
Set up a new company
l
Learn about Sage 50 products and services

Sage 50 Activation Options
You have these activation options because you are allowed to activate two versions of Sage 50 on the same computer and you have
already activated one.
l

Upgrade or update your current version - Select this if you are updating your activation because you have purchased
more licenses or you want to change your current version of Sage 50 to a different version.

Note: If you are updating or upgrading Sage 50 on a network, you must select this option and enter the activation information
on each computer that has Sage 50 installed.
l

Add a second version - Select this to add a second version of Sage 50 on this computer. The activation information for your
current version will remain the same. Tell me more about this.

Update Your Existing Sage 50 Activation Information
If you have recently purchased a new Sage 50 license, you can update the Sage 50 activation information linked to your computer's
workstation.

Note: If you purchased a single-user license of the Program, this license is for use of the Program on the computer(s) by one
individual. As stated in the Sage 50 Software License Agreement, you must purchase a license to use the Program for each
additional user on which the Program will be installed or accessed. .

To update Sage 50 activation information
1. Start Sage 50.
2. Select Sage 50 Activation from the Help menu.
If the Sage 50 Activation Options window appears, choose Upgrade or update your current version and click OK.
3. Enter your new serial number and click OK.
4. Click Yes on the message telling you that this will change your version of Sage 50. The product will close and reopen as your new
version.

5. Go to Help>Sage 50 Activation .
6. Click Activate Online Now to activate your new version.
You can activate two versions of Sage 50 on the same computer. Tell me more about this. If you have already activated one
version of Sage 50, you can update this activation or activate another version. Learn more about these options.
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Activate a new copy of Sage 50
Set up a new company
Learn about Sage 50 products and services

l
l
l

Activate Two Versions of Sage 50 on the Same Computer
You can activate two different versions of Sage 50 on one computer and easily switch back and forth between the two versions.
For example, if you have purchased Sage 50 Complete Accounting and Sage 50 Premium Accounting, you can activate both of them
on the same computer and switch back and forth between the two versions.

Note: The versions must be different and from the same year. For example, you can't activate Sage 50 Complete Accounting
2014 twice or Sage 50 Complete Accounting 2014 and Sage 50 Premium Accounting 2013.

To activate two versions:
1. Go to Help>Sage 50 Activation .
2. Click Activate Online Now to activate your first version.
3. After you have finished activating your first version, go back to Help>Sage 50 Activation .
4. Choose Add a second version and click OK.
5.
6.
7.
8.
9.

Enter the serial number for the second version.
Click OK.
Go to File>Switch Sage 50 Version .
In the new version, go to Help>Sage 50 Activation .
Click Activate Online Nowto activate your second version.

Once you have added the second version, you can go to File>Switch Sage 50 Version to change to the other version. You
don't have to close one version and open the other one.

What do you want to do next?
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Update existing Sage 50 activation information for your computer
l
Activate a new copy of Sage 50

How Do I: Getting Started Topics
l
l
l
l
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Getting Started Overview
Batch vs.SmartPosting vs. Real-Time Posting
Cash-Basis or Accrual Accounting
Dates and Accounting Periods
Your Chart of Accounts
Aging
Customer Statements
Work with your accountant

Getting Started Overview
There are four basic steps in moving from a manual system of bookkeeping to using Sage 50:

1. Decide on a conversion date.
2. Gather all the information you will need:
l
l

names and addresses for customers, vendors, employees, sales reps
beginning balances for your general ledger accounts, customers, and vendors, employees, jobs, and inventory items as of the
conversion date

3. Create a company.
4. Enter the necessary information.

Sage 50 walks you through the process of setting up a new company, explaining each step along the way. Still, the more you
prepare for this process, the smoother your transition will be.
If you are currently using bookkeeping software, you may be able to convert your existing information to Sage 50 automatically
using conversion features in Sage 50. You can convert data from QuickBooks and DacEasy.

What do you want to do next?
Read more getting started topics

l

Working with Your Accountant
Sage 50 is not an electronic checkbook. It's a real, double-entry accounting system. Your accountant will appreciate the detail
included in Sage 50's financial statements and other reports.
There are some initial decisions you should make with your accountant (see Initial Decisions). Then, at tax time you need to provide
your accountant with the information he or she needs.
At tax time, print the following financial statements for your accountant:
l

Balance Sheet

l

Income Statement

l

Statement of Changes

In addition, you may want to print the following reports:
l

Aged Receivables

l

Aged Payables

l

Inventory Valuation

Sage 50 provides most of the other information your accountant may require.

How Sage 50 Handles Cash-Basis
We have defined cash-basis accounting as a system that recognizes income and expenses when actual cash (including checks or
money orders) is received or disbursed. In the accounting world, there are different varieties of cash-basis accounting.
Sage 50 offers the cash-basis company two important benefits of an accrual system:
l

customer and vendor aging

l

projected cash flow, via customer and vendor ledgers

To reap these benefits, you must enter customer and vendor invoices in a timely fashion.

Customer and Vendor Aging
If you enter customer and/or vendor invoices, Sage 50 will compute and track aging for receivables and payables, even for cashbasis companies. This includes automatically tracking discounts for timely payment. For sales, you can calculate finance charges for
overdue customer invoices. For purchases, you can select a batch of bills to pay, based on due date, discount date, and other
criteria. In addition, you can use the Collection Manager and Payment Manager to analyze receivables and payables, and to
generate collection letters (Collection Manager) or select bills to pay (Payment Manager).

Projected Cash Flow
Cash-basis companies that record customer and vendor invoices can still accurately project cash flow. The two main tools for this in
Sage 50 Accounting are the Cash Flow Statement and the Cash Flow Manager.

Payroll
Because of their vital importance to your business, Sage 50 handles payroll taxes in an accrual fashion, even for cash-basis
companies. When you enter and post a payroll check, Sage 50 immediately updates all payroll tax expense accounts, even if the
check date is a future date.

Inventory
If you buy and sell inventory items, you should use the accrual method of accounting. However, Sage 50 updates inventory costing
in accrual fashion, even for cash-basis companies. In other words, when you post a purchase of inventory items, the cost of the item
is recalculated then, not when payment is made.

Related topics

The benefits of cash basis
The benefits of accrual
Example of cash vs. accrual accounting

Cash Basis or Accrual Accounting (Getting Started)
When you set up a company in Sage 50, one of your choices is between cash-basis and accrual accounting.
l
l

In cash-basis accounting, you recognize income and expenses when you receive cash.
In accrual accounting, you recognize income and expenses when you send or receive an invoice. In other words, accrual
accounting recognizes future receipts or disbursements, based on the reasonable expectation of cash flow.

Thus, in accrual accounting, you have Accounts Receivable and Accounts Payable account types.
l
l

The sum of your Accounts Receivable account(s) equals the sum of open invoices with customers.
The sum of your Accounts Payable account(s) equals the sum of open bills you have with suppliers (vendors, in Sage 50
terminology). In cash-basis accounting, you would not need these types of accounts.

For more information on the differences in these accounting methods, click here.
Please note that if yours is an established business, you may not have a choice. The Internal Revenue Service has strict rules
about switching between cash and accrual accounting. The switch must be made at the beginning of your fiscal year, and you must
advise the IRS. Consult your accountant or tax-preparation professional if you're considering this switch.
For the above reasons, Sage 50 will not let you switch between methods once you have established a company. If you do decide to
change methods, you would have to set up a new company.
Accrual accounting is the more common and accepted method.

Related topics
How Sage 50 handles cash basis
The benefits of cash-basis accounting
The benefits of accrual accounting
Example of cash vs. accrual accounting
What do you want to do next?
Read more getting started topics
l
Read the getting started overview
l

The Benefits of Accrual Accounting
Accrual Accounting provides the truest picture of how your business is doing, because it includes booked sales and purchases
(Accounts Receivable and Accounts Payable). Income and expenses are recognized when they are earned or incurred, regardless of
when they are received or paid.
Again, this choice may have been made for you, either by the Internal Revenue Service or by your accountant. The IRS requires the
accrual method if the production, purchase, and sale of merchandise is part of your business (in other words, if you sell inventory).
Your accountant may require financial statements that are based on generally accepted accounting principles (GAAP). Only accrual
statements meet GAAP requirements.

What do you want to do next?

The Benefits of Cash Basis Accounting
Many small, service-type businesses (accountants, lawyers, consultants) opt for the cash-basis method of accounting. There are
three main benefits to this method.
l

Tax Benefits

l

Less Bookkeeping Time

l

Simplicity

Again, the choice between cash basis or accrual may have been made for you. If you sell traditional inventory items (Stock items, in
Sage 50), you must use the accrual method.

Tax Benefits
If income is not recognized until received, you would have less income to report in a given year if cash-basis. Of course, the income
not reported for December would be reported in January of the following year, making this a short-term benefit. Most small service
organizations have more receivables than payables. Thus, it may be to their advantage to use cash-basis accounting.

Less Time/Simplicity
In cash basis, you could choose to not record customer or vendor invoices, or to record less information for them, since you have no
receivables or payables accounts. Of course, if you record no invoices, you lose the benefits of aging or projecting cash flow.

Related topics
Example of cash vs. accrual accounting
How Sage 50 handles cash basis

Example of Cash vs. Accrual
The difference in net income for a company can be large, depending on the accounting method. In this example, the choice of cash
versus accrual means the difference between profit and loss for the period.
A small service company invoiced $10,000 in September, but received only $5000. Their total purchases were $8000, but they
deferred payment on $2000 of that.

Account
Type

CashBasis

Accrual

Income

$5,000

$10,000

Expense

$6000

$8000

Net Income

- $1000

+$2000

Dates and Accounting Periods (Getting Started)
One of the most important decisions you must make is the Starting Date for converting to Sage 50. It must be a date on which you
know all account balances, customer balances, vendor balances, and so on. If possible, the start date should be the end of the
previous fiscal year. If you want reports comparing this year to last year, the starting date could be the end of the previous year.
You can easily enter balances from last year at any time, if you have Beginning Balance password rights.
One special feature of Sage 50 is that you can have two years open at once (up to 26 periods). That means you can keep last year's
records open. It also gives you a lot of flexibility as to when you convert. For example, you can set the first accounting period to the
first period of your fiscal year. This will make next year's closing easier to manage.
Next, you must decide how often you want financial statements. Keep in mind you can have from 1 to 13 periods in the fiscal year.

The Conversion Date (Getting Started)
The data you are entering must be accurate as of the conversion date you select. Ideally, this date would be the beginning of your
fiscal year. Or, a little less ideally, this date would be the beginning of a fiscal period.
One special feature of Sage 50 is that you can have two years open at once (up to 26 periods). This means you can keep last year's
records accessible. It also gives you a lot of flexibility as to when you convert. For example, you can set the first accounting period to
the first period of your fiscal year. This will make next year's closing easier to manage.

Global Options (Getting Started)
You can set certain options that are in effect for all of the companies you set up. You can access this option from the Options menu.
Remember that when you set global options for one company, you set them for all companies. Likewise, when you change options
for one company, you are changing them for all companies.
Global options include:
l

Whether to have Sage 50 warn you if a record was changed but not saved when you exit a journal

l

Whether to display one or two lines for each line item in a transaction-entry window

l

Whether to automatically recalculate the cash account balance when entering receipts or checks (if not selected, you can press a
Recalculate button to update the cash balance if necessary; this can save time in data entry)

l

Whether to have the program automatically insert a decimal point in numbers two places to the left or to have users type in the
decimal

l

Whether you use the Timeslips Accounting Link

l

Whether to warn you if an inventory item used in a transaction is out of stock

l

Whether to have lists open automatically when you place your cursor in a field where a list is available

l

Whether to have Sage 50 automatically fill in text for stored items when you begin typing in a field

l

Whether you want Sage 50 to create record IDs for you automatically.

It is important to realize all of the options you have, and what results your choices will have.

Your Chart of Accounts (Getting Started)
The Chart of Accounts is nothing more than a list of places to enter transactions. It contains a code (sometimes called an account
number), a description for each account, and a type code. The amounts that are posted (applied) to these accounts are used to
create financial statements, such as the Balance Sheet and Income Statement (P & L), so they are very important.
Sage 50 allows you a great deal of flexibility in designing your own chart. However, you can probably save a great deal of time by
copying one of the sample charts and modifying it to meet your needs. Sage 50 comes with several sample companies from which
you can copy default or setup information, including the chart of accounts.

Related topics
Necessary accounts
Masking

G/L Beginning Balances (Getting Started)
You need to gather beginning balances as of the conversion date you decide on. General ledger beginning balances are entered
through the Maintain Chart of Accounts option, using the Beginning Balances button. In this way, financial statements, such as
your Balance Sheet and Income Statement (P & L), will be accurate.
After you post a transaction to any general ledger account, you cannot enter G/L beginning balances in the current fiscal year. You
can only enter beginning balances for the prior year.
When you enter beginning balances in your general ledger, you will want to make sure that your customer,vendor, item, and
employee beginning balances total the amount shown in general ledger. (In other words, if you are using the Accrual accounting
method, the accounts receivable total in your general ledger must match the total of outstanding invoices in customer beginning
balances; likewise, the accounts payable total in general ledger must equal all outstanding bills.) The beginning balances for
customers and vendors are not connected to the general ledger beginning balances, so you must check to make sure they match.

What do you want to do next?
Enter G/L beginning balances

l

Necessary Accounts (Getting Started)
Some accounts are used by the system in daily transactions. In all Task windows except the General Journal Entry, Sage 50
performs some of the accounting distribution for you, based on accounts you establish in the Default Information (accessed through
the Maintain menu or the Setup Guide). The accounts you will need to use each feature of the program are listed below:

Accounts
Receivable

Accounts Receivable (Accrual)
Cash Received
Discounts Allowed
Sales Tax Payable
Interest Income (for Finance Charges)
Freight

Accounts Payable

Accounts Payable (Accrual)
Cash Disbursed

Discounts Taken

General Ledger

Retained Earnings rounding account (for Customized Financial
statements)

Inventory

Sales Revenue
Inventory
Cost of Goods Sold

Payroll

Cash Account
Salaries and Wages
All Deductions (Payable)
All Allowances (Expense)

Sage 50 will create defaults for these accounts when you copy information. Be sure to check the accuracy of the Default

information accounts before you begin entering transactions.
Remember that, even though everything is integrated in Sage 50, you do not have to set up everything at first. If you can, it would
be best to get everything set up at once, and these instructions assume that you do. However, if you want, you can set up just one or
two functions now and others later or never. Reconciling the General Ledger to the other functions is easier if you start at the same
time, but it is certainly still possible later, using means similar to those for setting up a new company.
If you need to use Sage 50 immediately—to print checks or invoices for example—you could set up just one account, and have
everything post to the account temporarily. Then you could add the general ledger and financial statements information later. You
would have to enter this account number in all the account fields in Default Information for each module that you need to use. By
doing this, you would, of course, sacrifice many of the benefits of Sage 50.

Batch vs. SmartPosting vs. Real-Time Posting (Getting Started)
You must decide whether to post using a batch, SmartPosting, or real-time method.
l

l

l

In batch posting, the transactions you enter are saved to a temporary holding area, where you can review them before posting
the batch to the General Ledger.
In SmartPosting, the transactions are saved by the program and then posted by the SmartPosting service. This posting method
is recommended for better performance.
In real-time posting, the transactions you enter are both posted and saved when you click the Save button. In batch posting,
transactions are just saved when you do so.

Check with your accountant to see which method you should use in your business.
You must make a choice about which posting method to use when you create a new company. Unlike the next decision, about cash
or accrual, you can change this option at any time. When you change from batch or SmartPosting to real-time, all unposted
transactions are posted before the switch is made.
We recommend real-time posting in a network environment for better performance.
We recommend SmartPosting in a network environment for better performance.

Aging (Getting Started)
Sage 50 ages vendor and customer invoices by the due date or the invoice date.
l

If you age by invoice date, the aging reports show how old each invoice and each balance is.

l

If you age by due date, the aging reports show how overdue each invoice is.

For this reason, many people choose to age accounts payable by due date and accounts receivable by invoice date. The way you
age invoices is established in the Default Information for vendors and customers (accessed through the Maintain menu).
You can establish up to four aging periods. The leftmost column on the report contains balances due for the most recent (or least
overdue) invoices, while the rightmost column contains balances due for the oldest (or most overdue).
You set the range of days for each of these columns in the Default Information for vendors and customers. This range is either the
number of days beyond the invoice date or the number of days beyond the due date, depending on how you choose to age. For
example, if you were aging by Due Date, you might enter 0 for the first aging column, to indicate that you wanted all invoices not yet
overdue to appear in the first column. You might then enter 15 on the second line to have all invoices which are up to 15 days

overdue (and not in the first column) appear in the second column. You might then enter 30 on the third line, to indicate that all
invoices less than 30 days overdue but more than 15 days overdue appear in the third column. You can enter 999 for the # of days in
the fourth column, to indicate that all invoices not listed in the first three columns will appear in the fourth.
You can also define a heading for the columns that appear on the aging reports: Current, Over 30, and so on.

Customer Statements (Getting Started)
You can set certain default parameters for printing customer statements. For example, you might not want to print statements for
customers with zero balances or credit balances or balances less than a certain amount or barely overdue. You can set all these
options in the Statements/Invoices Defaults (accessed from the Maintain menu).
You can also define dunning messages that appear on statements. Sage 50 places the message based on the number of days the
oldest invoice is overdue. In other words, you can define a message for invoices 30 days overdue, a different message for invoices
45 days overdue, and so on.

Account Segments (Getting Started)
Account segmentation in Sage 50 Premium Accounting (and higher) is a powerful tool that allows you to formally segment your chart
of accounts, allowing you to use the segment selection features in Sage 50's reporting to filter reports based on selection of
particular segments of the account ID. Using this feature, you can quickly and easily produce and print departmental or divisional
reports and financial statements, or any other segment, such as location, restriction status, and so on.

Learn More
In Bellwether Garden Supply, one of the sample companies provided with Sage 50, the income accounts in the General Ledger have
been departmentalized. Two account segments have been created: one for the account portion, and a second for the department
code, which is a two letter code. This is how it looks on the Account Segments tab in General Ledger Defaults:

When Bellwether wants to produce an Income Statement that shows only amounts for the Aviary department, it will filter the
information for income by selecting only the Aviary department. This is how the Options screen for the Income Statement will
appear:

When the report prints, only accounts that have AV in the Department segment will appear.
Setting up Account Segments in your company
You can set up account segments either during the New Company Setup Wizard or after the company is initially created by
using the Account Segments tab in General Ledger Defaults. It is advisable to set up your account segments before you enter
all of your accounts.

Set up Account Segments in New Company Setup
Set up Account Segments in General Ledger Defaults

Masking (Getting Started)
When setting up your chart of accounts and other records, you should be aware of a powerful feature of Sage 50 called masking.
Masking is the ability, when you order certain reports, to limit the information on the report to a single division, department, location,
or type code.
To take advantage of department masking in general ledger, you must set up your chart of accounts with division, department, or
location codes. To take advantage of type-code masking, you must set up type codes for customers, vendors, employees, jobs, and
items.

If you are using Sage 50 Premium Accounting or higher, the above information applies if you are not using Account Segments for
your General Ledger Account ID’s. However, you can use Account Segments and Sage 50 will provide drop-down lists for masking
purposes. Tell me more about Account Segments.

Masking Types
Department masking
Rollup masking
Type-code masking

Department Masking (Getting Started)
Sage 50 offers a powerful feature called masking that helps you departmentalize your financial statements. To take advantage of
this feature, you need to set up your account numbers in a special way.
Say you want to set up a company that comprises a main branch and a remote branch, with two departments: a sales and a service
department. You could establish a seven-character account number, with the fifth character representing location and the sixth and
seventh representing departments.
You could use an M or an R code for the two branches (for Main and Remote branch). You could use 01 and 02 for the department
numbers (leaving room for up to 99 departments in the future). Then you would enter each normal account number in your chart of
accounts four times, with each combination of location and department codes:
l

Account #--M--01

l

Account #-- R--01

l

Account #--M--02

l

Account #--R--02

When you order a report such as the General Ledger report, you are prompted for the Department mask. To have this report only
show totals for the main branch, enter ****M**. (Asterisks are wild-card characters; they represent any other possible character.)
To have the report only show totals for Department 02, you would enter *****02. To show totals for the Remote branch,
Department 01, enter ****R01.
Masking offers a lot of possibilities. You know your needs, so use your imagination when setting up your chart of accounts to take
advantage of this powerful feature.
In Sage 50 Premium Accounting and higher, you can set up Account Segments to use for masking General Ledger reports and
Financial Statements.

Rollup Masking (Getting Started)
Rollup Masking works similarly to department masking. It allows you to summarize, or "roll up," account totals by department.
Again, you must set up your chart of accounts in a special way for rollup masking to be effective.

Type Code Masking (Getting Started)
Type code masking is similar to department masking. Type Code Masking lets you organize similar records together. Then, you can
limit the information on reports to a single type code.
For example, you could organize customers by region, entering a type code for NE (Northeast), NW (Northwest), and so on. Then,
you could mask certain Accounts Receivable reports to display sales by region.

Lists
You can use Lists to see full-screen lists of records and transactions for your company, including Customers, Contacts, Quotes,
Proposals, Sales Orders, Sales Invoices, Receipts, Deposits, Credit Memos, Sales Tax IDs, Sales Tax Agencies, Vendors, Purchase
Orders, Purchases, Payments, Write Checks, Vendor Credit Memos, Employees, Paychecks, Chart of Accounts, General Journal
Entries, Inventory and Services, Items, Inventory Adjustments, Item Sales History, Time Tickets, Expense Tickets, Jobs, Phases,
Cost Codes, and Change Orders. There are also Lists for Notification Rules and Notifications.
These lists are extremely versatile and you can customize them by adding fields, deleting fields, rearranging the order of the fields,
and changing the sort order of records. In addition, you can add, and edit records right from the list. Finally, you can perform several
tasks using the data for a particular record. For instance, you can create a Sales Invoice from the Customer List.
To open a list

l

Select List from the menu bar; then select the list you want to open from the cascading menus.

l

Select the list option from the navigation aid.

l

Select List from a record or task toolbar.

Learn More
Customize a list.
You can customize your list in many ways. Any changes you make will be saved specifically for you, and all users can have
different settings depending on their access rights to the company data. In addition, if you have several companies, you can
have different settings for each list for each company.
How do I add fields to the list?
You can add fields to a list by following these steps.

1. Display the list you want to customize.
2. Select the Settings button in the toolbar. This will open the Settings window. On the right is a list of the fields that are
currently displayed. On the left is a list of other fields that you can select.

3. Click a field from the list to the left to select it.
4. Click Add. This will move that field to the right.
5. Repeat these steps to add further fields.
6. Click OK when you are done.
How do I remove fields from the list?
You can remove fields from the list by following these steps.

1. Display the list you want to remove fields from.
2. Click the Settings button in the toolbar. This will open the Settings window. To the right is a list of fields currently displayed; to
the left is a list of fields that can be added.

3.
4.
5.
6.

Click the field you want to remove from the list on the right to select it.
Click Remove. This will remove it from the list and move it to the list on the left.
Repeat these steps to remove other fields.
Click OK when you are done.

How do I rearrange the data on the list?
What do you want to do?
Rearrange the fields
You can rearrange the fields from left to right in two ways:
1) Simply click a field label, holding the mouse button down, and drag the field to the new spot.
2) Click the Settings button and use the Move Up and Move Down buttons to move the fields on the list to the right up and
down. Click OK when you are done rearranging the fields in this way.
Change the order in which records sort
To change the order in which records sort, either ascending or descending, and the field on which they will sort, simply click the
field label that you want to use for sorting. This will bring up an arrow triangle, pointing up, showing that records are now
sorted by this field in an ascending order, that is, from a to z. Click the field label again to change the sort order to descending,
from z to a.
How do I resize a column?
You can resize a column by following these steps:

1. Place the cursor over the vertical bar in the heading to the right of the field you want to widen or make thinner. The cursor will
change to a double-vertical bar with arrows at each end.

2. Click and hold the left mouse button.
3. Drag the vertical bar to the right or left to modify the width of the field.
Add a record to a list
To add a record to the list

1.
2.
3.
4.

Select the list you want to add a record to.
Click the New button. This will open the associated Maintain window for the list.
Enter the data on the Maintain window.
Save the new record. It will be added to this list.

You can also open the Maintain window by right-clicking the mouse and selecting Add New Customer.

Edit a record on a list
To edit a record in the list

1.
2.
3.
4.

Highlight the record you want to edit.
Click the Open button in the toolbar. This will open the Maintain window with the data of the record.
Make the change in the Maintain window.
Save the changes.

You can also open a record simply by double-clicking it in the list.

Copy a transaction in a list
1. Highlight the transaction you want to copy.
2.
3.
4.
5.

Click the Copy button.
The new transaction will open in the transaction screen.
Edit the transaction as necessary.
Click Save.

You can also select a transaction in the list and right-click to choose to copy it.

Find information in a list
Use the search features to find information on a list. For transactions, such as sales invoices, you can search by Date Range,
Status, and/or a particular piece of information. For records, you can search for a particular piece of information.
Search for a Transaction

1.
2.
3.
4.
5.

Select a Date Range and/or Status, if necessary.
Use the Search For field to enter a piece of information about the transaction.
Select the field that this piece of information applies to in the field to the right.
Click Search .
All transactions that have that value in the specified field will be displayed on the grid. All others will disappear. To refresh the
list with all transactions, click the Clear button.

This field is not case sensitive. Typing land, for instance, will call up values with land, Land, and LAND for the field specified.
You can do searches for multiple items also. For instance, you want to find all invoices with an ID between 10200 and 10299. You
can type 102 in the Search For field and select Invoice ID. Then click Search. All invoices with 102 as part of the Invoice ID will
appear.
Search for a Record

1.
2.
3.
4.

Enter the piece of information you are looking for in the Search For field.
Select the type of information from the field to the right.
Click Search .
All records that have that value in the specified field will be displayed on the grid. All others will disappear. To refresh the list
with all records, click the Clear button.

This field is not case sensitive. Typing land, for instance, will call up values with land, Land, and LAND for the field specified.
You can do searches for multiple items also. For instance, you want to find all invoices with an ID between 10200 and 10299.
You can type 102 in the Search For field and select Invoice ID. Then click Search. All invoices with 102 as part of the Invoice ID
will appear.

Print, e-mail, or export a list
Print a list

To print a list

1. Select the list you want to print.
2. Click the Print button in the toolbar.
3. Make your print selections and click Print.
E-mail a list
To send the list in an e-mail

1.
2.
3.
4.

Display the list you want to e-mail.
Click the Send to button to display a drop-down list of options.
Select the E-mail option.
Make any selections and click E-mail.

Export a list to Microsoft Excel
To export the list to Microsoft Excel

1. Display the list you want to export.
2. Select Send To in the toolbar.
3. Select Excel.
4. Make your selections and click OK.
Convert the list to PDF format
To convert your list to a PDF file

1. Display the list you want to convert.
2. Click the Send To button in the toolbar.
3. Select PDF.
4. Make your selections and click OK.
5. Specify where you want to save the list and what its name should be. Then click Save.
Perform a task using one of the records in the list
Follow these steps to perform a task using a record.

1. Highlight the Record that you want to use.
2. Click one of the task links in the pane at the left of the List window. This will open the appropriate Task window with the fields
populated with data from the selected record.

Print a report for the list
A list of the most commonly-used reports for the current list appears in the pane on the left. To view one of these reports, simply
click the report name.

What do you want to do next?
l

Get help for the Settings window for a list

Lists Settings
You can use the Settings window to customize the columns that appear on your lists. You can add and remove fields, as well as
rearrange their order. The settings you make here are saved on a per user, per company basis, so another user can have different
settings for the same list.
Below is a description of the fields.
l

Available Columns: Shows you the fields that can be added to the list, but are not currently on the list.

l

Selected Columns: Shows you which fields are currently included on the list.
You are limited with each list type to the fields that appear in these two boxes. You cannot add fields that do not appear in either
box. .

You can select multiple fields at one time by using the Shift key (for contiguous items) or Control key (for non-contiguous items)
and clicking. You can also double-click an item to move it from one box to the other.

l

Add: Click this button to add a selected field in the Available Columns box to a list. The field will move to the Selected Columns
box.

l

Remove: Click this button to remove a selected field from the Selected Columns box. The field will move to the Available
Columns box.

l

Move Up: Click this button to move a selected field in the Selected Columns box up. It will move the column on the list itself to the
left.

l

Move Down: Click this button to move a selected field in the Selected Columns box down. It will move the column on the list itself
to the right.

l

Reset Defaults: Click this button to reset the Available and Selected fields to their default settings. This option is not available
for all lists.
Fields with an asterisk next to them are calculated fields. Adding many of them to a list may slow down the performance of the list.

EZ-Access to Lists
Sage 50 allows you to preview lists of records and transactions to screen. With each list you can add a record or transaction, edit an
existing record or transaction, find information, perform a task, print a report, or make modifications to the fields and their order. To
do one of these tasks, click one of the links below:

Customize a list
You can customize your list in many ways. Any changes you make will be saved specifically for you, and all users can have
different settings depending on their access rights to the company data. In addition, if you have several companies, you can
have different settings for each list for each company.

How do I add fields to the list?

l

You can add fields to a list by following these steps.

1. Display the list you want to customize.
2. Select the Settings button in the toolbar. This will open the Settings window. On the right is a list of the fields that are
currently displayed. On the left is a list of other fields that you can select.

3. Click a field from the list to the left to select it.
4. Click Add. This will move that field to the right.
5. Repeat these steps to add further fields.
6. Click OK when you are done.
How do I remove fields from the list?

l

You can remove fields from the list by following these steps.

1. Display the list you want to remove fields from.
2. Click the Settings button in the toolbar. This will open the Settings window. To the right is a list of fields currently displayed;
to the left is a list of fields that can be added.

3. Click the field you want to remove from the list on the right to select it.
4. Click Remove. This will remove it from the list and move it to the list on the left.
5. Repeat these steps to remove other fields.
6. Click OK when you are done.
How do I rearrange the data on the list?

l

What do you want to do?
l

Rearrange the fields
You can rearrange the fields from left to right in two ways:
1) Simply click a field label, holding the mouse button down, and drag the field to the new spot.
2) Click the Settings button and use the Move Up and Move Down buttons to move the fields on the list to the right up
and down. Click OK when you are done rearranging the fields in this way.

Change the order in which records sort

l

To change the order in which records sort, either ascending or descending, and the field on which they will sort, simply
click the field label that you want to use for sorting. This will bring up an arrow triangle, pointing up, showing that records
are now sorted by this field in an ascending order, that is, from a to z. Click the field label again to change the sort order to
descending, from z to a.

How do I resize a column?

l

You can resize a column by following these steps:

1. Place the cursor over the vertical bar in the heading to the right of the field you want to widen or make thinner. The cursor
will change to a double-vertical bar with arrows at each end.

2. Click and hold the left mouse button.
3. Drag the vertical bar to the right or left to modify the width of the field.
Add a record or transaction to a list
To add a record or transaction to the list

1. Select the list you want to add a record or transaction to.
2. Click the New button. This will open the associated window for the list.
3. Enter the data on the Maintenance or Task window.
4. Save the new record or transaction. It will be added to this list.
You can also open the Maintain or Task window by right-clicking the mouse and selecting to Add.

Edit a record or transaction on a list
To edit a record in the list

1.
2.
3.
4.

Highlight the record or transaction you want to edit.
Click the Open button in the toolbar. This will open the Maintain or Task window with the data of the record or task.
Make the change in the Maintain or Task window.
Save the changes.

You can also open a record or task simply by double-clicking it in the list.

Find information on a list
Use the search features to find information on a list. For transactions, such as sales invoices, you can search by Date Range,
Status, and/or a particular piece of information. For records, you can search for a particular piece of information.
Search for a Transaction

1. Select a Date Range and/or Status, if necessary.
2. Use the Search For field to enter a piece of information about the transaction.
3. Select the field that this piece of information applies to in the field to the right.
4. Click Search .
5. All transactions that have that value in the specified field will be displayed on the grid. All others will disappear. To refresh the list
with all transactions, click the Clear button.
This field is not case sensitive. Typing land, for instance, will call up values with land, Land, and LAND for the field specified.
You can do searches for multiple items also. For instance, you want to find all invoices with an ID between 10200 and 10299. You
can type 102 in the Search For field and select Invoice ID. Then click Search. All invoices with 102 as part of the Invoice ID will
appear.

Search for a Record
1. Enter the piece of information you are looking for in the Search For field.
2. Select the type of information from the field to the right.
3. Click Search .

4. All records that have that value in the specified field will be displayed on the grid. All others will disappear. To refresh the list
with all records, click the Clear button.
This field is not case sensitive. Typing land, for instance, will call up values with land, Land, and LAND for the field specified.
You can do searches for multiple items also. For instance, you want to find all invoices with an ID between 10200 and 10299. You can
type 102 in the Search For field and select Invoice ID. Then click Search. All invoices with 102 as part of the Invoice ID will appear.

Print, e-mail, or export a list
l
Print a list
To print a list

1. Select the list you want to print.
2. Click the Print button in the toolbar.
3. Make your print selections and click Print.
E-mail a list

l

To send the list in an e-mail

1. Display the list you want to e-mail.
2. Click the Send to button to display a drop-down list of options.
3. Select the E-mail option.
4. Make any selections and click E-mail.
Export a list to Microsoft Excel

l

To export the list to Microsoft Excel

1. Display the list you want to export.
2. Select Send To in the toolbar.
3. Select Excel.
4. Make your selections and click OK.
Convert the list to PDF format

l

To convert your list to a PDF file

1. Display the list you want to convert.
2. Click the Send To button in the toolbar.
3. Select PDF.
4. Make your selections and click OK.
5. Specify where you want to save the list and what its name should be. Then click Save.
Perform a task using one of the records or transactions in the list
l
Perform a task using a record, such as a customer or vendor record.
1. Highlight the Record that you want to use.
2. Click one of the task links in the pane at the left of the List window. This will open the appropriate Task window with the fields
populated with data from the selected record.

Perform a task using a transaction, such as a sales invoice or receipt.

l

You can do this in one of two ways:
l

Highlight the transaction that you want to use, and click Open. This will open the transaction in the original window.

l

Double-click the transaction, and it will open in the original window.

Print a report for the list
A list of the most commonly-used reports for the current list appears in the pane on the left. To view one of these reports, simply
click the report name.

Create a New Company - What You Need
You use the Create a New Company wizard to establish basic information about your company and specific information about how
you want your company to work. You can choose to copy your chart of accounts from our sample charts of accounts for various
types of businesses or create your own.
Basic information includes the following:
l

Company Information: This includes name, address, telephone, FAX number, Web site address, federal and state employer
identification numbers, and state unemployment numbers.

l
l

l

Business Type: This defines what type of business your company operates as.
Chart of Accounts: You can choose to copy one of many sample charts of accounts or create your own. If you choose not to
copy a chart of accounts from a sample business, you'll need to enter a retained earnings account number after the setup is
complete.
Subsidiary Companies: (Sage 50 Premium Accounting and higher only) If the new company you're setting up is a
consolidated company, you need to know which existing companies you will be adding as subsidiary companies. Also, if any of
these subcompanies require a user ID and password for financial statement access, you need to know the IDs and passwords,
since you'll be prompted for them.

l
l

Posting Method: You have the choice between real-time posting, and batch posting, and SmartPosting.
Accounting Method: You have the choice of either cash-basis method or accrual-basis method of accounting. Most businesses
use accrual accounting.

l

Accounting Periods: You set up monthly accounting periods or customize your own fiscal-year structure.

After you enter your basic information, you can set up specific information for:
l
l
l
l
l
l

General Ledger: chart of accounts and beginning balances.
Accounts Receivable: default settings, customer records, and customer beginning balances.
Accounts Payable: default settings, vendor records, and vendor beginning balances.
Payroll: default settings, employee records, and employee year-to-date earnings and withholdings.
InventoryItems: inventory items , assemblies, and inventory beginning quantitiesitem information.
Jobs: job information and beginning balances.

What do you want to do next?
Begin setting up a new company
l
Read the Create a New Company overview
l
Read the getting started overview
l

Create a New Company
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l

Create a New Company Wizard - Introduction
Company Information
Business Type
Chart of Accounts - Use Sample Company
Chart of Accounts - Copy Existing Company
Set up Account Segments (Sage 50 Premium Accounting and higher only)
Accounting Method
Subsidiary Companies (Sage 50 Premium Accounting and higher only)
Subsidiary Company Passwords (Sage 50 Premium Accounting and higher only)
Posting Method
Accounting Periods
Accounting Periods - Monthly Setup
Accounting Periods - Custom Setup
Finish
Setup Guide

Create a New Company - Introduction
One of the first things you'll want to do after you install Sage 50 is set up your company. To get things started, Sage 50 provides the
Create a New Company wizard.
When you set up your company, you provide Sage 50 with basic information such as name and address. In addition, you select your
chart of accounts, choose your accounting and posting methods, and specify how your accounting periods are set up.
Once you have completed the Create a New Company wizard, you can go right ahead and start using Sage 50 to generate invoices
and pay bills. However, since there are some other setup tasks that you must complete in order to work efficiently in Sage 50, you
may first want to use the Setup Guide. This guide will assist you in completing the company setup process: entering default
information, record data (such as employee, vendor and customer records), and beginning balances.

Note: If you are rebuilding a company using import/export, there are special considerations you should be aware of before
proceeding. .

What do you want to do next?
Continue setting up a new company
l
Determine what you need before setting up a company
l
Convert an existing Sage 50 company data to a new release format
l

l

Read the getting started overview

Create a New Company - Company Information
You use the company information window to enter basic information about your company such as
l

name and address information

l

telephone and fax numbers

l

Web site address (for example, www.company.com) and primary e-mail address (for example, sales@company.com or
service@company.com)

Note: Do enter the "http://" prefix in the Web site address field.
l

federal and state employer identification numbers

l

state unemployment ID

l

type of business

You can change company information at any time.
When you're finished entering information, select the Next button. Sage 50 displays the Create a New Company -Select Method to
Create.

Read the Create a New Company overview

Create a New Company - Select Method to Create
You need to establish how your new company will be set up:
l

Use a sample business type that closely matches your type of company: Select this option to copy basic setup
information, particularly a chart of accounts, from a sample company. You can select either a simplified chart of accounts that
contains only the basic accounts you need to get started; or you can choose a detailed chart. Depending on which version of Sage
50 you are using your selections will vary. You can modify the accounts later, according to your needs. Tell me more about
selecting a business type.

l

Copy settings from an existing Sage 50 company: Select this option if you want to copy setup information from another
Sage 50 company or you are rebuilding a Sage 50 company.

l

Convert a company from another accounting program: Select this option if you want to import company data from
some other program. .

l

Build your own company: Select this option if you want to create a company from scratch. This option is only recommended
for experienced users who are comfortable setting up accounting information. For users coming from a paper ledger, we
recommend that they select a business type (see above) that most closely matches their existing chart of accounts and then
modify it as they have need.

If you select this option, make sure you set up your chart of accounts prior to setting up any other part of the company. Do this
immediately after finishing the Create a New Company wizard.
l

Consolidate existing Sage 50 companies: (Sage 50 Premium Accounting and above only) Select this option to combine the
charts of accounts of a number of existing Sage 50 companies to create a new consolidated chart of accounts. This will let you see
consolidated financial statements for multiple businesses operating under an umbrella organization. Tell me more about this.

To continue setting up your company, select the Next button.

Create a New Company - Copy Company Information
You can choose to copy specific setup information from the selected Sage 50 company. This option is useful if you have already set
up a company and want to save time entering default information.

1. Start Create a New Company, and make sure the Copy settings from an existing Sage 50 company chart of account
option is selected and you have chosen an existing company to copy.

2. Select each company setting you want to copy to your new company.
If you don't choose to copy the information, you can set up new information by selecting menu options from the Maintain menu.
If you are rebuilding a company, you should select each option.
l

Chart of Accounts: This copies account IDs, descriptions, budget information, and account types from the selected
company. If you choose not to copy a chart of accounts, it is strongly recommended that you set up the required retained
earnings account immediately following New Company Setup.

l
l

Accounting Periods: This copies the number and dates of accounting periods from the selected company.
Statement and Report Formats: This copies all customized financial statements that were designed in the selected
company.

l
l
l
l

General Ledger Defaults: This copies General Ledger default information entered in the selected company.
Customer Defaults: This copies customer and statement/invoice default information entered in the selected company.
Vendor Defaults: This copies vendor default information entered in the selected company.
Employee Defaults: This copies employee default information entered in the selected company, including payroll setup and
company payroll tax formulas. This option is not selected by default since most companies have a unique payroll setup.
However, if you are rebuilding your company, make sure to select this option.

Inventory Item Defaults: This copies inventory item default information entered in the selected company.
Job Defaults: This copies job default information entered in the selected company.
3. To continue setting up your company, select the Next button. Sage 50 displays the Create a New Company – Accounting
Method window.
l
l

Create a New Company - Chart of Accounts (Copy Existing Company)
You can choose to copy setup information from another Sage 50 company. This option is useful if you have already set up a
company and want to save time entering default information. This option should also be used if you are rebuilding a company.

1. Start Create a New Company, and make sure the Copy settings from an existing Sage 50 company business type
option is selected.

2. Select one of the available companies listed.
You can view the chart of accounts for an existing company in the pane to the right.

3. To continue setting up your company, select the Next button. Sage 50 displays the Create a new Company - Copy Company
Information window.

Create a New Company - Business Type
Your company's business type is a complete list of all account names that will be used in the general ledger, including a set of Equity
accounts tailor-made for the business. Each account is associated with an account ID to help locate it when recording data. Charts of
accounts can vary depending on the type of business. Sage 50 provides sample companies from which you can copy the chart of
accounts. This is a useful shortcut to set your company. Later, you can modify the chart of accounts to meet the specific needs of
your business.

1. Start Create a New Company and make sure the Use a sample business type that closely matches your company
option is selected.

2. Select the chart of accounts that matches your type from the list. Depending on the version of Sage 50 that you are using the list
of simplified and detailed business types will vary. To the right, you can see the chart of accounts that will be created if you select
a particular business type.

3. To view more information about an industry, select the View details about a business type link.
4. To continue setup of your company, select the Next button. Sage 50 displays the Create a New Company – Accounting Method
window.

Create a New Company - Subsidiary Companies
This procedure is possible only in Sage 50 Premium Accounting and higher.
This window lets you combine the charts of accounts of a number of existing Sage 50 companies to create a new consolidated chart
of accounts. The new consolidated company created in this way will let you see consolidated financial statements for the subsidiary
companies operating under that umbrella organization. For more information about consolidating companies, see the "Consolidate
Companies" overview.

1. In the Available Sage 50 companies list box, the companies contained in your default Sage 50 data path appear. To add any
of these companies to make a new group of subsidiary companies, select it in the list box, and then select the Add button.
The chosen company moves to the Selected subsidiary companies list box.
2. Repeat step 1 for each subsidiary company you want to consolidate.
3. To remove any selected subsidiary company and return it to the Available Sage 50 companies list box, select the company,
and then click the Remove button.
4. If you want to consolidate subsidiary companies that do not appear in your default Sage 50 data path, select the Browse for
More Companies button.
The Select Company to Add window appears. letting you select the appropriate data path and the subsidiary company you want to
consolidate.

5. Select the appropriate data path and the available company you want to use as a subsidiary company in the consolidation. Once
you select this company, it will be placed in the Selected subsidiary companies list box of the Create a New Company Subsidiary Companies window.

6. When finished adding subsidiary companies, select the Next button to continue setting up your company.

Create a New Company - Subsidiary Company Passwords
This procedure is possible only in Sage 50 Premium Accounting and higher.
When you are combining subsidiary companies to create a new consolidated company, you may choose a subsidiary company that
requires a user ID and password to grant user access. If this is the case, when you select Next in the Create a New Company Subsidiary Companies window, the Create a New Company - Subsidiary Company Passwords window appears. Here, the Company
Setup wizard displays all subsidiary companies that require passwords.

1. For each company that appears in the grid at left, enter the appropriate user ID and password in the User Name and
Password columns.
2. To continue creating your new consolidated company, select the Next button. Sage 50 displays the Create a New Company Posting Method window.

Create a New Company - Accounting Method
The accounting method determines how Sage 50 handles General Ledger, Accounts Receivable, and Accounts Payable transactions.

1. Start Create a New Company, and make sure the Accounting Method window is displayed.
2. Choose the accounting method to run your business:
Accrual Accounting:
What is Accrual Accounting?
In Accrual accounting, revenue is recorded in your general ledger as you invoice customers, and expenses are recorded in your
general ledger when you receive bills from vendors, regardless of when cash is actually exchanged. This presents a truer picture of
income and expenses for your Income Statement/Profit and Loss Statement. Most companies use this method.

Note that this does NOT mean that Sage 50 considers your customers' invoices to be paid. You will still be able to see how much
money your customers owe you and enter their payments. The choice made here affects only your financial statements, such as
your Income Statement/Profit and Loss Statement.

What are the benefits of Accrual Accounting
Businesses with inventory or that work on credit should use Accrual accounting. Some of the benefits are
l

Better reporting: You get a truer picture of how your business is doing because it includes booked sales and purchases
(Accounts Receivable and Accounts Payable). Income and expenses are recognized when they are earned or incurred, regardless
of when they are received or paid.

l

Tax benefits: Expenses are recognized in the year they are incurred not in the year they are paid. For instance, expenses
incurred in 2011 can be used as deductions on your 2011 taxes even if you don't pay the bills until 2012.

When should I choose Accrual Accounting?
You should use Accrual Accounting
l

l

If you sell traditional inventory items (called “stock items” in Sage 50). This includes any merchandise you sell. The IRS requires
this.
You grant or receive credit from customers or vendors.

Cash-Basis Accounting:
What is Cash-Basis Accounting?
In Cash-Basis accounting, revenue is recorded in your general ledger when cash (checks, money orders, or currency) is received,
and expenses are recorded in your general ledger when paid. However, unpaid credit sales and purchases do not show on ledgers,
which can present a misleading picture of income and expenses.
If you use cash-basis accounting, you may discover that the inventory valuation report does not agree with the general ledger
account for inventory. This is because inventory uses the accrual method, while the general ledger is cash basis. This means that the
inventory records will be updated to reflect unpaid purchases and sales, while the general ledger will not be updated until actual
money changes hands.

What are the benefits of Cash-Basis Accounting
Many small, service-type businesses (accountants, lawyers, consultants) like cash-basis accounting. There are three main benefits
to this method.
l

Tax benefits: If income is not recognized until cash is received, you would have less income to report in a given year. Income
not reported for December would be reported in January of the following year, resulting in a short-term benefit. Since most small
service companies have more receivables than payables, cash basis may be the best bet.

l

Less bookkeeping time/greater simplicity: In cash basis, you could choose not to record customer or vendor invoices or
record less information for them since you have no receivables or payables accounts. On the other hand, if you don’t record
invoices, you lose the benefits of aging and projecting cash flow.

l

Easier cash management: Because revenue and expense are only recognized when cash changes hands, it is easier to obtain
a truer picture of your cash position.

Check with your accountant to determine the best accounting method for your type of business.
You cannot track retainage or use the retainage feature in Sage 50 Construction Accounting or Sage 50 Quantum Accounting if
you select the Cash-Basis method of accounting. How do I set up Sage 50 to track retainage? .

Important: Once you choose the accounting method and complete the New Company Setup wizard, you cannot change it for this
company.

3. To continue setting up your company, select the Next button. Sage 50 displays the Create a New Company - Accounting
PeriodsCreate a New Company - Posting Method window.

Create a New Company - Posting Method
The posting method determines how Sage 50 processes transactions to journals and the general ledger.

1. Start Create a New Company, and make sure the Posting Method window is displayed.
2. Choose the posting method you want to use when processing transactions:

Real-Time Posting: Transactions are posted to the journals and the general ledger as they are entered and saved. This
method can save you time and is best for most business and network environments. Most companies use this method.
Batch Posting: Transactions are saved by the program and then posted in a group. When you use batch posting, you can print
registers and check the batch of transactions before posting them to the journals.

SmartPosting: Transactions are saved by the program and then automatically posted by the SmartPosting service. This
posting method helps improve performance by allowing you to save transactions without waiting for them to post. Unlike
batch posting where you have to manually post transactions, the posting happens automatically when you use
SmartPosting. In a network environment, you can use a separate computer to post the transactions and get even better
performance. We recommend you use this method.
You can switch posting methods at any time.

3. To continue setting up your company, select the Next button. Sage 50 displays the Create a New Company - Accounting Periods
window.

Posting Method
The posting method determines how Sage 50 processes transactions to journals and the general ledger.
You can choose between:

Real-Time Posting: Transactions are posted to the journals and the general ledger when Save button is selected after they are
entered. This method can save you time and is best for most business and network environments. Most companies use this
method.
Batch Posting: Transactions are saved by the program and posted in a group when Save button is selected after they are entered.
When you use batch posting, you can print registers and check the batch of transactions before posting them to the journals.

SmartPosting: Transactions are saved by the program and then automatically posted by the SmartPosting service. The service
regularly cycles through the database looking for transactions to post. You do not have to actively post the transactions since the
service does it for you. This method is recommended for better performance.
You can switch posting methods at any time.

Create a New Company - Accounting Period Structure
Accounting periods are units of time that divide your fiscal year for reporting purposes. In Sage 50 you can set up to 13 accounting
periods per fiscal year.

1. Start Create a New Company, and make sure the first Accounting Periods window is displayed.
2. Choose the accounting period structure you want your company to follow:
12 monthly accounting periods: Each accounting period's starting and ending dates match those of the 12 calendar months.
You can choose to start your fiscal year in January or any other month of the year. Most companies follow this fiscal year
structure.

Accounting periods that do not match the calendar months: Choose this option if you want to set up a custom fiscal
year structure. For example, you may want four accounting periods per year or possibly 13 four-week accounting periods per
year.

3. To continue setting up your company, select the Next button. Sage 50 displays the next Create a New Company window
corresponding to your setup option.

Create a New Company - Accounting Periods (Custom Setup)
A starting date need to be established for setting up your company.

1. Start Create a New Company, and make sure the Accounting periods that do not match the calendar months setup
option is selected.

2. Accept the default, or select the number of accounting periods in your fiscal year from the list. You can have up to 13 periods in a
single fiscal year.

Note: If you are creating a consolidated company, this field will be disabled (gray) and will display the number of periods in the
consolidated company's fiscal year.

3. Enter the first day of your first fiscal year, or click the calendar button to select a date.

Usually, a company's fiscal year starts in January and ends in December. However, some companies start their fiscal year in July
and end in June.

Note: If you are creating a consolidated company, this field will be disabled (gray) and will display the start date of the
consolidated company's fiscal calendar.

4. To continue setting up your company, select the Next button. Sage 50 displays the Create a new Company - Finish window.
Tip: The table on the right displays the start and end dates for each accounting period in your first two fiscal years. You can type or
select dates in each of these fields, if necessary, to further customize your setup.

Create a New Company - Define Account Segments
This window appears if you select Build your own company on the Create a New Company - Chart of Accounts window. Use
this window to indicate if you want to use Account Segments for your new company's chart of accounts.
Account Segments give you a powerful way to organize your general ledger accounts, by allowing you to create up to five segments
for each account ID. You can then filter reports based on a specific segment or group of segments. This is valuable if you need to
departmentalize your income and expense accounts and print departmentalized financial reports, or if you are a non-profit
organization that needs to mark certain expense accounts for a particular level of restriction.

Show me an example of using account segments.
If you do not want to use account segments, select No, I do not want to use account masking. Select the Next button to
continue New Company Setup.
If you want to use account segments, select Yes, I would like to use Account Masking. The fields below this option allow you
to define up to five segment sections, their lengths and the separator to divide the segment from the segment following it. As you
enter a description for a segment, the fields for the next segment will become available.
l

Segment Description:Enter a description (up to 10 characters) for the segment. This description could be department,
division, or any other designator for that segment of your Account ID. This description will appear on all windows that reference
account segments. For instance, General Ledger report and Financial Statement filtering options.

l

Length: Enter the length of the segment. For example, if this segment of the account ID is two characters in length, enter 2 in this
field.

l

Separator: Specify a separator between this segment and the segment following it (if any). The default separator is a hyphen
(-), but you can select other values from the drop-down list. In addition, you can type in any other character as a separator, with
the exception of the asterisk (*), question mark (?), plus sign (+), and a blank space.

As you enter values for the Length and Separator fields for each segment, Sage 50 updates the Account Structure field to the
right and shows you how the Account ID is structured, with a capital X used to represent each space in the segment length.
Moreover, Sage 50 updates the Total Account Length field, telling you how long the account ID is. The maximum length is 15.
After Create a New Company is complete and you are creating your chart of accounts, Sage 50 will expect the account IDs you enter
to match the segmentation structure you create here. Sage 50 will allow you to create new account IDs that do not match the
structure, but it will warn you when you try to save the new account.
If you should need to alter the account segments after New Company Setup is complete, you can do so on the General Ledger
Defaults - Account Segments tab. To open this tab, select Maintain ; General Ledger Defaults; General Ledger;
Account Segments tab. Tell me more about this.
Select the Next button to continue New Company Setup. Sage 50 displays the Create a New Company - Accounting Method
window.

Create a New Company - Fiscal Year
Starting dates need to be established for setting up your company and entering data. Once you establish a starting date, Sage 50 will
automatically set up monthly accounting periods for your first two fiscal years.

1. Start Create a New Company, and make sure the 12 monthly accounting periods setup option is selected.
2. Enter the first month of your first fiscal year, or select it from the drop-down list. Then, enter the year.
Usually, a company's fiscal year starts in January and ends in December. However, some companies start their fiscal year in July
and end in June.

Note: If you are creating a consolidated company Sage 50 Premium Accounting and above), this field will be disabled (gray)
and will display the first month and year of the consolidated company's first fiscal year, based on information taken from the
subsidiary companies.

3. To continue setting up your company, select the Next button. Sage 50 displays the Create a New Company - Finish window.

Create a New Company - Finish
Use this procedure to complete the new company setup process.

1.
2.
3.
4.

Start Create a New Company, and read the information in the window and follow the prompts.
Complete each window that follows until Sage 50 displays the New Company Setup – Finish window.
Read the information on the window.
Select the Finish button to save your company settings.

Note: New company setup does the basics, but to finish the process, you will need to establish your company's default values,
record information, and beginning balances. The Setup Guide, a special Sage 50 feature, will help you do this quickly and
efficiently. To use the Setup Guide, go to the Help>Setup Guide on the main Sage 50 window.

Sage 50 Setup Guide
The Sage 50 Setup Guide is designed to walk you through the process of setting up company default information, data records (such
as employee, vendor, and customer records), and beginning balances. It helps you complete all needed phases of your company
setup process.

How Do I Get to the Setup Guide?
The Setup Guide will appear each time you open a Sage 50 company unless you check the Don't show this screen at
startup checkbox at the bottom of the window. You can also access the Setup Guide from Help>Setup Guide on the main
Sage 50 window.

Using the Guide
The Setup Guide has a total of seven sections that are available from an overview page. These pages tell you how to set up your
company's
l

customers

l

jobs

l

vendors

l

inventory and service items

l

employees

l

chart of accounts

l

user security

We recommend that you start with customers and proceed in the order listed above (and as listed on the overview page). But you
can skip a section (or more) if you don't really use it in your business.
Each section in the Setup Guide is made up of a series of pages that let you enter the following:
l

Default information is common information. For example, if you set up customer defaults, the defaults you choose will be in
force for all customers serviced by your company.

l

Data records store information that is pertinent to your company's chart of accounts and to each of your company's customers,
vendors, employees, inventory items, and jobs.

l

Beginning balances represent outstanding customer or vendor invoices, outstanding earnings and deductions for
employees/sales reps, outstanding invoices and payments for jobs, and the quantity and cost of inventory items currently on
hand.

For example, in the Customers section of the Setup Guide, there are pages that let you set up customer records, beginning
balances, default information, sales taxes, and statement/invoice defaults. Once you complete a page, you just click the Next
button to go on to the following page; you can use the Back button to return to a page if needed.
The Setup Guide is designed to make entering information and setting up records easy, but it's a good idea to do a little planning. So
before you start, you should assemble some basic information required for setting up each area of Sage 50.

Get an overview of user security in Sage 50 .

Convert Sage 50 Company Data to a New Release Format
After installing a Sage 50 upgrade or update, the first time you open your company in Sage 50, the Data Conversion wizard may
appear automatically.

Note: Sage 50's Data Conversion wizard only works for company data established in prior Sage 50 releases of equal or lesser
versions. For example, you cannot convert a Sage 50 Complete Accounting company (full-featured version) to the Sage 50 Pro
Accounting format (mid-level version), even if that Sage 50 format is newer.

Before Starting the Data Conversion Wizard...
Before you launch the wizard, there are some precautionary tasks you may want to perform.
l

Turn off screen savers, disable anti-virus software, and close all other applications. This will speed up the
conversion process and avoid any errors.

l

Make sure you have ample hard disk space available where your data is located before converting your
company. The conversion may require up to three times the size of your company data to convert successfully, depending on
the version you are converting. For example, if your company is 6 MB, make sure 18 MB of hard disk space is free. Sage 50 uses
the extra space temporarily while converting.

Also, while the wizard requires that you back up your company data during the conversion process, you can do so before launching
the wizard if you prefer. In either case, backing up company data is highly recommended. Never overwrite an existing conversion
backup. How do I back up my company data?

Note: Since the conversion process may take a while to complete, we recommend that you start the process before lunch or at
the end of your business day, making sure you leave the computer running.

Starting the Data Conversion Wizard
Use this procedure to convert your company data to the new Sage 50 format.

1. From Sage 50's File menu, select Open Company. If your company is in a prior release format, the Data Conversion wizard
appears. If it does not, data conversion is not necessary.
The Data Conversion wizard walks you through the process of converting your company data to an updated format. At every
point in the process, the wizard makes your options clear and tells you the consequences of every action you might take. The first
window, Data Conversion Wizard - Introduction , informs you that your company data needs to be converted.

2. Once you've finished reading the introductory text, click the Next button to go to the next window in the series, Data Conversion
Wizard - Confirm Company.
This window identifies the company you are about to convert, the location of your company data, and which version you are
converting. After confirming the company you are about to convert, click Next to display the Data Conversion Wizard - Back Up
window.

Note: If you are not using SmartPosting as your posting method, the Data Conversion Wizard - Switch to SmartPosting window
will display. On this window you can decide if you want to use SmartPosting or not. Once you have made your decision, click
Next to display the Data Conversion Wizard - Back Up window.
Sage 50 requires that you make a backup of company data and customized forms before converting to the new format. If
something failed or there was a power outage, you could restore the backup and convert again. Also, it's a good idea to back up
your old company data to diskette, which can be filed away for audit purposes.

3. Select the Back Up button to start this process. .
4. After you back up your company, click Next to start the conversion process.
Sage 50 displays the Data Conversion In Progress window, which shows the progress of the conversion.

Warning: Do not interrupt the conversion or close the Data Conversion wizard! If you do, you may damage your company
data. If you run into errors, refer to the data conversion troubleshooting tips.
Once the data conversion is completed, a congratulations message appears confirming the success of the conversion process.

5. Click Finish to open your company in the new format.

Complete this procedure for each company you created in a previous version.

Note: If multiple users have access to your company (possible only in Sage 50 Complete Accounting and higher), all users will
have access to the company in the new format. Though each user must install the Sage 50 upgrade or product update, the
company data is converted only one time.

Tip: For last-minute information about the new product version, refer to the Release Notes.

Data Conversion Wizard - Introduction
The Data Conversion wizard walks you through the process of converting your Sage 50 company data to an updated format.
Typically this is required after you upgrade from a different or older version of Sage 50. At every point in the process, the wizard
makes your options clear and tells you the consequences of every action you might take.

Note: Sage 50's Data Conversion wizard only works for company data established in prior Sage 50 releases of equal or lesser
versions. For example, you cannot convert a Sage 50 Complete Accounting company (full-featured version) to the Sage 50 Pro
Accounting format (entry-level version), even if that Sage 50 Pro Accounting format is newer.

Before Starting the Data Conversion Wizard...
Before you launch the wizard, there are some precautionary tasks you may want to perform.
l

l

Turn off screen savers, disable anti-virus software, and close all other applications including memory
managers. This will speed up the conversion process and avoid any errors.
Make sure you have ample hard disk space available where your data is located before converting your
company. The conversion may require up to thee times the size of your company data to convert successfully, depending on the
version you are converting. For example, if your company is 6 MB, make sure 18 MB of hard disk space is free. This does not
mean your company will triple in size. Sage 50 uses the extra space temporarily while converting.

Also, while the wizard requires that you back up your company data during the conversion process, you can do so before launching
the wizard if you prefer. In either case, backing up company data is highly recommended. Never overwrite an existing conversion
backup. How do I back up my company data?

Note: Since the conversion process may take quite a while to complete, we recommend that you start the conversion before lunch
or at the end of your business day, making sure you leave the computer running.

Starting the Data Conversion Wizard
After upgrading Sage 50 in a new release (or in some cases installing a product update), the first time you open your company in
Sage 50, the Data Conversion wizard appears automatically.

1. From Sage 50's File menu, select Open Company. If your company is in a prior Sage 50 format, the Data Conversion wizard
appears. If it does not, data conversion is not necessary.
The first window, Welcome to the Sage 50 Data Conversion , informs you that your company data needs to be converted.
2. Once you've finished reading the introductory text, click the Next button to go to the next window in the series, Data Conversion
Wizard - Confirm Company.

Open Company As
This feature is only available for Sage 50 Accountant Edition.
You can specify the flavor or product of Sage 50 that you want to use when opening a client’s data. The program will recognize the
original flavor of your client’s company, and ask if you want to open it in the same flavor or in a different one.
For example, if you client sends you a Sage 50 Premium Accounting company, your Sage 50 Accountant Edition lets you open it in
Sage 50 Premium Accounting or convert it to any of the following:
l

Sage 50 Distribution Accounting

l

Sage 50 Manufacturing Accounting

l

Sage 50 Construction Accounting

l

Sage 50 Nonprofits Accounting

l

Sage 50 Quantum Accounting

Warning! If you open a company in a different flavor, the data gets converted to that flavor. Once you have converted a
company to a different flavor or format, you cannot return to the original format. If you will be returning this data set to your client,
you would generally not want to upgrade to a different flavor at this time. In most cases, you would want to keep the original flavor
of the company.

Opening Multiple Companies Simultaneously
This procedure is possible in Sage 50 Complete Accounting and higher.
You can have more than one Sage 50 company open at the same time. To do so

1. Open the first company.
2. Select File, and then either
l

Open Company

l

Open Previous Company

l

New Company

3. At the warning message, select Yes.
4. Select the company you want to open or create the new company.
This will cause the current company to become inactive, as marked in the taskbar at the bottom of your computer monitor. Notice
that it is grayed out and marked as "inactive." The newly-opened company will be active.
The first company that was opened will be marked with an asterisk in the Windows Taskbar at the bottom of your screen, as well as
at the top of the main Sage 50 next to the company name.
Clicking the company name in the taskbar will display it on the screen and activate it. At the same time, any other opened companies
will be marked as inactive.
Note if you try open two companies at the same time, certain functions in Sage 50 will operate ONLY in the company that was
opened first. See a list of these functions.

Limitations When Opening Multiple Companies
Opening multiple companies is possible in Sage 50 Complete Accounting and higher.

Although Sage 50 will allow you to have multiple companies open at the same time, certain features in Sage 50 will work ONLY
in the company that was opened first. To use these features in companies opened secondarily, close the company that was
opened first and then try again.
The first company that was opened will be marked with an asterisk in the Windows Taskbar at the bottom of your screen.

These programs are listed below
l

COM Add-Ins from third parties

l

Conversion from Sage DacEasy or QuickBooks

l

Credit Card Processing (Sage Exchange)

l

Daily Register reports

l

Direct Deposit processing

l

Sage 50 Fixed Assets

l

Internal Accounting Review

l

Online Banking

l

Payroll Forms (via Aatrix)

l

Checks and Forms information

l

Sage Customer Support information

l

Sage 50 Fixed Assets Solutions information

l

Sage 50 Industry Specific Solutions information

l

Sage 50 Online Backup information

l

Sage 50 Online Update information

l

Sage 50 Business Care information

l

Sage 50 Remote Access information

l

Sage 50 Special Edition of MAS 90 information

l

Sage 50 Tax Updates (downloads)

l

Sage Payment Solutions information

l

Sage Timeslips /TAL Pro for Sage 50

l

Sage Timeslips Integration with Sage 50

l

Web Transaction Center

l

What’s New page

l

Year-End Wizard

Maintain Company Information
The Maintain Company Information window allows you to enter or change your company's basic information. This includes the
following:
l

Company name and address information.

l

Company telephone and fax numbers.

l

Company Web site and e-mail addresses.

l

Company federal and state employer identification numbers.

l

Company state unemployment ID.

l

Business type.

l

Directory: The directory path where the currently displayed Sage 50 company resides.

l

Accounting and posting methods.

l

l

Direct Deposit: Additional windows let you authorize Sage 50 Direct Deposit and enter direct deposit information for your
company.
Managed Payroll: An additional window lets you activate the Sage 50 Managed Payroll. When you use this service, it replaces the
standard Sage 50 Payroll module.

Learn More
Making changes to your company information
You can change company information at any time. This includes the posting method you chose for your company. Note,
however, that you cannot change the type of accounting method used. If you want to do this, you must delete the
company and set it up again.

Change your company's basic information
Change your company's posting method

Change Your Company Name
You can easily change your company name at any time in Sage 50.

Note: Entering a new name here does not mean you are entering a new company, it merely means you are changing the name of
an existing company. To enter a new company, from the File menu, select New Company.
1. From the Maintain menu, select Company Information . Sage 50 displays the Maintain Company Information window.
2. Enter a new value in the Company Name field.
You can enter up to 30 characters for the company name. This field is required; therefore it cannot be blank.

3. Change other company information, if necessary. When finished, select OK.
The company now reflects your new company name. The next time you start Sage 50, the Sage 50 main window title bar will
display your new company name.

Change Your Company's Basic Information
Use this procedure to change your company's basic information including business address and phone number.

1. Open your company, if it is not already open.
2. From the Maintain menu, select Company Information . Sage 50 displays the Maintain Company Information window.
3. Enter your changes to one or more of the following: company name, company address, phone number, fax number, and tax ID
information.

4. If the type of business has changed, select the new type from the drop-down list.
5. If you want to change posting methods, click the arrow button.
6. To record the updated company information and close the window, select the OK button.

Change Your Company's Posting Method
Use this procedure to change your company's posting method (batch posting, or real-time posting, or SmartPosting).

1. Open your company, if it is not already open.
2. From the Maintain menu, select Company Information . Sage 50 displays the Maintain Company Information window.
3. Click the Posting Method arrow button, and choose the Batch , or Real Time, or SmartPosting option. Tell me more about
posting methods.
4. To record the updated company information and close the window, select the OK button.
If you are changing from batch posting or SmartPosting to real-time posting, Sage 50 will post all transactions before you can
continue.

Protecting Your Company Data
Sage 50 Security
Sage 50 provides several options that can maintain data security and can deter users from possible fraudulent activities. These
include
l
l
l
l

Company Users: User Names and Passwords
Audit Trail Log
Account Reconciliation
Backup and Restore

Company Users: User Names and Passwords
Sage 50 can allow custom access for different individuals. You can set up user profiles (records) for each person who will be using
Sage 50. Each user record is set up with a user name and password that will be required before opening and working with company
data. Sage 50 passwords comply with PCI standards for credit card transactions. Setting up user profiles also enhances security and
personal accountability as provided by the Sage 50 audit trail feature (see below). Tell me more about company users and
passwords.

Audit Trail
This feature is available only in Sage 50 Complete Accounting and higher.
Sage 50 has several methods to track information. For example, the general ledger, journals, reports, and financial statements can
be used to trace transactions and balances for audit purposes. However, if you want to track when an action is performed in your
company data, Sage 50's audit trail provides this information in a very usable form. The audit trail feature logs when a person enters
data, maintains (edits) existing data, and removes data. Audit trail provides accountability of users, deters users from fraudulent
activity or mistakes, and tracks transaction history. The Audit Trail report can trace fraudulent activity and other accounting
adjustments you may not know were completed. Tell me more about Sage 50's audit trail.
If you intend to have Sage 50 maintain an audit trail log, it is strongly recommended that you set up user profiles in your company.
The Audit Trail report can associate user IDs with each data and system activity performed as it occurs and establishes personal
accountability.

Account Reconciliation

You can reconcile any general ledger account in Sage 50. Typically, you would reconcile bank accounts, cash accounts (such as
petty cash), and credit card accounts. You should systematically reconcile accounts each period so that you can quickly signal bank
errors, match real-world data with Sage 50 data, and detect possible fraudulent activity. Tell me more about account
reconciliation .

Backup and Restore
It is important that you back up your company data on a regular basis and store these backups in a separate, secure location.
Backing up data allows you to record a snapshot of the current state of your company. If you suspect fraudulent activity or your data
becomes corrupt, you can restore a recent backup. Backups are also useful for auditing purposes. For example, you can restore a
backup that was made prior to closing a fiscal year to examine detailed transaction history. .

What do you want to do next?
Set up user records and passwords
l
Set up company users and roles
l
License Sage 50 users
l
Read the users and passwords overview
l
Reconcile an account
l
Back up company data
l

l

Restore a backup of company data

User Security
Sage 50 can allow custom access for different individuals. If you want to take advantage of this security feature, you set up user
rights for each person who will be using Sage 50. When set up, each user is issued a user name and password that will be required
before opening and working with company data.
Because access is specific to a company, if you work with multiple companies, you can set up users to have access to one or more of
your companies and not others. Get a brief overview of security and strategies for setting it up in Sage 50 .
Once user names and passwords are set up, Sage 50 prompts each user for a user name and password whenever he or she opens a
company. As long as users properly enter their passwords, they can access the areas of the program to which they have rightsthat
their roles entitle them to access and use.

Note: If you use the security feature, you must set up at least one user as company administrator. The administrator will have full
access to the Sage 50 program AND will be able to set up and maintain company users and their passwords.
In the unfortunate event that you lose your user name or password and no one else can open the Sage 50 company, contact Sage
50 Customer Support.

Learn More
Setting up users
Setting up Sage 50 users involves several steps, depending on the access rights of the user. First, you give the user a user
name and password. Then, you select the type of access the user will have to the Sage 50 program. If you choose to give the
user limited access, the Selected Access window lets you set the appropriate areas and levels of access.

Set up company users, passwords, and access rights
Setting up users and their roles
Setting up Sage 50 users involves several steps, depending on the role that you assign to the user. We recommend that the first
user you set up is the administrator. After that, you can enter additional new users up to the number of licenses you have
remaining.
If you're adding a new user as well as a new role for that user, you'll enter the user name and password and then go on to define
the user's role. Once you have roles defined, you can assign those roles to any new users you add to the company.

Set up company users, passwords, and user roles
Logging in to a Sage 50 company with a password
Once a user name and password are set up for a Sage 50 user, that person will have to enter the name and password to enter
the areas of the program to which he or she has secure access.

Log in to a Sage 50 company
Editing user information

Once a Sage 50 user is set up, you can change that user's password and access rights if needed.

Change a user's password and/or access rights
Editing users' roles and viewing user access rights
Once a Sage 50 user is set up and assigned a role or roles, you can change that user's role(s) and access rights if needed. If you
just want to view the user's rights, you can do that as well.

Change an individual user's role(s)
View a user's access rights
Changing password options
If you are logged in as the Sage 50 Administrator, you can set certain options regarding users' passwords. You can specify how
long a password is good for, making it less likely that security will be compromised.

Change password options
Copying user information or deleting a user
As an added convenience, you can use an existing user's access rights to create a new user and then edit the new one as
needed. You can also delete any existing user.

Copy user information to a new user
Delete company users
Editing an existing role
Once a role is added to a Sage 50 company, you can change that role as needed, including the role name, description, and
access-rights information.

Edit an existing user role
Copying or deleting a role
Once you've created user roles, you can use an existing role to create a role and then edit it as needed. You can also delete any
existing role, as long as that role is not assigned to any current Sage 50 users.

Copy a user role information to a new role
Delete an existing role

Set Up Company Users, Passwords, and Access Rights
In order to implement data security and password protection, you must set up user records. When user names and passwords are
set up, Sage 50 prompts you for a user name and password combination when you open a company. If you know the password, you
can access the areas of the program to which you have rights.
Setting up users in Sage 50 involves setting up a company administrator first. After that, you can set up individual users, as many as
you have licenses for.

Note: Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include
both upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
How do I get to the User Security window?
From the Maintain menu, select User Security. Sage 50 displays the User Security window.
Note: If you don't have access to the User Security option in the Maintain menu, then your user profile does not have
privileges to set up or maintain users/passwords in this company. Check with your company administrator, or open the
company using a user name and password combination that has this privilege.

Licensing Sage 50 company users
Setting up the first user (administrator)
In order to use user/password security in a Sage 50 company, you must first set up a single user record. After that, all other
users will need a user name and password to access the company.
The first user you set up must be an administrative user with full rights to each area of Sage 50 and the ability to set up and
maintain user records and passwords. Once the administrator is set up, he/she can then add other users to the system.

1. Select the New User button.
The User Rights window appears.

2. Enter a user name (for example, Admin062 ) and its corresponding password.
Note: Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include
both upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
3. To give the user full access to the program plus the ability to create individual users, select the Administrator option.
4. When finished, select OK.
The User Security window returns. Note that the user name and access level information have been added to the grid at the
center of the window. Note, too, that the Licensed checkbox is automatically checked. You're now ready to set up additional
users.

Setting up additional company users
1. Select the New User button.
The User Rights window appears.

2. Enter a user name and its corresponding password.
3. Choose the appropriate level for the user: Full access, Selected access, or None.
4. When finished, click OK or Next, whichever appears.
l
If you have chosen Full access or None, the Users window returns. Note that the user name and access level information
have been added to the grid at the center of the window. Note, too, that the Licensed checkbox is automatically checked.
You're now ready to set up additional users.
l

If you have chosen Selected access, the Sage 50 User Security window appears. It lets you select exactly the areas of the
Sage 50 that you want the user to be able to access.

Setting up users with selected access
1. Select the New User button.
The User Rights window appears.

2. Enter a user name and its corresponding password.
3. Choose the Selected access option.
4. Click Next.
The Selected Access window appears.

5. From the menu bar on the left side of the window, select the area of the Sage 50 program that you want to set access levels
for—Customers & Sales, for example.
l
If you want to grant either full or no access to this whole area of the Sage 50, use the drop-down list at the right-hand
top of the window.

l

If you want to grant access to some subareas but not others—for example, Sales Invoices—you can use the drop-down
list opposite the appropriate area. You can choose from a range of security access levels.

6. When you're finished, click OK to return to the Sage 50 User Security window.
Granting access to users who already have access to other companies
If a user listed in the User Security window has access to another company but not the current one (the user name is marked
with an asterisk), the Access Areas for This Company column will read No access. It will also have a blue Add user to this
company link.

If you want to grant the user access to the current company, click this link. Then, in the User Rights window,

1. Give the user a password.
2. Tell Sage 50 what type of access you want the user to have: administrator, full, selected, or none.
If you choose to give the user selected access, click Next to set access levels in the Selected Access window. Follow the
directions under "Setting up users with selected access"; begin with step 5.

Important: If you forget your user name or password, you won't be able to access the company data. It's your responsibility to
maintain user names/passwords. It is critical that you write down this information and file it away in a secure place. If you're the
company administrator, you'll be responsible for all user name/password information; be sure that individual users know and keep
secure their own user names/passwords.
In the unfortunate event that you lose your Administrator user name or password and no one else can open the Sage 50 company,
contact Sage 50 Customer Support.

Setting Up Admin Users
An admin user is able to use every area of Sage 50 and also set up new users. It's a good idea to have more than one admin user for
your company. This way you have a backup admin user in case one of them is out of the office or leaves the company.
When you set up security in Sage 50, the first user that is set up is required to be an admin user. You must have at least one admin
user if you use security in Sage 50.
To set up an additional Admin user:

1.
2.
3.
4.
5.
6.
7.

Go to Maintain >Users>Set Up Security.
Click New User.
Enter the user name for this user.
Enter the password for this user.
Select Administrator for the type of access.
Click Save.
Click Close.

To set up an additional Admin user:

1.
2.
3.
4.
5.
6.

Go to Maintain >Users>Set Up Security.
Click New User.
Enter the user name for this user.
Enter the password for this user.
Select Administrator as the role you want this user to have.
Click Save.

7. Click Close.
Learn More
Set Up Company Users, Passwords, and User Roles
Set Up Company Users, Passwords, and Access Rights

Password Options
If you are logged in as the Sage 50 Administrator, you can choose to have passwords automatically expire in a specified number of
days or weeks. Three days before the time limit you set is reached, users will receive a message upon logging in Sage 50 that they
must reset their password.
From the User Security window, select the Password Options button.

Passwords expire after: Check this box if you want users to periodically reset their passwords. Then, specify the number of
weeks or days passwords will last before they must be reset. (This is calculated based on your computer's system date.)

Automatically lock out users...: You can choose to automatically lock users out when they unsuccessfully try to log on. If you
choose to do this, you can also specify how many times they try before being locked out.

If you choose to lock users out after unsuccessful login attempts, you can choose to let them log in again after a specified time
interval, or make it mandatory that the Administrator must unlock them. Administrators will always be able to log in again after
5 minutes no matter what option is set here. There may be tasks that can only be performed by an Administrator and it could be a
problem if the Administrator is locked out for a long period of time. This also prevents problems that could arise if an Administrator
must unlock locked out users, but there is only one Administrator and he or she is locked out.

Users cannot reuse their previous four passwords: Check this box to prevent users from using a password they have used
for their last four passwords. Implementing this policy makes it more difficult for someone to access your data, in case they knew or
had obtained a recent password. It also helps with PCI compliance.

View a User's Access Rights
If you want see what company access rights a user has rather than edit those rights, you can do that from the User List tab of the
User Security window.

How do I get to the User Security window?
l
From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
Note: If you don't have access to the Set Up Security option in the Maintain menu, then your user profile does not have
privileges to set up or maintain users, passwords, or user roles in this company. Check with your company administrator, or
open the company using a user name and password combination that has this privilege.
To see a user's access rights, do the following:

1. Select the user in the grid at the center of the User List tab.
2. Click View User's Rights.
The Sage 50 Role Setup window appears. You won't be able to change any of the data in the window, just view the access-rights
setup.

Change a User's Password and Access Rights
To change a user's name, password, and/or access rights, follow these steps:

1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
To change a password
1. Highlight the user whose password you want to change. (You must be logged in as the Admin user.)
2. Click the Reset Password button.
3. Enter and confirm the new password. The user will have to create a new password the next time she logs in, but the password
you create will give one-time access.

4. You can also choose to e-mail the temporary password to the user.
To change a user's rights
1. Highlight the user whose user record you want to change.
2. Select the Edit User's Rights button.
The User Rights window appears.

3. Change the user's password, if desired.
Note: User passwords are case sensitive and must be unique. Two or more users cannot have the same password.
4. Change the user's security level, if desired; choose Full access, Selected access, or None.
l
If you have chosen Full access or None, click OK. The Users window returns. Note that the user password and/or access
level information have been changed as desired.
l

If you have chosen Selected access, click Next. The Sage 50 Selected Access window appears. It lets you select exactly the
areas of the Sage 50 that you want the user to be able to access. .

Copy User Information to a New User
Use the following procedure to create new user records with similar program area control levels based on existing user names.

1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
2. In the grid at the middle of the window, select the user record you want to copy.

3. Select the Copy User button.
The User Rights window appears.

4. Enter a user name and password for the new user.
Note: User names are NOT case sensitive. However, passwords are case sensitive and must be unique. Passwords must be at
least seven characters and must contain a combination of letters and numbers. Two or more users cannot have the same
password.

5. Click OK to save the user record.
The Users window returns with the new user listed in the grid.

How to Set up Your Accountant as a User
You can choose to set your accountant up as a user of your Sage 50 company; this gives him or her access to your company data.
As with any other user, you can limit access to certain areas of the Sage 50 program through the User Security window.

In Your Office
Since only licensed users of Sage 50 can log in to a Sage 50 company, you would need to license the accountant on one of your
company computers if you wanted him or her to be able to log in to Sage 50 and work with company data while visiting your office. If
the accountant will be accessing your company data only using Sage 50 Accountant Edition from his or her computer, then the
accountant does NOT have to be a licensed user.

In the Accountant's Office
If you have multiple companies, you should set up the accountant with the same user name in each of the individual companies.
That way, when the accountant works on company data at his or her office, he/she can go into each of the companies under a single
user name.
Note that if the accountant is using Sage 50 Accountant Edition, the accountant does NOT have to be a licensed user. You should
still give the accountant the same user name for all individual companies. however.

Tell me more about licensing and granting user rights and access

Set Up Company Users, Passwords, and User Roles
In order to implement data security and password protection, you must set up user records. When user names and passwords are
set up, Sage 50 prompts you for a user name and password combination when you open a company. If a user knows the password,
he or she can access the areas of the program to which you have rights. These rights are set up as a role that can be as specific your
company as you want to make it. For example, if your company is a sales company, you might want to set up sales
representative,buyer, and shipping clerk roles, among others.
Setting up users in Sage 50 involves setting up a company administrator first. After that, you can set up individual users and their
roles. You can set up as many Sage 50 users as you have licenses for.

Note: Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include
both upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
How do I get to the User Security window?
From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
Note: If you don't have access to the User Security option in the Maintain menu, then your user profile does not have
privileges to set up or maintain users/passwords in this company. Check with your system administrator, or open the
company using a user name and password combination that has this privilege.

Licensing Sage 50 company users
Setting up the first user (administrator)
In order to use user/password security in a Sage 50 company, you must first set up a single user record. After that, all other
users will need a user name and password to access the company.
The first user you set up must be an administrative user with full rights to each area of Sage 50 and the ability to set up and
maintain user records and passwords. Once the administrator is set up, he/she can then add other users to the system.

1. Select the New User button.
The User Rights window appears.

2. Enter a user name (for example, Admin ) and its corresponding password.
Note: Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include
both upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
3. To give the user full access to the program plus the ability to create individual users, select the Administrator option.
4. When finished, select OK.
The User Security window returns. Note that the user name and access level information have been added to the grid at the
center of the window. Note, too, that the Licensed checkbox is automatically checked. You're now ready to set up additional
users.

Setting up a new user and a new role
Once you've set up the administrator of the company, you can enter your first regular user and user role. Follow these steps:

1. Select the New User button.
The User Roles window appears.
2. Enter a user name and its corresponding password.
3. Because a role has not been set up yet for the user, click the New Role button.
The Role Setup window appears.
4. Enter a role name and its corresponding role description.
5. From the menu bar on the left side of the window, select the area of the Sage 50 program that you want to set access levels
for—Customers & Sales, for example.
l
If you want to grant either full or no access to this whole area of the Sage 50, use the drop-down list at the right-hand
top of the window.

l

6.
7.
8.
9.

If you want to grant access to some subareas but not others—for example, Sales Invoices—you can use the drop-down
list opposite the appropriate area. You can choose from a range of security access levels. Tell me more about access
levels.

When you're finished setting up the new role, click Save to save the role and return to the Sage 50 User Roles window.
Now, to assign the user to the newly set up role, check the appropriate checkbox in the Roles column.
Click Save to save the user and role combination.
To set up an additional user and role combinations, repeat steps 3 through 6.

Granting access to users who already have access to other companies
If a user listed in the User Security window has access to another company but not the current one (the user name is marked
with an asterisk), the Roles for This Company column will read No access. It will also have a blue Add user to this company
link.

If you want to grant the user access to the current company, click this link. Then, in the User Roles window,

1. Give the user a password.
2. Do one of the following:
l
l

Select an existing role or roles for the user; then select Save.
Click the New Role button to set up a new role for the user in the Role Setup window. Follow the directions under "Setting
up a new user and a new role"; start with step 4.

Important: If you forget your user name or password, you won't be able to access the company data. It's your responsibility to
maintain user names/passwords. It is critical that you write down this information and file it away in a secure place. If you're the
company administrator, you'll be responsible for all user name/password information; be sure that individual users know and keep
secure their own user names/passwords.
In the unfortunate event that you lose your user name or password and no one else can open the Sage 50 company, contact Sage
50 Customer Support.

User Roles
This window lets you set up users with a user names and passwords and then assign existing user roles to them. If you need to
establish a new role for any user, you can do that as well, and the role will then be available for other users too.
For the most part, you'll come to the this window from the Sage 50 User Security window:
click the New User button (once an administrator has been set up)
OR
click the Edit User's Roles button.

User Name/Password
When you set up new users, the first thing to do is give them a user name and password. Enter name/password in the text boxes.
Passwords are case-sensitive: you have to remember if letters are capitalized or not.

Note: Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include
both upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
Inactive (no access to this company)
To make the user inactive, select this check box. When a user is inactive, he or she can't open this Sage 50 company. You might
elect to make a user inactive, for example, if the individual has temporarily left the company or is on a leave of absence.
When inactive users try to log on, Sage 50 displays a message telling them to contact the company administrator. Only the
administrator can make an inactive user active.

Which roles would you like this user to have?
If you have already set up user roles, they will be listed in the grid at the middle of the window. If you want either to assign an
existing role to a new user or change the role of an existing user, you do that by selecting the check boxes corresponding to role(s)
you want the user to have.

New Role
If you want to set up a new role for a user you're adding to the system, click this button. The Sage 50 Role Setup window will appear.
Here, you enter a name and description for the role. Then you set security rights that will apply to the role.

Get step-by-step instructions for setting up new users and roles.

Role Setup
This window lets you choose areas of the Sage 50 program to which users set up with certain roles will have access. A new role can
be set up either from either of two places:

From the Sage 50 Users window:
1. From the User Security window, select the Roles List tab. .
2. Now, select the New Role button.
From the Sage 50 User Roles window:
1. From the User Roles window, select the New Roles button.
In either case, you will next see the Sage 50 Role Setup window, where you can enter a role name and description, then choose the
access levels that will define the role.

Setting up roles with access to areas of Sage 50

In Role Setup, you set up roles so that users with them can access certain areas of the Sage 50 program within the current
company. Sage 50 program areas include the following:
l

My Dashboard

l

Customers & Sales

l

Vendors & Purchases

l

Inventory & Services

l

Employees & Payroll

l

Banking & General Ledger

l

Company

For each area, the drop-down list at the top right-hand side of the window lets you grant blanket access. For example, you can set up
a role with either Full Access or No Access to the Customers & Sales area.

The left side of the window will tell you which access level you've chosen for that area.

Custom Access
In addition to full or no access, you can use the grid to set different levels of access for subareas such as maintenance, tasks, and
reports. For example, in the Customers & Sales area, you can set up a role with limited access to maintenance areas such as
Customer Information or Customer Beginning Balances.
When you set up a role with other than full or no access rights to an area, the left side of the window will read Custom Access.

Setting access levels: Drop-downs let you set different access levels for different subareas of the program-for example,
Payments/Write Checks.

Embedded Help
Embedded Help is available in the Role Setup window to tell you more about each of the settings. Just click a line in the grid-for
example, Customer Information -and you'll see Help text at the bottom of the window explaining the setting.

Set Up a New Role
You set up roles on the Roles List tab of the Sage 50 Users window.

How do I get to the User Security window?
From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.

Note: If you don't have access to the User Security option in the Maintain menu, then your user profile does not have
privileges to set up or maintain users/passwords in this company. Check with your company administrator, or open the
company using a user name and password combination that has this privilege.
To set up a new role, follow these steps:

1. Select the Roles List tab.
2. Select the New Role button.
The Role Setup window appears.
3. Enter a role name and its corresponding role description.
4. From the menu bar on the left side of the window, select the area of the Sage 50 program that you want to set access levels for—
Customers & Sales, for example.
l
If you want to grant either full or no access to this whole area of the Sage 50, use the drop-down list at the right-hand top of
the window.

l

If you want to grant access to some subareas but not others—for example, Sales Invoices—you can use the drop-down list
opposite the appropriate area. You can choose from a range of security access levels. .

5. When you're finished setting up the new role, click Save to save the role to return to the Sage 50 User Roles window.

Copy a User Role
Use the following procedure to create new user roles with similar program area control levels based on existing roles.

1.
2.
3.
4.

From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
Select the Roles List tab.
In the grid at the middle of the window, select the role you want to copy.
Select the Copy Role button.
The Role Setup window appears.

5. Enter a role name and description for the new role.
6. Click Save to save the role.
The Users window returns with the new role listed in the grid.

Change a User's Role or Roles
To change the role or roles assigned to an individual user, follow these steps:

1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
2. In the grid at the middle of the window, select the user whose user role(s) you want to change.
3. Select the Edit User's Roles button.
The User Roles window appears.
4. Change the user's password, if desired.
Note: User passwords are case sensitive and must be unique. Two or more users cannot have the same password.
5. Do one of the following:
l

l

If you want to add to or change the user's assigned roles to an existing role or roles, check the check boxes corresponding to
the desired role(s).
If you need to establish a new role for the user, click the New Role button; you will go to the Role Setup window. Get
instructions on setting up a new role (start at step 3).

Edit an Existing User Role
To change a role name, description, and/or the access rights that go with that role, do the following:

Change the role name and description
1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
2. Select the Roles List tab.
3. In the grid at the middle of the window, select the role that you want to change.
4. Select the View/Edit Role button.
The Role Setup window appears.
5. Change the role name and description as needed.
Change the access levels, if needed
From the menu bar on the left side of the window, select the area of the Sage 50 program that you want to change access
levels for—Customers & Sales, for example.
l

l

If you want to grant either full or no access to this whole area of the Sage 50, use the drop-down list at the right-hand top
of the window.

If you want to grant access to some subareas but not others—for example, Sales Invoices—you can use the drop-down
list opposite the appropriate area. You can choose from a range of security access levels. .

When you're finished editing the role, click Save to save the role and return to the Sage 50 User Security window.

Delete a User Role
Use this procedure to remove an existing role from the current Sage 50 company.

Note: You can delete a role only if no current Sage 50 users are assigned to that role.
1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
2. In the grid at the middle of the window, select the role that you want to delete.
3. Select the Delete Role button.
l

If the role is not currently assigned to a Sage 50 user, a message appears asking you to confirm that you want to delete the
role.
Click Yes to delete and return to the Users window.

l

If the role is currently assigned to a Sage 50 user or users, a message appears telling you that you can't delete the role.
Click OK to close the message and return to the Users window.

Licensing Sage 50 Company Users
The information on this page does not apply to Sage 50 Accountant Edition.
In order to access a Sage 50 company, a user must be licensed. When you start granting new users security and access rights, Sage
50 will automatically license as many users as you have licenses for. For example, if you have five licenses according to your
agreement, Sage 50 will automatically license the first five users for which you set up security/access rights.
When all licenses are assigned, unlicensed users will be prevented from opening Sage 50 companies. A company administrator can
modify license assignments to change who has a license to access Sage 50 companies and who does not. Licensing does not impact
user security access to Sage 50 companies and should not be used as a means of limiting access to companies. Rather, user
security should be configured to limit rights to access Sage 50 companies and to restrict tasks performed within Sage 50 companies.

Getting the maximum number of licenses for your office
In order to have more licenses available, you can activate the serial numbers for all single-user units of Sage 50 in your office. If
you have five single-user units, activating all of them will give you a total of five licenses. Similarly, if you have a multi-pack version
of Sage 50, activating your multi-pack version will automatically give you the number of licenses that you purchased.

If you're running out of licenses....

If you run out of licenses but want to add a new user to the system, you may need to unlicense one of the existing users in order to
add the new one. You remove the license from a user by unchecking the Licensed checkbox beside his/her user name in the Sage
50 User Security window. Since generally only the company administrator has access to the User Security window, the
administrator will have to perform this task.
Note, however, that if you remove the license from a user, that user will automatically be licensed the next time he or she logs into
Sage 50 as long as a license is available. So as company administrator, especially if you are running out of licenses, you'll want to
assign licenses only to those people you want to have access.
In some cases, you'll be able to add licenses for your business. To learn about options for purchasing additional licenses, please
contact Sage 50 Sales .

Logging in to a company if no licensed user is present
In the event that there are no licensed users in the office, you may not be able to log in to your Sage 50 company. Say the only
licensed user is out sick one day! In that case, you will need to clear all user licenses; then you'll be able to open the Sage 50
company without a hitch.
To clear all licenses, do the following:

1. Start Sage 50 OR if you are currently working in a Sage 50 company, from the File menu, select Close Company.
2. From the Help menu, select Customer Support and Services, and then select Clear User Licenses.

Log in to a Sage 50 Company
If you have company users and passwords set up, you will be required to enter security check information (a user ID and password)
prior to opening your Sage 50 company.

1. Open the Sage 50 company from the Start screen.
If company users have been set up, Sage 50 displays the Log In window.

2. Enter the user name.
3. Enter the user's password. Then, select OK.
When you enter the password, Sage 50 displays it as asterisks (*****) for security reasons. Remember that passwords are case
sensitive.
Sage 50 opens the company and allows you access to the areas where you have rights.

Log In Window
When user names and passwords are set up, Sage 50 prompts you for a user name and password upon opening a company. If you
know the user name and password, you can access the areas of the program to which you have rights. Passwords are case
sensitive; user names are NOT case sensitive.

Note: If your Sage 50 Administrator has chosen to do so, you may only have a limited amount of entry attempts before you are
locked out. In the event you are locked out, there are two ways to unlock your account: 1) your Administrator would have to
unlock your account, or 2) you have to wait a specified amount of time before logging in. Your Sage 50 Administrator specifies
which method to use in Password Options.

How to change your password
You can change your password from this window, by typing in the user name and password and then clicking the Change button
(before clicking OK).
If you are the Administrator and you lose your user name or password, contact Sage 50 Customer Support. We recommend that you
have two user names set up with Admin rights.

Change Password
You can access the Change Password window from multiple places:
l

the login window, by clicking the Change... button after typing your current password

l

selecting Change Password from the Maintain, Users menu

l

selecting the Change My Password Now button on the Company Maintenance Section of the System Navigation Center

What makes a good password?

Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include both
upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
A good password should be easy for you to remember, but difficult for someone else to guess.

How passwords work in Sage 50
Once user names and passwords are set up, Sage 50 prompts each user for a user name and password whenever he or she opens a
company. As long as users properly enter their passwords, they can access the areas of the program to which they have rights.
In the unfortunate event that you lose your Administrator user name or password and no one else can open the Sage 50 company,
contact Sage Customer Support.

Reset Password
If you are logged in as the Administrator in Sage 50, you can reset a user's password. You can even e-mail the user a temporary
password; they would then need to change their password the next time they logged in.

What makes a good password?
Passwords must be at least seven characters. They must contain both numbers and letters. It's a good practice to include both
upper- and lower-case letters, although this is not required. An example of a strong password: MLsmith707.
A good password should be easy for you to remember, but difficult for someone else to guess.

E-mail password to user?
If you logged in as the Admin, and Outlook is installed, the option to e-mail the user her password displays. Check the box to send
the user a temporary password. The first time she logs in, she would need to change her password.

Resetting the Administrator password
Passwords for the Sage 50 Administrator have slightly different rules. You have a set amount of login attempts before you get locked
out. If you should get locked out as the Administrator, you have to contact Sage customer support for access (and to reset your
password). Or, another Admin user can unlock you, if you have set up more than one Administrator user in this company.

How passwords work in Sage 50
Once user names and passwords are set up, Sage 50 prompts each user for a user name and password whenever he or she opens a
company. As long as users properly enter their passwords, they can access the areas of the program to which they have rights.
In the unfortunate event that you lose your Administrator user name or password and no one else can open the Sage 50 company,
contact Sage Customer Support.

Related Topics
Password options
Set up a user's password and access rights

Delete Company Users
Use this procedure to remove a user from the current Sage 50 company.

1. From the Maintain menu, select Users, then Set Up Security. Sage 50 displays the User Security window.
2. In the grid at the middle of the window, select the user whose user record you want to delete.
3. Select the Delete User button.
A message appears telling you that if you delete the user from the current company, he or she will not lose access rights to any
other Sage 50 company, if this applies.

4. Click Yes to delete the user.

Logging Out Users
You can use the User Login Manager screen to see which users are currently logged in to your company and log them out if
necessary. There are some situations where all users that are logged in will not show up in the list.

Note: With the User Login Manager, you can view users in the current company or in all companies. However, you can only log out
users in the current company.
l

l

If you select Log Out All Users, this will log out everyone who is currently logged into the current company. This includes any
users who are logged in, but not showing up in the list. The log out will happen based on your settings in Log Out Options.
If you select Log Out Selected Users, this will log out all of the users that you have selected. However, if you select all of the
users in the list, any users who are logged in, but not appearing in the list will also be logged out because it appears that you want
to log out all users. The log out will happen based on your settings in Log Out Options.

Warning: You should be very careful when logging out users. It's a good idea to make sure users aren't in the middle of doing
something before you log them out. In most cases, whatever process a user is doing will be stopped and the user will be logged
out. However, there may be some cases where the process cannot be stopped and the user is not logged out. Good communication
is key to preventing issues when logging out users.

Logout Options
You can choose to log out users immediately or to send them a message giving them a chance to save their work. If you choose to
send a notification to users, they will receive a popup message in Sage 50 within the time range you specify. You can also specify the
minimum amount of time that users will be locked out and notify them of that as well.

Getting to the Logout Options window
1. From the Maintain menu, select Users, then User Login Manager.
2. Select the Logout Options button.
Notification Message: Sage 50 supplies a standard notification message. You can change it if you like; there are 255 characters
available for the message.

Set Log Out Duration: You can specify the minimum length of time that users will be locked out. The lock out period may be
longer if a single user process is running after the specified length of time. If you have selected to send the users a notification
message, you can also include information about the length of time they will be locked out.

Note: The log out duration only applies to users who do not have administrative access.
Tip: If you have set the log out duration longer than necessary, you can return to the User Login Manger screen to allow users to
log in again.
You have to have special security rights in order to log out users. This option can be given to a user in User Security, available from
the Maintain, Users menu. The Administrator user can always log out other users.

In this case, there are only two options--either Full Access (you can log people out) or No Access.

User Login Manager
This feature is available only in Sage 50 Pro Accounting and higher.
This window shows a list of all users who are logged in to Sage 50. You can choose to view all users for a specific company, or all
companies.
Click the Refresh button to update the window with the current list of users.

Admin Tasks
If you logged in as the Sage 50 Admin, you can do additional tasks within this window.

Log Out Selected Users
To log out a single user, highlight the user and click the Log Out Selected button. You can also hold down the Control button
and click on multiple users, then click Log Out Selected. The user(s) will either be logged out immediately or sent a message
that they must log out, based on the Logout Options that you have set.

Log Out All Users
To log out all users, click the Log Out All Users button. Users will either be logged out immediately or sent a message that they
must log out, based on the Logout Options that you have set.

Set Logout Options
You can choose to log users out immediately or send them a notification, giving them time to save their work and log out. You
can use the notification message text that is supplied for you or you can edit it, if necessary, to better meet your needs. You can
also set the minimum length of time that the users will be locked out.

Logout Options
If users have been logged out for a certain duration of time (set in Logout Options), you will be able to allow them to log back in
before the duration is up from this window.

Tell me more about logging out users.
Warning: You should be very careful when logging out users. It's a good idea to make sure users aren't in the middle of doing
something before you log them out. In most cases, whatever process a user is doing will be stopped and the user will be logged
out. However, there may be some cases where the process cannot be stopped and the user is not logged out. Good communication
is key to preventing issues when logging out users.

Remove User and Password Security
Erasing all company user records will no longer display the Log In window, where you must enter a user name and password when
opening the company. In Sage 50 Complete Accounting and higher, it will also remove user accountability provided by Sage 50's
audit trail feature and the Audit Trail report.

Note: Before removing user and password security, you should log on to the Sage 50 company as an administrative user
(meaning you must have access to the Users window).

1. From the Maintain menu, select Users. Sage 50 displays the User Security window.
2. Delete all users listed in the window. How do I do this?
It is important that you first delete all non-administrative user records (those who do not have access to the User Security
window) first. Then, delete administrative user records.

Note: If multiple users still exist and you attempt to delete the only administrative user record with access to Users, Sage 50
will prompt you with an error message. You cannot delete the single administrative user record until all other user records are
removed.
Once you delete the last user record, you will not be prompted for a user name and password when opening your Sage 50
company. Also, in the Sage 50 Audit Trail report, activity will no longer be associated with user names (Sage 50 Complete
Accounting and higher only).

Preventing Data Loss with Backup and Restore
Sage 50 makes preventing data loss easy with its backup and restore functionality. Simply, make regular backups so you can
restore your company data, if necessary.
The Back Up and Restore section of the System Navigation Center gives you easy access to creating backups and restoring them, if
necessary.

How often should I backup my data?
We recommend that you back up your data every day. Having a recent backup minimizes your data loss if you have to restore a
backup.
You can see when your last backup was made in the Back Up and Restore Data section on the System Navigation Center.

What does the Back Up Data status indicator mean?
This is a visual indication of the age of your most recent backup.

Green: Less than 4 days old
Yellow: 4-7 days old
Red: More than 7 days old
Why should I create a backup?
Sometimes your data can accidentally get corrupted or deleted. If you have a backup, you can restore your data to a previous
state.
It's important to make regular backups to minimize your data loss if you have to restore your data.

What is the difference between Back Up Now and Automate Backups?
Click Back Up Now to make a backup right now. All other users must be logged out of Sage 50 when you do this.
Click Automate Backups to schedule backups to automatically occur. This way you don't have to remember to make back
ups. Another advantage is that you can schedule the back ups to occur when no one would typically be using Sage 50.

Learn More
Backing Up Company Data
Scheduling Automatic Backups
Restoring Company Data Files

Back Up Company Data
It is important that you back up your company data files on a regular basis in case information is accidentally deleted or corrupted.
You can then restore your data, if necessary.
To back up your company data files and customized forms, use the following procedure:

1. From the File menu, select Back Up. Sage 50 displays the Back Up Company window.
Note: You can also create a backup from the System Navigation Center.
2. Select the Reminder check box if you want to be prompted to back up in a specified number of days.
If the specified number of days have elapsed since your last Sage 50 backup, Sage 50 will display a reminder message when you
close the company or exit the program.

3. Select the Include company name check box if you want Sage 50 to incorporate your company name in the name of the
backup file it creates.

4. Select the Include archives in the backup check box if you want Sage 50 to include your archived companies in the backup.
This option is disabled if you do not have any archived companies.

5. Select the Include attachments in the backup if you want Sage 50 to include files you've attached to records and
transactions in the backup. This option will be disabled if you do not have any attachments.

6. Click the Back Up button to enter or select where you want to save your Sage 50 backup file. If you are not prepared to back up
your company data at this time, click Close.
7. In the Save Back Up As window, the Save in field shows the location where your last backup was saved. You can change this
location by selecting the path where you want to save your backup.

8. At File name, enter the name for the backup copy. Sage 50 offers a default file name that includes the current system date—for
example, Bellwether Garden Supply-022507.ptb. You can change this if you like. Sage 50 backup files use the *.ptb file
extension.
For increased security, avoid backing up data over existing backups.

9. Click the Save button. Sage 50 displays one of the following:
If you are backing up to your hard drive, the estimated size in megabytes (MB) of your backup.
If you are backing up to an external source such as diskette or ZIP drive, the number of diskettes needed.
10. Click OK. The system displays the progress of the backup until it is complete.
l
l

If you are backing up to diskettes, Sage 50 will prompt you to insert the first and subsequent diskettes, as needed. You should
number these diskettes as instructed.

Note: Depending on the quantity of data, the backup process may take a while to complete. Be patient and do not interrupt the
process. If you interrupt the backup process, you might damage your data.

What do you want to do next?
Restore company data files
l
Learn about Online Backup
l
Learn about Automatic Backup
l
Read the backup company overview
l

Back Up Company
It is important that you back up your company data files on a regular basis in case information is accidentally deleted or corrupted.
You can then restore your data, if necessary.
You should back up company data within Sage 50. In this way, your company data files and customized forms will be backed up
using the Sage 50 format. You can save your Sage 50 backup to a hard disk, a diskette, or other data storage device (for example, a
ZIP disk or CD).
You should not back up your Sage 50 data using an alternate form of backup, such as a tape drive. Sage 50 data files are stored in
several files on your hard drive or network server and you run the risk of making an incomplete backup using an alternate
method.
l

l

l

Select the Reminder check box if you want to be prompted to back up in a specified number of days. If the specified number of
days have elapsed since your last Sage 50 backup, Sage 50 displays a reminder message when you close the company or exit the
program.
Select the Include company name check box if you want to incorporate your company name in the name of the backup file
that Sage 50 creates.
Select the Include archives in the backup check box if you want to include your archived companies in the backup.

Note: This option is only available in Sage 50 Premium Accounting and higher and will be disabled if you do not have any
archived companies.
l

Select the Include attachments in the backup check box if you want to include attachments to records and transactions in
your backup.

Note: This option will be disabled if there are no attachments. Once you add an attachment to a record or transaction, this
option will be enabled.
Select the Back Up button to enter or select where you want to save your Sage 50 backup file. If you are not prepared to back up
your company data at this time, select Close.
If you want to use the Online Backup Service to back up your company, click Back Up Online. Get more information about
Online Backup.
You can also schedule backups to take place automatically. Get more information about Automatic Backup.

Scheduling a Backup
Once you have used Sage 50's Automatic Backup to create a configuration file, you can create a scheduled task in your scheduler
software that uses the information in the configuration file to back up your data. This topic explains how to do this using Microsoft
Scheduler, which is included with most versions of Microsoft Windows.
If you have a different scheduler program, it should still be similar, as long as there is a command line you can update. You just
need to copy and paste the command line at the bottom of the Sage 50 Automatic Backup window into your scheduler's Run
command.

1. Open your Sage 50 Automatic Backup program.
2. Open the configuration file you want to schedule.
3. Click the Schedule button at the top of the window.

If the Schedule button is disabled, that means either: a) you don't have Microsoft Scheduler installed, or b) you have yet to create
a configuration file in Sage 50 Automatic Backup.

4. On the Schedule Backup window, enter the time and how often you want the backup to occur.
Important! The backup can't run if other users are logged into the company. Make sure to schedule the backup when users
shouldn't be accessing the company. Also, make sure all users are aware of when the backup will be run so they are not
accessing the company or running processes in Sage 50 at that time.
5.
6.
7.
8.

Click OK.
Enter your Windows user name and password. This is required by Microsoft Scheduler to create a scheduled task.
Click OK.
Click Close to close the Sage 50 Automatic Backup window.

Your backup should run when you set it to run, using the parameters you defined in Sage 50 Automatic Backup.
You can verify if the backup was created successfully by starting Sage 50 Automatic Backup, opening your configuration file, and
clicking View Log. It is best to check periodically to ensure that your backups are being created successfully.
All users should be logged out of the company before the scheduled backup will work.

Automatic Backup
Sage 50's Automatic Backup is a utility that you can run from outside of Sage 50 to schedule backups of your company data. You can
run it from a command line if you want.
In the Automatic Backup window, you are creating a configuration file, or the rules your backups will follow. You can create multiple
configuration files if you want. For example, you might have a daily backup that doesn't include attachments or archived companies,
but a weekly backup that does include these extra data types.
Complete the fields on the window and click Save. You must give your configuration a name at the time you save it.

How do I find Sage 50 Automatic Backup so I can start using it?
From within Sage 50:

1. Open the company you want to back up.
2. Go to File>Automatic Backup or select Automate Backups on the System Navigation Center.
From outside of Sage 50:
Click the Sage 50 Automatic Backup Configuration icon located on your computer desktop.

OR
1. From your computer desktop, click Start.
2. Select Programs.
3. Find your Sage 50 product.
4. Select Sage 50 Resources & Help.
5. Select Sage 50 Automatic Backup Configuration .
How do I restore a backup made automatically?
You restore an automatic backup in the same way that you restore a regular backup, using File, Restore. For more information,
click here.

How do I know if a backup was successfully made?
1. Open Sage 50 Automatic Backup.
2. Click Open and select your configuration file. It has the extension PTC.
3. Click View Log. This will show you the history. If View Log is disabled, no backup has ever been created.
4. You should also browse to the location where you specified the backup to be stored and make sure that it is there. The backup will
have a .ptb extension.

How do I delete a saved automatic backup configuration?
1. Open Sage 50 Automatic Backup.
2. Click Open and find your configuration. It has the extension PTC.
3. Highlight it, right-click, and select Delete.

4. Then, click Yes.
If you have set up a schedule, deleting the configuration will not necessarily delete the scheduled task. For instance, if you used
Microsoft Scheduler to schedule each backup, the scheduled task will remain even if you delete the configuration.

File Locations
Enter the path where your company data is located and the path where the backup should be stored.

Tell me how to find out what the path is
1. Open your company.
2. Click Maintain , Company Information . The field labeled Directory will show you the exact path.
User Details
If your company has users set up in Sage 50, you must enter the user name and password of a user who has security access to back
up the company. Once you enter the user details, click Verify User Details to verify that the user you have entered has the
required security access.
If the User Detailed fields are disabled, it is because there are no users set up for the company you want to back up. In that case,
you do not need to enter any User Details.

How do I set up users?
1. Open your company.
2. Select Maintain , Users, Set Up Security.
3. Complete the fields to create users and passwords.
Backup Settings
Include, if available:
Company name in the backup file name: This is recommended if you have multiple companies. It helps you easily
identify the files and associate them with their company.

Archived companies: Obviously, this could have a big impact on the time to back up, depending on how many or how large
your archives are.

Attachments: Attachments are files that you associate with transactions, using the Attach button on the Task windows. They
can be any related document or image that further defines the transaction.

If a backup file already exists:
Automatically create a new backup file: This is recommended as long as you have the disk space. It will add a sequential
number to the name of the backup file. You should have more than one version of a backup available.

Overwrite the existing backup file: When you overwrite each backup, you only have one version of a backup available.
So if a backup were corrupt, you have nothing to fall back on. So we don't recommend this option.

Stop the backup process: The process will stop if it encounters any backup file with the same name in this same location. An
entry will be made to the log file.

Log Out Settings
All users must be logged out of the company in order for the backup to run. If you want to automatically log out any users who are
logged in at the scheduled backup time, select the Log out users prior to running backup checkbox. If this checkbox is not
selected, the automatic backup will not run if users are logged in at the scheduled backup time. .

Scheduler Command
When you save the configuration, the command line to execute the backup configuration file builds in this box. If you use , you don't
need to do anything with this; just click the Schedule button at the top of the window.

If you use a different scheduler program, you can copy and paste this command into your scheduler. Use Ctrl-C to copy and Ctrl-V
to paste.
The command line provides the path for the Sage 50 Automatic Backup utility--PeachtreeBackup.exe. It also provides the location of
your Sage 50 backup configuration file--filename.ptc.

How to set up a backup task using a scheduler

Tips for using Microsoft Scheduler to create a backup

Tips for Using Microsoft Scheduler to Schedule an Automatic Backup
When using Microsoft Scheduler to schedule an automatic backup, here are a few tips.
l

Enter the scheduled time for the backup
To set up the scheduled time for the backup:

1. Enter the time and frequency that the backup should be run. Make sure no other tasks are scheduled to run at the same time.
2. Click OK on the Schedule Backup window.
3. Enter a Windows user name and password.
4. Click OK.
l
Enter a Windows user name and password
In order to schedule a task, a Windows user name and password must be entered. This is a Windows user name and not a Sage 50
user name. You will be prompted to enter this information when you click OK on the Schedule Backup window.
In order for the automatic backup to run properly, the Windows user entered for the backup task must have access to Log on as a
batch job. This is because Microsoft Scheduler will log the user in as a batch user when trying to run scheduled tasks such as the
automatic backup. This is the way Microsoft Scheduler works and has nothing to do with Sage 50. Please see your Administrator or
Windows help for more information. Tell me more.This Windows user setting is found at Control Panel>Administrative Tools>Local
Security Policy>Local Policies>User Rights Assignment>Log on as a batch job.
l

Verify the backup was created
After scheduling a backup, you should verify that the backup actually occurred. To do this, you should browse to the location you
specified for the backup to be created and make sure it is there.
You can also make sure the backup was created by looking at the Sage 50 Automatic Backup log file. To access this file:

1. Go to File>Automatic Backup from within Sage 50 or select the Sage 50 Automatic Backup Configuration icon from
your desktop.

2. Click Open and choose the configuration you want to verify a backup was made for. Configurations are saved with a .ptc
extension.

3. When you have the configuration open on the Sage 50 Automatic Backup screen, click View Log to see information about the
backups that have been created for this configuration. If no backup has ever been created, the View Log button will be disabled.
l

Remove backup from Microsoft Scheduler if Sage 50 is uninstalled
Microsoft Scheduler is separate from Sage 50. If you uninstall Sage 50, you should remove the scheduled backup task from
Microsoft Scheduler.

Save Back Up As
This process will back up (compress) your company data files and customized forms into a single file using the Sage 50 format. If
you intend to use this data file in the future, you must select Restore from the Sage 50 File menu. You cannot restore a Sage 50
backup file using another device or program.

Save in:The default path is the location where your last backup was saved. You can save the backup to a different location by
choosing the hard drive, network drive, or data storage device connected to your computer where you want to save your Sage 50
backup file.

File Name: Enter or select the file name for your Sage 50 backup. For example, you may want to name your backup 031512.ptb
for data backed up March 15, 2012.

Save as Type: Choose the Sage 50 Backup (*.ptb) type from the drop-down list.

Open Backup File
This process will restore your company data files and customized forms to a previous state. Restoring your backup will overwrite
and replace your existing company data, unless you select to restore the backup into a new company. You should make a backup of
your current company before restoring your company data.

You must have a Sage 50 backup file in order to restore your company data using this method. If you backed up using another
program or device, you must exit Sage 50 and restore your company data using that same method.

Look in: Choose the folder, hard drive, diskette drive, network drive, or data storage device connected to your computer where
your Sage 50 backup file is located.

File name: Enter or select the file name for your Sage 50 backup. Sage 50 backup files use the *.ptb file extension.
Files of type: Choose the Sage 50 Backup (*.ptb) type from the drop-down list.
Depending on the quantity of data, the restoration process may take a while to complete. Be patient and do not interrupt the
process. If you interrupt the restoration process, you might corrupt the data.

Restore
The Restore Wizard walks you through the process of restoring company files previously backed up in Sage 50. You can restore and
overwrite your existing company--one that you've previously set up--or you can restore to a new company, bypassing the normal
process of setting up a new company.
You can choose which backed-up files you want to restore:
l

l
l

l

To restore all backed-up data files for the company, select the Company Data check box. This includes records, transactions,
and other company information. It does not include the items listed below. They must be selected separately if you want to restore
them.
To restore all backed-up custom forms, such as customized invoices, select the Customized Forms check box.
To restore all Web transactions in the Sage 50 Web Transaction Center, select the Web Transactions check box. All
unprocessed Web transactions (those listed in the Inbox list and Exceptions list) that were synchronized using the WebSync
wizard after the date of the backup will be lost.
To restore all backed-up Sage 50 Intelligence Reports, select the Intelligence Reports checkbox. This includes the standard
Sage 50 Intelligence Reporting reports and any reports that you have created using Sage 50 Intelligence Reporting. Standard
reports will be replaced with the most recent versions available, but custom reports will be replaced with the set of reports
included in the backup.

Important! If you choose to restore Sage 50 Intelligence Reporting reports, any custom Intelligence Reporting reports you
have changed since the backup was made will be overwritten and any new custom Intelligence Reporting reports will be lost.
Before restoring your Intelligence Reporting reports, you may want to export your custom reports and save them in a different
location. You can import them back in after restoring the company if you need to. To export and import Sage 50 Intelligence
Reporting reports, go to Reports & Forms>Report Manager.

Tell me more.
Let's say you had 2 custom Sage 50 Intelligence Reporting reports when you made the backup. In the current state of your
company, you have 3 custom Intelligence Reporting reports - the two that exist in the backup, which were edited after the
backup was made, and one new report. If you choose to include Intelligence Reporting reports when you restore the backup, the
new custom report will be deleted and the two existing custom reports will be replaced with the reports from the backup.

Restore Company Data Files
In order to restore company data, you must replace all the current data files with those that have been previously backed up. You
cannot restore individual files because all files are related to one another.
If you backed up company data using Sage 50's backup utility, follow the steps below to restore your data. If you backed up
company data using an alternate utility (for example, a tape program), you must use that program to restore your company data.

Warning: When you restore company data, you will overwrite your existing company unless you select to restore into a new
company. You should make a backup of your current company before restoring your data, in case anything goes wrong.

1. From the File menu, select Restore. Sage 50 displays the Open Backup File window.
Note: You can also access Restore from the System Navigation Center.
2. Enter or select the company backup file from the folder, hard drive, diskette drive, network drive, or data storage device where
your Sage 50 backup file is located. You can enter a path or click the Browse button to search for the company location. Sage 50
backup files use the *.ptb file extension. Click Next to continue.

3. You can restore to an existing company already set up on your computer or create a new company to restore to. If you select an
existing company, you can browse to that company's location. Click Next after selecting.
4. The Restore Options window lets you select which elements to restore.
l
To restore all backed-up data files for the company, select the Company Data check box.
l
To restore all backed-up custom forms, such as customized invoices, select the Customized Forms check box.
l
To restore all Web transactions in the Sage 50 Web Transaction Center, select the Web Transactions check box. All
unprocessed Web transactions (those listed in the Inbox list and Exceptions list) that were synchronized using the
WebSync wizard after the date of the backup will be lost.
l

To restore all Sage 50 Intelligence Reporting reports, select the Intelligence Reporting reports check box. Standard
Intelligence Reporting reports will be replaced with the most recent versions available, but custom reports will be replaced
with the set of reports included in the backup.

Important! If you choose to restore Sage 50 Intelligence Reporting reports, any custom Intelligence Reporting reports
you have changed since the backup was made will be overwritten and any new custom Intelligence Reporting reports will be
lost.
Before restoring your Intelligence Reporting reports, you may want to export your custom reports and save them in a
different location. You can import them back in after restoring the company if you need to. To export and import Sage 50
Intelligence Reporting reports, go to Reports & Forms>Report Manager.

Tell me more.
Let's say you had 2 custom Sage 50 Intelligence Reporting reports when you made the backup. In the current state of your
company, you have 3 custom Intelligence Reporting reports - the two that exist in the backup, which were edited after the
backup was made, and one new report. If you choose to include Intelligence Reporting reports when you restore the
backup, the new custom report will be deleted and the two existing custom reports will be replaced with the reports from the
backup.

5. Select the options you want and click Next.
6. The Confirmation window lets you review your choices before beginning the Restore.
Warning: Restoring is a potentially dangerous process; you will overwrite your existing data files, so make sure you have a
current backup before proceeding.

5. When you're sure everything is correct, select Finish.
6. If you are restoring data from diskettes, the system will prompt you to insert the first and subsequent diskettes, as needed.
7. During the restore process, Sage 50 displays a progress indicator.
Note: Depending on the quantity of data, the restoration process may take a while to complete. Be patient and do not interrupt
the process. If you interrupt the restoration process, you might damage the data.

Online Backup
Online backup is similar to Sage 50's backup, but with the added security of storing your data offsite on a remote server. Your data is
secure no matter what happens at your company site. The Online Backup window is the command center for all of your Sage 50
online backup activities. From this window, you can set up an online backup schedule, create a manual backup, and restore an online
backup, and see how much space you have left.
If you have multiple versions of Sage 50 installed on your computer, Online Backup will follow only the schedule of the LAST
version set up on the Schedule tab. For instance, if you have Sage 50 Premium Accounting and Sage 50 Complete Accounting on
your computer. First, you set up a company in Sage 50 Complete Accounting to automatically make an online backup on Tuesday
and Thursday. Then, you set up a company in Sage 50 Premium Accounting to automatically make an online backup on
Wednesday and Friday. The scheduled online backups will ONLY be made on Wednesday and Friday for the company specified in
Sage 50 Premium Accounting.
If you have multiple versions of Sage 50 installed, we recommend that you make your online backups manually.
The Online Backup window has the following tabs:

Schedule tab
Backup Settings tab
Restore tab

All online backup plans recommend high speed or broadband Internet connection (DSL/Cable).

What do you want to do next?
l
Set Up an Online Backup Schedule
l
Select Companies for Online Backup
l
Remove a Company from the Backup List
l
Create a Manual Online Backup
l
Restore an Online Backup

Sage 50 Online Backup
Sage 50’s Online Backup Service allows you to protect your company data by storing a backup of your data offsite on a remote
server. This gives you the added peace of mind that your data is protected. Sage 50 has partnered with Connected to offer this
subscription service. By installing a Sage 50 customized version of the backup software, you can manage your backups directly in
Sage 50. Accessed from the File menu in Sage 50, Online Backup adds another dimension to your backup strategy. The Sage 50
Online Backup Service is an easy-to-use, yet powerful tool for protecting your company data.
All online backup plans recommend high speed or broadband Internet connection (DSL/Cable).

Learn more about Sage 50 Online Backup service.

Set Up an Online Backup Schedule
One of the first steps in setting up an automatic online backup is establishing a schedule. The schedule tells Sage 50 when to initiate
an online backup of your company data. When planning this schedule, consider scheduling the backup at a time when you will not be
using Sage 50.

1. From the File menu, select Online Backup\Restore. Sage 50 displays the Online Backup window.
2. Select the Schedule tab, if it is not already selected.
3. In the Schedule Settings group, select the Back up automatically on specified days at schedule time check box,
then select the days that you want to back up. Finally, select a time range in which to start the backup. Include the AM or PM after
the time you select. The backup process will begin at a random time between the hours you specify.

4. In the Back up when I connect to the Internet group, select the check box if you want to begin a backup every time you
connect to the Internet. Then, select the time since your last backup that you want to start this backup.

5. In the Prompt Settings group, select the appropriate check box if you want Sage 50 to prompt you before starting an
automatic backup. Select a deferment time if you want the backup to be postponed.

6. When you have finished setting up your online backup schedule, either select the Backup Settings tab or select OK. Selecting
OK saves your schedule and closes the Online Backup window. Selecting the Backup Settings tab does not save your schedule,
but allows you select the companies that you want to backup.

Note: A scheduled backup will only occur once per day. If you need to make an additional backup, other than a scheduled backup,
you will have to create a manual backup. For example if you have a backup scheduled for Wednesday at 11:00 AM that completes
successfully and you schedule another backup at 1:00 PM on the same day, no backup will be made.

Backup Settings (Online Backup)
On the Backup Settings tab, you can

add a company to the backup list
l
remove a company from the backup list
l
start a manual backup
Company list: Shows the company name and file location of the companies that will be backed up. Use the Add or Remove
Company buttons to make changes to the list.
l

Other Online Backup window tabs

Schedule tab
Restore tab
What do you want to do next?
Set Up an Online Backup Schedule
l
Select Companies for Online Backup
l
Remove a Company from the Backup List
l
Create a Manual Online Backup
l
Restore an Online Backup
l
Learn about Online Backup
l

Online Backup Registration
As part of setting up Online Backup, you must register it. Enter a valid e-mail address and password and then check the I agree to
the terms of the agreement checkbox. You must complete both fields and check the checkbox if you want to enter online
backup.
l

E-mail Address: Enter a valid e-mail address where you receive mail.

l

Password: This password does not have to be the password for your e-mail account. It can be something different, but it must fit
these parameters:

l

l

contain at least 8 alphanumeric characters

l

contain at least one numeric character

l

contain at least two unique characters

l

contain no leading or trailing spaces

Click the View Iron Mountain EULA if you want to read the license agreement prior to checking the check box.
All online backup plans recommend high speed or broadband Internet connection (DSL/Cable).

Schedule tab (Online Backup)
To set up and maintain an automatic online backup schedule, select the Schedule tab. On the Schedule tab, you establish a
backup schedule and control.
If you have multiple versions of Sage 50 installed on your computer, Online Backup will follow only the schedule of the LAST
version set up on the Schedule tab. For instance, if you have Sage 50 Premium Accounting and Sage 50 Complete Accounting on
your computer. First, you set up a company in Sage 50 Complete Accounting to automatically make an online backup on Tuesday
and Thursday. Then, you set up a company in Sage 50 Premium Accounting to automatically make an online backup on
Wednesday and Friday. The scheduled online backups will ONLY be made on Wednesday and Friday for the company specified in
Sage 50 Premium Accounting.
If you have multiple versions of Sage 50 installed, we recommend that you make your online backups manually.

Back up automatically on specified days at scheduled times: If you want Online Backup to make a backup automatically,
select this checkbox and then check the days of of the week that you want backups made. After that, specify the time range that will
determine the approximate time that the backup will be made.

Other Online Backup window tabs
Backup Settings tab
Restore tab

Select Companies for Online Backup
1. From the File menu, select Online Backup\Restore. Then, select the Backup Settings tab.
2. Select the Add Company button. Sage 50 displays the Select Company to Add window.
3. Select the name of the company that you want to back up from the Company Name list, and select OK.
If a company name is not listed, select another drive or click the Network button to browse for the company on the network.

4. Select the Include archives option if you want to add your archived companies to your backup.
Note: You can only select one company at a time. Repeat Steps 2 and 3 for each company that you want to back up.

Select Company to Add
The Select Company to Add window allows you to add a company to the list of companies that will be backed up online. You can only
select one company at a time to add to the backup list. For each company that you want to add, you will have to return to this
window.

Company Name: Select a company name by highlighting it and double-clicking. If your company name does not appear, the path
may be incorrect. Check the Directories field and change the path, if necessary.
Directories: Use this to select the directory where your company is stored. When the correct directory is selected, the company
name appears in the list box.

Drives: Select the drive where you keep your company information.
Include archives:
Select this option if you want to include your archived companies in the backup.
Network: Select this button to locate a network drive, if applicable.

Remove a Company from the Backup List
1. From the File menu, select Online Backup, then select the Backup Settings tab.
2. Highlight the name of the company you want to remove, by clicking the company name. Once you select a company name, the
Remove Company button becomes available.

3. Select the Remove Company button to remove the company from the backup list. This company will not be backed up during
your next scheduled online backup.

4. When you have finished removing companies from the list, select OK to close the Online Backup window.

Moving Companies and Online Backup
If you use Online Backup and you have to move or copy a company to another location (i.e., another directory or a network drive),
resulting in two backups of the same company on your computer, you may not be able to distinguish between the companies in the
Online Backup window. Therefore a few guidelines should be followed when moving or copying companies.

Guidelines for Moving Companies
1. Add a prefix or suffix to the company name that you are moving.
2. Rename the company that you are moving.
By following either of these guidelines, you will avoid not being able to distinguish between online backup companies.

Create a Manual Online Backup
1. From the File menu, select Online Backup\Restore. Then, select the Backup Settings tab.
2. Select the Back up All Now button to start a manual backup. All companies in the list will be backed up.
Tip: If you want to back up a single company, remove the other companies from the list and then select Back Up All Now.
Remember to go back and add the companies back to the list. That way, your automatic backup will include all the companies you
originally intended to back up.

Restore an Online Backup
Corrupted data or some other unforeseen circumstance may give you a need to restore an online backup. Whatever the case,
restoring a backup is a serious operation. Make sure that you have backed up the company in its current state before you restore an
online backup.

Tip: Before you attempt to restore a company, make sure that you have closed the Sage 50 Online Backup Powered by
Iron Mountain application. (This is the application that runs outside of Sage 50.) Failure to close this application may cause the
restore dates not to display in the Select the restore date field.
To restore an online backup follow these steps:

1. From the File menu, select Online Backup\Restore. Then select the Restore tab.
2. Select the company that you want to restore from the list.
3. Select the information that you want restored. You can restore company information, unprocessed Web transactions, standard
and custom form files, and/or Intelligence Reporting Reports.
Important! If you choose to restore Sage 50 Intelligence Reporting reports, any custom Intelligence Reporting reports you
have changed since the backup was made will be overwritten and any new custom Intelligence Reporting reports will be lost.
Before restoring your Intelligence Reporting reports, you may want to export your custom reports and save them in a different
location. You can import them back in after restoring the company if you need to. To export and import Sage 50 Intelligence
Reporting reports, go to Reports & Forms>Report Manager.

Tell me more.
Let's say you had 2 custom Sage 50 Intelligence Reporting reports when you made the backup. In the current state of your
company, you have 3 custom Intelligence Reporting reports - the two that exist in the backup, which were edited after the
backup was made, and one new report. If you choose to include Intelligence Reporting reports when you restore the backup,
the new custom report will be deleted and the two existing custom reports will be replaced with the reports from the backup.

4. Select the restore date from the list.
5. Select Restore Now to start the restore process. When the restore process is finished, Sage 50 will display a message telling
you that the restore process has finished. Click OK to open the company that you have restored.
Note: Remember that if you entered information into Sage 50 after the restore date, you will need to reenter that information.

Restore (Online Backup)
On the Restore tab, you select the company you want to restore, the information that you want restored, and the date of the
backup you want to restore. Once you select this information, select the Restore Now button for Sage 50 to start the restore
process.

Note: Before you restore a backup, we recommend making a backup of the company in its current state.
Select the company you want to restore: Only companies that have been backed up successfully will be listed.
Sage 50 Information to restore:Select the check box of the information that you want restored. You can restore company
information, unprocessed Web transactions, standard and custom form files, and/or Intelligence Reporting Reports.
Important! If you choose to restore Sage 50 Intelligence Reporting reports, any custom Intelligence Reporting reports you have
changed since the backup was made will be overwritten and any new custom Intelligence Reporting reports will be lost.
Before restoring your Intelligence Reporting reports, you may want to export your custom reports and save them in a different
location. You can import them back in after restoring the company if you need to. To export and import Sage 50 Intelligence
Reporting reports, go to Reports & Forms>Report Manager.

Tell me more.
Let's say you had 2 custom Sage 50 Intelligence Reporting reports when you made the backup. In the current state of your
company, you have 3 custom Intelligence Reporting reports - the two that exist in the backup, which were edited after the backup
was made, and one new report. If you choose to include Intelligence Reporting reports when you restore the backup, the new
custom report will be deleted and the two existing custom reports will be replaced with the reports from the backup.

Select the restore date: Select the date of the backup you want to restore. The dates listed indicate when a full backup was
made, not individual company backups.

Other Online Backup window tabs
Schedule tab
Backup Settings tab

Using Sage 50's Audit Trail

This feature is available only in Sage 50 Complete Accounting and higher.
Sage 50 has several methods to track information. For example, a combination of the general ledger, journals, reports, and financial
statements can be used to trace transactions and balances for audit purposes. However, if you want to track when an action is
performed in your company data, Sage 50's audit trail provides this information in a very usable form. The audit trail feature logs
when a person enters data, maintains (edits) existing data, and removes data. Audit trail provides accountability of users, deters
users from fraudulent activity or mistakes, and tracks transaction history. The Audit Trail report can trace fraudulent activity and
other accounting adjustments you may not know were completed.

Getting the most out of audit trail
In order to get the most use out of the audit trail feature, we highly recommend that you set up user records in the Sage 50
User Security window. Sage 50 can associate the user currently logged into the Sage 50 company with the data that is being entered
or maintained, thus providing a more complete audit trail. For example, USER1 adds a customer record. USER2 then logs on and
modifies the customer record. The Audit Trail report will show that USER2 was the last person who maintained the customer record,
and it will display what was changed. This establishes user accountability.

What Audit Trail Tracks
This feature is available only in Sage 50 Complete Accounting and higher.
The Sage 50 audit trail feature records the following items (when applicable) with each activity performed while operating in the
Sage 50 company:
l
l
l
l
l

Date: System (computer) date of action
Time: System (computer) time of action
User Name: User Name (if available); otherwise, Sage 50 displays "Not Available"
Action: Add, Change, or Delete
Window Name (or System Function): Name of window where action occurred (for example, Sales Orders) or name of
system function implemented (for example, Unpost)

l

Transaction ID: For maintenance records, the ID associated with the record; for tasks, the ID associated with the transaction
after change

l

Transaction Reference: Reference number associated with the transaction after change
Amount: Amount of transaction after change

l

All the above items are recorded in the Audit Trail report.

l

Below is a summarized list of actions Sage 50's audit trail tracks.

Records and Transactions
Records include customers, vendors, employees, inventory items, and so on. Transactions include quotes, sales orders, invoices,
payments, general journal entries, inventory adjustments, and so on.
These include
l

adding records or transactions (when Save is selected)

l

editing records or transactions (when Save is selected)

l

deleting records or transactions (when Delete is selected)

l

entering or maintaining record beginning balances (when OK or Save is selected)

l

voiding checks and paychecks

l

making payments in Payment Manager

Miscellaneous Actions
l

reconciling accounts

l

maintaining company information and options

l

maintaining and loading user-maintained and Sage-maintained payroll tax formulas

l

importing data into the company

System Functions

l

posting and unposting journals (Batch mode only)

l

closing the fiscal year

l

closing the payroll tax year

l

backing up company data (using the Backup option from the File menu)

Print the Audit Trail Report
This feature is available only in Sage 50 Complete Accounting and higher.
The Audit Trail report lists important information about each activity performed while anyone is operating in the Sage 50 company. It
can trace fraudulent activity and other accounting adjustments or errors you may not know were completed.

1. From the Reports & Forms menu menu, select Company. Sage 50 displays the Select a Report or Form window.
2. Select the Audit Trail report, then select the Preview button (if you want to display the report) or select the Print button (to print
the report).

3. In the Filter window select a date range, then select OK. Sage 50 prints or displays the Audit Trail report on the screen.
Note: To personalize audit trail information, it is highly recommended that you set up user records in the User Security window.
Sage 50 can associate the user currently logged into the Sage 50 company with the data that is being entered or maintained.

Tip: To display or print the Audit Trail report by user name, select User ID as the Report Order option in the Filter tab.

Data Verification
Data Verification is a Sage 50 utility that allows you to verify if any of your data files are missing or possibly damaged. During the
verification process, Sage 50 makes any needed changes so that your data records are compatible with Sage 50 data formats. For
example, if an ID in a data record has more than the maximum allowable characters, Sage 50 will truncate the ID. Also, any files
that Sage 50 finds to be corrupt and unusable are deleted during the verification process.
Following verification, Sage 50 generates a log that details all errors encountered and reports on any changes made, as well as any
corrupt records deleted.
To run this utility, open your company, and select Data Verification from the File menu.

Warning: It is vital that you back up your company data before you verify data with this utility; if the procedure is not
successful or your computer locks up during a test, you could lose valuable data.
The following are types of tests you can perform.

Data Reliability: Verifies that all data files within your Sage 50 company are set up correctly and use the proper, required format.
If errors are found, you will be instructed on what to do. In most cases, Sage 50 will attempt to correct data errors for you.

Note: If you are working in a network environment (available only in Sage 50 Complete Accounting and higher, , note that the
computer on which the data reliability test is run must be in single-user rather than multi-user mode.
Data Access: Verifies that your data path is valid and that Sage 50 can access all your data files successfully. For example, your
data may be stored on a network. This test searches for all linked Sage 50 data files for the current open company.

Both Tests (recommended): Performs both the Data Reliability and Data Access tests. We recommend that you choose this
option.
Each time you run the data verification tests, Sage 50 automatically generates a verification error log and places it in your
company's data directory; new verification information is added to the log each time the verification tests are run. The log lists all
errors encountered during the tests, the start and finish times for the tests, and all changes made during verification, including any
corrupt data records deleted.

Note: Once you verify data, Sage 50 strongly recommends that you back up your company data (in its repaired state).
What do you want to do next?
Back up company data
l
Verify company data
l
Run the Integrity Check utility
l

Verify Data
Data Verification is a Sage 50 utility that allows you to verify if any of your data files are missing or possibly damaged. Always
contact Sage 50 Customer Support before you use the Data Verification utility. A support analyst will instruct you on
which test(s) to run.

Warning: It is vital that you back up your company before you run a Data Verification test; if the procedure is not successful,
you could lose valuable data.
To Run Sage 50 Data Verification Tests
1. Back up all of your company data. Get detailed instructions.
2. Open your Sage 50 company.
3. From the File menu, select Data Verification . Sage 50 displays the Data Verification window.
The following are types of tests you can perform.

Data Reliability: Verifies that all data files within your Sage 50 company are set up correctly and use the proper, required
format. If errors are found, you will be instructed on what to do. In most cases, Sage 50 will attempt to correct data errors for
you.

Data Access: Verifies that your data path is valid and that Sage 50 can access all your data files successfully. For example, your
data may be stored on a network. This test searches for all linked Sage 50 data files for the current open company.

Both Tests (recommended): Performs both the Data Reliability and Data Access tests.
4. Select both verify options (highly recommended).
5. Click Start to begin the verification tests.
The Verification Progress window appears. It has two progress meters that graphically display in real time the amount of the
process that is complete. Note that the window has a Cancel button; it will be unavailable whenever Sage 50 encounters an error
and tries to fix it.

Important: While you have the option of canceling, we recommend that you do not interrupt a data verification test while it is
in progress. If the procedure is not successful or your computer locks up during a test, you could lose valuable data.
l
l

If Sage 50 encounters any irresolvable errors during the tests, it will launch a message telling you what to do next.
Following a successful run of the tests, a window appears telling you that the process is complete. This window lets you review
the data verification error log, which Sage 50 automatically generates during verification and places it in your company's data
directory. The log lists all errors encountered during the tests, the start and finish times for the tests, and all changes made
during verification, including any corrupt data records deleted.

Data Integrity Check/Repair
Data Integrity Check is a Sage 50 tool that allows you to verify if any of your data files have been corrupted and to possibly repair
them. This data tool should only be run with the assistance of Sage Customer Support. A support analyst will instruct you on which
integrity test(s) to run.

Before you run any integrity check test, complete Data Verification procedures. Data Verification is a Sage 50 utility that
determines if any of your data files are missing or possibly damaged; it can typically repair minor errors for you instantly. Learn
how to verify your data .
If a Sage Customer Support Analyst determines that your data must be repaired, you can run the Sage 50 Data
Integrity/Repair utility. Learn how to run this utility .
Warning: Always contact Sage Customer Support before you use the Integrity Check utility. Also, it is vital that
you back up your company data before you running Integrity Check; if a repair procedure is not successful or your computer
locks up during a test, you could lose valuable data.
The following are types of tests you can perform. Perform only one test at a time. Do not select multiple tests. Selecting
multiple tests can make the problem more difficult to correct.
File Tests
Data Synchronization Tests
Invoice/Payment Synchronization

Run the Integrity Check
The Integrity Check is a tool that allows you to verify if any of your data files have been corrupted and to possibly repair them.

Important: This data tool should only be run with the assistance of Sage Customer Support. A support analyst will instruct
you on which integrity test(s) to run.

Before you run any integrity check test, complete Data Verification procedures. Data Verification is a Sage 50 utility that
determines if any of your data files are missing or possibly damaged; it can typically repair minor errors for you instantly. Learn
how to verify your data .
To Run the Integrity Check
If a Sage 50 Customer Support Analyst determines that your data must be repaired, you can run Sage 50 Data Integrity/Repair
utility.

1. Go to Help>Customer Support and Service>Integrity Check.
2. Click Backup to make a backup of your company data and then proceed to the Integrity Check utility.
Warning: It is vital that you back up your company before you use Integrity Check; if the Integrity Check procedure is not
successful, you may lose valuable data.
3. After you create a backup of your company, the Data Integrity Check/Repair window will appear.
4. Select the type of test to perform. Perform only one test at a time. Do not select multiple tests. Selecting multiple tests may
make the problem more difficult to correct.
You can perform the following types of tests:
File Tests
Data Synchronization Tests
Invoice/Payment Synchronization

5. Select OK to continue.

Repair Company
The Repair Company tool allows you correct damaged data files. Never run the Repair Company utility without first
contacting Sage 50 Customer Support. A support analyst will instruct you on which test(s) to run before starting this option.

Warning: It is vital that you back up your company data before you use the Repair Company utility. If the procedure is not
successful or your computer locks up during a test, you could lose valuable data.

Archive Wizard
This feature is available only in Sage 50 Premium Accounting and higher.
When you archive your company data, you are saving your data and financial statements so you can have access to that information
when you need to refer to it for future use, such as providing your financial information for a tax audit. You can archive your
company information at any time, and you also have archive as an option during the year-end process.
The archived company is an exact copy of your company, and while you can view transactions and print reports and financial
statements (including any custom forms you created before you archived), the archived data is read-only. Therefore, you can't add,
modify, or delete records or transactions in the archived company. Whatever transactions existed in the company will also be saved
within the archived company data and all user security settings are archived. Also, you can't add archived data to your current open
company.
Before archiving a company you should run data verification to detect any possible data errors so you can fix them first.
To begin Archiving your company data:

1. From the File menu, select Archive Company.
The Archive Company wizard window appears.

2. Accept the default Archive Name (based on Windows system date mmddyy format) or enter a different name.
3. Select the Archive button to start the archive process, or click cancel to close the Archive wizard.
4. Select the Finish button when the archive process is complete.
The archive files are stored on your computer in an Archives subfolder of your company folder.

What do you want to do next?
Open an Archived Company
l
Restore an Archive
l

Open Archived Company
This feature is available only in Sage 50 Premium Accounting and higher.
The Open Archived Company window displays a list of available archived companies to open.
To open an archived company:

1. From the File menu, select Open Archived Company.
A message appears displaying "This will close the current company."

2. Select OK on the message to close the current company and display the Open Archived Company window, or select Cancel to
return to the company.

3. From the Open Archived Company window, select the archived company file from the list and select OK to open the archived
company, or select Close to close the window.
Note: If you are running Sage 50 Accountant Edition and are using a company from Sage 50 Pro Accounting, or Sage 50 Complete
Accounting, the archive feature will not be available.

What do you want to do next?

Restore an Archived Company
This feature is available only in Sage 50 Premium Accounting and higher.
You can restore a backup of an archived company to its original location while in an active company if the original archive files were
lost, moved, or damaged. When restoring an archive company backup, the archived company is restored, not the active company.
To restore an active company, see Restore Company Data Files.
To restore an archived company:

1. From the File menu, select Restore Archive.
A Restore Archive window appears.

2. Find the archived file you want to restore from the Look In drop-down list, or browse to find the file.
The default is the company folder of the company you are currently using.

3. Click the Open button to restore the archive, or click Cancel to cancel the restore.
The archive is restored to its original location.

Note: If you are running Sage 50 Accountant Edition and are using a company from Sage 50 Pro Accounting, or Sage 50 Complete
Accounting, the archive feature will not be available.

Purge Wizard - Introduction
Purging is the process of removing inactive customers, vendors, employees, jobs, quotes, invoices, purchases, and so on from the
records of a company. Purging reduces the size of the files of a company and frees valuable disk space for current and active data.
In Sage 50, purging can be performed at any time, including after you close the fiscal year and or close the payroll tax year using
the Year-End wizard.
Due to the complexity of the purging process, you will need to provide information to Sage 50 on what needs to be purged and
through what date. To facilitate this process, and reduce the possibility of error, Sage 50 includes a Purge wizard to assist you
through the process. You can cancel at any time while you are using the Purge wizard.

It is extremely important to make a backup before you begin purging. In fact, we recommend that you make two backups, one for
current reference and one to be stored in a secure location for emergency needs. If you haven't already made sufficient backups,
note that the Purge wizard will allow you to make them during the purge process.
The purge process is not intended to remove or fix corrupt data. If you are experiencing problems with your data or suspect it is
corrupt, you must restore a backup of your company data.

Note: Since the purge process may take quite a while to complete, we recommend that you start the process at the end of your
business day, making sure you leave the computer running. Also, make sure that all other applications are closed before you
begin.

Tip: If your company data is extensive, you may want to consider purging the data in sections rather than selecting several options
at one time. This allows you to purge in incremental sessions that you control, saving time and memory resources. For example,
purge only three months worth of data at a time. Or, purge transactions first, then records.

Using the Purge Wizard
The Purge wizard comprises a series of windows with instructions and options. The first window, the Welcome to the Sage 50 Purge
Wizard window, tells you the end date of the most recently closed fiscal and payroll tax years. Once you've finished reading the text
in this window, you can click the Next button to go to the next window in the series. The windows that make up the wizard are:

Back Up Company Data: It's very important that before you close the year, you make a backup of company data and
customized forms; otherwise, this information will be lost. The Back Up Company Data window creates a backup for you. Learn
more .
Old Transactions: This window lets you choose a date on or before which old, unneeded transactions can be purged. Then the
wizard asks you to select the types of transactions you'd like to purge. Learn more .
Account Reconciliation: This window asks whether or not you use Account Reconciliation and need to have certain accounts
reconciled before purging. If so, here you can choose the accounts that need reconciling. Learn more .
Inactive Maintenance Records: This window lets you choose the types of inactive records you want to purge. Inactive
maintenance records can be purged as long as they are not used by a transaction and have zero remaining balances. Learn more .
Summary of Options: Here you will see a summary of all purge options you have chosen in previous windows. You can either
proceed with the purge or use the Back button to return to the earlier windows and make any needed adjustments. Learn more .
In Progress: This window displays progress meters that tell you how much of the purge process has been completed; if needed,
you can cancel at any time. The wizard will notify you when purge is complete. The In Progress window also lets you print a log that
details the purge process. Learn more .

Starting the Purge Wizard
1. From the Tasks menu, select System and then Purge Wizard.
The Welcome to the Sage 50 Purge Wizard window appears.

2. Read the introductory information.
Note: If you want to purge old transactions and payroll/1099 transactions, the most recent fiscal and payroll tax years must be
closed before you continue. The Closed Years section of the Welcome window will tell you the end dates of the last fiscal and
payroll tax years to be closed. If these years are not the most recent ones, use the Year-End wizard to close them.
3. Now, to proceed with the purge process, select the Next button.
Sage 50 displays the Back Up window.

Billing Your Customers & Receiving Money
Sales/Invoicing
Use the Sales/Invoicing window to enter invoices for customers. All entries made here are posted to General Ledger, customer
records, and possibly job and inventory item records. You have the choice of applying transactions to Jobs through the distribution
list box.
You can also use this window to print an invoice for a customer and set up recurring invoices for customers. Sales/Invoicing allows
you to enter as many as 500 line items per invoice.

Learn More

Are you entering a standard invoice for products or an invoice for services?
Sage 50 has two standard invoice templates—one for billing for products and one for billing for services. In addition, you can
customize your own templates.

Enter a product invoice
Enter a service invoice
Entering a product invoice
If you want Sage 50 to print an invoice, leave the Invoice No. field blank, and Sage 50 will supply the number. Otherwise,
enter your own invoice number of other reference.

Enter a product invoice
Is this an invoice you send on a regular basis?
Sage 50 has different methods for handling invoices that you send on a consistent basis.
Memorized transactions are like a template that you can quickly flesh out for specific transactions. They are not posted to the
general ledger.
Recurring transactions are complete transactions you set up to happen on a set timetable—monthly, quarterly, yearly, etc. An
example would be if you have a contract with someone to provide a monthly service.
You can also create a new sales invoice by copying an existing one.

Do you want to create the same invoice for multiple customers?
You can use Broadcast Invoicing to create the same invoice for multiple customers. This is especially helpful if you bill many of
your customers for the same service or fee. You can create one invoice and broadcast it to multiple customers instead of
creating the invoices one at a time for each customer.

Note: This feature is available only in Sage 50 Premium Accounting and higher.
How to create broadcast invoices
Did you know you can customize this window, hiding fields you don't use?
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select a standard template, like Product Invoice.

Recording customer payments for invoices
If the customer has paid you at the same time you are entering the invoice, you can record an amount paid at sale on the
Sales/Invoicing screen. You can enter this amount before you save the invoice and it will be reflected in the invoice total.
After the invoice has been saved, you can go to the Receive Money screen to record a payment for that invoice. On the Receive
Money screen, you will select a customer and then select any invoices that the customer is paying.

Tip: If the customer is just paying one invoice, you can open that invoice on the Sales/Invoicing screen and click the Pay Now
link. This opens the Receive Money screen with the invoice already selected to be paid.

Apply a Customer Payment to an Invoice on the Receive Money Screen
Printing or previewing customer invoices
When you enter customer invoices in Sage 50, you can leave the Invoice No. field blank to have Sage 50 automatically assign
invoice numbers to invoices when printed.

How to print an invoice
How to preview an invoice
Using the Track It panel
You can use the Track It panel to update the tracking status of a sales invoice (pending, approved, etc.), including assigning it to
a specific user or all users that have a specific role in your company.

Why does Sage 50 print "duplicate" on my invoice when I know it isn't a duplicate?
Sage 50 will print "duplicate" on the invoice if an Invoice Number has already been assigned to the invoice, either because it was
printed before or because the Invoice Number field on the Sales Invoicing window was filled in prior to printing. On the
Sales Invoicing window

l
l

Complete the Invoice Number field ONLY if the invoice was printed outside of Sage 50, such as by hand.
Leave the Invoice Number field blank if you plan to print the invoice you are entering. Sage 50 will automatically assign the
next invoice number when you click Print and it will not print "duplicate" on the invoice.

Deleting, editing, or voiding an invoice
Be careful when editing or deleting invoices. If you've already entered a receipt, you may need to first delete the receipt before
you can edit or delete the invoice.
Note: If you delete a sales invoice that originated from a quote, Sage 50 will delete the original quote as well. However, you
will get a warning message and you can cancel out if you want. However, the quote will be retained in the following case: if a
sales invoice is deleted, but the quote was converted to a sales order or proposal first. In this case, the sales order or proposal
will be retained, and thus, the quote will be retained as well.

Editing or deleting an invoice
Help with specific fields
For a listing of fields in the Sales/Invoicing window, click the link.

How to enter job information
Select the job and the phase and/or cost code to which this transaction applies. To do so

1. In the Job field, click the folder button to display a drop-down list of available jobs, phases, and cost codes (if the job uses
them).

2. Click the folder for the job you want to apply these costs to. This will display the list of phases.
3. Click the folder for the phase you want. This will display the list of cost codes, if there are cost codes associated with the
phase you selected.

4. Click the cost code you want to select, if necessary. This will close the list of jobs and select that particular job, phase, and
cost code.
Purchases of stock and assembly items cannot be applied to a job. These types of inventory items are applied to a job using
Inventory Adjustments or Sales Invoicing.

Processing retainage

Setting up Sage 50 to handle retainage
Processing retainage on sales invoices
Releasing retainage for sales invoices
Add an Attachment
You can attach files, such as Word or Excel documents or pictures, to a sales invoice.

Enter a Cash Sale
When a customer pays for an item and there is no invoice, enter a cash sale.

1. From the Tasks menu, select Receive Money. Sage 50 displays the Receive Money window.
2. Enter a check/reference number for this transaction. This must be a unique number and is generally the customer's check
number. Avoid entering "CASH" as the reference for more than one transaction.

3. In the Cash Account list, enter or select the bank account in which the receipt is deposited.
If you have the Hide General Ledger Accounts global option activated, the Cash Account lookup list displays only names of cash
accounts currently set up in the chart of accounts.

4. If you are recording deposit tickets within the Receive Money window, enter or accept the suggested Deposit Ticket ID.
Otherwise, leave this field blank. You can record deposit ticket IDs in the Select for Deposit window.

5. Select the Apply to Revenues tab. Then, enter the line items on the receipt the same way as you do in Sales/Invoicing.

Tip: If the Apply to Revenues tab is in focus, you can enter an amount in the Receipt Amount field and Sage 50 will automatically
populate the Apply to Revenues tab for you. This is useful if you don't need to enter any details about the receipt in the line items.
If the line item contains serialized inventory, you will need to select serial numbers for the item(s). Select the line item
with the serialized inventory item, then select the Serial No button to select serial numbers. The Serial Number Selection window
appears. Select the serial numbers you need and select OK when you're finished to return to the Receive Money window.
However, if the Receive Money window has more than one line item that contains serialized inventory, you can select the
OK/Next button to save the current entry and move to the next serialized item.

6. If you need to enter retainage on this receipt, select the Apply to Revenues tab and enter a new line item, making sure that
you select the Receivable Retainage general ledger account and entering the retained amount as a negative number. This will
ensure that the retainage is tracked properly.

7. Select the Print button if you want to print and save the receipt. Otherwise, click the Save button.
What do you want to do next?
Enter a payment from a customer not on file
l
Edit or delete an invoice with a receipt
l
Enter a standard invoice
l
Look up the current payment status of a sales invoice
l

l

Read the receive money overview

Recurring Billing
In most businesses, you have customers that you bill every month. In your business, you can bill the same customers every month,
even for the same amount. No matter which situation is yours, you can probably save time by setting up recurring invoices.

1. From the Tasks menu, select Sales/Invoicing.
2. In the Sales/Invoicing window, complete the transaction as you normally would. You do not have to enter an invoice number at
this time.

Note: You are actually creating an invoice here, not just a template.
3. Instead of selecting Save, select the drop-down arrow next to the Copy button and select Create recurring.
A Create Recurring <transaction> dialog appears.

4. Select How often you want to recur this transaction from the drop-down list. You can choose Weekly, Biweekly, Every
four weeks, Monthly (the default), Per Period, Quarterly, Twice a year, or Annually.

5. Select the First transaction date from the calendar. This is the date that your recurring transaction will begin.
Select the end date from one of three options:
l

l

If you know a specific date you want to end the recurring transactions, select a date from the calendar for the End on
option.
If you know the specific number of recurring transactions you want to set up, select the End after option and enter the
number of occurrences.

l
If you want your recurring transaction to continue indefinitely, select No end date option.
6. You have to assign a number, either here or when printing invoices. If you don't plan to print invoices, select the Assign
Invoice Numbers option, and enter a number. If you do plan to print invoices, leave this box unchecked. Then, you can assign

numbers when printing.
If you check the box and assign a number, Sage 50 will assign all the numbers now, increasing each invoice number by 1.

7. Choose the OK button. Sage 50 saves all transactions in the appropriate period. The first transaction is saved for the current
transaction date.

What do you want to do next?
l
Enter a product invoice
l
Enter a service invoice
l
Print an invoice

l
l

Perform other report, form, and financial statement tasks
Read the sales orders overview

Enter a Product (Standard) Sales Invoice
1. From the Tasks menu, select Sales/Invoicing.
Select the Layout toolbar button, and choose the predefined Product template from the pull-down menu.

Note: This procedure assumes you are using the predefined Product template. If you choose a customized template, please
adjust the instructions below accordingly.

2. Enter or select the customer ID.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping addresses, sales
account, shipping method, payment terms, and sales tax ID.

Tip: If you haven't set up the customer, you can click the Add a new customer link to open the Maintain Customers/Prospects
screen where you can enter the customer information.

3. If this customer has open sales orders, the Apply to Sales Order tab appears in front. To enter new items on the invoice, select
the Apply to Sales tab.
4. Leave the Invoice # field blank if you want Sage 50 to print an invoice. Sage 50 will increase the invoice number by one when it
is printed. Otherwise, enter an invoice number or other reference number. (If you print the invoice with an invoice number
assigned or print it again later, the invoice will have the word DUPLICATE on it.)

5. Enter the date of the invoice if it is different from the displayed invoice date.
6. Enter the due date of the invoice if it is different from the displayed due date.
7. Sage 50 will automatically enter the Contact and Ship To information for the address marked as Ship To Address 1 on the
customer record. You can select another contact and shipping address from the choices available in the Ship To drop-down list,
or manually enter another address in the Ship To fields.

8. If you have entered a default P.O.# in the customer's record, it will appear on the invoice. If not, you can enter the customer's
purchase order number now or change the default to any other piece of information that will identify this invoice to the customer.

9. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via button if you
want to select a different shipping method. You can also enter a ship date.

10. Sage 50 uses the default terms you have entered for the customer, but you may want to select the Terms link to change the
default discount dates or amounts for this invoice. When a receipt that qualifies for an early-payment discount is applied against
the invoice, Sage 50 will calculate the discount.

11. If you entered a default Sales Rep in the customer's record, it will appear. Otherwise, select the rate of the sales representative, if
applicable.

12. Enter the information for each item included on the invoice on a separate line, including the item's quantity, item ID, description,
unit price (the number of decimal places is selected in Global Options), and sales tax status, and job information.

13.

If the line item contains serialized inventory, you will need to select serial numbers for the item(s). Select the line item
with the serialized inventory item, then select the Serial No button to enter or select serial numbers. The Serial Number Selection
window appears. Select the serial numbers you need and select OK when you're finished to return to the Sales/Invoicing window.
However, if the invoice has more than one line item that contains serialized inventory, you can select the OK/Next button to
save the current entry and move to the next serialized item.

14. Select the job and the phase and/or cost code to which this transaction applies. To do so
l
In the Job field, click the folder button to display a drop-down list of available jobs, phases, and cost codes (if the job uses
them).
l
l

l

Click the folder for the job you want to apply these costs to. This will display the list of phases.
Click the folder for the phase you want. This will display the list of cost codes, if there are cost codes associated with the phase
you selected.
Click the cost code you want to select, if necessary. This will close the list of jobs and select that particular job, phase, and cost
code.

13. Continue entering line items until you have entered them all.
14. Select the Apply tickets/expenses link to include job-expense transactions related to this customer on the invoice. .

15. If yours is an accrual-based company, you can select the Accounts Receivable G/L account for this potential sale. On financial
statements, this will be your accounts receivable asset account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R Account field in
this window. To modify the A/R account used for this transaction, you must select the Journal button.

16. Select the Withhold Retainage tab and review any retainage amounts that have been calculated. If you need to change the
Retainage % or Retain Amount for a line item, you may do so now. Tell me more about entering retainage on sales invoices.
(Retainage is available only if you are using an accrual basis accounting company.)

17. Select the sales tax ID for this sale.
18. If you intend to charge freight for shipping this order, include an amount in the Freight field.
19. If you have received a partial or full payment for this invoice at the time of the sale, select the Amount paid at sale link. Sage 50
displays the Receive Payment window, where you can enter receipt information.
The Net Amount Due displays what the customer currently owes for the sale.
20. At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed. You can click
the customer balance link to display the current Customer Ledgers report for this customer.

21. Select the Print button if you want to print and save the invoice. Otherwise, click the Save button.
What do you want to do next?
Preview a sales invoice form before printing it
l
Edit or delete an invoice with a receipt
l
Apply job-reimbursable expenses to sales invoices
l
Look up the current payment status of a sales invoice
l
Receive payment from a customer
l
Enter a customer payment at time of sale
l
Read the sales/invoicing overview
l
Read an overview of retainage
l

Enter a Service Invoice
Sage 50 provides a service invoice in addition to the standard invoice if you want to create an invoice without inventory items. You
will want to use this type of invoice if you provide a service and don't ship products to your customers. Make sure you select the
invoice type before you begin entering information on the invoice.

1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Select the Layout toolbar button, and choose the predefined Service template from the pull-down menu.
Note: This procedure assumes you are using the predefined Service template. If you choose a customized template, please
adjust the instructions below accordingly. .

3. Enter or select the customer ID.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping addresses, sales
account, shipping method, payment terms, and sales tax ID.

Tip: If you haven't set up the customer, you can click the Add a new customer link to open the Maintain Customers/Prospects
screen where you can enter the customer information.

4. If this customer has open sales orders, the Apply to Sales Order tab appears in front. To enter new items on the invoice, select
the Apply to Sales tab.
5. Leave the Invoice # field blank if you want Sage 50 to print an invoice. Sage 50 will increase the invoice number by one when it
is printed. Otherwise, enter an invoice number or other reference number. (If you print the invoice with an invoice number
assigned or print it again later, the invoice will have the word DUPLICATE on it.)

6. Enter the date of the invoice if it is different from the displayed invoice date.
7. Enter the due date of the invoice if it is different from the displayed due date.

8. Sage 50 will automatically enter the Contact and Ship To information for the address marked as Ship To Address 1 on the
customer record. You can select another contact and shipping address from the choices available in the Ship To drop-down list,
or manually enter another address in the Ship To fields.
9. If you have entered a default P.O.# in the customer's record, it will appear on the invoice. If not, you can enter the customer's
purchase order number now or change the default to any other piece of information that will identify this invoice to the customer.

10. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via button if you
want to select a different shipping method. You can also enter a ship date.

11. Sage 50 uses the default terms you have entered for the customer, but you may want to select the Terms link to change the
default discount dates or amounts for this invoice. When a receipt that qualifies for an early-payment discount is applied against
the invoice, Sage 50 will calculate the discount.

12. If you entered a default sales representative in the customer's record, it will appear. Otherwise, select the code of the sales
representative, if applicable.

13. Enter the information for the services that you provided. Enter each service item on a separate line, including the description, unit
price (the number of decimal places is selected in Global Options), sales tax status, and job information (if applicable).

14. The default G/L sales account that appears for each line item is based on the customer sales account default or the item ID
selected.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account fields in this
window. To modify G/L accounts used for this transaction, you must select the Journal button.

15. 1. Select the job and the phase and/or cost code to which this transaction applies. To do so
l
In the Job field, click the folder button to display a drop-down list of available jobs, phases, and cost codes (if the job uses
them).
l
l

l

Click the folder for the job you want to apply these costs to. This will display the list of phases.
Click the folder for the phase you want. This will display the list of cost codes, if there are cost codes associated with the
phase you selected.
Click the cost code you want to select, if necessary. This will close the list of jobs and select that particular job, phase, and
cost code.

16. Continue entering line items until you have entered them all.
17. Select the Apply tickets/expenses link to include job-expense transactions related to this customer on the invoice. .
18. If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale. On financial
statements this will be your accounts receivable asset account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R Account field in
this window. To modify the A/R account used for this transaction, you must select the Journal button.

19. Select the sales tax ID for this sale.
20. If you have received a partial or full payment for this invoice at the time of the sale, select the Amount paid at sale link. Sage
50 displays the Receive Payment window, where you can enter the receipt information.
The Net Amount Due displays what the customer currently owes for the sale.
21. At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed. You can click
the link for the customer balance to display the current Customer Ledgers report for this customer.

22. Select the Print button if you want to print and save the invoice. Otherwise, click the Save button.

Creating Broadcast Invoices
This feature is available only in Sage 50 Premium Accounting and higher.
Broadcast invoicing allows you to create the same invoice for multiple customers. You can create one invoice and broadcast it to
multiple customers instead of creating the invoices one at a time for each customer.

Can I broadcast any invoice?
l

You cannot broadcast an invoice that contains serialized inventory items.

l

l

l

l

You can broadcast invoices that have sales orders and proposals applied to them. Sage 50 will put the line items from the Apply to
Sales Order or Apply to Proposal tab of the original invoice on the Apply to Sales tab of the broadcast invoices. The broadcast
invoices will not be applied to any sales orders or proposals.
You can broadcast invoices that have credit memos applied to them. The broadcast invoices will be created using the line items
from the original invoice. Any items that have been returned via an applied credit memo will not be removed.
You can broadcast invoices that have jobs applied to them. Be aware that these jobs will be applied to all of the invoices created in
the broadcast.
You can broadcast invoices that have retainage withheld. However, you should be careful when doing this because the retainage
will be withheld for the customers assigned to the job or jobs on the invoice. You will need to make sure that the retainage is being
withheld for the correct customer on each invoice. You can also broadcast invoices that bill retainage. Again, you should be careful
when doing this because each invoice will bill retainage based on the original invoice that was created to bill retainage for a
particular customer. You should also make sure the sales tax type is correct on the invoice before broadcasting it to make sure
that sales tax isn't charged on retainage invoices. It is probably best not to broadcast invoices that withhold or bill retainage.

How to use broadcast invoicing
1. Go to Tasks-Sales/Invoicing.
2. Create the invoice that you want to broadcast to multiple customers. You do not have to enter information in the customer ID field
or the invoice date or invoice number fields. These fields will be populated on each invoice based on the selections that you make
on the Create Broadcast Invoices screen.

OR
Open an existing invoice that you want to broadcast.

3. Click the drop-down arrow next to the Copy button on the Sales/Invoicing screen toolbar, then select Send to multiple
customers.
4. The Select Customers for Broadcast Invoicing-Filter Selection screen will appear.
5. Make any necessary filter selections to narrow down the list of customers to use when creating the invoices.
6. Click OK.
7. The Create Broadcast Invoices screen will appear.
8. In the Selection Grid, select the customers that you want to use to create the invoices. Some customers may have messages in
the Warning column of the grid. Look carefully at these customers before selecting to create invoices for them.
If you do not see the desired customers in the Selection Grid, click the Return to filter screen button to return to the filter
screen where you can change your filter selections.

9. Enter a date for the invoices in the Broadcast Invoice Date field.
10. Click Create. This will save the invoices without invoice numbers so that you can print them later.
A message will appear showing the number of invoices that you just created and giving you the option to print the invoices and
view a summary list of the invoices.

11. Click View Summary to see a list of the invoices you just created. You will not have the option to view this report any other
time.

12. Click Print Invoices to print these invoices. The Preview and Print Invoices and Packing Slips screen will appear with the
invoices you just created selected in the grid. You will be able to select other unprinted invoices to print also.
Click Print/E-mail to print the invoices.

What do you want to do next?
Print a single invoice
l
Print a batch of invoices
l

Edit or Delete an Invoice with a Receipt
If you would like to edit or delete an invoice for a customer and you have already entered a receipt, you may need to first delete the
receipt before you can edit or delete the invoice. You need to delete the receipt if you want to change the invoice number or the
customer on an invoice or if you want to delete the invoice. Follow these steps:

1. From the Tasks menu, select Receive Money. Then, select the List button so you can delete the receipt you entered for the
invoice.

2.
3.
4.
5.

From the list, select the receipt and then OK.
Once the receipt is displayed, select the Delete toolbar button to remove it.
From the Tasks menu, select Sales/Invoicing. Then, select the List button so you can edit the original invoice.
From the list, select the invoice you want to edit, and click OK.
Once Sage 50 displays the original invoice, make any necessary changes. If this invoice is for items ordered on a sales order, you
cannot change the customer ID. If you want to remove the transaction, select the Delete toolbar button. If you were editing the
invoice select the Save button. You will have to enter the receipt for the payment again.

Note: In cases where maintaining an audit trail is important, you will want to void rather than delete an invoice.

Look Up the Current Payment Status of a Sales Invoice
Use this procedure to quickly determine if any payments have been applied to an invoice.

1. From the Tasks menu, select Sales/Invoicing.
2. Select the List toolbar button to display the Invoicing List.
The payment status appears in this list as Unpaid, Partially Paid, or Paid in Full.

3. Select an existing sales invoice transaction to display, if desired.
4. The Payment Status appears in red just below the Bill to address. If the status is Partially Paid or Paid in Full, you will also see the
date the last payment was received.

Note: The payment status is established after the invoice is posted (or saved) and updated when a receipt is applied to it.

Print an Invoice
When you enter customer invoices in Sage 50, you can leave the Invoice # field blank to have Sage 50 automatically assign
invoice numbers to invoices when printed.
To print sales invoices, you can do any of the following:
l

Print invoices one at a time from the Sales/Invoicing window by simply selecting the Print button. Printing from the Sales/Invoicing
window both prints and saves the invoice.

l

Print a batch of invoices in one session from the Sales/Invoicing window.

l

Print a batch of invoices in one session from the Select a Report or Form window .

How to print a batch of invoices from the Sales/Invoicing window
1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Select the Print drop-down button and choose Select Invoices to Print from the menu. Sage 50 displays the Preview and Print filter
window.

3. When you print invoices, you can choose to print invoices that have not been printed, which are those invoices saved or posted in
the Sales/Invoicing window without an invoice number, or you can choose to reprint previously printed invoices.

4. Sage 50 displays the suggested first invoice number in the Number the first invoice field on
the Preview and Print filter screen. You can change this if you want.

5. Select Print/E-mail after you make your filter selections and then click OK on the Print dialog.
6. When the invoices stop printing, Sage 50 displays a message asking if the invoices printed correctly and if it's okay to update the
journal. Look carefully at your invoices before you answer Yes to this question.
l
When you answer Yes, Sage 50 records the Invoice numbers used on the forms into the Sales Journal.
l
If you answer No, the Invoice numbers are left blank, and the invoices will be printed again during the next invoice run.
How to print a batch of invoices from the Select a Report or Form window
1. From the Reports & Forms menu, select Forms, then Invoices and Packing Slips . Sage 50 displays the Select a Report
or Form window.

2. Select the form that best meets your needs from the Forms list and click the Preview and Print button which is located below
the sample image of the form on the Select a Report or Form window.

You can print invoices on plain paper, or you can print invoices on preprinted forms.
When you print invoices, you can choose to print invoices that have not been printed, which are those invoices saved or posted in
the Sales/Invoicing window without an invoice number, or you can choose to reprint previously printed invoices.

3. Sage 50 displays the suggested first invoice number in the Number the first invoice field on
the Preview and Print filter screen. You can change this if you want.

4. Select Print/E-mail after you make your filter selections and then click OK on the Print dialog.
5. When the invoices stop printing, Sage 50 displays a message asking if the invoices printed correctly and if it's okay to update the
journal. Look carefully at your invoices before you answer Yes to this question.
l
When you answer Yes, Sage 50 records the Invoice numbers used on the forms into the Sales Journal.
l
If you answer No, the Invoice numbers are left blank, and the invoices will be printed again during the next invoice run.

Print Packing Slips
Sage 50 includes a packing slip form so you can print packing slips to include in the orders you ship. Packing slips are a specialized
version of the invoice. Note that you must print the invoices first, then print the packing slips for the range of invoices you just
printed; otherwise, the word "Duplicate" will print on the invoices.
It is important to note that Sage 50 sorts numbers one digit at a time.
It is a good idea to assign numbers with the same number of digits.
For example, Sage 50 sorts the following numbers in this order.

1
104
12
2
23

Make sure you perform your tasks in this order:

1.
2.
3.
4.

Enter your sales orders. How do I do this?
Print the Picking List report to "pick" the items needed to fulfill the order.
Print your invoices. Sage 50 assigns the invoice # when they are printed. How do I print invoices?
Print packing slips selected for a range of invoice #s. In the Select a Report or Form window, make sure Invoices and Packing
Slips is selected in the Form Types list, then select Packing Slip from the Forms list. Select the Preview and Print button
located below the sample image on the Select a Report or Form window. Make any necessary filter selections, then select
Print/E-mail to print the packing slips.

Receive Money (Receipts)
This allows you to enter all checks, cash, and credit card slips you receive and deposit them in your checking account.
There are two ways you can account for receipts in Sage 50:
l

l

If you sent an invoice to a customer, you apply the receipt to the invoice. Invoices entered in the Sales/Invoicing window appear
as distribution lines when you enter the customer ID. You can check the Pay column beside each invoice being paid in full by this
receipt.
If you made a direct sale that didn't require an invoice, you use the Receive Money screen and enter it on the Apply to
Revenues tab. This requires you to specify a check number and sales account.

You can enter as many as 500 lines per receipt.
When you enter a receipt, you can:
l

l

Select the invoices to be paid on the Apply to Invoices tab or enter the line item information on the Apply to Revenues tab and
have Sage 50 calculate the receipt amount.
Enter the receipt amount and have Sage 50 select the invoices to be paid on the Apply to Invoices tab or enter the line item
information on the Apply to Revenues tab.

Use the way that works best for you. If you need to change the receipt amount or the information entered on the tabs, go ahead. Just
be sure the receipt amount equals the total of the amounts on the tabs before you save the receipt.

Learn More
Are you receiving payment from an invoice, or is this a cash sale?
The process of entering a receipt is different depending on whether the receipt is against an invoice or represents a cash sale.

If the sale is to a customer who is not in your database, you can enter the customer's name without keeping a record on that
customer.

Receive payment from a customer
Enter a cash sale
Enter a payment from a customer not on file
Is the customer making a prepayment or deposit?
If the customer is making a down payment on an item, when you enter the receipt, select the Apply to Revenues tab; then
select the Prepayment check box.

Is the customer paying by credit card?
Manual Transactions
If your customer is paying by credit card and you are not processing the payment through Sage 50, click the Record button to
enter the credit card information and the transaction authorization code.

Transactions Authorized through Sage 50
If you want to authorize the transaction through Sage 50, select the Process button. You can enter the credit card information or
use a card reader to approve the credit card transaction within Sage Exchange. If you're using a card reader, you'll see an
option to swipe the credit card once you are in Sage Exchange. You must have a Sage Payment Solutions processing account set
up in order to do this.

Note: If the credit card payment was authorized in Sage Exchange, "(Approved)" appears below the Record and Process
buttons.

Printing or previewing receipts
You always print receipts one at time, from the Receive Money window.

How to print a receipt
How to preview a receipt
Using the Track It panel
You can use the Track It panel to update the tracking status of a receipt (pending, approved, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Recalculating the cash balance in Receive Money
If you see the word Uncalculated in the Balance field of the window, then the Recalculate cash balance automatically
in Receipts and Payments in Maintain Global Options is currently not selected. However, you can manually update cash
balance; click the link to find out how.

Help with specific fields
For help with specific fields on the Receive Money window, click the link.

Add an Attachment
You can attach files, such as Word or Excel documents, to a customer receipt.

Apply a Customer Payment to an Invoice
When a customer pays an invoice, enter the amount in the Receive Money window.

To enter customer payment on an invoice
1. From the Tasks menu, select Receive Money. Sage 50 displays the Receive Money window.
2. Enter a deposit ticket ID that can easily represent the type and source of payment. This will make account reconciliation easier to
manage.
Sage 50 automatically enters the deposit ticket ID as a numeric representation of the current date. All receipts that use the same
deposit ticket ID will appear as one lump sum in Account Reconciliation . If you want this transaction to be reconciled as a
separate item, enter a unique deposit ticket ID.

3. Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup button.
If there are unpaid invoices for this customer, Sage 50 lists them on the Apply to Invoices tab. If there are no unpaid invoices,
Sage 50 displays the Apply to Revenue tab.
Tip: If the customer is paying one invoice, there is a quick way to get the information into the Receive Money screen. Open the
invoice on the Sales/Invoicing screen and click the Pay Now link. The Pay Now link is located next to the invoice status for
invoices that have not been paid in full. This will open the Receive Money screen with the invoice selected to be paid.

4. Enter a check/reference number that will help identify the receipt (for example, the customer's check number).
5. If you are recording deposit tickets within the Receive Money window, enter or accept the suggested Deposit Ticket ID.
Otherwise, leave this field blank. You can record deposit ticket IDs in the Select for Deposit window.

6. Select a payment method (for example, Cash or Check). Payment methods are set up in Customer Defaults; these are quite
useful in reports when managing receipts.

7. In the Cash Account list, enter or select the bank account in which the receipt is deposited.
If you have the Hide General Ledger Accounts global option activated, the Cash Account lookup list displays only names of cash
accounts currently set up in the chart of accounts. If you want to apply an alternate G/L account (an account that uses an account
type other than Cash) for this payment receipt, you must select the Journal button.

8. With the Apply to Invoices tab shown, enter the amount of money you received from the customer in the Receipt Amount field.
Sage 50 will look on the Apply to Invoices tab for an invoice matching that amount. If one is found, it will be selected to pay.
Otherwise, the receipt amount will be applied to the first invoice listed. If there is an amount remaining, it will be applied to the
next invoice and so on until the entire receipt amount is applied.
If you don't want Sage 50 to automatically select the invoices to pay or if you want to change what has been selected, on the
Apply to Invoices tab, select the Pay check box next to each invoice that the customer is paying.

Tip: The Pay All/None links allow you to easily select or deselect all of the invoices in the list.
l

l

If the customer has paid the invoice in full, place the cursor in the Amount column for the invoice, and select the Pay check
box. Sage 50 will fill in the Amount Paid field.
If the customer has only paid a partial amount on the invoice, enter that amount. Sage 50 will automatically select the Pay
check box.

Note: If your customer overpays the amount, a credit is made to the customer's ledger; for underpayments, the payment
amount is applied to the invoice balance. You will need a reference number in order to post or save the record.

9. Make sure the Receipt Amount is equal to the total of the amounts from the Apply to Invoices and Apply to Revenues tabs.
10. Select the Print button if you want to print and save the receipt. Otherwise, click the Save button.

Receive Money (Time of Sale Receipt)
When you select the Amount Paid at Sale link in the Sales/Invoicing window, Sage 50 displays this window. It allows you to enter
a receipt for the sale at the time the sales invoice is posted. You can enter the amount paid on this invoice, the payment method, and
the G/L account to receive the payment.

Note: You can only enter one payment for the invoice using this method. All other payments must be entered and applied by
going to Tasks> Receive Money .
Fields
Deposit Ticket ID: The date from the Control Panel in Windows appears in this field, but you can change it. All receipts that have
the same date for account reconciliation will have the same reference number.

Reference: Enter information in this field that will help you identify this receipt such as the check number or the word cash . This is a
required field.

Customer ID: This appears based on the customer selected on the invoice and cannot be changed here.
Date: The date is the invoice date and cannot be changed here.
Name: The customer's name and billing address are displayed and cannot be changed here. This information can be changed on
the invoice, and any changes made will be reflected here too.

Receipt Amount: Enter the amount the customer is paying at this time.

Payment Method: From the list, select the method of payment this customer is using. The payment methods are entered on the
Pay Methods tab of the Customer Defaults window.
Cash Account: The account that appears here when you open the Receive Money at Time of Sale window is the last Cash Account
that was used on the Receive Money task window. You can select a different account or add a new one here.
If you have the Hide General Ledger Accounts global option activated, the Cash Account lookup list displays only names of
cash accounts currently set up in the chart of accounts. Select the cash account name to apply to this payment receipt.

Note: If you want to apply an alternate G/L account (an account that uses an account type other than Cash) for this payment
receipt, you must select the Journal button.

Record: If your customer has paid by credit card and you aren't processing the credit card payment through Sage 50, click the
Record button to record the credit card information for this transaction. This button will be disabled if the credit card was authorized
through Sage 50. (Process button).

Process: If your customer is paying by credit card and you want to process the credit card payment through Sage 50, click this
button. You must have a Sage Payment Solutions processing account to do this. This will take you to Sage Exchange where you can
enter the credit card information or use a credit card reader to process the credit card transaction. If you have already processed
the credit card payment, the Credit Card Information window will appear. This button will be disabled if an authorization code has
been entered manually (Record button).

Note: If the credit card payment was authorized using Sage Exchange, "(Approved)" appears below the Record and Process
buttons.

Enter a Customer Payment at Time of Sale
If a customer makes a payment at the time you record the sale, you can enter the amount paid directly from the Sales/Invoicing
window. Follow these steps:

1. From the Tasks menu, select Sales/Invoicing.
2. In the window, enter the receipt information according to one of the following procedures:
l
If this is a product invoice, follow the steps under Enter a Product Sales Invoice.
l
If this is a service invoice, follow the steps under Enter a Service Invoice.
3. Once you have finished entering the information, select the Amount Paid at Sale link.
The Receive Money at time of sale window appears.
4. In the Deposit ticket ID field, enter the ID number from your deposit ticket. If you make a daily deposit, you can also use the
default ticket ID, which is the current date.
This ID ties a group of receipts to the deposit total and allows you to clear all the receipts for the entire deposit ticket when
reconciling the account in Account Reconciliation .

5. In the Reference field, enter the reference number, usually a check number if your customer paid you by check. You can also
enter a credit card authorization number or some other means of identifying the transaction.

6. In the Receipt Amount field, enter the amount of the receipt.
7. From the Payment Method drop-down list, select the appropriate payment method.
8. From the Cash Account drop-down list, select the payment method the customer used. For example, you can use one account
for cash and checks and another for credit cards.

9. When finished, select OK. Then save the invoice.

The amount paid at sale appears at the bottom of the Sales/Invoicing window along with the following information:

1. total of other applied receipts
2. invoice total
3. net amount due

Enter a Payment from a Customer Not on File

1. From the Tasks menu, select Receive Money. Sage 50 displays the Receive Money window.
2. Leave the Customer ID field blank. This allows you to enter the customer's name. The receipt sale will update the general
ledger but eliminate the need to keep a customer record.

3. Make sure you enter something in the Check/Reference No. field, such as the check number. This is a required field.
4. In the Cash Account list, enter or select the bank account in which the receipt is deposited.
If you have the Hide General Ledger Accounts global option activated, the Cash Account lookup list displays only names of cash
accounts currently set up in the chart of accounts.

5. On the Apply to Revenues tab, enter details that make up the receipt amount. You may have several line items or just one line
item. It depends on your processes and what the customer has purchased.

Note: If you enter an amount in the Receipt Amount field, the Apply to Revenues tab will populate with this amount on one line
item. You might want to do this if you don't need to track any details about what this customer has purchased or break out sales
tax.

6. Make sure the Receipt Amount is equal to the total amount on the Apply to Revenues tab.
7. Select the Print button if you want to print and save the receipt. Otherwise, click the Save button.

Print a Receipt
You cannot print receipts in a batch from the Select a Report or Form window; instead, you must print receipts one at a time from the
Receive Money window by selecting the Print button. This process both prints and saves the receipt.
You print receipts on preprinted forms that are designed to fit all receipt data into three sections. The receipt form is called “MultiPurpose 2 Stub Receipt” because it contains two stubs, the top one the merchant’s copy and the bottom one the customer’s copy.
Both these stubs include information taken from the Receive Money window, such as item, price, quantity, and amount. In addition,
the customer’s copy stub includes your company name and phone number.
Between the two stubs is the face of the receipt, which contains non-detail information, such as subtotal, sales tax, and grand total.
In addition, using Sage 50 Forms Design, you can redesign the Multi-Purpose 2 Stub Receipt form so that the face includes a credit
card signature form or merchandise received signature form that you can use in the case of credit card disputes with a customer or
to balance your receipt totals.
l
l

For more information on redesigning standard forms, see Forms Design.
For specific information on redesigning the receipt to include a credit card signature form, see Add a Credit Card Signature Form to
a Receipt.

You can print receipts that have not previously been printed, or you can reprint previously printed receipts. Be sure you have
entered something in the Check/Reference No. field before you print.

Enter Bank Deposits and Print Deposit Tickets
To choose receipts that you want to include in a bank deposit, follow these steps.

Note: If your company uses user name/password security, you must have a minimum of Edit access to Receive Money and/or
Sales tasks in the Sage 50 Selected Access window in order to create new deposits. Tell me more about access rights.
1. From the Tasks menu, choose Select for Deposit. Sage 50 displays the Select for Deposit window.
All receipts associated with the currently selected general ledger cash account that have no deposit ticket IDs initially appear in
the list.

2. Either accept the cash account or select a new account ID from the drop-down list.
3. The Deposit Ticket Date field displays the current system date; this is the date that will print on the deposit ticket. If you want
another date to appear, change the date using the Calendar button.
4. To enter a new bank deposit, select which receipts (that currently do not have deposit ticket IDs) you want included in the
current cash account deposit.
l

For each receipt you want to deposit, select the Deposit check box.

Tip: To quickly select all Deposit check boxes, click the All (Select) toolbar button. To quickly clear all Deposit check boxes,
click the All (None) toolbar button.

l

Enter or accept the currently suggested deposit ticket ID.

l

Continue with Step 6.

5. To modify or print an existing deposit, select the Open button.
Existing deposits include receipts that already have a deposit ticket ID associated with them. If the receipt had been entered (in
the Receive Money window) with a deposit ticket ID, that ID appears in the Deposit Ticket ID field. You can change this to any
alphanumeric number.

Note: On the Pay Methods tab of the Customer Defaults window, you can choose when Sage 50 should automatically create
deposit ticket IDs. Sage 50 can create deposit ticket IDs automatically when you enter transactions in the Receive Money
window. Or if you prefer, leave deposit ticket IDs blank in the Receipts window and have Sage 50 automatically suggest deposit
ticket IDs in the Select for Deposit window.

6. To print the deposit ticket, be sure a deposit ticket form is inserted in your printer, and then select the Print button. Follow the
directions under Print a Form from a Task Window. If you are not prepared to print the deposit ticket, remember to save the
transaction.

Quotes
Quotes are printed estimates for a possible sale that can be presented to either a new prospect or recorded customer. You can also
set up expiration dates for entered quotes, or apply a Status to a quote using the Track It panel.
When you print or save a sales quote, you do not actually update accounting information. The sale is recorded and accounting
information updated when you convert the quote to a sales invoice.

Learn More
Are you entering a standard quote for products or a quote for services?
Sage 50 has two standard quote templates, one for quoting on products and one for quoting on services. In addition, you can
customize your own templates.

Enter a product sales quote
Enter a service sales quote
Did you know you can customize this window, hiding fields you don't use?
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select a standard template, like Product Quote.

Is this a quote you send on a regular basis?
If you want to send basically the same quote to a customer a number of times, you can memorize the quote. Memorized
transactions are like a template that you can quickly flesh out for specific transactions. They are not posted to the general
ledger. You can also create a new quote by copying an existing one.

Converting a quote to a sales order or invoice
When your customer accepts the quote you sent, then you can convert it to either a sales order or a sales invoice.
After you convert the quote, it will be available for viewing but not editing. A converted quote will display the word "converted" in
large red letters to notify you, and the Save, Print, Convert, E-mail, and Delete buttons will be disabled. You will be able to select
a converted quote from the Quotes list, as well as from the Sales Order or Sales Invoice that it was converted to.

Convert a quote
Using the Track It panel
You can use the Track It panel to update the tracking status of a quote (pending, expired, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Printing or previewing customer invoices
When you enter customer quotes in Sage 50, you can leave the Quote No. field blank to have Sage 50 automatically assign
numbers to quotes when printed.

How to print a quote
How to preview a quote
Help with specific fields

Enter a Product Sales Quote
To enter a quote that uses inventory items, follow these steps:

1. From the Tasks menu, select Quotes/Sales Orders/Proposals; then select Quotes from the submenu.
2. In the Quotes window, select the Layout toolbar button, and choose the predefined Product template from the pulldown menu.

Note: This procedure assumes you are using the predefined Product template. If you choose a customized
template, please adjust the instructions below accordingly. .

3. Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup
button. To add a new customer, type + or double-click the field, which displays the Maintain Customers/Prospects
window.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping
addresses, sales account, shipping method, payment terms, and sales tax ID.

4. Leave the Quote # field blank if you want Sage 50 to print the quote. Sage 50 will increase the quote number by
one when it is printed. Otherwise, enter a quote number or other reference number. (If you print the quote with a
quote number assigned or print it again later, the invoice will have the word DUPLICATE on it.)

5. Enter the date of the quote if it is different from the displayed date. Then, enter the date that the quote will expire.
6. If you have entered a default shipping address in the customer's record, the first shipping address appears on the
quote. You can select another shipping address from the choices available in the Ship To drop-down list, or
manually enter another address in the Ship To fields.

7. If you have entered a default P.O.# in the customer's record, it appears on the quote. If not, you can enter the
customer's purchase order number now or change the default to any other piece of information that will identify this
quote to the customer.

8. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via
button if you want to select a different shipping method. You can also enter a ship date.

9. Sage 50 uses the default terms you have entered for the customer, but you may want to select the Terms to
change the default discount dates or amounts for this quote. When a receipt that qualifies for an early-payment
discount is applied against the invoice, Sage 50 will calculate the discount.

10. If you entered a default sales representative in the customer's record, it will appear. Otherwise, select the code of
the sales representative, if applicable.

11. Enter the information for each item included on the quote on a separate line, including the item's quantity, item ID,
U/M (displays if multi-packs enabled in Inventory Item Defaults), description, unit price (the number of decimal
places is selected in Global Options), sales tax status, and job information (if applicable).

12. The default G/L sales account that appears for each line item is based on the customer sales account default or the
item ID selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account,
type + or double-click the field, which displays the Maintain Chart of Accounts window.
Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account
fields in this window. To modify G/L accounts used for this transaction, you must select the Journal button.

13. Continue entering line items until you have entered them all.
14. If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale.
On financial statements this will be your accounts receivable asset account. If yours is a cash-basis company, this
field will display <Cash Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R
Account field in this window. To modify the A/R account used for this transaction, you must select the Journal
button.

15. Click Attach to add documents and pictures to the quote.
16. Select the sales tax ID for this sale.
17. If you intend to charge freight for shipping this order, include an amount in the Freight field.

18. At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed.
You can click the arrow button to the right of the customer balance to display the current Customer Ledgers report
for this customer.

19. Select the Print button if you want to print and save the quote. Otherwise, click the Save button.
Note: Quotes are not posted to general ledger. When you convert the quote to an invoice, the sale can be posted
to the general ledger. Quotes can also be converted to sales orders, but again you must invoice the customer to
actually post the sale.

Enter a Service Sales Quote
To enter a quote that uses descriptive service items (does not require item quantities or use inventory), follow these steps:

1. From the Tasks menu, select Quotes/Sales Orders/Proposals; then select Quotes from the submenu.
2. In the Quotes window, select the Layout toolbar button, and choose the predefined Service template from the pulldown menu.

3. Note: This procedure assumes you are using the predefined Service template. If you choose a customized
template, please adjust the instructions below accordingly.

4. Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup
button. To add a new customer, type + or double-click the field, which displays the Maintain Customers/Prospects
window.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping
addresses, sales account, shipping method, payment terms, and sales tax ID.

5. Leave the Quote # field blank if you want Sage 50 to print the quote. Sage 50 will increase the quote number by
one when it is printed. Otherwise, enter a quote number or other reference number. (If you print the quote with a
quote number assigned or print it again later, the invoice will have the word DUPLICATE on it.)

6. Enter the date of the quote if it is different from the displayed date. Then, enter the date that the quote will expire.
7. If you have entered a default shipping address in the customer's record, the first shipping address will appear on
the sales quote. You can select another shipping address from the choices available in the Ship To drop-down list,
or manually enter another address in the Ship To fields.
8. If you have entered a default P.O.# in the customer's record, it will appear on the quote. If not, you can enter the
customer's purchase order number now or change the default to any other piece of information that will identify this
quote to the customer.

9. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via
button if you want to select a different shipping method. You can also enter a ship date.

10. Sage 50 uses the default terms you have entered for the customer, but you may want to select the Terms button
to change the default discount dates or amounts for this quote. When a receipt that qualifies for an early-payment
discount is applied against the invoice, Sage 50 will calculate the discount.

11. If you entered a default sales representative in the customer's record, it will appear. Otherwise, select the code of
the sales representative, if applicable.

12. Enter the information for each service you intend to provide on the quote on a separate line, including the
description, sales tax status, amount (the number of decimal places is selected in Global Options), and job
information (if applicable).

13. The default G/L sales account that appears for each line item is based on the customer sales account default or the
item ID selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account,
type + or double-click the field, which displays the Maintain Chart of Accounts window.
Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account
fields in this window. To modify G/L accounts used for this transaction, you must select the Journal button.

14. Continue entering line items until you have entered them all.
15. If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale.
On financial statements this will be your accounts receivable asset account. If yours is a cash-basis company, this
field will display <Cash Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R
Account field in this window. To modify the A/R account used for this transaction, you must select the Journal
button.

16.
17.
18.
19.

Click Attach to add documents and pictures to the quote.
Select the sales tax ID for this sale.
If you intend to charge freight for shipping this order, include an amount in the Freight field.
At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed.
You can click the arrow button to the right of the customer balance to display the current Customer Ledgers report
for this customer.

20. Select the Print button if you want to print and save the quote. Otherwise, click the Save button.
Note: Quotes are not posted to general ledger. When you convert the quote to an invoice, the sale can be posted
to the general ledger. Quotes can also be converted to sales orders, but again you must invoice the customer to
actually post the sale.

Convert a Quote to an Invoice or Sales Order
1. From the Tasks menu, select Quotes/Sales Orders/Proposals; then select Quotes from the submenu.
2. In the Quotes window, select the List toolbar button, and select the quote you want to convert to an invoice or sales order.
3. When the quote is displayed, select the Convert button. Sage 50 displays the Convert Quotes window.
4. Choose what you want to convert the quote to. You have four choices.
Sale/Invoice
The quote will be available for editing on the Sales/Invoicing task window. If you have an invoice number for this quote already
and will not print the invoice, enter it in the Invoice # field. You can also leave the Invoice # field blank so you can print the
assigned number later.

Sale/Invoice and Print Now
This option allows you to convert the quote to an invoice and immediately print the invoice. Sage 50 opens the standard windows
for selecting the invoice form you want to use and provides you with the starting invoice number.

Sales Order
This option allows you to convert the quote to a sales order, so you can send partial shipments of items on the quote if, for
example, some of the items on the quote are not in stock. Sage 50 will display the next available sales order number and assign
it when you convert the quote.

Note: When you convert a quote to a sales order, Sage 50 checks available inventory to fill the sales order. If the quantity on
the sales order exceeds the quantity on hand, a warning is issued (only if the Warn if inventory item is out of stock box on the
Maintain Global Options window is selected). This does not prevent you from selling the item, it just warns you that there is not
enough of the item to complete the sales order.

Proposal (available only in Sage 50 Premium Accounting and higher)
This option allows you to convert the quote to a proposal, so you can bill the customer for the items on the proposal. Sage 50 will
display the next available proposal number and assign it when you convert the quote.

Note: If you delete a sales invoice, sales order, or proposal that originated from a quote, Sage 50 will delete the original quote as
well. However, you will get a warning message and you can cancel out if you want. However, the quote will be retained in the
following case: if a sales invoice is deleted, but the quote was converted to a sales order or proposal first. In this case, the sales
order or proposal will be retained, and thus, the quote will be retained as well.

5. After you select the option you want to use, select OK, and the quote is converted and the accounting information is updated.
When you convert a quote, the quote number is retained for reference. You cannot edit the quote in the Quotes task window, but
you will be able to see what the original quote number was and view the original quote from the new task window. The Save,
Print, Convert, E-mail, and Delete buttons will be disabled.
You can see what type of transaction a quote was converted to on the Quotes List. Click the List button on the Quotes window or
from the main Sage 50 menu, go to Lists>Customers & Sales>Quotes.

Print a Quote
You can print a single quote from the Quotes window by selecting the Print button. This both posts (or saves) and prints the quote.
You can print a batch of quotes from the Quotes window by selecting the Print drop-down button and then choosing Select a Quote
to Print from the menu.
You can print a batch of quotes from the Select a Report or Form window by selecting Sales Orders, Proposals and Quotes in
the Form Types list and then selecting the quote you want from the Forms list.
You can also design your own quote.

Note: Proposals are only available in Sage 50 Premium Accounting and above. Select Sales Orders and Quotes from the
Form Types list if you are not using Sage 50 Premium Accounting or above.

Convert Quotes
Once your customer has accepted a quote, you can then convert it to an actual sale. Once you convert a quote, you will not be able
to edit it, but you will be able to view it using the Quote list or from the type of transaction that it was converted to.
You can convert a quote to one of the following:

Sale/Invoice: The quote will be available for editing on the Sales/Invoicing task window. If you have an invoice number for this
quote already and will not print the invoice, enter it in the Invoice # field. You can also leave the Invoice # field blank so you can
print the assigned number later.

Sale Invoice and Print Now: This option allows you to convert the quote to an invoice and immediately print the invoice. Sage
50 opens the standard windows for selecting the invoice form you want to use and provides you with the starting invoice number.

Sales Order: This option allows you to convert the quote to a sales order, so you can ship partial shipments of items on the quote
if, for example, some of the items on the quote are not in stock. Sage 50 will display the next available sales order number and
assign it when you convert the quote.

Proposal: This option allows you to convert the quote to a proposal. Sage 50 will display the next available proposal number and
assign it when you convert the quote.
Proposals are available only in Sage 50 Premium Accounting and higher.
When you convert a quote, the quote number is retained for reference. You cannot edit the quote in the Quotes task window, but you
will be able to see what the original quote number was and view the original quote from the new task window. The Save, Print,
Convert, E-mail, and Delete buttons will be disabled.
Note: If you delete a sales invoice, sales order, or proposal that originated from a quote, Sage 50 will delete the original quote as
well. However, you will get a warning message and you can cancel out if you want. However, the quote will be retained in the
following case: if a sales invoice is deleted, but the quote was converted to a sales order or proposal first. In this case, the sales
order or proposal will be retained, and thus, the quote will be retained as well.
You can see what type of transaction a quote was converted to on the Quotes List. Click the List button on the Quotes window or
from the main Sage 50 menu, go to Lists>Customers & Sales>Quotes.

Proposals
This feature is available only in Sage 50 Premium Accounting and higher.
Proposals let you enter proposals for a customer, then invoice them as projects or jobs are completed. Proposals can be printed,
previewed, or sent via email. Once a proposal has been accepted by the customer, you can mark it as Accepted and it will be
available for billing in Sales Invoicing. Quotes can also be converted to proposals. You can also apply or update the Status of the
proposal.
Proposals work in conjunction with the Billing Method field in Job Costing as well. If you select Percent of Proposal as the Billing
Method for a job, Sage 50 will automatically update the Estimated Revenues fields for your jobs as you enter and accept Proposals.
You will also be able to use Progress Billing to bill your proposals as portions of jobs are completed. .

Learn More
Entering a Proposal for a customer
You can enter and accept a proposal for a customer.

Enter a proposal
Accept a proposal
Did you know you can customize this window, hiding fields you don't use?
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select the standard template.

Copying a proposal
You can create a new proposal by copying an existing one. Click the Copy button on the Proposals window.

Printing or previewing proposals
As you enter proposals in Sage 50, the Proposal No. field is automatically increased by one based on the last proposal or
sales order entered. If you want to override this for the printed proposal, you can, but note that Sage 50 won't let you have
duplicate proposal numbers. Nor can a proposal and sales order have the same number.
How to preview a proposal
How to print a proposal
Billing/converting/applying proposals to a sales invoice
Click the link below for step-by-step instructions on billing proposals.
Bill/convert/apply a proposal to a sales invoice
Using the Track It panel
You can use the Track It panel to update the tracking status of a proposal (pending, expired, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Enter a Proposal
This feature is available only in Sage 50 Premium Accounting and higher.
Proposals let you enter proposals for a customer. Later, you can invoice the customer as portions of a project or job are completed.
l

From the Tasks menu, select Quotes/Sales Orders/Proposals; then select Proposals from the submenu.

Note: This procedure assumes you are using the predefined Standard template. To select a template, click the Layout toolbar
button, and choose the template you want to use from the pull-down menu. If you choose a customized template, please adjust
the instructions below accordingly. .

What area of the proposal do you need help with?
Who to Bill and Ship to
1.
Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup button. To add
a new customer, type + or double-click the field, which displays the Maintain Customers/Prospects window.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping addresses,
sales account, shipping method, payment terms, and sales tax ID.

2. Enter the date of the proposal if it is different from the displayed date.
3. Enter the Complete By date for the proposal. You can sort proposals by the Complete By date on the proposal reports.
4.

Enter a proposal number if you want to change the one Sage 50 automatically enters.
If you have not previously entered a proposal or sales order, this field is blank. Once you enter the first one, Sage 50
automatically increases the number by one.
Although Proposals share numbers with Sales Orders, Sage 50 will remember the last values separately.

5. If this proposal has already been accepted by the customer, check the Accept Proposal button. This will make the proposal
available for billing in Sales Invoicing and Progress Billing.

6. If you have entered a default shipping address in the customer's record, the first shipping address will appear on the
proposal. Change the customer's ship-to information, if necessary, by selecting an address from the choices in the Ship To
drop-down list, or by manually entering another address in the Ship To fields.

Proposal Information
1. If you have entered a default P.O.# in the customer's record, it will appear on the proposal. If not, you can enter the

customer's purchase order number now or change the default to any other piece of information that will identify this proposal
to the customer.

2. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via button if
you want to select a different shipping method.

3. If you entered a default sales representative in the customer's record, it will appear. Otherwise, select the code of the sales
representative, if applicable.

4.

If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale. On financial
statements this will be your accounts receivable asset account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R Account
field in this window. To modify the A/R account used for this transaction, you must select the Journal button.

Proposal Line Items
1. Enter the information for each item included on the proposal on a separate line, including the item's quantity, item, U/M
(displays if multi-packs is enabled in Inventory Item Defaults), description, unit price (the number of decimal places is
selected in Global Options), sales tax status, amount, and job information (if applicable).
If you want to be able to bill for line items using the Percent of Proposal tab on the Select for Progress Billing window, be certain to
include a Job ID (and Phase/Cost Code IDs as applicable).

2.

The default G/L sales account that appears for each line item is based on the customer sales account default or the item ID
selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account, type + or doubleclick the field, which displays the Maintain Chart of Accounts window.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account fields in
this window. To modify G/L accounts used for this transaction, you must select the Journal button.

Other Amounts (Sales Tax, Freight)
1. Select the sales tax ID for this proposal, if it was not filled in when you selected the customer.
2. If you intend to charge freight for this proposal, include an amount in the Freight field. You can also add freight to the invoice
at a later time.

3. At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed. You can
click the arrow button to the right of the customer balance to display the current Customer Ledgers report for this customer.

4.

Select the Print button if you want to print and save the proposal; or select the E-mail button if you want to e-mail and save
the proposal. Otherwise, click the Save button.

Note: Proposals are not posted to the general ledger. When you apply this proposal to a customer invoice, the proposal
data is transferred to the sales invoice. Then, the billed amounts will be posted to the general ledger.

What do you want to do next?
l
l
l
l
l

Preview a proposal form before printing it
Print a proposal
Accept a proposal
Bill/apply/convert a proposal to a sales invoice
Read the Proposal overview

Accept an Existing Proposal
This feature is available only in Sage 50 Premium Accounting and higher.
You accept an existing proposal by opening the proposal and checking the Accept Proposal box on the Proposals window. Once
you have accepted the proposal, you will be able to bill for the items on the proposal in Sales Invoicing and Progress Billing.
In addition, Sage 50 will automatically update the Estimated Revenues fields in the job record for jobs that are specified on the
proposal and whose Billing Method is Percent of Proposal.
Step-by-step instructions

1. Select Tasks > Quotes/Sales Orders/Proposals > Proposals.

2.
3.
4.
5.

Select the List button in the toolbar.
On the Select Proposal window, highlight the proposal you want to accept and click OK.
Check the Accept Proposal check box.
Click Save to save changes, Print to save the proposal and print it, or E-mail to save the proposal and e-mail it.

Proposals will not auto-create purchase orders.

Billing an Accepted Proposal
This feature is available only in Sage 50 Premium Accounting and higher.
Using the Sales Invoicing window
To bill a proposal, open the Sales/Invoicing window, select the customer, then choose the open proposal you want to invoice. Once
you specify the billing percentage or amount on the line items, you can print this invoice and have Sage 50 assign an invoice
number, or you can enter an invoice number if the invoice was prepared manually and you will not print it from Sage 50.

1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
Note: This procedure assumes you are using the predefined Standard template. To select a template, click the Layout toolbar
button and choose the template you want to use from the pull-down menu. If you choose a customized template, please adjust
the instructions below accordingly. .

2. Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup button. You will
receive a message notifying you that open, accepted proposals are available to be invoiced. Click OK.
3. Enter the invoice number in the Invoice # field if you are not going to print the invoice. Leave this field blank if you are going to
print the invoice and Sage 50 will assign the next available invoice number for you when you print the invoice.
If you will be changing terms, shipping information, and so on for this invoice, be sure to select the proposal before making your
changes. The information on the proposal is entered into the fields on the Sales/Invoicing window and will overwrite any
information currently in those fields.

4. From the Apply to Sales Order # drop-down list, select <View Proposals>. The tab name changes to Apply to Proposal No.
Note that the Apply to Proposal tab will appear automatically if the customer does not have any open sales orders but has
open, accepted proposals.

5. Now, select the proposal number that you want to invoice from the same drop-down list. Sage 50 displays the items on the
proposal in the line-item list and the Select Percentage to Bill window opens. Select the appropriate option and click OK to return
to the Sales Invoicing window.
The first four columns in the line-item list--the Item, Description , Proposal Amt, and Prev billed Amt--are gray, meaning
you cannot edit them. To edit a proposal you must open it in the Proposals window.
Depending on the choice you made on the Select Percentage to Bill window, Sage 50 will have completed the fields for each
line item. If you selected Different percentages of line items, however, enter the Bill % or Amount for each line item that
you want to bill. If you need to recall the Select Percentage to Bill window, click the Bill button.

6. If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale. On financial
statements this will be your accounts receivable asset account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R Account field in
this window. To modify the A/R account used for this transaction, you must select the Journal button.

7. Select the sales tax ID for this sale, if necessary.
8. Enter the Freight amount for the invoice.
Note: You must select The remaining percent to bill of the Proposal from the Select Percentage to Bill window if you
want the freight amount from the proposal to transfer to the invoice.

9. If retainage should be withheld for this invoice, you can modify the retained amounts by selecting the Withhold Retainage tab.
Note that you cannot change or add the Job ID here. It must be added to the original proposal.

10. If you have received a partial or full payment for this invoice at the time of the sale, select the Amount Paid at Sale link. Sage 50
displays the Receive Payment window, where you can enter receipt information.
The Net Amount Due displays what the customer currently owes for the sale.
11. Select the Print or E-mail button if you want to print or e-mail and save the invoice. Otherwise, click the Save button.
Using Progress Billing
You can also use the Progress Billing feature to bill for accepted proposals. To do so

1. Select Tasks > Select for Progress Billing. This will open the Select for Progress Billing - Filter Selection window.
2. Enter or select the appropriate As of date. It is important that you use the correct date here because all information that will be
displayed in the Select for Progress Billing grid is date-sensitive. The system uses the As of date, job start and end dates, the
proposal date, and dates of transactions for actual costs in determining which line items appear.

3.
4.
5.
6.

Select the range of Customer IDs and/or Job IDs in the upper section of the window.
Select the Percent of Proposal check box in the Display information for section of the window.
Check any other boxes that apply to your selections and click OK.
The Select for Progress Billing window appears, open to the Percent of Proposal tab and displaying proposal line items that
meet the criteria you selected.

7. Enter the appropriate values in the Qty, Bill %, Total %, and/or Amount fields as you want. If you want to quickly enter the
same percentage for all lines on a proposal, select the proposal in the grid and click the Bill button. The Select Percentage to
Bill window opens. Select the option and click OK. Repeat this procedure for any other proposals in the grid.
Note: You must select The remaining percent to bill of the Proposal from the Select Percentage to Bill window if you
want the freight amount from the proposal to transfer to the invoice.

8. Review the calculations and ensure that the Invoice column is checked for each line item that you want to bill. .
9. When you are ready, select Save, Print, or E-mail to save, print, or send the invoices created, and follow the steps to print or
e-mail the forms.

10. Once you have completed the routine, Sage 50 will create invoices for each line item (collected by customer and job) and will
update proposal information and reports. These invoices can be edited in the Sales Invoicing window.

Printing Proposals Overview
This feature is available only in Sage 50 Premium Accounting and higher.
Printing a proposal gives you the ability to confirm customer proposals.
As you enter proposals in Sage 50, the Proposal # field is automatically increased by one based on the last proposal or sales order
entered. You can override the assigned number by entering an alternate number. However, you cannot have duplicate proposal
numbers in Sage 50. Nor can a proposal number be the same as an existing sales order number.
You can print proposals one at a time from the Proposals window by selecting the Print button and you can print a batch of
proposals by selecting the Print drop-down button and then choosing Select Proposals to Print. You can also print a batch of
proposals from the Select a Report or Form window. Printing from the Proposal window both prints and posts (or saves, if you use
batch posting or SmartPosting) the proposal.
On the Select a Report or Form window, select Sales Orders, Proposals, and Quotes in the Form Types list. The
Forms list contains the predefined proposal form and any custom forms created by you. Select the form that best meets your needs.
When printing proposals, you can choose to print all open proposals (proposals that have not been applied to an invoice), print all
proposals for a range of customers or dates, or to reprint previously printed proposals based on a range of proposal numbers.
When you choose to print a proposal, Sage 50 automatically saves and posts the proposal.

Note: Proposal information is not posted to the General Ledger until you apply the proposal items to an invoice and post that
invoice.

Sales Orders
Sales orders let you enter items for a customer, then invoice and ship the items as they become available in your inventory, tracking
the backorders in the system. You can view inventory reports that show the number of items backordered for your customers to
help you plan your purchases.

Sales orders can be printed as warehouse picking slips or package packing slips that can be marked up before shipping the product
to your customer. After the sales order has been marked up, the shipped items can be applied to an invoice. Only one sales order
can be applied to an invoice. However, multiple invoices can be entered from a single sales order.

Learn More
Entering a sales order for a customer
You can enter a sales order even before you have inventory to ship to your customer.

Enter a sales order
Did you know you can customize this window, hiding fields you don't use?
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select the standard (Product Sales Order) template.

Converting a sales order to an invoice
When items on a sales order are ready to be delivered or picked up, you can bill your customer and convert the sales order to a
sales invoice.

Convert a sales order to an invoice
Copying a sales order
You can create a new sales order by copying an existing one. Click the Copy button the Sales Order window.

Printing or previewing sales orders
As you enter sales orders in Sage 50, the Sales Order No. field is automatically increased by one based on the last sales order
entered. If you want to override this for the printed sales order, you can, but note that Sage 50 won't let you have duplicate
sales order numbers.
When you're ready to ship the order, you can print a packing slip to accompany it.

How to print a sales order
How to preview a sales order
How to print a packing slip
Using the Track It panel
You can use the Track It panel to update the tracking status of a sales order (pending, expired, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Tracking and shipping sales orders
Sage 50 offers a unique way to track your sales orders by using the Ship By date field in the Sales Orders window. Doing this
will help you manage the inventory needed to fill the order as well.

Did you know you can auto-generate Purchase Orders when you create Sales Orders?
If you are using Sage 50 Complete Accounting or above, you can set up Sage 50 to automatically create Purchase Orders for
inventory items when you drop below a certain quantity on hand. To learn how to do this, use the links below. We recommend that
you read the overview page prior to setting Sage 50 up for this feature. This will give you information that will help you set up the
option properly.

Overview of auto-creating Purchase Orders
Step-by-step instructions
Help with specific fields

Enter a Sales Order
Sales orders let you enter items for a customer. Later, you can invoice and ship the items as they become available in your
inventory, tracking the backorders in the system.

1. From the Tasks menu, select Quotes/Sales Orders/Proposals; then select Sales Orders from the submenu.
Note: This procedure assumes you are using the predefined Product template. To select a template, click the
Layout toolbar button, and choose the template you want to use from the pull-down menu. If you choose a
customized template, please adjust the instructions below accordingly.

2. Enter or select the customer ID. To display a list of existing customers, type ? in this field, or select the Lookup

button. To add a new customer, type + or double-click the field, which displays the Maintain Customers/Prospects
window.
When the customer is selected, Sage 50 supplies the customer default information, including billing and shipping
addresses, sales account, shipping method, payment terms, and sales tax ID.

3. Enter a sales order number if you want to change the one Sage 50 automatically enters.
If you have not previously entered a sales order or proposal, this field is blank. Once you enter the first one, Sage
50 automatically increases the number by one.

4. Enter the date of the sales order if it is different from the displayed date.
5. Enter the date by which the order should be shipped.
Use this date to help you remember to follow up on the order and manage the required inventory. Once entered,
this date will show up in a number of sales order reports: Picklist report, Sales Backorder report, Sales Order
Register, and Sales Order report.

Tip: As a further reminder, you can create a "sales orders to ship" event in Action Items. .
6. If you have entered a default shipping address in the customer's record, the first shipping address will appear on
the sales order. Change the customer's ship-to information, if necessary, by selecting an address from the choices
in the Ship To drop-down list, or by manually entering another address in the Ship To fields.

7. If you have entered a default P.O.# in the customer's record, it will appear on the sales order. If not, you can enter
the customer's purchase order number now or change the default to any other piece of information that will identify
this sales order to the customer.

8. If you have entered a default shipping method in the customer's record, it will appear. You can select the Ship Via
button if you want to select a different shipping method.

9. Sage 50 uses the default terms you have entered for the customer, but you may want to select the Terms button
to change the default discount dates or amounts for this sales order. When a receipt that qualifies for an earlypayment discount is applied against the invoice, Sage 50 will calculate the discount.

10. If you entered a default sales representative in the customer's record, it will appear. Otherwise, select the code of
the sales representative, if applicable.

11. Enter the information for each item included on the sales order on a separate line, including the item's quantity,
item ID, U/M (displays if multi-packs enabled in Inventory Item Defaults),description, unit price (the number of
decimal places is selected in Global Options), sales tax status, and job information (if applicable).

Note: When you enter a quantity for a sales order, Sage 50 checks available inventory to fill the sales order. If
the quantity on the sales order exceeds the quantity on hand, a warning is issued (only if the Warn if inventory
item is out of stock box on the Maintain Global Options window is checked). This does not prevent you from selling
the item, it just warns you that there is not enough of the item to complete the sales order.

12. The default G/L sales account that appears for each line item is based on the customer sales account default or the
item ID selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account,
type + or double-click the field, which displays the Maintain Chart of Accounts window.
Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account
fields in this window. To modify G/L accounts used for this transaction, you must select the Journal button.

13. If yours is an accrual-based company, you can select the accounts receivable G/L account for this potential sale.
On financial statements this will be your accounts receivable asset account. If yours is a cash-basis company, this
field will display <Cash Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/R
Account field in this window. To modify the A/R account used for this transaction, you must select the Journal
button.

14. Click Attach to add documents and pictures to the sales order.
15. Select the sales tax ID for this sale.
16. If you intend to charge freight for shipping this order, include an amount in the Freight field.

17. At the bottom left corner of the window, the selected customer's balance, credit limit, and credit status is displayed.
You can click the arrow button to the right of the customer balance to display the current Customer Ledgers report
for this customer.

18. Select the Print button if you want to print and save the order. Otherwise, click the Save button.
Note: Sales orders are not posted to general ledger. When you apply this sales order to a customer invoice
(after shipping the items ordered or performing services requested), the sales order data is transferred to the
sales invoice. Then, the sale can be posted to the general ledger.

Printing Sales Orders Overview
Printing a sales order gives you the ability to confirm or acknowledge customer orders and fill orders more efficiently. You can use
the printed sales order as a picking slip for warehouse personnel to mark up. One copy of the marked-up picking slip can be shipped
with ordered items as a packing slip and another copy can be sent to the accounting department for invoicing.
As you enter sales orders in Sage 50, the Sales Order # field is automatically increased by one based on the last sales order
entered. You can override the assigned number by entering an alternate number. However, you cannot have duplicate sales order
numbers in Sage 50.
You can print sales orders one at a time from the Sales Orders window by selecting the Print button and you can print a batch of
sales orders by selecting the Print drop-down button and then choosing Select Sales Orders to Print. You can also print a batch
of sales orders at once from the Select a Report or Form window. Printing from the Sales Order window both prints and posts (or
saves, if you use batch posting or SmartPosting) the sales order.
On the Select a Report or Form window, select Sales Orders, Proposals, and Quotes in the Form Types list. The Forms list
contains several types of predefined sales order forms from which to choose. Select the form that best meets your needs.

Note: Proposals only exist in Sage 50 Premium Accounting and higher. Choose Sales Orders and Quotes from the Form Types
list if you are not using Sage 50 Premium Accounting or higher.
When selecting forms to print, you have the following choices:
Sales Order w/Totals Form
Sales Order Picking List Form
When printing sales orders, you can choose to print all open sales orders (sales orders that have not been applied to an invoice),
print all sales orders for a range of customers or dates, or to reprint previously printed sales orders based on a range of sales order
numbers.
When you choose to print a sales order, Sage 50 automatically saves and posts the sales order.

Note: Sales order information is not posted to the General Ledger until you apply the sales order items to an invoice and post that
invoice.

Using the Collection Manager
The Collection Manager provides numerical and graphical analysis of your accounts receivable, or the money owed to you. You can
zoom in on various aging brackets. There are four aging brackets in Sage 50. By default, they are 0-30 days, 31-60, 61-90, and over
90. You can drill down to various levels of detail to see balances for a customer and even to see the original invoice. In addition, you
can check off a batch of customers to send collection letters to.

Click a column in the graph to see the customers and invoices that make up that column. You can do the same thing in the Numeric
display of this data.

Select the check boxes beside those customers to whom you want to send a collection letter; then select the Letter button at the top
of the window.
To see just the totals for a single customer, highlight the customer, and click the Source button. To see the original invoice,
highlight the transaction, and click the Detail button or just double-click the transaction.

Processing a Customer Refund
There will be times when you need to refund customers some of the money they paid you for products or services. Processing a
refund in Sage 50 correctly is a three-part process:

1. Enter a credit memo for the item being returned or the amount that you are removing from the customer's balance. How do I
enter a customer credit memo?
2. Use the Payments window to enter and print the refund check for the customer. How do I enter a refund check?
3. Reconcile the credit memo and the check on a receipt.
What do you want to do next?
l
Enter a cash sale
l

Read the receive money overview

Print a Refund Check for a Customer
Sometimes, you will need to issue a refund check to cover a customer credit. This would happen, for example, if you enter a
customer credit memo for a sale on which payment was not received at the time of invoicing. It would also be true for customer
credits on sales without invoice. To print a refund check, do the following:

1. From the Tasks menu, select Payments.
2. Select Customer for the type of ID you want.

3.
4.
5.
6.
7.

Enter or select the customer ID that you want to pay.
Go to the line-item grid, and in the Description field, enter a reason or reference for the refund.
In the Amount field, enter the amount of the refund.
Select the Print button.
From the dialog box, select the check disbursement form that you want to use.

Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose the
OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

8. If you're unsure of how the check will be aligned, select the Print Sample button. This prints a sample check with placeholder
text, instead of the actual check. If your checks have pre-printed numbers, this will use the first number, thus printing a void
check. Make sure you enter the correct number. For example, if you aligned your forms as a practice using check #3002, make
sure you enter check #3003 here (the last check number printed plus 1).

9. After the check aligns to your satisfaction, select the Print button.
The check prints.

What do you want to do next?
Read an overview of customer refund processing

l
l
l
l

Enter a credit memo
Enter a cash sale
Read the receive money overview

Credit Memos
Use the Credit Memos window to enter credit memos for customer returns and credits; you can apply credit memos to any existing
customer invoices. All entries made on this window are posted to General Ledger, customer records, and possibly inventory and job
item records. You have the choice of applying transactions to Jobs through the distribution list box.
The Credit Memos window allows you to enter as many as 500 return or credit line items per memo.

Learn More
Entering a customer credit memo
Use the Credit Memos window to apply credit to a customer invoice.

Enter a customer credit memo
Printing or previewing credit memos
When you enter customer credit memos in Sage 50, you can leave the Credit No. field blank to have Sage 50 automatically
assign numbers to credit memos when printed.

How to preview a credit memo
Why does Sage 50 print "duplicate" on my credit memo when I know it isn't a duplicate?
Sage 50 will print "duplicate" on the credit memo if a Credit Number has already been assigned to the memo, either because it
was printed before or because the Credit Number field on the Credit Memos window was filled in prior to printing. On the Credit
memos window
l

Complete the Credit Number field ONLY if the credit memo was printed outside of Sage 50, such as by hand, or if you do
not plan to print it.

l

Leave the Credit Number field blank if you plan to print the credit memo you are entering. Sage 50 will automatically
assign the next credit number when you click Print and it will not print "duplicate" on the memo.

Voiding a credit memo
Be careful when editing or deleting invoices. If you've already entered a receipt, you may need to first delete the receipt before
you can edit or delete the invoice.

Using the Track It panel
You can use the Track It panel to update the tracking status of a credit memo (pending, approved, etc.), including assigning it to
a specific user or all users that have a specific role in your company.

Help with specific fields

For a listing of fields in the Credit Memos window, click the link.

Enter a Customer Credit Memo
1. From the Tasks menu, select Credit Memos.
2. Enter or select the customer ID.
3. In the Credit # field, enter the ID that you want to apply to the credit memo.
Note: You may want to connect the application amount to the credit memo. For example, if this credit memo is based on an
existing invoice no. 106, you may want to type 106-C to indicate that the credit memo is applied to the invoice.

4. Enter the date of the credit memo if it is different from the displayed credit date.
5. Enter the due date of the credit memo if it is different from the displayed due date.
6. Do one of the following:
l

l

If the credit memo is to be applied to an existing invoice for the customer, on the Apply to Invoice # tab, use the drop-down
list to select the appropriate invoice. When line-item information for the invoice appears, find the item or items to be returned,
and in the Returned column enter the quantity. Sage 50 will automatically restore this quantity to inventory.
If the credit memo is to be applied to a sale for which there is no existing invoice, on the Apply to Sales tab, enter line-item
information for the item or items to be returned or credited, including quantity. Sage 50 will automatically restore this quantity
to inventory.
If the line item contains serialized inventory, you will need to select serial numbers for the item(s). Select the line item
with the serialized inventory item, then select the Serial No button to enter or select serial numbers. The Serial Number
Selection window appears. Select the serial numbers you need and select OK when you're finished to return to the Credit
Memos window. However, if the Credit Memo has more than one line item that contains serialized inventory, you can select the
OK/Next button to save the current entry and move to the next serialized item.

6. If you need to adjust the amount of retainage for the job, select the Withhold Retainage tab and either verify that the amount
calculated automatically is correct or enter a different amount of retainage for any affected jobs. If you select an invoice from the
Apply to Invoice tab, Sage 50 will automatically default the information on the Withhold Retainage tab to the values on the
original invoice selected. If you enter credits on the Apply to Sales tab, Sage 50 will use defaults from the Job record and Job
Defaults for the GL Account number and retainage percentage.

7. If you want to print the credit memo, we recommend that you print it at this time and not from the Select a Report or Form
window. To print the credit memo, select the Print button.
8. When finished, select Save.
Note: In some cases (for example, when payment is not received at the time the invoice is entered or when the sale is not
invoiced), you will need to issue a refund check to your customer. How do I issue a refund check?
.

Customer Bad Checks
If a customer writes you a check that is returned by the bank for insufficient funds, you need to rectify the situation. This procedure
is a little tricky to understand at first, so it is recommended you test this out in the sample company data first.
First, open an invoice on the customer that reflects the original invoice amount and the amount of the Not Sufficient Funds (NSF)
charge. Next, reestablish the customer’s balance because he or she still owes you money for the original invoice. This keeps an
accurate record of the activity on the customer ledger, and account reconciliation will be easier to manage because you will have
lines for each day. If you delete or change the original receipt, it is more difficult to track the process day-by-day.

1. Create an Invoice #101 for Customer A of $100.00 on Jan 1.
2. Now create a receipt for Customer A on Jan 2, and indicate that you receive check #201 for $100.00, which pays Invoice# 101.
3. On Jan 10 you receive a return notice from the bank for check #201 for $100.00 and are charged a $15.00 Not Sufficient Funds
(NSF) charge.

4. First create a new invoice to charge the customer for the NSF expense. Create invoice #101NSF for Customer A with a date of Jan
10; then create a single line description where $15.00 is going to a GL account for Bank Charges Expense.

5. Next, reestablish the customer’s balance because he or she still owes you money for the original invoice.

In this example we will apply it to the NSF invoice. This keeps an accurate record of the activity on the customer ledger, and
account reconciliation will be easier to manage because you will have lines for each day. If you delete or change the original
receipt, it is more difficult to track the process day by day.

6. Go to Receive Money and enter a receipt dated Jan 10 for Customer A. You will see that the only invoice that appears on the Apply
to Invoices tab is #101NSF for $15.00. You want to decrease the cash account. To do this, put -$100.00 in the pay line for invoice
#101NSF. Enter a check/reference number of 201NSF, and select Post or Save. The cash account is back down to its correct level
on the correct date.
At this point you see on the Apply to Invoices tab Invoice #101NSF due with a balance of $115.00.

7. Two things can happen at this point. The customer pays you back on Jan 15 in one of two ways.
l

l

The customer writes you a second check. Go to Receive Money and create a receipt using that check number to pay off the
invoice.
The customer tells you to send the check back through the bank and writes a second check for the amount owed later. Since
Sage 50 allows it, you can use the same check number again, or you can use a secondary number such as 201-2 for $100.00
and then Save or Post. You will see later that the balance remaining on invoice #101NSF is still $15.00.

Your customer ledger will have transactions that are easy to audit and a bank reconciliation that is easier to manage.
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What do you want to do next?
Receive payment from a customer
l
Read the receipts overview
l

Account for Bad Checks from Customers (NSF)
If a customer writes you a check that is returned by the bank for insufficient funds, you need to rectify the situation. This procedure
is a little tricky to understand at first, so it is recommended that you test this out in the sample company data first.
First, open an invoice on the customer that reflects the original invoice amount and the amount of the Non-Sufficient Funds (NSF)
charge. Next, reestablish the customer’s balance because he or she still owes you money for the original invoice. This keeps an
accurate record of the activity on the customer ledger, and account reconciliation will be easier to manage because you will have
lines for each day. If you delete or change the original receipt, it is more difficult to track the process day by day.

1. Open one of the sample companies or follow the logic behind this example.
2. From the Tasks menu, select Sales/Invoicing. Create invoice #101 for Customer A for $100.00 dated January 1.
3. From the Tasks menu, select Receive Money. Create a receipt for Customer A dated January 2, and indicate that you received
check #201 for $100.00, which pays invoice # 101.
On January 10, you receive a return notice from the bank for check #201 for $100.00 and are charged a $15.00 Non-Sufficient
Funds (NSF) charge.

4. From the Tasks menu, select Sales/Invoicing. Create a new invoice to charge the customer for the NSF expense. Enter invoice
#101NSF for Customer A dated January 10; then create a single-line description, where $15.00 is assigned to Bank Charges
Expense G/L account.
Next, reestablish the customer’s balance because they still owe you money for the original invoice. In this example, we will apply
the balance to the NSF invoice. This keeps an accurate record of the activity on the customer ledger. Also, account reconciliation
will be easier to manage because you will have separate entries for each day. If you delete or change the original receipt, it is
more difficult to track the process each day.

5. From the Tasks menu, select Receive Money. Select Customer A, and choose the January 10 date. On the Apply to Invoices
tab, the only invoice listed is #101NSF for $15.00. You want to decrease the cash account. To do this, enter -$100.00 in the pay

line for invoice #101NSF. Enter 201NSF as the check/reference number, and save or post the receipt. The cash account is back
down to its correct level on the correct date.
At this point, the Apply to Invoices tab will reflect invoice #101NSF with a balance due of $115.00.
6. Two things can happen at this point. The customer pays you back on January 15 in one of two ways.
l
The customer writes you a second check. In Receive Money, enter that check number to pay off the invoice.
l

The customer tells you to send the check back through the bank and writes a second check for the amount owed later. Since
Sage 50 allows it, you can use the same check number again, or you can use a secondary number such as 201-2 for $100.00
and then Save or Post. You will see later that the balance remaining on invoice #101NSF is still $15.00.

How it works
Your customer ledger will have transactions that are easy to audit and a bank reconciliation that is easier to manage.
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Write Off a Customer Bad Debt
In some cases customers will not pay money owed, and the accounts receivable must be written off to bad debt expense.
There are two methods to writing off bad debts.
l

Direct Method: Each invoice that is a bad debt is posted to Bad Debt Expense (an expense account) as the bad debt is
recognized.

l

Allowance Method: A percentage of your accounts receivables is written off periodically or at the end of each fiscal year. The
amount that is written off depends on the percentage of bad debt you believe your company incurs throughout the year. Normally,
you would make a General Journal entry affecting an accounts receivable (used as a contra-asset) account titled "Allowance for
Doubtful Accounts" and Bad Debt Expense (an expense account). Then, each invoice is written off to Allowance for Doubtful
Accounts as the bad debt is recognized.

To write off an invoice(s) whether partially paid or not paid at all in Accounts Receivable as a bad debt, follow the procedure below.

1. Determine the method you will use to write off bad debts.
2. Identify the customer and invoice number to be written off as a bad debt.
3. From the Tasks menu, select Receive Money. Sage 50 displays the Receipts window.
4. Enter or select the customer ID associated with the invoices you want to write off as bad debts. To display a list of existing
customers, type ? in this field, or select the Lookup button.
Sage 50 displays the outstanding invoices that are due.

5. Enter a check/reference number that will help identify the write off (for example, WO-001 ).
6. In the Cash Account list, enter or select a Bad Debt expense account or an Allowance for Doubtful Accounts account. This will
create a debit to that account.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the Bad Debt expense
account in this window. You will see only the current list of cash accounts. To use the Bad Debt expense account here, select the
Journal button and change it in the Accounting Behind the Screens window.

7. On the Apply to Invoices tab, select the Pay check box next to the invoices you want to write off as bad debts. This will credit
the Accounts Receivable account that was originally associated with the invoice.
Important: If the Hide General Ledger Accounts global option is NOT activated, whatever the last used account was in the Cash
Account field will continue to default again until it is changed, even after the Receive Money window is closed and reopened. If

you do not change it back to your normal cash account, all Receipt transactions after the bad debt write off
will continue to debit the Bad Debt Expense account or Allowance for Doubtful Accounts account.
8. Save the receipt to record the write off and clear the customer balance.

Recording Expenses & Paying Bills
Pay Vendors
There are two basic methods of paying vendors:
l

Apply vendor invoices: pay invoices that were previously entered in the Purchases window.
Tip: If you are paying a vendor for one invoice, there is a quick way to do this. Open the invoice on the Purchases/Receive
Inventory screen and click the Pay Now link. The Pay Now link is located next to the invoice status for invoices that have not been
paid in full. This will open the Payments screen with the invoice selected to be paid.
If you are paying a vendor for more than one invoice, follow the steps below.

l

Apply to expenses (cash purchase): pay a vendor without using a vendor invoice. See Enter a Cash Purchase for further
information.

Use the following procedure to apply payments to vendor invoices:

How do I get to the Payments window?
From the Tasks menu, do one of the following:
Select Payments.
Select Bills and then Pay Bills.
Enter/select vendor ID
1. Enter or select the vendor ID that you want to pay. To display a list of existing vendors, type ? in this field, or select the
Lookup button.
If there are unpaid invoices for this vendor, Sage 50 lists them on the Apply to Invoices tab. If there are no unpaid
invoices, Sage 50 displays the Apply to Expenses tab.

2. If you want this bill to be paid electronically (Sage 50 Complete Accounting and Sage 50 Premium Accounting only), select the
Electronic Payment box.
Note: If the vendor is set up for default electronic payments, the Electronic Payment box will be checked automatically.
If you don't want this to be an electronic payment, deselect the box.

3. Next, if this is an electronic payment, enter or accept the displayed Pay On date.
4. Select the Pay check box.
Important: In order for the payment to arrive at the payee on time, it must be transmitted electronically on or before the
displayed Send By date.

Enter check/reference number, cash account, and payment method
1. If you are entering a handwritten check, enter the check number in the Check/Reference Number field. If you want
Sage 50 to print the check, leave this field blank. If this is an electronic payment, the Check/Reference Number field will
read "Electronic." If you are entering a different type of payment such as cash or credit card, enter a reference number in the
Check/Reference Number field that will help you identify the payment in reports and account reconciliation.

2. Enter or select the cash account from which you will be writing the check.
3. Select the payment method to designate the type of payment being made, for example, Check. If this is an electronic
payment, the payment method will automatically be set to Electronic unless you have deleted that payment method.

Tip: You can click the Payment Method link to add, edit, or delete payment methods.
Select invoices to pay

With the Apply to Invoices tab shown, enter the amount of money you're paying the vendor in the Payment Amount field.
Sage 50 will look on the Apply to Invoices tab for an invoice matching that amount. If one is found, it will be selected to pay.
Otherwise, the payment amount will be applied to the first invoice listed. If there is an amount remaining, it will be applied to
the next invoice and so on until the entire payment amount is applied.
If you don't want Sage 50 to automatically select the invoices to pay or if you want to change what has been selected, on the
Apply to Invoices tab, select the Pay check box next each the invoice that you want to pay.

Tip: You can use the Pay All/None links to check or uncheck all of the invoices listed.
l

If the you want to pay an invoice in full, place the cursor in the Amount column for the invoice, and select the Pay check
box. Sage 50 will fill in the Amount Paid field.

l
If you want pay a partial amount on the invoice, enter that amount. Sage 50 will automatically select the Pay check box.
Note: If you overpay the amount, a credit is made to the vendor's ledger; for underpayments, the payment amount is applied to the

invoice balance. You will need a reference number in order to post or save the record.
Make sure the Payment Amount is equal to the total of the amounts from the Apply to Invoices and Apply to Expenses tabs.

Print or save the check
If you want to print the check, select the Print button; for step-by-step instructions on printing from the Payments window, see
Print a Single Form from a Task Window. Otherwise, select the Save button to record the payment.
If you want to print a batch of checks, select the Print drop-down button and then choose Select Checks to Print. For more
information on printing a batch of checks from the Payments window, see .
The program debits Accounts Payable for the total amount and credits the cash account for the net check amount and also
credits the discount-taken account (if applicable).
You can also use the Select for Payment selection. This allows you to pay invoices that meet certain criteria and print checks for
them. You can also partially pay invoices using this selection.

Bills (Tasks Menu)
The Bills option is available on the Sage 50 Tasks menu. It lets you enter and pay bills from vendors. When you click Bills, you see
a submenu with the following options.
l

Enter Bills: Select this to go to the Purchases/Receive Inventory window. Here, you can enter the information that appears on
the purchase invoice you receive from your vendor.

l

Pay Bills: Select this to go to the Payments window. Here, you can make payments on either open invoices or purchases from
one-time vendors.

Using the Payments Manager
The Payment Manager provides a numerical and graphical analysis of your accounts payable, or the money you owe. You can drill
down in each of the four aging brackets and see details of the vendors and transactions that make up a balance. You can check off a
batch of invoices to pay and print checks. You can even drill down to see the original purchase transaction.

Click on a column in the graph to see the vendors and invoices that make up that column. You can do the same thing in the Numeric
display of this data.

Select the check boxes beside those vendors you want to pay; then, select the Check button at the top of the window.
To see just the totals for a single vendor, highlight the invoice and click the Vendor button. To see the original invoice, highlight the
transaction and click the Detail button, or just double-click the transaction.

Pay Taxes
In order to pay sales taxes, payroll taxes, or other local, state, or federal taxes, you must first set up the payee as a vendor in
Maintain Vendors. For example, if you pay federal taxes to your bank using federal coupons, enter the bank as a vendor. Sales
taxes may require checks written to local tax authorities.
To pay taxes, follow these steps:

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
2. In the Vendor ID field, select the appropriate tax authority.
3. In the line-entry area, enter a description of the tax and the amount to be paid.
For sales taxes, the amount due is determined by running the Taxable/Exempt Sales report. Use the appropriate G/L liability
account for taxes (for example, Sales Tax Payable).

4. Click Save to record the payment.
What do you want to do next?
l
Look up the current payment status of a purchase invoice
l
Pay vendors or enter payments for purchases
l
Preview checks before printing them

l
l

Write a check to a customer (refund)
Read the payments overview

Should I Enter Vendor Invoices?
You do not have to enter purchases or vendor invoices in Sage 50. You could certainly save data-entry time by only entering
payments. If you are a cash-basis company, you might figure that there is no point in entering purchases since you only record
expenses when you disburse cash.
However, even for cash-basis companies, there are still important benefits to entering vendor invoices in Sage 50.

Vendor Aging
If you enter vendor invoices, Sage 50 will compute and track aging for payables, even for cash-basis companies. This includes
automatically tracking discounts for timely payment. For purchases, you can select a batch of bills to pay, based on due date,
discount date, and other criteria. You can also use the Payment Manager to analyze payables and to select bills to pay.

Projected Cash Flow
Cash-basis companies that record vendor invoices can still accurately project cash flow. The two main tools for this in Sage 50 are is
the Cash Flow Statement and the Cash Flow Manager.

Purchases/Receive Inventory
This window allows you to either enter vendor purchase invoices or receive inventory for purchase orders.
l

Apply to Purchase Order tab: When you select a vendor who has open purchase orders, Sage 50 displays the this tab,
allowing you to select which purchase order to receive items against.

l

Apply to Purchases tab: If you select a vendor with no open purchase orders, by default Sage 50 displays this tab, where you
can enter a purchase that did not originate on a purchase order. In addition, if items were included on the purchase invoice that
are not included on the purchase order, you can add them here.

Learn More
Entering a purchase invoice
When you enter a purchase or receive inventory on a purchase order, the vendor can be an already-existing vendor, or you can
add a new vendor.
Note that if you are paying the vendor by credit card, you do that in the Payments window.

Receive inventory on a purchase order
Enter credit card purchases
Customizing the Purchases window by hiding fields you don't use
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select the standard template.

Copying a purchase invoice
You can create a new purchase by copying an existing one. You can create the same purchase in future intervals (i.e. weekly,
monthly) by recurring it.

Recurring a purchase
Finding out if a purchase invoice has been paid
It's an easy matter to find out the status of any outstanding vendor invoices.

Look up the current payment status of a purchase invoice
Entering and applying a vendor credit memo
Whenever a vendor issues you a credit memo, you enter and apply it right here, on the Purchases/Receive Inventory window.

Enter and apply a vendor credit memo
Using the Track It panel
You can use the Track It panel to update the tracking status of a purchase invoice (pending, approved, etc.), including assigning
it to a specific user or all users that have a specific role in your company.

Add an Attachment

You can attach files, such as Word or Excel documents, to a purchase or inventory receipt.

Recurring Purchases and Payments
In most businesses, you have bills that you pay every month, like utilities. By setting up recurring entries, you can save a great deal
of time entering these purchases and payments.
The process is basically the same for entering recurring purchases or payments.

1. From the Tasks menu, select Purchases or Payments.
2. Complete the transaction as you normally would. For purchases, you have to assign a starting invoice. All of the transactions will
be numbered incrementally; for example, if you enter 4501, the next invoice will be numbered 4502.

Note: You are actually creating a transaction here, not just a template.
Even if the amount will differ for the next time, it's helpful to have all the other information filled out for you. Then, you only have
to change the amount.

3. Instead of selecting Save, select the Recur button on the Payments screen. On the Purchases screen, select the drop-down
arrow next to the Copy button, then select Create recurring.
A Create Recurring <transaction> dialog appears.

4. Select How often you want to recur this transaction from the drop-down list. You can choose Weekly, Biweekly, Every
four weeks, Monthly (the default), Per Period, Quarterly, Twice a year, or Annually.

5. Select the First transaction date from the calendar. This is the date that your recurring transaction will begin.
6. Select the end date from one of three options:
l
If you know a specific date you want to end the recurring transactions, select a date from the calendar for the End on option .
l
If you know the specific number of recurring transactions you want to set up, select the End after option and enter the number
of occurrences.
l

If you want your recurring transaction to continue indefinitely, select No end date option.

7. Select OK to save all the recurring transactions. Select Cancel to close the recur dialog (nothing is saved) and return to the
transaction window.

Payments
This allows you to write checks for vendor invoices, for payments that don't have a vendor invoice, and for prepayments or
discounts. You can also write a check to a customer.
Note the distribution list box at the bottom of the window. The fields of the distribution box differ depending on whether you're
applying the payment to invoices or expenses. If a vendor has open invoices, the Apply to Invoices tab will be in front. However,
if you are entering a payment to a one-time vendor not in the system, the Apply to Expenses tab is defaulted.
You can also select the prepayment check box for a payment to an existing vendor where there isn't an invoice.
When you enter a payment, you can:
l

l

Select the invoices to be paid on the Apply to Invoices tab or enter the line item information on the Apply to Expenses tab and have
Sage 50 calculate the payment amount.
Enter the payment amount and have Sage 50 select the invoices to be paid on the Apply to Invoices tab or enter the line item
information on the Apply to Expenses tab.

Use the way that works best for you. If you need to change the payment amount or the information entered on the tabs, go ahead.
Just be sure the payment amount equals the total of the amounts on the tabs before you save the payment.

Payments vs. Write Checks: Which one should I use?
l

Use Write Checks if
1. You simply need to enter a payment and print a check "on the fly."
2. You are not paying an invoice that is in the system and do not need to update inventory or job costing expenses.

l

Use Payments
1. You need to record the receipt of inventory items.
2. You need to record the payment of a vendor bill/invoice that is in the system.

3. You need to update job cost expenses with a payment.(This is the Drop-down text)

Learn More
Are you paying a regular vendor or one that is not on file?
In the Payments window, you can pay vendors that you have set up in Maintain Vendors, or you can make a one-time payment
to a vendor who is not in your database.

Pay vendors or enter payments for purchases
Enter a payment to a vendor not on file
Entering cash purchases and manual checks
You can use the Payments window to enter payments without a previous purchase transaction. You can also enter a manually
written check so that you'll have a record of it in Sage 50.

Enter a cash purchase
Enter a payment for a manually written check
Is this a payment you make on a regular basis?
Sage 50 has two methods for handling payments that you make on a consistent basis. Memorized transactions are like a
template that you can quickly flesh out for specific transactions. They are not posted to the general ledger. Recurring
transactions are complete transactions you set up to happen on a set timetable—monthly, quarterly, yearly, etc. An example
would be if you have a monthly service contract with a vendor.

Enter a memorized payment
Printing and previewing check for invoices
Sage 50 gives you the opportunity to review the information that will appear on forms before you print them. The Print
button in the toolbar of Payments gives you three options: Select Print Preview to look over a check before printing;
when you're ready, select Print for a hard copy of the check; select Select Checks to Print if you want to print a batch of
checks from this window.
Preview a check before printing
Print checks for invoices
Voiding a disbursement check
Sometimes you need to void a check for an invoice. You'll be able to do this for any checks that have been posted but not
cleared with the bank. To void a check:
1. Display it in the window.
2. Select the Delete button.
3. From the drop-down options, select Void.
Using the Track It panel
You can use the Track It panel to update the tracking status of a payment (pending, expired, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Why does Sage 50 print "duplicate" on my check when I know it isn't a duplicate?
Sage 50 will print "duplicate" on the check if a Check Number has already been assigned to the check, either because it was printed
before or because the Check/Reference Number field on the Payments window was filled in prior to printing. On the Payments
window
l
l

Complete the Check/Reference Number field ONLY if the check was printed outside of Sage 50, such as by hand.
Leave the Check/Reference Number field blank if you plan to print the payment you are entering. Sage 50 will
automatically assign the next check number when you click Print and it will not print "duplicate" on the check.

Recalculating the cash balance in Payments
If you see the word Uncalculated in the Balance field of the window, then the Recalculate cash balance
automatically in Receipts and Payments in Maintain Global Options is currently not selected. However, you can
manually update cash balance; click the link to find out how.
Add an Attachment
You can attach files, such as Word or Excel documents, to a payment.

Enter a Payment at Time of Purchase from Vendor
If you make a payment to a vendor at the time you record the purchase, you can enter the amount paid directly in the Purchases
window. Follow these steps:

1. From the Tasks menu, do one of the following:
l
Select Purchases.
l
Select Bills and then Enter Bills.
2. In the window, enter the purchase information following the instructions under Enter a Purchase Invoice.
3. Once you have finished entering the information, in the Amount Paid at Purchase field, enter the amount you are paying; then
press Enter.
The Reference, Payment Method, and Cash Account fields appear under the Amount Paid at Purchase field.

4. In the Reference field, enter something to help you identify the payment, such as the check number if you are paying by check.
5. In the Payment Method field, select the way that you made the payment, for example, Check.
Tip: You can click the Payment Method link to add, edit, or delete payment methods.
6. In the Cash Account field, enter or select the general ledger account ID to which you want to apply the amount paid. The
default account is the cash account that was used in the Payments or Write Checks window. You can select a different account or
add a new one here.

Note: If you have the Hide General Ledger Accounts global option activated, the Cash Account lookup list displays only
names of cash accounts currently set up in the chart of accounts. Select the cash account name to apply to this payment. If you
want to apply an alternate G/L account (an account that uses an account type other than Cash) for this payment, you must
select the Journal button.

7. When finished, select Save to record the purchase and your payment.

Enter a Payment to a Vendor Not on File
To enter a payment for a vendor who has not been entered through Maintain Vendors, follow these steps:

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
2. Press Enter to skip the Vendor ID field.
3. Select the Pay to the Order of arrow button. Enter the vendor’s name and address in the window that appears.
4. Once you’ve entered the name and address information, select OK.
5. Select the payment method to designate the type of payment being made, for example, Check.
Tip: You can click the Payment Method link to add, edit, or delete payment methods.
6. Enter the purchase on the Apply to Expenses tab.
Note: If you enter an amount in the Payment Amount field, the Apply to Expenses tab will populate with this amount on one line
item. You might want to do this if you don't need to track any details about what this vendor has purchased.
If the line item contains serialized inventory, you will need to either add or select serial numbers for the item(s). Select
the line item with the serialized inventory item, then select the Serial No button to enter or select serial numbers. Either the
Serial Number Entry or the Serial Number Selection window appears, depending upon whether you entered a positive
or negative quantity. Enter or select the serial numbers you need and select OK when you're finished to return to the Payments
window. However, if the payment has more than one line item that contains serialized inventory, you can select the OK/Next
button to save the current entry and move to the next serialized item.

6. Select the Print button if you want to print and save the check. Otherwise, click the Save button.

Enter Credit Card Purchases

To record credit card purchases, you need to "pay" the vendor using the credit card liability account rather than a cash account.
Later, you will pay the credit card vendor using the cash account.

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
Sage 50 displays the Payments window.
2. Enter or select a vendor ID associated with the purchase you want to pay using a company credit card. To display a list of existing
vendors, type ? in this field, or select the Lookup button.
3. Enter a reference number that identifies the purchase in the check/reference number field.
We suggest using a date followed by a sequential number. (For example, enter 031511-1 to represent the first credit card
payment on March 15, 2011.) This will make account reconciliation easier to manage later.

4. Enter or select the actual date of the purchase (when paid by credit card).
5. Select the credit card you used for the purchase in the Payment Method field. If you don't see the credit card listed, click the
Payment Method link to add it.

6. Enter or select the credit card liability account from the Cash Account list.
Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the cash account field in this
window. To modify the cash account used for this transaction, you must select the Journal button.

7. Complete the remainder of the payment, making sure to enter a description that identifies the purpose of the purchase. Then,
select save the transaction.

Note: There are several methods of entering vendor payments. The key point here is to change the cash account ID to the
credit card account ID. See also

Enter a Cash Purchase and Print Checks
A cash purchase can either be a check that you write to a vendor or other payee that you have not entered a purchase for, or it can
be a purchase for which you have actually paid cash. A cash purchase needs to be applied to expenses.

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
2. Enter or select the vendor ID that you want to pay. To display a list of existing vendors, type ? in this field, or select the Lookup
button. Or, press ENTER to skip the Vendor ID field, and type in the name in the Pay to the Order of field.
3. If you want to print a check, leave the Check # field blank. If you paid cash for the purchase, enter CASH01, CASH02, and so on.
4. In the Payment method field, select Cash .
Tip: Clicking the Payment method link will take you to the Vendor Defaults screen where you can add, edit, or delete payment
methods.

5. If you chose a vendor with existing invoices, select the Apply to Expenses tab.
6. Enter the line items on the payment the same way as you do in Purchases/Receive Inventory.
Tip: If the Apply to Expenses tab is in focus, you can just enter an amount in the Payment Amount field and Sage 50 will
automatically populate the Apply to Expenses tab for you. This is useful if you don't need to enter any details about the payment
in the line items.
If the line item contains serialized inventory, you will need to either add or select serial numbers for the item(s). Select
the line item with the serialized inventory item, then select the Serial No button to enter or select serial numbers. Either the
Serial Number Entry or the Serial Number Selection window appears, depending upon whether you entered a positive
or negative quantity. Enter or select the serial numbers you need and select OK when you're finished to return to the Payments
window. However, if the transaction has more than one line item that contains serialized inventory, you can select the OK/Next
button to save the current entry and move to the next serialized item.

6. If you need to enter retainage that you are withholding from this vendor, select the Apply to Expenses tab and enter a new line
item, specifying Retainage as the description, selecting an appropriate Payable Retainage account, and entering the amount of
retainage in the Amount field as a negative number. This will ensure that the amount is subtracted from the total and that the

retained amount is tracked properly.

7. If you want to print the check, select the Print button. Otherwise, select the Save button to record the payment.

Enter a Manual Check
To enter a manual (handwritten) check, you need to:

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
2. Enter or select the vendor ID that you want to pay. To display a list of existing vendors, type ? in this field, or select the Lookup
button.

3. Enter or select the check date.
4. Enter the check number in the Check/Reference Number field.
Sage 50 considers all payments with a check/reference number assigned as printed. If you print the check with a
check/reference number already assigned, the word "Duplicate" will appear on the check.

5. Select Check as the Payment Method.
6. Enter the payment information the same way that you enter regular payments.
7. When you're done, select the Save button.

Maintain Memorized Payments
You can enter and save common transactions such as vendor payments for later use. For example, you can repeat a previous
transaction several times. Using memorized transactions can save time in repetitive data-entry tasks.

Learn More
Entering and using memorized payments
To enter a memorized payment, enter a transaction ID and description that describes the transaction; then enter the payment
information. When finished, select Save to record the memorized transaction for later use. Memorized transactions are not
posted to journals or the general ledger.

Note, however, that not all payment fields are maintained in memorized transactions. Once the memorized
payment is selected for use in the Payments window, you must enter unique fields such as check/reference number and date.
When you create a payment on the Payments window, you have to choose a payment method. The payment method on
payments created from memorized payments will default to the payment method that was set up for the vendor, but you can
choose a different payment method if you want to. If you are entering an electronic payment, the payment method will default
to Electronic unless you have deleted that payment method from Vendor Defaults.

Memorizing existing payments
You don't have to create a memorized payment from scratch; you can memorize an already existing transaction as well.

Using memorized payments while working in the Payments window
Once you set up memorized invoices, you can select and use them. On the Payments window, click the drop-down arrow to the
right of the List button. Then, click Select.

Select for Payment (Overview)
You can use this to select invoices from vendors to be paid as a batch. You can print the checks from this selection.

Windows
Select for Payment
What do you want to do next?
Pay vendors or enter payments for purchases
l
Select invoices to pay
l
Preview check forms before printing them
l

l
l

Print checks for invoices
Look up the current payment status of a purchase invoice

Select for Payment
This window lists all outstanding invoices, credit memos, and prepayments. By selecting check boxes in the Pay column to the right
of the window, you are telling Sage 50 which invoices you want to pay. If you have multiple invoices from a single vendor, only one
check will be created for the total of the invoices.
l
l

Select the Detail button to display invoice information associated with the selected transaction.
Select the Report button to print a "pre-check" register that lists all payments that you have currently selected in the window. In
other words, this is a list of vendor payments that will be made (checks that will be printed) when you select the Print button. You
can use this preview report to examine payment detail, approve selected vendor checks, and prepare the check order before the
checks are actually printed and posted.

Learn More
Select the vendors you want to pay
The Select for Payment option is a two-part process:
1. You choose the range of vendors you want to pay at one time. You do this in the Select for Payment--Filter Selection window.
2. Once you finish selecting vendors and click OK, the Select for Payment window appears, listing all outstanding invoices for
the vendors. The next order of business is to choose which of these invoices you want to pay.

Select invoices to pay
Printing and previewing checks
Sage 50 gives you the opportunity to review the information that will appear on forms before you print them. The Print button
in the toolbar of Select for Payment gives you the following two options: Select Preview to look over a paycheck before
printing; when you're ready, select Print for a hard copy of the check.

Preview checks before printing
Print checks for invoices
Recalculating the cash balance in Select for Payment
If you see the word Uncalculated in the Balance After Checks field of the window, then the Recalculate cash balance
automatically in Receipts and Payments in Maintain Global Options is currently not selected.

Select Invoices to Pay
Selecting invoices to pay is a two-step process.

1. In the Select for Payment - Filter Selection window, you select the vendors you want to pay.
2. After you select vendors and click OK, the Select For Payment window appears. (You can change the filter selection from this
window by clicking the Selection button.)
This window lists all outstanding invoices, credit memos, and prepayments. By checking the Pay column on the far right, you tell
Sage 50 which invoices you want to pay. If you have multiple invoices from a single vendor selected, then only one check will be
created for the total amount of these invoices.
If an invoice is waiting on a bill from a vendor, you will not be able to select that invoice to pay. Only once you receive the invoice
and enter the invoice number on the Purchases/Receive Inventory task window will you be able to select the invoice for payment.
To select invoices for payment follow these steps:

1. Change the cash account and/or discount account if necessary.
2. Select a payment method to designate how you are paying the invoices, for example, Check.
3. Select a Sort By option from the drop-down list: Invoice Date, Due Date, or Vendor.
This changes the order the items appear in this list.

4. Clear the Pay check box for items you do not want to pay at this time. Sage 50 assumes you want to pay all of the invoices
displayed in the window and selects all the Pay check boxes by default.
l
To clear all Pay check boxes, click the All (None) button.
l
To select all Pay check boxes, click the All (Select) button.

Tip: To display information about the invoice that you want to pay, select the Detail button.
To print a "pre-check" register that lists all payments that you have currently selected in the window, select the Report button.
In other words, this is a list of vendor payments that will be made (checks that will be printed) when you click the Print button.
You can use this preview report to examine payment detail, approve selected vendor checks, and prepare the check order
before the checks are actually printed and posted.
The Total Checks field at the bottom right of the window is updated each time a check is marked or unmarked for payment. If
Automatic Recalculation is turned on in Maintain Global Options, or if you select the Recalculate button, the account balance and
the Balance After Checks fields update as you check and uncheck invoices as well. This shows you the account balance, how
much you are paying, and what your balance will be after payment.

5. Change the amount of discount taken on this invoice if necessary.
The original invoice will not be updated if you change the amount here, but the amount in the Pay Amount field will reflect any
changes.

6. After making your selections, select the Print button. For step-by-step instructions on printing from the Select for Payment
window, see Print a Form from a Task Window.

Print Checks for Invoices
You can print checks individually or in a batch. Always remember to leave the check/reference number blank, otherwise Sage 50
assumes that a check has already been printed and will not print the check.

Printing an Individual Check for an Invoice
If you are paying one invoice, instead of following steps 1-4, you can open the invoice on the Purchases/Receive Inventory
screen and click Pay Now. The Pay Now link is located next to the invoice status for invoices that have not been paid in full. This
will take you to the Payments screen with the invoice selected to be paid. Go to step 5 to print the check.

1. From the Tasks menu, do one of the following:
l
Select Payments.
l
Select Bills and then Pay Bills.
2. Sage 50 displays the Payments window.
3. Enter or select the vendor ID that you want to pay. To display a list of existing vendors, type ? in this field, or select the
Lookup button.

4. With the Apply to Invoices tab shown, enter the amount of money you're paying the vendor in the Payment Amount field.
Sage 50 will look on the Apply to Invoices tab for an invoice matching that amount. If one is found, it will be selected to pay.
Otherwise, the payment amount will be applied to the first invoice listed. If there is an amount remaining, it will be applied to
the next invoice and so on until the entire payment amount is applied.
If you don't want Sage 50 to automatically select the invoices to pay or if you want to change what has been selected, on the
Apply to Invoices tab, select the Pay check box next each the invoice that you want to pay.

Tip: You can use the Pay All/None links to check or uncheck all of the invoices listed.
Make sure the Payment Amount is equal to the total of the amounts from the Apply to Invoices and Apply to Expenses tabs.

5. Select the Print button.
6. Select the check disbursement form that you want to use from the dialog box.
Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose
the OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

7. If you're unsure of how the check will be aligned, select the Print Sample button. This prints a sample check with
placeholder text, instead of the actual check. If your checks have pre-printed numbers, this will use the first number, thus
printing a void check. Make sure you enter the correct number. For example, if you aligned your forms as a practice using
check #3002, make sure you enter check #3003 here (the last check number printed plus 1).

8. After the check aligns to your satisfaction, select the Print button.
The check prints.

Printing a Check for More Than One Invoice
1. From the Analysis menu, select Payment Manager. Sage 50 displays the Payment Manager window.
2. Enter or select the vendor ID that you want to pay. To display a list of existing vendors, type ? in this field, or select the
Lookup button.

3. Enter the amount you want paid for each invoice.
4. Select the Check button to print the check.
Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose
the OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

Printing Checks in a Batch for Vendors
1. From the Tasks menu, choose Select for Payment. Sage 50 displays the Select for Payment--Filter Selection window.
2. Choose your filter options and select OK to display the Select for Payment window.
3. Enter or select the cash account from which you will be writing the checks.
4. Select Check as the payment method.
5. Select each invoice you want paid.
6. Select the Print button, and Sage 50 will create one check for all the invoices from the same vendor you selected.
Tip: Select the Report button to print a "pre-check" register that lists all payments that you have currently selected in the
window. In other words, this is a list of vendor payments that will be made (checks that will be printed) when you click the
Print button. You can use this preview report to examine payment detail, approve selected vendor checks, and prepare the
check order before they are actually printed and posted.

Printing Checks from the Select a Report or Form Window
1. Create checks for the vendors you want to pay in Payments. Save these checks without entering a check number.
2. From the Reports & Forms menu, select Forms, then Checks.
3. In the Forms list on the Select a Report or Form window, select the check form you want to use (for example, preprinted
form, multiple checks on preprinted forms, and so on). Click the Preview and Print button. Sage 50 displays the Preview
and Print filter screen.
Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose
the OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

4. On the Print/E-mail tab, fill in the check information.
5. Make sure the printer information on the Print Setup tab is correct.
6. If you need to change the check alignment, select the Align button on the Print Setup tab, and adjust the vertical and
horizontal alignments. To print another practice check, select the Practice button in the Align Form window. This prints
variables (X's, N's, and so on) instead of the actual check. If your checks have pre-printed numbers, this will use the first
number, thus printing a void check. Make sure you enter the correct number. For example, if you aligned your forms as a
practice using check #3002, make sure you enter check #3003 here (the last check number printed plus 1).

7. After the check aligns to your satisfaction, select OK to return to the Preview and Print filter screen.
8. Click Print/E-mail. Sage 50 displays the Print dialog.
9.
Make any necessary changes to the printer information and select OK.
The checks print.

Printing a Batch of Checks from the Payments Window
1. Create checks for the vendors you want to pay in Payments. Save these checks without entering a check number.
2. In the Payments window, select the Print drop-down button and then choose Select Checks to Print. Sage 50 displays the
Preview and Print filter screen.

3.

On the Print/E-mail tab, fill in the check information.
Make sure the form you want to use to print the checks is selected in the Use this form field. You can choose a different form if
the correct form is not selected.

Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose the
OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

4. Make sure the printer information on the Print Setup tab is correct.
5. If you need to change the check alignment, select the Align button on the Print Setup tab, and adjust the vertical and
horizontal alignments. To print another practice check, select the Practice button in the Align Form window. This prints variables
(X's, N's, and so on) instead of the actual check. If your checks have pre-printed numbers, this will use the first number, thus
printing a void check. Make sure you enter the correct number. For example, if you aligned your forms as a practice using check
#3002, make sure you enter check #3003 here (the last check number printed plus 1).

6. After the check aligns to your satisfaction, select OK to return to the Preview and Print filter screen.
7. Click Print/E-mail. Sage 50 displays the Print dialog.
8. Make any necessary changes to the printer information and select OK.
The checks print.

Look Up the Current Payment Status of a Purchase Invoice
Use this procedure to quickly determine if any payments have been applied to an invoice.

1. From the Tasks menu, do one of the following:
l
Select Purchases.
l
Select Bills and then Enter Bills.
2. Select the List toolbar button to display the Purchases List.
The payment status appears in the list as Unpaid, Partially Paid, or Paid in Full.

3. Select an existing purchase invoice transaction to display it, if desired.
4. The Payment Status appears in red just below the Date field. If the status is Partially Paid or Paid in Full, you will also see the date
the last payment was made.

Note: The status is established after the invoice is posted (or saved) and updated when a payment is applied to it.

Purchase Orders
This is where you enter a purchase request for items from a vendor. When you post a Purchase Order, you do not actually update
any accounting information. The accounting information is updated only when you actually receive the items on the purchase order
through the Purchases/Receive Inventory task, or if you're using cash accounting, when you pay the vendor.

Note: The vendor must already be entered in Maintain Vendors before you can enter a purchase order. To enter a one-time
purchase from a vendor you don't want to keep on record, use Payments and leave the Vendor ID field blank.
Learn More
Entering a purchase order
Enter a purchase order to request items that you sell to your customers.

Enter a purchase order
Did you know you can customize this window, hiding fields you don't use?
Sage 50 has templates that let you customize Task windows. You can hide certain fields that you never use, such as Ship To
fields. If you ever need those fields, just select the Layout button and select the standard template.

Read an overview of customized templates
Is this an order you send on a regular basis?
If you want to send basically the same purchase order to a vendor a number of times, you can memorize the order. Memorized
transactions are like a template that you can quickly flesh out for specific transactions. They are not posted to the general
ledger. You can also create a new purchase order by copying an existing one.

Auto-filling and auto-creating purchase orders
The Autofill toolbar button lets you automatically add line items to the displayed purchase order for any low-stock items that you
routinely order from the currently selected vendor.

You can choose to have Sage 50 automatically generate purchase orders, behind the scenes, when certain transaction involving
inventory items are entered into the system. To set up auto-creation of purchase orders, you must choose one or more of the
Auto Creation of Purchase Orders options on the Ordering tab of Inventory Item Defaults.

Auto-create purchase orders
Creating purchase orders for multiple vendors
Besides the Purchase Orders window, you can use the Sage 50 Select for Purchase Orders option to generate POs based on
inventory items you need to reorder. This lets you create POs for multiple vendors at one time, if needed. A series of selection
criteria let you choose the items you want to include on the POs.

Select items for purchase orders
Select purchase orders to create
Printing, previewing, and editing purchase orders
When you print a purchase order, do not enter number in the a PO No. field. Sage 50 automatically assigns a number at print
time.
If you want to see how the purchase order will look when it is printed, you can preview the form beforehand.

How to print a purchase order
How to preview a purchase order
How to edit a purchase order
Using the Track It panel
You can use the Track It panel to update the tracking status of a purchase order (pending, expired, etc.), including assigning it to
a specific user or all users that have a specific role in your company.

Maintain Memorized Purchase Orders
You can enter and save purchase orders for later use. For example, if you frequently request quotes for the same goods or group of
goods (office supplies, inventory, and so on), you can create a memorized purchase order and you won't have to re-enter all of the
line items each time you want a quote for these items.

Learn More
Entering and using memorized purchase orders
To create a memorized purchase order,

1.
2.
3.
4.

Select Maintain , Memorized Transactions, Purchase Orders.
Enter a transaction ID and description that describes the transaction.
Enter the order information.
When finished, select Save to record the memorized transaction for later use.
Memorized transactions are not posted to journals or the general ledger.

Note, however, that not all purchase order fields are maintained in memorized transactions. Once the
memorized order is selected for use in the Purchase Orders window, you must enter unique fields such as the purchase order
number and date.

Memorizing existing purchase orders
You don't have to create a memorized purchase order from scratch; you can memorize an already existing transaction as well.

Using memorized purchase orders while working in the Purchase Orders window
Once you set up memorized invoices, you can select and use them. On the Purchase Orders window, click the drop-down arrow
to the right of the List button. Then, click Select.

Maintain Purchase Order Templates
You can set up different formats, known as templates, for entering and reviewing data in the various task windows. When you select
the Layout toolbar button and then choose Customize Purchase Order Layout in the Purchase Orders window, Sage 50
displays the Maintain Purchase Orders Templates window, where you can create your own template or modify an existing one.
Templates are designed by choosing to add or remove data entry fields. You can also associate a form with the template and choose

to remove or add fields from the form as well. You can also make other changes to the form such as adding a logo or changing the
font used on the form.
Predefined templates cannot be edited or deleted. To customize a template, you must first create a new one or edit an existing
customized template.

Learn More
Why use templates?
To read more about templates, including a discussion of why they're useful, click the link below.

Designing a task window template
To create a template, enter a template name and description that describes the template format. Make any necessary changes
to the template and click the Save button.
A quick way of creating a new template is to copy an existing template that incorporates features you'd like to see in the new
template.

Editing or deleting a task window template
You can easily change the features of a task window template once created. If you no longer need an existing template, you can
easily delete it as well.

Enter a Purchase Order
Follow this procedure to enter a purchase request for items from a vendor; the vendor must already be entered in Maintain Vendors
before you can enter a PO.

How do I get to the Purchase Orders window?
From the Tasks menu, select Purchase Orders. Sage 50 displays the Purchase Orders window.
Note: The procedure outlined below assumes you are using the predefined Standard template. To select a template, click the
Layout toolbar button, and choose the template you want to use from the pull-down menu. If you choose a customized template,
please adjust the instructions below accordingly.

Enter vendor ID, PO #, and dates
1.
Enter or select the vendor ID. To display a list of existing vendors, type ? in this field, or select the Lookup button. To add a
new vendor, type + or double-click the field, which displays the Maintain Vendors window.
When the vendor is selected, Sage 50 supplies the vendor default information, including name, remit address, shipping
method, and payment terms.

2. If you will be printing the purchase order and want Sage 50 to automatically assign this purchase order a number, leave the
PO # field blank. Otherwise, enter the purchase order number in this field.
3. If the purchase order date is not today's date, enter the date in the Date field.
4. Enter the date this purchase order is good through in the Good thru field. Change the shipping address if necessary and the
method of shipment. Click on the arrow button to display the ship-to information. To change the shipment method, select the
method from the drop-down list.

Enter discount, terms, and A/P account
1.
Change the discount amount if necessary, as well as the displayed terms.
The Displayed Terms field automatically fills in with the default terms.
2. If you are using special terms from this vendor and want to show them on the printed purchase order, enter the new term
information here.

3.

If yours is an accrual-based company, you can select the accounts payable G/L account for this purchase. On financial
statements this will be your accounts payable liability account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/P Account
field in this window. To modify the A/P account used for this transaction, you must select the Journal button.

Enter item information
1.
Enter the information for each item on a separate line, including the item's quantity, item ID, U/M (displays if multi-packs

enabled in Inventory Item Defaults), description, unit price (the number of decimal places is selected in Maintain Global
Options), and job information (if applicable). The default unit price is the last posted price for this item.
The default G/L purchase account that appears for each line item is based on the vendor purchase account default or the item
ID selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account, type + or
double-click the field, which displays the Maintain Chart of Accounts window.

2. Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account fields in
this window. To modify G/L accounts used for this transaction, you must select the Journal button.

3. At the bottom left corner of the window, the selected vendor's balance is displayed. You can click the arrow button to the right
of the vendor balance to display the current Vendor Ledgers report for this vendor.

4. Continue entering line items until you have completed the purchase order.
Enter job information
Select the job and the phase and/or cost code to which this transaction applies. To do so

1. In the Job field, click the folder button to display a drop-down list of available jobs, phases, and cost codes (if the job uses
them).

2. Click the folder for the job you want to apply these costs to. This will display the list of phases.
3. Click the folder for the phase you want. This will display the list of cost codes, if there are cost codes associated with the
phase you selected.

4. Click the cost code you want to select, if necessary. This will close the list of jobs and select that particular job, phase, and
cost code.
Purchases of stock and assembly items cannot be applied to a job. These types of inventory items are applied to a job using
Inventory Adjustments or Sales Invoicing.

Print or save the PO
When you are finished entering all line items, elect the Print button if you want to print and save the order. Otherwise, click the
Save button.

Note: Purchase orders are not posted to general ledger. When you receive inventory and apply this purchase order to a
customer invoice (after shipping the items ordered or performing services requested), the purchase order data is transferred
to the vendor invoice. Then, the purchase can be posted to the general ledger.

Add an attachment
You can attach files, such as Word or Excel documents or pictures, to a purchase order.

What do you want to do next?
l
Receive inventory on a purchase order
l
Print a purchase order
l
l
l

Preview a purchase order before printing it
Edit a purchase order
Read the purchase order overview

Edit a Purchase Order
1. From the Tasks menu, select Purchase Order. Sage 50 displays the Purchase Orders window.
2. Select the List toolbar button.
3.
4.
5.
6.

From the displayed list, select the purchase order you want to edit.
Select OK. Sage 50 displays the purchase order.
Make any changes or updates you need to.
Select Save.

Receive Inventory on a Purchase Order

After you have entered a purchase order for your vendor, the next step is to receive the inventory for that purchase order as it
arrives. Sage 50 allows you to receive a different quantity for an item than you originally ordered. That is, you can receive less than
or more than the originally ordered quantity.

How do I get to the Purchases window?
From the Tasks menu, select Purchases/Receive Inventory. Sage 50 displays the Purchases/Receive Inventory
window.

Note: The procedure outlined below assumes you are using the predefined Standard template. To select a template, click the
Layout toolbar button, and choose the template you want to use from the pull-down menu. If you choose a customized template,
please adjust the instructions below accordingly. .

Enter vendor ID, invoice #, and dates
1.
Enter or select the vendor ID. To display a list of existing vendors, type ? in this field, or select the Lookup button.
If you have open purchase orders with this vendor, the Apply to Purchase Order # tab displays in front.
2.
Enter the vendor's invoice number in the Invoice # field. This is a required field.
If you have not yet received a vendor invoice (bill) for this shipment, select the Waiting on Bill from Vendor check box. Once
your vendor sends you the bill, edit this invoice; clear the Waiting on Bill from Vendor check box; and enter the invoice
number. Then, when you post the invoice with the invoice number, you will be able to select the invoice for payment.

Note: If you have received inventory from a vendor by entering a purchase using the "Waiting on Bill" option, Sage 50 will
warn you when you select this vendor so you don't enter the invoice for this vendor's order twice by mistake.

3. Enter the date of the invoice if it is different from the displayed invoice date.
4. Enter the due date of the invoice is due if it is different from the displayed due date.
Enter address, terms, and A/P account
1. Change the shipping address if necessary and the method of shipment. Click the arrow button to display the box with ship-to
information. To change the shipment method, select the method from the drop-down list.

2.

Change the discount amount if necessary, as well as the displayed terms.
The Displayed Terms field automatically fills in with the default terms.
3. If the vendor used special terms, enter the new term information here.

4.

If yours is an accrual-based company, you can select the accounts payable G/L account for this purchase. On financial
statements this will be your accounts payable liability account. If yours is a cash-basis company, this field will display <Cash
Basis>.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display the A/P Account field
in this window. To modify the A/P account used for this transaction, you must select the Journal button.

Enter item information
1.

From the drop-down list on the Apply to Purchase Order # tab, select the purchase order number that you want to
receive inventory against. Sage 50 displays the items on the order in the line-item list.
The first two columns on the line-item list (the Item ID column and the Remaining column) are gray, meaning you cannot
edit them. To edit a purchase order, you must edit it in the Purchase Order task.
The Remaining column shows the number of items left to be shipped to complete the purchase order. For example, if there
were 20 widgets on a purchase order and you were shipped 15 of them, the Remaining column will show that 5 widgets still
need to be shipped the next time you display the purchase invoice.

2. In the Received field, enter the quantity of an item received.
3. If necessary, you can edit the information for each item included on the invoice, including the item's quantity, item ID,
description, unit price (the number of decimal places is selected in Maintain Global Options), and job information (if
applicable). The default unit price is the last posted price for this item.

4. If you are tracking job costs, you can assign a job for each non-stock line item. You cannot enter a purchase order for a stock
or assembly item in your inventory and assign a job to it. You can apply stock or assembly items to a job at the time of the
sale, but not the time of purchase.

5.

The default G/L purchase account that appears for each line item is based on the vendor purchase account default or the item

ID selected. To change the account ID, type ? in this field, or select the Lookup button. To add a new account, type + or
double-click the field, which displays the Maintain Chart of Accounts window.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account fields in
this window. To modify G/L accounts used for this transaction, you must select the Journal button.

6.

Continue entering items until you have completed receiving the items in this shipment.
If the vendor included additional purchase items on the invoice that were not included on your purchase order, select the
Apply to Purchases tab..

Enter amount paid and save the purchase
1.
If you have paid a partial or full payment at the same time you received this invoice, enter the amount in the Amount Paid at
Purchase field. The Reference field, Payment Method field, and Cash Account field will appear allowing you to enter payment
information.
The Net Amount Due displays what you currently owe for the purchase.

2. When finished, select the Save button to record the purchase.

Auto-Create Purchase Orders Behind the Scenes
This feature is available only in Sage 50 Complete Accounting and higher.
Sage 50 allows you to set up Inventory Item Defaults for the automatic creation of purchase orders behind the scenes. The Ordering
tab of this window has options that let you enable the auto-creation of POs for

l

drop-ship transactions
non-drop-ship transactions

l

work tickets

l

Important: For auto-creation of purchase orders to work, your company must be using the real-time posting or the
SmartPosting method. If you are using the SmartPosting method and the SmartPosting service is not running, purchase orders
may not be created correctly if unposted transactions exist.
You can treat each auto-created purchase order just as you would a manually created one: you can edit it, print it, or e-mail it to a
vendor in the Purchase Orders window.

Note: Even if your company is set up for auto-creation of purchase orders, Sage 50 will not automatically create POs for recurring
customer invoices. Instead, you will have to manually generate POs for any inventory that you need to reorder as a result of
recurring invoices.

Drop-Ship Transactions
For the automatic creation of POs, each item must be set up in Maintain Inventory Items with a preferred vendor. Also, the user who
is entering the transactions listed below must have access rights to add POs. If these conditions are met and your company is set up
for auto-creation of POs, Sage 50 will automatically create a PO each time
l

a drop-ship quote is converted to a sales order

l

a drop-ship quote is converted to a sales invoice

l

a drop-ship sales order or accepted proposal is entered and saved

l

a drop-ship sales invoice is entered and saved, if the invoice has line items entered on the Apply to Sales tab of Sales /Invoicing
Drop-ship proposals will not auto create purchase orders. Nor will proposals auto create purchase orders when they are converted
from quotes.

Item Classes Covered by Auto-Creation
As long as the conditions mentioned above are met, Sage 50 will auto-create POs for inventory items of all item classes, including
stock, substock, serialized stock, non-stock, assembly, serialized assembly, service, and labor items.

Non-Drop-Ship Transactions
For the automatic creation of POs,

1. Each item must be set up in Maintain Inventory Items with a preferred vendor.
2. The user who is entering the transactions listed below must have access rights to add POs.
3. The quantity ordered of one or more of the items must cause the quantity available as of the transaction date to fall below
minimum stock levels.
If these conditions are met and your company is set up for auto-creation of POs, Sage 50 will automatically create a PO each time
l

a quote is converted to a sales order

l

a quote is converted to a sales invoice

l

a sales order or accepted proposal is entered and saved

l

a sales invoice is entered and saved, if the invoice has line items entered on the Apply to Sales tab of Sales /Invoicing

l

a receipt is entered and saved using the Apply to Revenues tab of Receive Money
Proposals will not auto create purchase orders. Nor will proposals auto create purchase orders when they are converted from
quotes.

In addition, to ensure that auto-creation works most effectively, each item in Maintain Inventory Items should be set up with a
minimum stock level and minimum reorder quantity.

Item Classes Covered by Auto-Creation
As long as the conditions mentioned above are met, Sage 50 will auto-create POs for inventory items that fall into the following item
classes only: stock, substock, and serialized stock.

What do you want to do next?
l
Get step-by-step instructions for setting this feature up
l
Edit a purchase order
l
Receive inventory on a purchase order
l
Read the purchase orders overview

Setting Up Sage 50 for Auto-Creation of Purchase Orders
This feature is available only in Sage 50 Complete Accounting and higher.
Follow these steps to set up Sage 50 to auto-create Purchase Orders.

1. Select Maintain , Default Information , Inventory Items.
2. Select the Ordering tab.
3. Make the appropriate choices for your company on these fields:
l

Include purchase orders when calculating quantity available

l

Enable auto-creation of purchase orders for drop ship transactions

l

Enable auto-creation of purchase orders for non-drop ship transactions

Note that if you check this option, Sage 50 automatically selects the Include purchase orders when calculating
quantity available field.

4. Click OK.
5. Select Maintain , Inventory Items.
6. For each item, make sure that the following fields are completed:
l

Minimum Stock

l

Reorder Quantity

l

Preferred Vendor ID.

Sage 50 will need all of this information for each item to ensure that the Purchase Orders are created properly.

7. Save each customer record as you complete it.
Now, Sage 50 will automatically generate unprinted Purchase Orders for items that fall below minimum stock quantities, based on
the vendor you chose and the Reorder Quantity entered for the items.

Select for Purchase Orders (Overview)
This feature is available only in Sage 50 Complete Accounting and higher.
You can use this to select the inventory items you want to reorder. Unlike the Sage 50 Purchase Orders option, the Select for
Purchase Orders option lets you create POs for multiple vendors. Following the selection of the range of items you want to include on
the orders, you can create and print POs to send to the appropriate vendors.

Windows
Select for Purchase Orders

Select for Purchase Orders
This feature is available only in Sage 50 Complete Accounting and higher.
This window works together with the Select for Purchase Orders--Filter Selection window to generate purchase orders based on
inventory items you want to reorder. Unlike the Purchase Orders option, this lets you create purchase orders for multiple vendors.
First, you use the Select for Purchase Orders--Filter Selection window to filter inventory items based on a number of criteria such as
item ID, preferred vendor, and stock status. Once you make these selections and click OK, the Select for Purchase Orders window
appears with a list of all items that match the selection criteria you set. From this list, you choose the items you want to turn into
purchase orders, which you can then print and/or e-mail to the appropriate vendors.
If you'd like to review a hard copy of all the items that will be included on purchase orders as well as the total number of POs to be
created and total cost of all items on those orders, select Preview from the drop-down menu of options on the Print button to print
the Select for Purchase Orders Preview report.

Learn More
Creating purchase orders for selected items
The Select for Purchase Orders option is a two-part process:
1. You select those inventory items that you want to appear on purchase orders. You do this in the Select for Purchase Orders-Filter Selection window.
2. Once you finish selecting items and click OK, the Select for Purchase Orders window appears, listing all items for which
purchase orders can be created, based on your selection criteria. The next order of business is to choose which purchase
orders you want to create to send to your vendors.

Select items for purchase orders
Select purchase orders to create
Printing and previewing the purchase orders
If you want to see how the purchase order or orders created on this window will look when they are printed, you can preview
them beforehand.

How to print purchase orders
How to preview purchase orders
Entering purchase orders for a single vendor
If you want to create a purchase order for a single vendor, you can do so quickly and easily in the Purchase Orders window.

Enter a purchase order

Select Purchase Orders to Create
This feature is available only in Sage 50 Complete Accounting and higher.
Selecting the purchase orders you want to create based on your inventory-reorder needs involves a two-step process:

1. In the Select for Purchase Orders - Filter Selection window, you select the items for which you want to create purchase orders.
2. After you select items and click OK, the Select For Purchase Orders window appears. (You can change the filter selection from
this window by clicking the Select button.)
This window lists all items that meet the selection criteria you set in the Filter window. By checking the Order column on the far left,
you tell Sage 50 which of these items you want to order, thus creating a purchase order or purchase orders. If you have multiple
items from a single vendor selected, then only one PO will be created for these items.

To select the items for which you want to create purchase orders:

1. Clear the Order check box for items you do not want to order at this time. Sage 50 assumes you want to order all the items in the
window and checks all the Order check boxes by default.
l
To clear all Order check boxes, click the All (None) button.
l
To select all Order check boxes, click the All (Select) button.
2. Some of the item fields that appear in the grid, such Description and Amount, are editable; fields that are not editable
appear in gray. The following editable fields include Lookup buttons for making choices from existing records: Vendor, GL
Account, and Job.

Make changes as needed to the editable information for an item or items.

Note: You can sort the items by the following fields: Vendor, Item, Description , Available, On Hand, U/M (Sage 50
Distribution Accounting, Sage 50 Manufacturing Accounting, and Sage 50 Quantum Accounting only), Order Qty, Unit
Price, GL Account, Job, Quantity on SOs, Quantity on POs. To sort the items by any of these fields, click the
appropriate button at the top of the column. For example, to sort items by ID, click the Item button. Clicking the button once
sorts the items in ascending order, and clicking again sorts them in descending order.
The Total Amount field at the bottom right of the window is updated each time an item is checked or unchecked. This shows the
total dollar amount of all items from which purchase orders will be created. The Number of POs field reflects the total number
of purchase orders that will be created based on the items you've chosen to reorder.

3. To print the Select for Purchase Orders Preview report detailing all the choices you've made in the window, click Preview in the
drop-down menu of options on the Print button.
4. After making your selections, click the Print button to print the purchase orders you've created. For step-by-step instructions on
printing from the Select for Purchase Order window, see Print a Form from a Task Window.
If you want, you can also e-mail copies of the purchase orders to the appropriate vendors. For step-by-step instructions on emailing POs, see E-Mail a Form from a Task Window.

Select Items for Purchase Orders (Filter Selection)
This feature is available only in Sage 50 Complete Accounting and higher.
To select the inventory items that will appear on the purchase orders you want to create:

1. From the Tasks menu, choose Select for Purchase Orders.
The Select for Purchase Orders--Filter Selection window appears.

2. In the Select Items with group box, choose as many filters as you want to apply to the items that will be selected for reorder.
l

l

Item ID: The default setting is All, meaning that all existing item IDs will be selected. If you want to limit the selection to
single ID, click Select, and then enter or use the Lookup button to choose an item by ID.
Item Type: The default setting is All, meaning that items of all types will be selected. If you want to limit the selection to a range
of item types, click Select. In the From box, enter the first type in the range. In the To box, enter the last type in the range of
types you want to include.

l

Item Class: The default setting is Stock, meaning that all stock items that meet the other filters you set will be selected. You
can choose any combination of the other classes as well:

l

Assembly

l

Non-stock

l

Labor

l

Service

3. Next, in the And items with group box, you can choose to filter the items for reorder according to vendor and buyer ID.
l
Vendor ID: The default setting is All, meaning that all vendor IDs will be selected. If you want to limit the selection to a single
vendor or items, click Select, and then enter or use the Lookup button to choose a vendor by ID.
l
Buyer ID: The default setting is All, meaning that all buyer IDs will be selected. If you want to limit the selection to a single
buyer who purchases items for your company, click Select, and then enter or use the Lookup button to choose a buyer by ID.
4. Last, in the Display a list of items group box, further filter the items that will be selected for reorder based on criteria dealing
with numbers of items in stock.
l

l

Based on: Choose whether you want the items selected for reorder to be based on Quantity on Hand or Quantity Available.
The default setting is Quantity on Hand.
As of: Use the calendar button to enter a date as of which either the quantity on hand or the quantity available will be
calculated.

l

And stock status: Choose one of the following options:
l

Out of stock: Select this if you want inventory items to be ordered only if you are completely out of stock. This is the
default setting.

l

Below minimum stock: Select this if you want inventory items to be ordered only if they are below minimum stock
levels.

l

At or above minimum stock: Select this if you want inventory items to be ordered only if they are at or above
minimum stock levels.

l

And set order quantity: Choose one of the following options, if desired, or accept the default:
l
Greater of reorder quantity and quantity needed to bring to minimum: Select this if you want the quantity of
an item reordered to be whichever is greater: the default reorder quantity or the amount needed to bring the item to
minimum stock quantity. This is the default setting.
l

Bring quantity up to minimum stock: Select this if you want the quantity of an item reordered to be that needed to
bring it to minimum stock quantity. Note: If Stock status is set to At or above minimum stock, this setting will be
ignored.

l

l

Reorder quantity: Select this if you want the quantity of an item reordered to be that needed to bring it to the default
reorder amount. Note: For some of the Stock status settings, this setting will be ignored.
Quantity needed to fill SOs only: Select this if you want the quantity of an item reordered to be that needed to fill only
outstanding customer sales orders.

5. When all selections are correct, click OK.
The Select for Purchase Orders window appears; here, you can choose the purchase orders you want to create and print and/or
e-mail to vendors. .

Print a Purchase Order
There are several ways to print a purchase order.

To print a purchase order when you enter it
See Enter a Purchase Order, and follow the instructions for entering and printing a purchase order.
To print a purchase order any other time
1. From the Tasks menu, select Purchase Orders. Sage 50 displays the Purchase Orders window.
2. Select the List toolbar button.
3. Select from the displayed list the purchase order you want to print.
4. Select OK. Sage 50 displays the purchase order.
5. Select the Print button, and proceed as directed under Print a Form from a Task Window.
To print purchase orders from the Vendors and Purchases Navigation Center

1. In the Vendors and Purchases Navigation Center, select the Purchase Orders navigation aid and then select Print
Purchase Orders. Sage 50 displays the Select a Report or Form window with Purchase Order forms shown in the Forms list.
2. From the Forms list, select the form you want the purchase order to print on, and select Preview and Print. Make any
necessary filter selections and click Print/E-mail.
3. Click OK to print the forms.
To print a batch of purchase orders from the Purchase Orders task window
1. From the Tasks menu, select Purchase Orders. Sage 50 displays the Purchase Orders window.
2. Select the Print drop-down button and then choose Select Purchase Orders to Print. Sage 50 displays the Preview and Print
filter screen.

3. Make any necessary filter selections and click Print/E-mail.
4. Click OK to print the forms.

Write Checks
The Write Checks window is a simplified version of the Payments window. Write Checks allows you to quickly enter check
information without having to make individual line-item distributions.

Write Checks vs. Payments: Which one should I use?
l

Use Write Checks if
1. You simply need to enter a payment and print a check "on the fly."
2. You are not paying an invoice that is in the system and do not need to update inventory or job costing expenses.

l

Use Payments if
1. You need to record the receipt of inventory items.
2. You need to record the payment of a vendor bill/invoice that is in the system.
3. You need to update job cost expenses with a payment.

Note: All checks written in either the Payments or the Write Checks window are listed in the Cash Disbursements Journal.
Learn More
Writing expense checks
Like the Payments window, Write Checks lets you write a check to a vendor. Unlike Payments, however, Write Checks doesn't
let you pay vendor invoices or make prepayments. So Write Checks should be your choice whenever you want to make
payments for transactions, such as expenses, that don't involve invoices or the need to track inventorymaintain items.
If you need to distribute a payment to multiple line items, select the Split button. The Split Transaction window appears; there,
you can enter the appropriate line-item information.

Write expense checks
Do you need to edit an expense check?
If you click the List button while working in Write Checks, the Select Write Checks window appears, letting you select and edit
any check previously entered in the Write Checks window.
You can also edit these checks through the Payments window, using the List button there. However, once you edit the check in
the Payments window, it will no longer be treated as a payment coming from Write Checks. Instead, Sage 50 will treat the
check as a regular payment, and you can then work with it in the Payments window, applying it either to expenses or invoices
just like any other regular payment.

Is this a payment you make on a regular basis?
Sage 50 has two methods for handling payments that you make on a consistent basis. Memorized transactions are like a
template that you can quickly flesh out for specific transactions. They are not posted to the general ledger. Recurring
transactions are complete transactions you set up to happen on a set timetable—monthly, quarterly, yearly, etc. An example
would be if you have a monthly service contract with a vendor.

Enter a memorized payment
Printing and previewing expense checks
Sage 50 gives you the opportunity to review the information that will appear on forms before you print them. The Print button

in the toolbar of Payments gives you three options: Select Print Preview to look over a check before printing; when you're
ready, select Print for a hard copy of the check; select Select Checks to Print if you want to print a batch of checks from
this window.

Preview a check before printing
Print a form from a task window
Using the Track It panel
You can use the Track It panel to update the tracking status of a check (pending, approved, etc.), including assigning it to a
specific user or all users that have a specific role in your company.

Why does Sage 50 print "duplicate" on my check when I know it isn't a duplicate?
Sage 50 will print "duplicate" on the check if a Check Number has already been assigned to the check, either because it was printed
before or because the Check Number field on the Write Checks window was filled in prior to printing. On the Write Checks window
l
l

Complete the Check Number field ONLY if the check was printed outside of Sage 50, such as by hand.
Leave the Check Number field blank if you plan to print the check you are entering. Sage 50 will automatically assign the
next check number when you click Print and it will not print "duplicate" on the check.

Voiding expense checks
Sometimes you need to void a check for an invoice. You'll be able to do this for any checks that have been posted but not
cleared with the bank. To void a check:

1. Display it in the window.
2. Select the Delete button.
3. From the drop-down options, select Void.
Recalculating the cash balance in Write Checks
If you see the word Uncalculated in the Balance field of the window, then the Recalculate cash balance automatically
in Receipts and Payments in Maintain Global Options is currently not selected.

Write Expense Checks
This lets you write checks to vendors whenever there is no need to pay off an invoice or make prepayments. Follow this procedure:

How do I get to the Write Checks window?
From the Tasks menu, select Write Checks.
Enter/select vendor ID
1. Enter or select the ID of the vendor you want to pay.
l
To display a list of existing vendors, type ? in this field, or select the Lookup button.
l
To add a new vendor, type + or double-click the field, which displays the Maintain Vendors window.
2. If you want this bill to be paid electronically (Sage 50 Complete Accounting and higher only), select the Electronic
Payment box.
Note: If the vendor is set up for default electronic payments, the Electronic Payment box will be checked automatically.
If you don't want this to be an electronic payment, deselect the box.

3. Next, if this is an electronic payment, enter or accept the displayed Pay On date.
4. select the Pay check box.
Important: In order for the payment to arrive at the payee on time, it must be transmitted electronically on or before the
displayed Send By date.

Enter check #, date, amount, payment method, and memo
1. If you are entering a handwritten check, enter the check number in the Check Number field. If you want Sage 50 to print
the check, leave this field blank. If this is an electronic payment, the Check Number field will read "Electronic."
2. Enter or select the date of the disbursement, not necessarily today's date.
3. Enter the total amount of the check.

4. Select the payment method to designate the type of payment being made, for example, Check. If this is an electronic
payment, the payment method will automatically be set to Electronic unless you have deleted that payment method.

Tip: You can click the Payment Method link to add, edit, or delete payment methods.
5. If desired, enter a memo up to 30 characters long.
Enter/select accounts and description
1. Enter or select the cash account from which you will be writing the check.
2. Enter or select the expense account you want to use to distribute the payment.
3. If you want to distribute this payment to multiple individual line items, select the Split button. The Split Transaction window
appears, allowing you to make additional distributions.

4.

In the Description field, Sage 50 offers a default description for the distribution. If needed, change it.
This is for your reference only; the description will not print on the check.

5. If you are tracking job cost, enter or select the job you want to distribute the payment to.
Print or save the check
Now, if you want to print the check, select the Print button; for step-by-step instructions on printing checks from the Write
Checks window, see Print a Single Form from a Task Window. Otherwise, select the Save button to record the payment.

Print a batch of checks from the Write Checks window
1. Create checks for the vendors you want to pay in Write Checks or Payments. Save these checks without entering a check
number.

2. In the Write Checks window, select the Print drop-down button and then choose Select Checks to Print. Sage 50 displays the
Preview and Print filter screen.

3.

On the Print/E-mail tab, fill in the check information.
Make sure the form you want to use to print the checks is selected in the Use this form field. You can choose a different form if
the correct form is not selected.

Tip: If you want to print item descriptions on your check stubs (as well as item quantity, item ID, and item amount) choose the
OCR Multi-Purp AP Detail Cont or OCR Multi-Purp AP Detail Laser form when printing checks.

4. Make sure the printer information on the Print Setup tab is correct.
5. If you need to change the check alignment, select the Align button on the Print Setup tab, and adjust the vertical and
horizontal alignments. To print another practice check, select the Practice button in the Align Form window. This prints variables
(X's, N's, and so on) instead of the actual check. If your checks have pre-printed numbers, this will use the first number, thus
printing a void check. Make sure you enter the correct number. For example, if you aligned your forms as a practice using check
#3002, make sure you enter check #3003 here (the last check number printed plus 1).

6. After the check aligns to your satisfaction, select OK to return to the Preview and Print filter screen.
7. Click Print/E-mail. Sage 50 displays the Print dialog.
8. Make any necessary changes to the printer information and select OK.
The checks print.

Vendor Credit Memos
Use the Vendor Credit Memos window to enter credit memos for returns to and credits from a vendor; you can apply credit memos
to any existing vendor invoices that have not been paid. All entries made on this window are posted to General Ledger, vendor
records, and when applicable, inventory and job item records. You have the choice of applying memos to jobs through the
distribution list box.
When you enter an item ID, the quantity on hand is reduced by the quantity entered. Vendor Credit Memos allows you to enter as
many as 500 return or credit line items per memo.

Learn More
Entering a vendor credit memo
Use the Vendor Credit Memos window for vendor returns and credits.

Enter and apply a vendor credit memo

Using the Track It panel
You can use the Track It panel to update the tracking status of a vendor credit memo (pending, approved, etc.), including
assigning it to a specific user or all users that have a specific role in your company.

Enter and Apply a Vendor Credit Memo
Occasionally, a vendor may issue you credit.
l

l

If the credit is issued on a purchase without an invoice, you enter it on the Apply to Purchases tab of the Vendor Credit Memos
window.
If the credit is issued on an existing invoice, you enter the credit on the Apply to Invoice tab of the Vendor Credit Memos
window.

Entering a Vendor Credit on an Existing Invoice
Enter vendor ID and dates
1. From the Tasks menu, select Vendor Credit Memos.
2. Enter or select the ID of the vendor who is issuing the credit. To display a list of existing vendors, type ? in this field, or select
the Lookup button.

3. In the Credit # field, enter the ID that you want to apply to the credit memo.
Note: You may want to connect the application amount to the credit memo. For example, if the existing invoice number is
106, you may want to type 106-C to indicate that the credit memo is applied to the invoice.

4. Enter the date of the credit memo if it is different from the displayed credit date.
5. Enter the due date of the credit memo if it is different from the displayed due date.
Select original invoice; enter quantity
1. Select the Apply to Invoice tab.
2. Use the drop-down list that appears at the top of the tab to select the original invoice to apply the credit memo to.
The grid displays all line items that appear on the original invoice.

3. In the Return column, enter the quantity of any item that you want to credit or return.
The quantity that you enter here will appear on the completed credit memo; Sage 50 will automatically remove this quantity
from your inventory item records.

4. Repeat step 3 for each additional item that you want to return or complete.
Enter retainage (if needed)
If you need to enter retainage, select the Withhold Retainage tab and enter the appropriate amount of retainage credited
to you on the appropriate job line item. This will ensure that retainage is tracked properly in the system.
Make sure that the general ledger account number selected is a Payable Retainage account. This number will default to the
account used on the original invoice.

Save memo
When finished entering transaction information, select the Save button. If you are using batch processing, to post the memo,
select Tasks>System, and then select the Post option.

Entering a Vendor Credit on a Purchase without Invoice
Enter vendor ID, credit #, transaction date
1. From the Tasks menu, select Vendor Credit Memos. Sage 50 displays the Vendor Credit Memos window.
2. Enter or select the ID of the vendor who is issuing the credit. To display a list of existing vendors, type ? in this field, or select
the Lookup button.

3. In the Credit # field, enter the ID that you want to apply to the credit memo.
4. If the transaction date is different from the one displayed, enter or select a new date.

Enter quantity and item information
1. In the Quantity column, enter the quantity of an item that you want to credit or return.
The quantity that you enter here will appear on the completed credit memo; Sage 50 will automatically remove this quantity
from your inventory item records.
In Sage 50 Premium Accounting and higher, if the line item contains serialized inventory, you will need to either add or select
serial numbers for the item(s). Select the line item with the serialized inventory item, then select the Serial No button to
enter or select serial numbers. Either the Serial Number Entry or the Serial Number Selection window appears,
depending upon whether you entered a positive or negative quantity. Enter or select the serial numbers you need and select
OK when you're finished to return to the Vendor Credit Memos window. However, if the credit memo has more than one line
item that contains serialized inventory, you can select the OK/Next button to save the current entry and move to the next
serialized item.

2. Next, enter all information for the returned or credited item, including the item's quantity, item ID, description, and unit price
(the number of decimal places is selected in Maintain Global Options), and job information (if applicable). The default unit
price is the last posted price for this item. If you are tracking job costs, you can assign a job for the item.

3. Repeat steps 1 and 2 for each additional item that you want to return or credit.
Enter job information
Select the job and the phase and/or cost code to which this transaction applies. To do so

1. In the Job field, click the folder button to display a drop-down list of available jobs, phases, and cost codes (if the job uses
them).

2. Click the folder for the job you want to apply these costs to. This will display the list of phases.
3. Click the folder for the phase you want. This will display the list of cost codes if there are cost codes associated with the phase
you selected.

4. Click the cost code you want to select, if necessary. This will close the list of jobs and select that particular job, phase, and
cost code.
Purchases of stock and assembly items cannot be applied to a job. These types of inventory items are applied to a job using
Inventory Adjustments or Sales Invoicing.

Enter retainage (if needed)
If you need to enter retainage, select the Withhold Retainage tab and enter the appropriate amount of retainage credited
to you on the appropriate job line item. This will ensure that retainage is tracked properly in the system.
Make sure that the general ledger account number selected is a Payable Retainage account. This number will default to the
account used on the original invoice.

Save memo
When finished entering transaction information, select the Save button. If you are using batch processing, to post the memo,
select Tasks>System, and then select the Post option.

Processing a Refund from a Vendor
This is a three step process.

1. Enter a credit memo for the vendor.
You should receive this prior to receiving the refund check from the vendor.

2. Enter the refund check from the vendor.
When you request and receive the refund check from the vendor, follow the steps to enter it properly.

3. Reconcile the credit memo and the refund check.
This will remove the credit memo and the refund check from the Vendor Ledgers report.

Entering a Vendor Refund Check
On occasion, you will enter a refund check from a vendor. To do so

1.
2.
3.
4.

Select Tasks, Receive Money.
Select Vendor ID from the drop-down at the top left.
Select the vendor.
Enter the information from the check, such as date, check number, and the correct general ledger account. The check number
should be entered in the Reference field.

5. On the Apply to Vendor account tab, enter a Description of the refund and the amount.
6. Click Save.
This will record the check, update the proper general ledger accounts, and make the check available to be reconciled against the
credit memo.

Account Register
Account Register
The Account Register lets you enter a payment to a vendor or a receipt from a customer in an easy-to-use, checkbook-register
window.
You can use shortcut keys to move around easily in the register. .

Learn More
Entering transactions in the Account Register
The grid format makes entering payments and receipts fast and easy.

Enter a transaction in the Account Register
Editing Account Register transactions
You can directly edit only those transactions that originated on the Account Register. These transactions are marked by an icon
in the Edit column:

You can drill down to most transactions on the register that originated from other Task windows. Some of the transactions you
cannot drill down on are:
l

the reverse portion of a general journal entry

l

beginning balances

l

opening balance lines

l

applied prepayments for payments

l

applied prepayments for receipts

Edit a transaction in the Account Register
Is this an entry you make on a regular basis?
Recurring transactions are complete transactions you set up to happen on a set timetable—monthly, quarterly, yearly, etc. An
example would be if you have a contract with someone to provide a monthly service.

Want to change the way the Register displays transactions?
You can sort the transactions that appear in the Account Register according to a number of criteria, including date. If you sort
transactions by date, you can also filter out ones you don't want to see.

Sort transactions on the Account Register
Filter transactions by date on the Account Register

Enter a Transaction in the Account Register
1. From the Tasks menu, select Account Register.
2. Select the Cash Account, if it is different than the displayed account.
The first cash account in your chart of accounts, alphabetically by name, defaults as the Cash Account. You can select a different
account by clicking on the lookup icon. Only cash accounts display in the lookup list.

3. Click the New button to jump to end of the displayed transactions, to a blank transaction line.
4. Enter a transaction date, or click the calendar icon to select a date.
Note: The tab order for entering a transaction on the register is different depending on whether you have chosen to display one
entry line or two. (This option is set in Global Options on the General tab.) These instructions assume you are showing two lines. You
can use your Enter or Tab key to move from one field to the next in the register.

5.
6.
7.
8.
9.

Select either Payment or Receipt.
Select a customer (receipt) or vendor (payee).
Enter the payment or receipt amount.
Enter a reference number, such as a check number. This is required for receipts, but not for payments.
Enter a GL account to balance the entry to the cash account. For receipts, this would usually be an Account Receivable or Income
account. For payments, it would usually be an Accounts Payable account or Expense account.

10. Click on the Split button if more than one account needs to be updated for this transaction.
11. Enter or confirm the value in the Memo field. For receipts, this defaults to the deposit ticket ID that was used for the last saved
receipt. For payments, it is blank. You might enter the date or your purchase order number.

12. Click the Save button. You can type Alt-S from anywhere in the highlighted transaction to save.
When you create a payment on the Payments window, you have to choose a payment method. The payment method on payments
created from the Account Register will default to the payment method that was set up for the vendor.

What do you want to do next?
Read an overview of the account register
l
See step-by-step instructions for editing a transaction on the register
l
Change the filter options on the register
l
Change the sort order of transactions on the register
l

Edit a Transaction in the Account Register
1. From the Tasks menu, select Account Register.
2. Select the Cash Account, if it is different than the displayed account.
The first cash account in your chart of accounts, alphabetically by name, defaults as the Cash Account. You can select a different
account by clicking on the lookup icon. Only cash accounts display in the lookup list.
You can change the filter selection of the transactions displayed, if desired, by clicking the lookup icon beside the Show
Transactions for field.
You can only edit those transactions which originated on the Account Register. They are marked with an icon:

For other transactions, you can drill down on them and edit them in the Task screen where they were created.

3. Scroll through the listed transactions and click on the transaction you want to edit. Change the information as necessary.
4. Click the Save button. You can type Alt-S from anywhere in the highlighted transaction to save.
Note: The tab order for entering a transaction on the register is different depending on whether you have chosen to display one
entry line or two. (This option is set in Global Options on the General tab.) These instructions assume you are showing two lines. You
can use your Enter or Tab key to move from one field to the next in the register.

Filter Transactions on the Account Register
You can change the group of transactions that appear on the register by date. The Show Transactions for filter displays at the
top right of the register.

You can choose to show
All

Will show all transactions in open fiscal years

Today

Will show all transactions dated on the current system date

This Month

Will show all transactions dated between the first and last days of the current month

This Period

Will show all transactions dated between the first and last days of the current period

This Quarter

Will show all transactions dated between the first and last days of the current quarter

This Year

Will show all transactions dated between the first and last days of the current fiscal year

This Week-to-Date

Will show all transactions dated between the Sunday prior to the current system date and the
current system date

This Month-to-Date

Will show all transactions dated between the first day of the current month and the current
system date

This Period-to-Date

Will show all transactions dated between the first day of the current period and the current
system date

This Quarter-to-Date

Will show all transactions dated between the first day of the current quarter (based on the
calendar year) and the current system date

This Year-to-Date

Will show all transactions dated between the first day of the current fiscal year and the
current system date

Sort Transactions on the Account Register
You can change the order in which transactions appear on the register. The Sort By field appears at the bottom left of the Account
Register.

You can choose to sort by
l

Date

l

Type

l

Payee/Paid By

l

Payment

l

Receipt

l

Reference

l

Edit

Cash Flow Manager
The Cash Flow Manager gives you a powerful tool you can use to quickly grasp the state of your business's cash. It shows you the
balances of your cash accounts, cash expected to come in, and cash expected to go out. In addition, you can modify settings, such
as the time frame you want to see, the types of transactions (invoices, quotes, purchases, and so on) you include and expected
totals.

Quick Answers
What do numbers in red mean?
Numbers in red and in parentheses are negative numbers. They will subtract from the total on the tab they appear on.

What does the small triangle in the bottom right corner of a cell/field mean?
This triangle indicates that the field was modified in the Cash Flow Manager. For instance, a user might have changed the due date of
a sales invoice to see how it would affect the forecast in the graph. To see the original value of the field, simply roll your mouse over
the triangle.

Why are some items in the grid checked, while others are unchecked?

Certain items on each tab will be checked or unchecked. For instance, on the Expected Incoming Cash tab, overdue invoices will be
unchecked by default, while other unpaid invoices will be checked by default.

Why did some of the changes I made to the Cash Flow disappear?
l

l

When you change the way Sage 50 calculates the due dates for customer invoices, some of the modifications you made to the
cash flow will be lost. For instance, if you change the Expected Receipt date setting from Transaction due date to Average days to
pay, any changes you made to the due dates of customer invoices will be lost, since Sage 50 will recalculate due dates based on
customer payment history.
If you modify a transaction outside of the Cash Flow Manager, any changes to the Amount or Due date will be lost.

Why did Sage 50 automatically uncheck a line item after I reset the date of a transaction to its original value?
Resetting the date of the transaction to its original value placed it outside of the Time frame selected for the current cash flow.

Why do some invoices appear overdue when I know they aren't?
Most likely, this is because the Cash Flow Manager has been set to calculate the due dates based on Average days to pay rather than
the actual due dates.

How do I adjust the balances of my cash accounts?
You can do this in one of two ways:
l

Simply click in the Amount field of the Cash account on the Starting Cash tab and change the amount.

l

Enter an adjustment on the first line of the Starting Cash tab.
Note: This will NOT affect Sage 50's actual balance for the cash account; it will only affect the figures in the Cash Flow Manager.

How can I change the sort order of line items on the grids?
By clicking on the Title of a column in the grid, you can cause Sage 50 to sort alphabetically by the items in that column. Click the
title again and Sage 50 will sort the items in reverse alphabetical order. For instance, clicking the Name column on the Expected
Incoming Cash tab will cause the line items to sort alphabetically by the customer name.

I just converted from QuickBooks and none of my customer and vendor beginning balances appear in my Cash Flow. What
should I do?
You will need to change the information in the Invoice Number field on the beginning balances window for your customer and
vendors.

How do I send my cash flow information to Microsoft Excel?
1. Click the Excel button in the toolbar.
2. Select the options you want.
3. Click OK. What format will my cash flow will appear in after I send it to Microsoft Excel?
What does Add Attachments do?
You can attach files, such as Word or Excel documents, to a sales invoice.

Cash Flow (Financial Statement)
The Statement of Cash Flow shows the change in cash over a specified range of time. The cash flow is roughly the same as income
from operations plus depreciation, depletion, and any other expenses that had no effect on working capital during the accounting
period.
Sage 50's report sums the following:
Operating Activities
Investing Activities
Financing Activities
Net Increase in Cash
By default, there is a column for the current-month and the year-to-date totals.
When you display or print a financial statement, Sage 50 displays the following options:
l

Time Frame: You have the choice of a range of periods, current period, or current three periods. If you select a range, use the
From and To list boxes.

l

Print Page Numbers: Checking this will print page numbers on the top right corner of the page. Both the page number and the
number of pages are indicated. For example, if you are looking at page 2 of a 13-page document, it will display on the report as
"Page: 2 of 13."

l
l
l
l

Show Zero Amounts: Select this check box to show accounts with zero amounts.
Print All Words Capitalized: Select this check box if you want the report to print in all capital letters.
Right Margin/Left Margin: Enter the size of the margins you want, in inches.
Center on Page: Select this check box if you want each page of the report to be centered on the page instead of left justified
when it is printed.

l

Number of Copies: Enter the number of copies you want to print. You can enter any number from 1 to 99.

Related topics
Learn how to read financial statements

How Can I Improve My Cash Flow?
Simply stated, improving your cash flow is a matter of increasing money coming into your business and decreasing the money going
out. The more money you collect from customers the better. The less money you spend on expenses the better.
Below are some ways you can improve your money coming in and decrease your money going out, and how Sage 50 can help you
keep track of both.

Improving Money In
Manage credit limits on customers. For customers who pay their invoices quickly, increase their limits so they can buy

l

more. Since you know they’ll pay, you can confidently increase their credit limit. Sage 50 will track the average number of days it
takes your customers to pay their invoices and you can use this feature when managing your cash flow reports.

l

Fill orders for goods and services promptly. The sooner you give your customers what they bought, the sooner you can
collect. You can use Sage 50's Sales Order report to help you track orders and backorders.

l

Bill customers promptly. The sooner you send an invoice, the sooner they will pay. Don’t wait until the end of the month. Send
them immediately after you fill their order. Sage 50 will allow you email invoices in PDF format so that your customers will receive
them quickly.

l

Learn more about sending invoices electronically in Sage 50
Improve your collections procedure. Use collection letters to remind your customers of their obligations to you.

l

Make deposits promptly. When you receive money from customers, get it into the bank quickly so it will be available to spend.

l

Ask customers for payments upfront.

l

Improving Money Out
Don't pay your bills before they are due. Make sure you pay on time, though. The exception to this, of course, is when you
receive a discount for early payment. Take the discount.

l

Minimize expenses. Cutting down on wasted supplies and resources is a sure method of reducing expenses.

Paying Employees
Payroll Setup Wizard - Overview
The Payroll Setup wizard walks you through setting up most payroll defaults and standard payroll fields. As you answer the prompts
in the wizard, Sage 50 will create for you most of the common payroll fields used in calculating deductions and taxes. For example,
you are asked what the unemployment percentage for your company is. Based on the percentage you enter, Sage 50 creates the
state unemployment insurance (SUI) employer tax field and calculation formula that applies to it.

Note: You must subscribe to a Sage Business Care plan for payroll taxes and other deductions to be calculated within Sage 50. If
you don't subscribe, you will have to manually calculate and enter the amounts for payroll taxes and other deductions.
The Sage 50 Payroll Setup wizard establishes the following:

l

State and locality defaults

l

State unemployment percentage and limit

l

Common federal and state payroll fields for employee-paid and company-paid taxes

l

General ledger account defaults for payroll fields

l

Optional payroll fields for employee tips and meals

l

l

Optional payroll fields for employee and employer contributions to retirement plans (401K, 403(b), etc.), insurance plans, and
flexible spending accounts
Optional payroll fields for employee vacation and sick time

Not Ready Yet?
When you are first setting up a company, however, you might not have all the information available to set up payroll. If you are not
prepared to enter benefit information or are not sure of certain payroll setup options, you don't have to work all the way through the
Payroll Setup wizard. Instead, you can click the Save for Later button on any window in the wizard and then return to it to at a
later time to complete payroll setup.

How to Start the Wizard
Use this procedure to begin using the Payroll Setup wizard.

1. From the Maintain menu, select Payroll, and choose Payroll Setup Wizard.
Sage 50 displays the Payroll Setup Wizard.(Once you complete the wizard, its name changes to Payroll Settings.)
The initial screens tell you about your options for processing payroll with Sage 50: full-service and in-house payroll. Read this
information carefully; it's an important decision.

What do you want to do next?
l
Set up an employee
l
Perform other payroll tasks

Should You Track Payroll If You Don't Print Paychecks?
Because of the relative complexity of payroll, and the tax liabilities, many companies have their payroll checks calculated and
printed for them by an accountant or service company. At the other end of the spectrum, some companies manually write checks.
However, there are still benefits to entering some degree of payroll information in Sage 50.
There are varying degrees of how much information you could track. Are you responsible for filling out payroll forms such as W-2s?
If so, then you can enter complete information from each employee's pay stub. If not, then you can get by with entering general
journal entries for payroll-related accounts (tax liabilities, salary expense).

Method 1: Updating the General Ledger
If an accountant or service prepares your payroll, and they handle tax reporting and the printing of tax forms, you would probably
just need to enter general journal entries, either once a payroll or once a quarter. Get a report or batch of check stubs from your
accountant of the aggregate tax liabilities and salary expenses, and any other payroll-related accounts.
General journal entries, available from the Tasks menu, must be balanced manually. In other words, the Out of Balance amount
at the bottom of the window must equal zero before you post or save. Normally, you would be crediting a cash account and debiting
the payroll expense or liability.

Method 2: Entering information for each employee pay stub
This method, while more time-consuming, offers some advantages:
l

your financial statements are up-to-date with correct payroll information

l

you have complete, accurate information for reports

Note: Some payroll reports such as the Payroll Tax Report are calculated. You will not have access to these reports unless
you subscribe to a Sage Business Care plan.
1. From the Tasks menu, select Payroll Entry.
2. Bring up each employee, and enter the check number, hourly or salary amounts, and any deductions or allowances.

To be on the safe side, you may want to clear the Calculate check boxes in the Employee Defaults window since you are
manually entering these amounts. However, taxes and deductions will only be calculated on paychecks if you have subscribed to
a (missing or bad snippet)

3. Select Save when you're done with each employee.
What do you want to do next?
Set up an employee
l
Set up common payroll deductions
l
Pay employees
l
Enter manual paychecks
l
Perform other payroll tasks
l
Read the employee setup overview
l
Read the payroll setup overview
l

Employee Defaults
To set up or review employee defaults, select Default Information from the Maintain menu, and choose Employees.
Here (and in the Payroll Setup Wizard or Payroll Settings), you enter basic setup information that applies to most of your employees
and payroll transactions. Then, when you set up new employees and enter paychecks, the default information is automatically
included. This can save a great deal of time during data entry.

Note: Sage 50 requires that you first complete the Payroll Setup Wizard before you access Employee Defaults. That's because the
setup wizard will create most of the default information for you.
There are three tabs in Sage 50 Pro Accounting and five tabs in Sage 50 Complete Accounting and higher. There is one tab of
information in Employee Defaults:

General
Employee Fields
Company Fields

Paying Your Employees - Overviews and Procedures
Setting up
l
l
l

Employees

Sales representatives
Enter employee beginning balances

Creating Common Payroll Deductions
l
l
l
l
l
l
l
l
l
l
l
l

Company 401(k) plan and track contributions
Track employee vacation or sick time
Record employee tips
Group health payroll deductions
Bonus or commission fields for hourly employees
Local payroll taxes
Multiple state withholdings
Employee loans or advances
Labor tax or union dues deductions
Employee garnishment
Federal earned income credit
Fringe benefits

Tasks

l
l
l
l

Pay employees
Pay employees using time-ticket hours
Enter manual paychecks
Apply payroll expenses to a job

Maintain Employees/Sales Reps
Use the Maintain Employees/Sales Reps window to enter, change, and store information about your company employees and sales
representatives (reps).

Learn More
Setting up a new employee
First, you want to decide whether to set the person up as an employee, sales rep, or both.
First, you should set up your default or common information using the Sage 50 Payroll Setup wizard. This automates part of the
process of setting up employees and standard fields used in Payroll. Then you can set up individual employees/sales reps,
including specific payment and withholding information, as well as beginning balances.

Set up payroll default information
Set up an employee
Set up a sales rep
Enter employee beginning balances
Setting up common payroll deductions
In order to track payroll deductions for an employee, you will need to set up a number of payroll and deduction fields for
him/her. Common deductions you may want to track include 401(k) plans, tip income, group health plans, fringe benefits, and
bonus/commission payments for hourly employees.

Common payroll deductions and how to set them up
If you just added benefits in the Payroll Settings wizard
If you just finished adding benefits in the Payroll Settings wizard, you may still need to add employee-specific settings for those
benefits. Ask yourself this question for each benefit: Is there one standard percentage or amount for this benefit for every
employee? If the answer is yes, then you shouldn't have to do anything else for that benefit; the Payroll Settings wizard sets up
default or standard settings for the whole company. If, however, there are specific settings that have to be tailored for
employees, follow the link below.

Specific settings by employee
Adjusting vacation and sick-time information
You set up default or standard vacation and sick time policy for your company in Payroll Settings. If necessary, you can tweak
those for individual employees on the Vacation/Sick Time tab.
Setting up direct deposit employees
If your company is authorized to pay employees through the Sage 50 Direct Deposit service, you first need to set up your
company and then set up individual employees for direct deposit. Once your company is set up, the Direct Deposit tab
becomes available in the Maintain Employees/Sales Reps window. Here, you will enter bank account and other information
needed to pay an employee through direct deposit.

Set up a direct deposit employee
What are custom fields and how can I use them?
Custom fields let you track information that Sage 50 normally doesn't track. You set up the fields and input the data based on
specific information that your business requires.

Add an Attachment
You can attach files, such as Word or Excel documents, to an employee record.

Set Up an Employee
You set up an employee record in the Maintain Employees window. This information is used in payroll transactions and reports.

You should run the Payroll Setup Wizard and create all of the necessary employee and employer pay rates and deductions before
setting up employees. How do I get started with the Payroll Setup Wizard?

How do I get to the Maintain Employees window?
From the Maintain menu, select Employees/Sales Reps.
Setting up an employee record involves the following:

Entering employee ID and name
In the header area of the window (the area just below the toolbar), enter a new Employee ID. This must be an ID unique to
this employee. It is NOT case-sensitive.
If you leave the ID field blank, Sage 50 will create an ID based on the Name you enter (provided this option is set in Maintain
Global Options).

Entering general employee information
General information includes the address of the employee, the social security number, and type (if any). .

Entering employee customizable fields
Employee customizable fields allow you a way to keep track of specific information about your employees.

Why Customizable Fields?
You use custom fields to set up fields that aren't available on the Maintain Employees window. For example, you can add a
custom field for the employee's education level.
Setting up custom fields is a two-step process:
1. Enter the field label (Education ) on the General tab of Employee Defaults.
2. When you set up an employee (Maintain Employees), on the bottom of the General tab, enter the actual education level of the
employee (such as College degree).
.

Entering additional employee information
Additional information includes details such as hire date and gender.

Entering pay information
Pay information includes the employee's hourly or salary rates (based on default settings), the frequency with which the
employee is paid, and the general ledger accounts that their earnings should be applied to. Information entered here will
automatically be entered whenever you pay the employee.

Tell me more about employee pay information .
Entering withholding information
Withholding information includes the employee's federal, state, and local (if any) filing statuses, as well as any special
withholdings or 401k contributions. Here, you can also specify whether or not the employee has a retirement plan or is a
statutory employee.

Note: You must subscribe to one of the Sage Business Care plans for withholdings to be calculated and automatically entered
on paychecks within Sage 50.

Tell me more about the withholding information tab.
Entering vacation and sick-time information
Most employees should use the default or standard information set up in Payroll Settings. You only need to adjust this
information for employees with special circumstances for vacation or sick time. Just uncheck the This employee uses the
company default settings box and enter the unique information.

Note: You must subscribe to one of the Sage Business Care plans for vacation and sick time to be calculated within Sage 50.
.

Entering employee deduction information
Use this tab to make special modifications to the employee's deductions. For instance, if an employee has a flat percentage

withheld for federal income tax rather than an amount based on the formula. Also, any individual amounts that the employee
might pay for health or dental coverage are entered here.
Deductions found here are created on the Employee tab of Employee Defaults. You must first create a deduction there before
you will see it here.

Note: You must subscribe to one of the Sage Business Care plans for deductions to be calculated and automatically entered
on paychecks within Sage 50.
.

Entering employer deduction information
The Employer tab displays deductions and amounts that the employer is required to pay for this employee. These deductions
include the employer portion of Social Security, Federal Unemployment Tax, and any employer 401K contributions.

Note: You must subscribe to one of the Sage Business Care plans for withholdings to be calculated and automatically entered
on paychecks within Sage 50.
.

Tip: At a minimum, you should complete the fields listed here. Completing all of these fields will ensure that you can process a
payroll for this employee and print a check with all required information and correct deductions.

Heading
Employee ID
Employee Name
Type: Employee or Sales Rep

General Tab
Address
Social Security #

Pay Info Tab
Pay Method
Pay Frequency
Hours per Pay Period
Pay Rates

Withholding Tab
All Fields

Vacation/Sick Time
All fields (or use defaults)

Employee Tab
All fields

Employer Tab
All fields

When you're finished, select the Save button.

Set Up and Pay a 1099 Contractor
There are four steps to setting up and paying a contractor in Sage 50.
Step 1: Set Up the Contractor as a Vendor

1. Open the Maintain Vendors window.
2. Enter the vendor contact information.
3. Be sure and make a selection in the field "1099 Type".
Select Ind. Contractor for independent contractors that you have to send a 1099 to.
Select Interest if this vendor should receive a 1099-INT at the end of the year.
Select None if the vendor does not get a 1099.
Note: If you leave this field set to None, Sage 50 will not print a 1099 for the vendor. However, if you inadvertently left the field
set to None, you can change it to Ind. Contractor or Interest and Sage 50 will still be able to accurately report their 1099 wages.

4. Note the Expense Account that you enter or select. You will need to remember it in the next step.
5. Save the vendor record.
Step 2: Make Sure the Vendor Expense Account Is Set Up Correctly
You need to make sure that the Expense Account you entered on the vendor record is configured to print in the right box on the
contractor's 1099 form.

1. Open the Vendor Defaults window.
2. Click on the 1099 Settings tab.
3. Scroll to find the Expense Account you entered on the Vendor record.
4. In the 1099 Settings column, click on the dropdown list to select the box for this account.
INT Box 1 or MISC Box 7: This is the default setting for all general ledger accounts. It allows the calculation of contractor
payments to be based on the 1099 type you have set up for each contractor in Maintain Vendors (either Independent Contractor or
Interest).

1099-INT, Box 1: Select this to report interest income for each contractor you have paid at least $10 in interest as a loan. Sage
50 will then make interest income calculations for all contractor payments credited to the chosen general ledger account.

1099-MISC, Box 1: Select this to report income for each contractor to whom you pay rent. Sage 50 will then make miscellaneous
income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 2: Select this to report income for each contractor to whom you pay royalties. Sage 50 will then make
miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 3: Select this to report income for each contractor to whom you make other, unspecified payments. Sage 50
will then make miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 5: Select this to report income for each contractor you pay in the form of fishing boat proceeds. Sage 50 will
then make miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 6: Select this to report income for each contractor you pay in the form of medical and health care payments.
Sage 50 will then make miscellaneous income calculations for all contractor payments credited to the chosen General Ledger
account.

1099-MISC, Box 7: Select this to report miscellaneous income for each contractor you pay more than $600 annually. Sage 50
will then make miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 8: Select this to report income for each contractor who receives substitute payments in lieu of dividends or
interest. Sage 50 will then make miscellaneous income calculations for all contractor payments credited to the chosen General
Ledger account.

1099-MISC, Box 9: Select this to report income for each contractor you pay in the form of direct purchase of $5,000 or more in
consumer products that you intend for resale. Sage 50 will then make miscellaneous income calculations for all contractor payments
credited to the chosen General Ledger account.

1099-MISC, Box 10: Select this to report income for each contractor you pay in the form of proceeds from crop insurance. Sage
50 will then make miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

1099-MISC, Box 13: Select this to report income for each contractor who has received excess golden parachute payments from
your company. Sage 50 will then make miscellaneous income calculations for all contractor payments credited to the chosen
General Ledger account.

1099-MISC, Box 14: Select this to report income in the form of gross proceeds paid to an attorney. Sage 50 will then make
miscellaneous income calculations for all contractor payments credited to the chosen General Ledger account.

None: Select this option if you don't want either miscellaneous income or interest income calculations to be made for the chosen
general ledger account.

Step 3: Make a Payment to the Contractor

1. Select either Payments or Write a Check.
2. Click on the lookup icon and select the contractor.
3. Enter the payment information and save the check.
Note: It's important to choose the correct payment method when you enter a payment to a 1099 vendor.
Step 4: Print 1099's

1. From the Reports and Forms menu, select Forms, then Tax Forms.
2. On the Select a Report or Form window, double-click on the form to print in the Forms list.
3. Set your options and click Print/E-mail to print.

Set Up a Sales Representative
You may set up a sales representative using the Employees/Sales Reps selection from the Maintain menu, using a task window, or
the navigation aid. Sales representatives can be associated with any sales transaction.

Note: A sales representative can also be an employee.
To set up a Sales Representative using the menu
1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. If the sales representative is not an employee, select the Sales Rep option. If the sales representative is also an employee
select the Both option.
Sales representatives are not included in payroll entry. If you chose Both (an employee and a sales rep), the sales rep will be
included in payroll.

3. When you're finished filling in the window, select the Save button. Then, select the Close button.
You can also select the Employees icon in the Payroll Navigation Aid or the Sales Reps icon in the Sales Navigation Aid.
To set up a sales representative from a task window
1. Type + or double-click the Sales Rep ID field. Sage 50 displays the Maintain Employees/Sales Reps window, where you can
enter the sales representative.

2. When you're finished filling in the window, select the Save button. Then, select the Close button.

Beginning Balances for Employees
To enter beginning balances for each employee record, select the Beginning Balances button on the General tab of the Maintain
Employees/Sales Reps window. Entering your employee beginning balances correctly ensures that your monthly, quarterly, or
year-end reports will print correctly. You can enter a beginning balance for each new employee and edit it at any time—it does not
affect the general ledger. It is advisable to enter beginning balances for employees before entering any payroll transactions.
The toolbar at the top of the window contains the following buttons: Close, Save, and Help.

Employee ID: You can select another employee who has had no transactions posted by using the Lookup button at the side of the
entry box.

Dates: These are the dates of the pay periods for which you'd like to see the history on the employee. Because you probably won't
be starting Sage 50 at the beginning of the year, here are some suggestions on how to enter information to get the correct quarterly
and year-end reporting of the employee's earnings. Right-click in the Date field to choose a date.
As an example, let's say you want to use Sage 50 at the beginning of the 4th quarter:
l

If you were using a computer system and have already printed out reports and statements for the previous periods, you could
enter the balance for each field into one period—say Jan. 1 to Sept. 30. Then enter any pay periods that have occurred after the
start of the quarter to make sure your payroll reports are correct.

l

If you were in the previous situation, you could also enter the first three quarters as three separate pay periods.

l

You could also enter each of the pay periods in the year, but entering all the amounts would be a long and tedious process.

Payroll Field Amounts: Enter the amount for each employee payroll field. You define the payroll fields under the Employee tab
of Employee Defaults. Enter all deductions as negative amounts, and earnings as positive amounts.

Note: You can use the scroll bar at the bottom of the period box to view your periods. Select the scroll button and drag it until you
see the period you want. You can also press the right or left arrow key to move one period at a time right or left.
When you're finished filling in the window, select the Save button.

Enter Employee Beginning Balances
Once you save an employee, but before you post any transactions, you can enter year-to-date earnings and withholdings for the
employee. You can only enter beginning balances for sales reps who are selected as Both (Employee and Sales Rep).

1. Open the Employee Beginning Balances window.
1. Do one of the following:
l
From the Maintain menu, select Employees/Sales Reps.
l
Click the Employees icon on the Payroll Navigation Aid.
Sage 50 displays the Maintain Employees/Sales Reps window.

2. Enter or select the employee ID to display the employee information. If you don't select an employee here, you can select
one on the Employee Beginning Balances window.

3. On the General tab, select the Employee Beginning Balances button. Sage 50 displays the Employee Beginning
Balances window.
2. If you didn't select an employee on the Maintain Employees window, select an employee on the Employee Beginning Balances
window.

3. Set up dates for the balances you're going to enter. You can enter up to 52 dates for paychecks, or you can enter quarterly dates,
so that quarterly reports and W-2s will compute properly.
Beginning balances are available only for Employee fields, not Employer (Company) payroll fields.

4. When you're finished entering the dates, enter balances for each appropriate payroll field, gross pay, deductions, and
allowances.

Note: Deductions must be entered as negative amounts.
5. When you're finished entering the earnings and withholdings, select the Save button.
6. To enter beginning balances for additional employees, select another employee from the list.
7. After you have finished entering and saving the beginning balances, select the Close button to return to the Maintain Employees
Sales Reps window.

General (Employee Defaults)
To set up basic default information for your employees, including custom field names and how employee names display in lists.

Custom Fields
Here, you create the labels for custom fields. The actual data is then entered on each employee record (through Maintain
Employees).
Custom fields lets you record and track any information that you need about employees that is not already in Sage 50. For example,
say you create a custom field called Education in employee defaults. In Maintain Employees, you would enter the actual education
level for each employee (College degree, for example).
Other examples of information you might want to track with custom fields:
l

the employee's spouse's name and place of business

l

the number of children

l

the children's names (Child 1, Child 2, and so on)

l

previous employer and employer's address

l

level of training/education

Display Employee Name With...
You can select whether to sort employees alphabetically by first name or last name in lookup lists and on reports. So, for example,
when you're searching for an employee when creating a paycheck or a W-2 form, the lookup list will be ordered by last name or first
name.

Note: This affects the Name column, which is the second column from the left in lists; it does not affect the ID column.

Pay Info (Maintain Employees/Sales Reps)
To enter information about the employee's pay rates, frequency of pay, and whether the employee is hourly or salaried, select the
Pay Info tab in the Maintain Employees/Sales Reps window. Help me set up a salaried employee.

Fields

Enter Pay Information for a Salaried Employee
When you set up a salaried employee, you have to choose a pay frequency and then enter the salary amounts that will paid to the
employee for each pay period. Follow these steps:

1. From the Maintain menu, select Employees/Sales Reps.
Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the record of the employee you want to set up.
3. Select the Pay Info tab.
4. From the Pay Method drop-down list, select Salary.
5. If this is a Time & Billing employee, enter an hourly billing rate for the employee.
6. From the Frequency drop-down list, select the appropriate pay frequency for the employee. You can choose among the
following:
l

weekly

l

bi-weekly

l

bi-monthly

l

semi-monthly

l

monthly

l

annually

7. You have the option to enter the Hours Per Pay Period that the employee worked. This information is primarily used for reporting
purposes. When you create a paycheck in Payroll Entry for this salary employee, the hours entered will not affect the amount of
the paycheck.

8. In the grid at the center of the window, enter the salary rate for each of the pay levels set up in Employee Defaults. The amounts
you enter should be based on the chosen pay frequency. See the example below.
Salary Rate Example
Say you pay your employee on a semi-monthly basis, and that his salary includes a base salary plus a bonus. You want to
pay the employee a semi-monthly salary of $1,500 and a bonus of $250 every pay period. His total for each pay period would
thus be $1,750.
Because the employee is paid twice monthly, he receives 24 paychecks. His total annual salary would thus be $1,500 + $250
X 24 = $42,000.
At the bottom of the Pay Info tab, you would see the following totals:
Total Semi-monthly Salary: 1,750.00
Annual Salary: 42,000.00
The following table lists the number of pay periods for each of the five available pay frequencies.
Frequency

Pay
Periods

Weekly

52

Bi-weekly

26

Semimonthly

24

Monthly

12

Annually

1

9. Once you've entered the salary rate for the employee, the Salary Total fields at the bottom of the tab will reflect totals for the
chosen pay period and for the year.

Employee Withholding Information
Withholding information identifies how the employee will be taxed during payroll entry. The employee's filing status, allowances, and
additional withholding amounts are maintained for Federal, State and Local payroll fields. This information can be obtained from
the employee's Federal W-4 form and other withholding records. You can establish the percentage of gross pay that the employee
wants to contribute to a 401(k) plan, if appropriate. The Special 1 and Special 2 fields are available if you want to customize your
payroll setup. For example, you can use Special 1 to set up an employee contribution rate for labor union dues. Tell me more
about setting up labor tax or union dues withholding.

Withholding Info (Maintain Employees/Sales Reps)
To enter information about the employee's withholding information (federal and state filing statuses) select the Withholding Info
tab in the Maintain Employees/Sales Reps window.

Enter Employee 401(k) Contribution Rates
Use this procedure to enter the percentage of gross pay that each of your employees wants to contribute to your company's 401(k)
plan.

Note: This procedure assumes you have set up a 401(k) plan using the Payroll Setup Wizard.
1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select an employee who wants to contribute to your company's 401(k) plan. To display a list of existing employees, type
? in the Employee ID field, or select the Lookup button.
3. On the Withholding Info tab, locate the 401K field in the Withholding Information table.
4. Enter the percentage claimed by this employee for 401(k) contributions in the Percentage column. Enter the amount as a
number, for example 4.00 (for 4%).
5. If the employee is eligible for catchup contributions, select Yes in the Catch Up column.
6. Save the employee record.
Repeat this procedure for each employee that participates in your 401(k) plan.

How it works
If you subscribe to a Sage Business Care plan, during payroll entry, the employee's 401(k) contribution will be automatically
calculated and subtracted from gross pay before calculating and deducting federal and state payroll taxes. The employee
contribution amount will be recorded and tracked in the K401 payroll field. If your company matches the employee contributions,
these amounts will be recorded and tracked in the K401_C payroll field.
If you don't subscribe to a Sage Business Care plan , the contribution details are for informational purposes only since payroll
deductions will not be calculated. You will have to manually calculate and enter 401K amounts.

What do you want to do next?
l
Set up other payroll deductions
l
Set up an employee
l
Pay employees
l
Perform other payroll tasks
l

Read the 401(k) overview

Tracking Employee Vacation or Sick Time (Overview)
Vacation and sick time for employees can be set up two ways:
l

Employees earn all their hours at one time (for example, at the beginning of the year).

l

Employees earn a specified number of hours each payroll period that accrues throughout the year.

If you subscribe to a Sage Business Care plan , when employees go on vacation or are sick, the used hours are recorded on their
paychecks and subtracted from their total hours allowed or earned. The remaining hours are tracked throughout the payroll tax
year.
If you don't subscribe to one of the Sage Business Care plans, you can set up the policies for informational purposes, but you will
have to manually calculate vacation and sick time.
To quickly set up vacation-time defaults, sick-time defaults, or both, use the Payroll Setup wizard. You can then set up employee
records with their allotted vacation and sick hours for the payroll tax year. To open the Payroll Setup Wizard, select Maintain ,
Payroll, Payroll Settings. Vacation and sick time are set up under Benefits on the left.

Vacation or Sick Time Cannot Be Set Up
Vacation or sick-time tracking cannot be set up in the Payroll Setup wizard because there is an existing field or fields already set up
in the Employee Fields tab of Employee Defaults. Additionally, the field or fields have been modified from their original default
status. When this is the case, the wizard is unable to modify the existing field or fields. One of two conditions exists:
l
l

A Sick or Vacation field has been set up in the Employee Fields tab.
Fields have been set up to handle accrued, taken, and remaining vacation or sick time. The names of these fields are VAC_
Accrue, VAC_Taken , and VAC_Remain (vacation time) and SICK_Accrue, SICK_Taken, and SICK_Remain (sick
time).

Before the wizard can set up vacation or sick time, you need to change the modified vacation or sick-time fields back to their original
default status:

VAC_Accrue: The default setting is
Calc: checked
l
Memo: checked
l
Run: unchecked
VAC_Taken: The default setting is
l
Calc: unchecked
l
Memo: checked
l
Run: unchecked
VAC_Remain: The default setting is
l
Calc: checked
l
Memo: checked
l
Run: checked
SICK_Accrue: The default setting is
l
Calc: checked
l
Memo: checked
l

l

Run: unchecked

SICK_Taken: The default setting is
l
Calc: unchecked
l
Memo: checked
l
Run: unchecked
SICK_Remain: The default setting is
l
Calc: checked
l
l

Memo: checked
Run: unchecked

Enter Beginning Balances for Employee Vacation and Sick Time
Use this procedure to establish each employee's total vacation (or sick) hours allowed for the payroll tax year. For example, if your
company gives each employee two weeks vacation at the beginning of the payroll tax year, you must enter a beginning balance of
80 hours for each employee.

Note: The procedure below assumes that you chose the Vacation (or sick) time issued in a lump sum option in the Payroll Setup
wizard. .

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select an employee ID. To display a list of existing employees, type ? in the Employee ID field, or select the Lookup
button.

3. On the General tab, select the Beginning Balances button.
4. In the first available column, enter or select the vacation- or sick-time starting date (for example, 1/1/2011).
5. Select the row associated with Vacation or Sick payroll field and enter an amount (for example, 80.0 for 80 hours or two weeks
of vacation or sick time).
Since Vacation is a memo field, it will not reduce the net figure at the bottom of the column chosen.

6. Select the Save button.
7. Enter or select another employee ID and continue entering the beginning balances for each employee.
8. When you have finished entering employee beginning balances, close the window.

Customizable Fields (Employee Defaults)
To set up custom field names for your employee records, select the General tab in the Employee Defaults window. Custom fields
offer you a way to keep track of specific information your business needs. Each business is unique. While we already provide fields
to record most common business data, you probably require other information about your employees from time to time.
Customizable fields let you set up and store that data.
You use the custom fields to set up fields that don't exist on the Employees/Sales Rep window. For example, if you wanted to record
your employees' education levels (such as high school, college degree, graduate degree), you could enter the label for the field as

Education in Employee Defaults. Then, when entering employees (in Maintain Employees/Sales Reps), you would enter their
education levels on the General tab.
Select the Enabled check box to enter or change the field label. If you decide not to use a field, simply clear the Enabled check
box. The data will remain, but it will not be accessible. If you decide you want to use the field label again, check the Enabled box,
and the program will make the data available.
There are three steps to setting up and recording custom fields:

1. Set up and enable custom field names in Employee Defaults.
2. Enter custom field data for each employee record in Maintain Employees/Sales Reps.
3. View and print the data in Payroll reports.
Examples
Custom fields let you use your imagination. What do I really need to know about my employees? Below are examples of employee
custom fields you could set up:
l

the employee's spouse name and place of business

l

the number of children

l

the children's names (Child 1, Child 2, and so on)

l

previous employer and employer's address

l

level of training/education

l

employee benefit plan

Employee Fields (Employee Defaults)
To set up defaults for how Sage 50 handles employee gross pay including any applicable calculations, select the Employee Fields
tab in the Employee Defaults window. This can include various employee deductions and additions.

Important: You must subscribe to a Sage Business Care plan to calculate payroll fields within Sage 50. Otherwise, you will have to
manually calculate your payroll taxes, withholdings, and deductions.

Field Name: Enter the name of the payroll field, or use the defaults.
Warning: Once you start entering payroll transactions, do not change the name of payroll field names or
change the order in which payroll field names are listed. If you change the payroll field "name" setup, earnings reports
and W-2 form information will become inaccurate. Also, it is not recommended to change Fed_Income and other standard payroll
fields names Sage 50 sets up for you. These payroll field names are used in tax calculations if you have signed up for a Sage
Business Care plan.

G/L Account: Account number in general ledger where information entered into this field for this employee is posted. Not
applicable if the Memo check box is selected.
Calculate (Calc): Selecting this check box allows you to select a formula name to use when calculating tax amounts. Formula
names use formulas and (sometimes) tables to calculate tax amounts. If you subscribe to a Sage Business Care plan, formula
names and their formulas are provided, and you will be able to calculate taxes and other deductions in Sage 50.
If you uncheck this box, you will have to manually calculate taxes and enter them on each paycheck. For instructions, see
publications such as the current Circular E document, available on www.irs.gov.

Formula: If you chose to Calculate this field, enter the name of the formula to use (not the Formula ID) without the payroll year.
Type ? to display a list of the currently set-up formulas. (If you choose to set up your own payroll formulas, make sure each formula
entered here corresponds to a formula in User-Maintained Payroll Formulas.)

Amount: If you aren't using a calculation, enter a flat rate here. Positive numbers are earnings and negative numbers are
deductions.

Memo: Select this check box if the information in this field does not affect your company general ledger or financial statements. An
example of this would be tips.

Run: Select this check box to indicate that you don't want the balance to be set to zero when you close the year.
Adjust: If this field can be calculated, select this button to display the Calculate Adjusted Gross window where you can choose which
payroll fields are accumulated to determine the adjusted gross for this calculation. Remember, payroll fields cannot be calculated
unless you subscribe to a Sage Business Care plan.

Company Fields (Employee Defaults)

To set up defaults for how Sage 50 handles employer-paid taxes and contributions, select the Company Fields tab in the
Employee Defaults window. These payroll fields do not impact the net amount of the employee paycheck.

Important: You must subscribe to a Sage Business Care plan to calculate payroll fields within Sage 50. Otherwise, you will have to
manually calculate your payroll taxes, withholdings, and deductions.

Description: Enter the name of the payroll field, or use the defaults.
Warning: Once you start entering payroll transactions, do not change the name of payroll field names or
change the order in which payroll field names are listed. If you change the payroll field "name" setup, earnings reports
and W-2 form information will become inaccurate. Also, we do not recommend changing Fed_Income and other standard payroll
fields names that Sage 50 sets up for you. These payroll field names are used in tax calculations if you subscribe to a Sage
Business Care plan. You can change the order of fields that display on pay checks and the Payroll Entry screen in the Payroll
Settings wizard. But you should not change the order of fields here, in Employee Defaults.

Liability Account: This is the number of the general ledger liability account you want to use. Typically this is employer-paid
payroll tax liability.

Expense Account: This is the number of the expense account you want to use. Typically this is employer-paid payroll tax
expense.

Calculate (Calc): Select this check box if you want Sage 50 to automatically calculate the payroll field amount when computing
paychecks. If you select this check box, you must also select a formula name to use when calculating the amount. You should
uncheck this checkbox if you don't subscribe to a Sage Business Care plan . You must subscribe to one of these plans in order for
payroll fields to be calculated in Sage 50.

Formula: If this field can be calculated, enter the name of the payroll formula to use (not the Formula ID) without the payroll year.
Type ? to see a list of formulas. You must subscribe to a Sage Business Care plan for this field to be calculated.
Memo: Select this check box if the information in this field does not affect your company general ledger or financial statements. An
example of this would be if you need to track the cost of health care insurance without posting entries to the General Ledger.

Adjust: If this field can be calculated, select this button to display the Calculate Adjusted Gross window where you can choose which
payroll fields are accumulated to determine the adjusted gross for this calculation. You must subscribe to a Sage Business Care plan
for this field to be calculated.

Performance Reviews
This feature is available only in Sage 50 Complete Accounting and higher.
To enter or view the performance review history for an employee, select the Performance Reviews button on the Pay Info tab
of the Maintain Employees/Sales Reps window. The Performance Reviews window appears. The Performance Reviews window
allows you to view, add, edit, and delete performance review information for the selected employee.

Next Review Date: Use this date as a reminder of when the next review for this employee should take place. The date will appear
in red if it has already passed.
You can enter up to 40 review entries for each employee. Simply, enter new review information in the first line of the grid.

Date: Enter the date of the review in this field. It is automatically populated with the current date, but you can change it if
necessary.
Rating: If your company uses performance ratings, select the rating that the employee received on the review. Select Customize
ratings to enter or change the performance ratings that your company uses. These ratings are maintained on the Review Ratings
tab of Employee Defaults.

Reviewer: This field is automatically populated with the name of the employee's supervisor. The supervisor is specified on the
Additional Info tab of the Maintain Employees/Sales Reps window. You can select a different reviewer if necessary.
Notes: Enter any notes about the review. You can hold the mouse over the notes field to view the entire note after you have entered
it. If you need to enter more notes than will fit in the notes field, you could enter the notes in Microsoft Word or Notepad and then
attach the file to the review.

Attachments: You can add attachments to each review entry. If an entry has an attachment added, you will see a View/Edit link
instead of the Add link. You can add multiple attachments to each review entry.

Enter Employee Performance Review Information

This feature is available only in Sage 50 Complete Accounting and higher.
You can attach review information to each employee record. You can have up to 40 review entries for each employee. You can also
add attachments to each review record.
To enter review information for an employee:

1.
2.
3.
4.
5.
6.

From the Maintain menu, select Employees/Sales Reps.
On the Maintain Employees/Sales Reps window, select the employee whose review information you want to enter.
On the Pay Info tab, select the Performance Reviews button.
Enter the review information on the first line of the grid.
Enter the review date, if different from the current date, in the Date field.
In the Rating field, select the rating the employee received on his or her review if your company uses ratings.

Note: If you don't have ratings set up or you need to change the ratings, click the Customize ratings link. When you are
finished entering the ratings, you can return to the Performance Reviews screen and continue entering the review information.

7. In the Reviewer field, select the employee who conducted the review, if necessary. If the employee has a supervisor entered on
the Additional Info tab, that supervisor will automatically appear in the Reviewer field. You can select a different employee as
the reviewer if you need to.

8. Enter any notes about the review in the Notes field. After you enter the notes, you can move the mouse over the notes field to
see the entire note.

Tip: If you want to add a note that is too large to fit in the Notes field, you can enter the note in Microsoft Word or Notepad and
then add the file as an attachment to the review entry.

9. If you want to add an attachment to the review, you can do this from the link in the Attachments field. Click the Add link to add
an attachment to a review that doesn't have any attachments. Click the View/Edit link to view or edit an attachment for the
review or to add another attachment for the review. You can have multiple attachments for each review entry.

10. If you want to keep track of when the next review for this employee should take place, you can enter the date in the Next
Review Date field. The date in this field will be red when the date has passed.
11. When you have completed all of the review information, click Save to save the review information and return to the Maintain
Employees/Sales Reps window.

Raise History
This feature is available only in Sage 50 Premium Accounting and higher.
To enter the compensation history for an employee record, select the Raise History button on the Pay Info tab of the Maintain
Employees/Sales Reps window. The Raise History window appears. The Raise History window allows you to view, add, edit, and
delete compensation information for the selected employee.
You can enter compensation information for each employee and edit it at any time—it does not affect the employee's pay rate. The
Raise History window is for informational purposes only. To make the pay rate effective on actual payroll calculations, rate changes
must be entered on the Pay Info tab.
The toolbar at the top of the window contains the following buttons: Cancel, OK, Row, and Help.

Raise Date: Enter or select the date of the pay raise. You can enter the date manually, or choose a date by clicking the calendar
button. (The calendar appears when you place your cursor in the Raise Date field.)

Applicable Rate: From the drop-down list, select the pay rate to which you want to apply the raise. (For example, Regular or
Overtime pay.) Note: The Applicable Rate drop-down list includes pay rates that have associated general ledger accounts, and pay
rates that have previously been used in the Raise History table.

Base Amount: When you choose a pay rate from the Applicable Rate drop-down list, its associated rate appears in the Base
Amount field. The Base Amount is then combined with the amount of the raise to calculate the New Amount.

Raise Amount: You can enter a specific amount for the raise in the Raise Amount field. Note: If you enter the employee's raise as
a percentage instead, the amount will still be calculated and will appear in the Raise Amount field.

Raise Percentage: You can enter a specific percentage for the raise in the Raise Percentage field. Note: If you enter the
employee's raise as an amount instead, the percentage will still be calculated and will appear in the Raise Percentage field.

New Amount: After selecting the applicable rate and entering the amount or percentage of the raise, the total of the base amount
plus the raise appears in the New Amount field.

Notes: Select the Note button to enter or display a comment.
When you're finished filling in the window, select the OK button.
What do you want to do next?
Enter the raise history for an employee
l
Perform other payroll tasks
l
Read the employee setup overview
l

Enter Employee Raise History Information
This feature is available only in Sage 50 Premium Accounting and higher.
Use the following procedure to enter an employee's compensation history.
Note: The Raise History window is for memo purposes only. To make changes to actual payroll calculations, you must enter the
rate changes on the Pay Info tab.

1.
2.
3.
4.
5.

From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
Enter or select the employee record for which you want to enter raise history information.
On the Pay Info tab, select the Raise History button. Sage 50 displays the Raise History window.
To add a new row of information, click the Row button, and then select Add from the drop-down button list.
Enter the date of the raise in the Raise Date field. You can enter the date manually, or choose a date by clicking the calendar
button. (The calendar appears when you place your cursor in the Raise Date field.)

6. From the Applicable Rate drop-down list, select the pay rate to which you want to apply the raise. (For example, Regular pay.)
When you select the applicable rate from the list, its associated pay rate appears in the Base Amount field. You can edit the
amount in the Base Amount field, if necessary.
7. Next, enter a raise amount, or a raise percentage. If you want to enter a specific raise amount, enter it in the Raise Amount
field. If you want to enter the raise as a percentage, enter it in the Raise Percentage field.
Note: Regardless of whether you enter the raise as an amount or percentage, both figures are calculated and entered in the
appropriate fields. For example, let's say your employee's base amount is $10 an hour, and you enter 5 in the Raise
Percentage field to give the employee a 5% raise. When you enter the percentage and move to another field, the raise
amount (50 cents) is calculated for you and entered in the Raise Amount field. Likewise, if you enter the raise as an amount
(.50 ), the percentage will be calculated and entered in the Raise Percentage field for you.
8. After entering the amount or percentage of the raise, press Enter (or move to another field). The employee's base amount is
combined with the amount of the raise, and the new pay rate appears in the New Amount field. Using the example above, if the
base amount is $10 and a 5% (or 50 cent) raise is entered, the employee's new pay rate of $10.50 appears in the New Amount
field.

9. If you want to enter a note about the compensation information, click the Note button in the far right of the row.
10. When you're finished entering the raise history information, click OK to close the window and return to the Maintain
Employees/Sales Reps window.

Fringe Benefits
Many companies provide employment benefits to their employees. These benefits, known as fringe benefits, are a form of payment
made to employees for services provided. Examples of fringe benefits include the following:
l

car allowances

l

use of a car

l

free airplane flights

l

discounts on property or services

l

country club memberships

l

sporting event tickets

Usually, the value of fringe benefits is included in an employee’s gross income. You can easily tailor Sage 50’s payroll setup to
handle your employee fringe benefit needs.
For example, the value of an employee’s use of a car provided by an employer must be included in the employee’s gross income.
The value of the personal use of the car is subject to federal and other taxes.
Before you close your payroll tax year, you must set up the personal use of the car as a fringe benefit in Sage 50, and enter the
value of the use of the car as income so that your W-2s and other year-end reports are correct.
Setting up fringe benefits involves the following steps:

1.
2.
3.
4.

Establish the fringe benefit as default information.
Include the fringe benefit amount in the adjusted gross for tax calculations.
Assign the fringe benefit field for W-2s and other forms.
Include the fringe benefit amount in payroll entry.

Note: Consult your tax accountant or the IRS for rules and information regarding the value of fringe benefits.

Set Up Fringe Benefits
Fringe benefits are a form of payment made to employees for services provided. Some examples of fringe benefits are car
allowances, country club memberships, and so on. Tell me more about fringe benefits.
Click the headings below to expand and display the respective procedures.

Note: Consult your tax accountant or the IRS for rules and information regarding the value of fringe benefits.
Step 1: Establish the Fringe Benefit as Default Information
For Sage 50 to recognize the fringe benefit, its name must be set up in Employee Defaults.

1. From the Maintain menu, select Default Information and then Employees from the submenu.
Sage 50 displays the Employee Defaults window.

2. Select the Employee Fields tab.
3. In the first blank line of the Field Name column, type a description of the fringe benefit. Never replace an existing field.
Note: The description can be a maximum of 11 characters. For example, if the fringe benefit entails an employee’s use of a car,
you might type “AUTO” in the first Field Name column.

4. Select the Memo check box to indicate that the information in this field will not affect your company’s General Ledger or financial
statements, but will be included in payroll reporting.

5. Continue to the next section. Do not click OK.
Step 2: Include the Fringe Benefit Amount in the Adjusted Gross for Tax Calculations
After the fringe benefit has been defined, you need to identify it as a taxable addition to income.

1. On the Fed_Income line, click the Adjust button.
Sage 50 displays the Calculate Adjusted Gross window.

2. Select the benefit Use check box. For our example, you would select the AUTO check box.
Sage 50 adds the fringe benefit amount to the adjusted gross before it calculates the federal withholding.

3. Select OK.
4. Repeat the steps in this section for any other tax on the Employee Fields and Company Fields tabs where the fringe benefit
amount will be added to the adjusted gross before the tax is collected.

Note: You may need to repeat these steps for Social Security and Medicare taxes, and your state’s withholding taxes. Consult with
your accountant about which taxes you need to adjust.

5. Click OK to save the default information.
Step 3: Assign the Fringe Benefit Field for W-2s and Other Forms
To ensure that the fringe benefit prints in the proper place on the employee’s W-2, you must assign the field to the proper box on the
W-2.

Note: This information is also used for corresponding amounts on other forms such as Federal Form 941, so follow these steps
even if you don’t print W-2s.

1. From the Maintain menu, select Payroll and then Payroll Settings.
2. In the left navigation area, click on Taxes and then Assign Tax Fields.
3. Click the button for W-2 Fields.
Sage 50 displays the Assign Payroll Fields for W-2s window.

3. The fringe benefit should be assigned to either Box 12 or 14, depending on the type of benefit. See your accountant or the IRS for
more information.

4. Click on the drop-down arrow in Box 12 or 14 to open the list. Select the fringe benefit that you set up. For our example, select
AUTO from the list.

5. Click OK to save the changes. Then click Finish in the Payroll Settings wizard.
Step 4: Include the Fringe Benefit Amount in Payroll Entry
To record the value of the fringe benefit as income so that your year-end reporting will be correct, include the benefit in the
employee’s next paycheck.

1. From the Tasks menu, select Payroll Entry.
Sage 50 displays the Payroll Entry window.

2. Enter or select the employee ID from the lookup list.
3. In the list of fields on the right (Taxes, Benefits, Liabilities) scroll down and select the fringe benefit. In our example, scroll down
to the AUTO field.

4. Enter the value of the fringe benefit in the Amount field. For our example, enter the value of the personal use of the AUTO as
a positive number.
Consult your tax accountant or the IRS for rules and information regarding the value of fringe benefits.
Adding the amount does not increase the net check because the fringe benefit is set up as a memo field used for tracking
purposes only. However, your federal income tax amount will increase because the benefit is an addition to gross income.
If the total gross does not cover the additional taxes, enter part of the value on this check. Then enter the remaining amount on
subsequent checks until the entire amount is posted to payroll.
If you have to add the total gross to one check, enter the value of the benefit in the Employee Beginning Balance window. This
includes the value of the benefit in the total gross wages on the W-2 and other payroll reports. It does not, however, adjust the
federal taxes. Consult your accountant for information on the appropriate tax treatment of the fringe benefit taxes.

5. Enter all payroll information as necessary and then select Post, Save, or Print.
6. Select Close when you are finished.
How it works:
Add the value of the use of the car to the employee’s payroll entry so it is included as income on the employee’s next paycheck. The
AUTO line with its associated value is printed on the employee’s paycheck.
Since the fringe benefit is set up as a memo payroll field, it does not appear on your General Ledger, but it is included in payroll
recording.
If you have subscribed to a (missing or bad snippet), the fringe benefit amount is added to the employee's adjusted gross during
payroll entry. This assures proper calculations of withholdings and taxable gross reporting on payroll tax forms, including the
employee’s W-2.

Adjusting benefit rates/amounts by employee
Sometimes when you add a benefit (either in Payroll Settings or Employee Defaults), there is just one standard amount or
percentage for all employees. For example, maybe everyone gets 40 hours of sick time per year, with no exceptions. For these
cases, your work is done once you've set them up.
But sometimes, you have one or more employees with unique situations. Maybe each employee selects a different rate for a benefit-as with 401K's, for example. Here's how to handle any employee-specific rates or amounts.

1. First, set up the default or standard rules for the benefit in the Payroll Settings wizard or (sometimes) Employee Defaults.
2. From the Maintain menu, select Employees/Sales Reps.

You would want to fill in the information on the General, Additional Info, and Pay Info tabs if you haven't already. In this topic,
we're concerned with what you might need to do for added benefits.

The Withholding Info tab--Employee contributions for retirement plans and most flexible spending accounts (FSA's) are
entered on the Withholding Info tab of Maintain Employees.
Just find the cell for the benefit you're adjusting and enter the percentage or FSA amount. You can enter catchup amounts for
qualifying retirement plans.

The Vacation/Sick Time tab--Uncheck the This employee uses the company default settings... box to edit
vacation or sick time information for this employee.

The Employee Fields tab--Health Savings Accounts (HSA's), insurance plans, and some customized benefits may need to be
added on the Employee Fields tab of Maintain Employees.
l
l

Uncheck the box Use Defaults beside the benefit you're adjusting.
Make any changes, including entering the Amount per pay period that should be deducted for the benefit. (To enter an
amount, the Calculated box must be unchecked.)

The Company Fields tab--If there is a company-paid portion of the benefit, it is normally a set percentage or amount that
gets established in the Payroll Settings wizard or in the payroll formula. However, if there are exceptions, you can enter them
here by unchecking the Use Defaults box.

Pay Employees
We recommend that you subscribe to one of the Sage Business Care plans and install the latest tax service update. Otherwise,
you will have to manually calculate and enter your payroll taxes and other deductions.
There are two ways to print payroll checks: individually and in a batch.

To pay a single employee and print a check
Select Tasks, then Payroll Entry.
Then select the area of the window you want help for.
Enter the Employee ID
Select the employee you want to pay using the lookup. Once you select an employee, Sage 50 will enter that employee's
address information, as well as enter their default pay (based on settings on the Pay Info tab of Maintain Employees).
Deductions will be calculated and displayed immediately if you have subscribed to a (missing or bad snippet).
Enter Check Date, Account #, Pay Period Ending

1. Enter or select the paycheck date for this payroll period.
2. Select a cash account from which to write the paycheck (for example, Payroll Checking).
Leave the check number blank. Otherwise, Sage 50 assumes you wrote a manual check and will not print a check. If you
print a check with a check number already assigned, the word "Duplicate" prints on the check.

3. Enter the Pay Period ending date.
Modify earnings information

1. If necessary, change the employee's hours or salary amounts for the pay period. This would include adding overtime hours
or bonus pay. Hours entered for salary employees is for reporting purposes and will not affect the amount of the check.

2. The default G/L payroll accounts that Sage 50 uses for each payroll field are based on the employee's defaults. To change the
account ID, click in the field to display the lookup; then click the lookup and select another account.

Note: If you have the Hide General Ledger Accounts global option activated, Sage 50 will not display G/L Account fields in
this window. To modify G/L accounts used for this transaction, you must select the Journal button.

3. If the selected employee is set up for direct deposit, select the Direct Deposit check box to create a direct deposit payroll
transaction and print a non-negotiable advice form notifying that a deposit has been made to the employee's account(s). .

Tip: To check the number of bank accounts set up to receive direct deposit allocations for the employee and the percentage
and amount of each allocation, select the Allocation Percent button.
Modify pay information (hours worked, deduction amounts)

If necessary, enter or change payroll field amounts. This would include entering vacation or sick hours taken by the employee
during the pay period.
If you do not subscribe to a Sage Business Care plan, you will need to enter your payroll taxes and deductions.
Save and print the check
When you're finished filling out the check information, select the Print button to print the check. How do I print a check from

the Payroll Entry window?
If the employee is a direct deposit employee, once you save the payroll transaction you are ready to sync it for processing by
the employee's financial institution.

Note: To ensure the accuracy of the information you will be syncing, you should always print the Direct Deposit Pre-Sync
report before you sync either pre-notes or direct deposit payroll transactions.

To pay a group of employees and print checks
From the Tasks menu, choose Select for Payroll Entry. Sage 50 displays the Select Employees--Filter Section window.
Select the section of the process you want help for.
Make filter selections

1. Select the pay frequencies, pay types, and the range of employees for whom you want to print checks.
2. Click OK. Sage 50 displays the Select Employees to Pay window, where you can edit individual paychecks for hours,
amounts, and pay frequencies (number of weeks).
If an employee is set up with the Hourly-Time Ticket Hours pay method (possible only in Sage 50 Complete
Accounting and Sage 50 Premium Accounting), an asterisk (*) appears next to the employee's name in the Select
Employees to Pay list (for example, *Steve W. Austin). The total hours displayed represent the total number of unused
time ticket durations recorded during the selected payroll period.

3. You can enter the date you want on the checks, the pay period ending date, and the cash account number from which you
want the checks to be paid.
Modify pay information (hours worked, deductions, applying to jobs)

1. Select the Pay check box next to the employees you want paid.
l
To select all Pay check boxes, click the All (Select) button.
l
To clear all Pay check boxes, click the All (None) button.
l

Select the Detail button to edit the account, amount, and hours for salaried employees, as well as the amount and the hours
worked for hourly employees.
If you do not subscribe to a Sage Business Care plan, you will need to click the Detail button to enter payroll taxes and
other deductions for each check.

l

Select the Report button to print a "pre-check" register that lists all payments that you have currently selected in the
window. In other words, this is a list of employee paychecks that will be printed when you click the Print button. You can use
this preview report to examine paycheck detail, approve selected employee checks, and prepare the check order before
the checks are actually printed and posted.

2. If an employee is set up for direct deposit, select the DD check box to create a direct deposit payroll transaction and print a
non-negotiable advice form notifying that a deposit has been made to the employee's account(s).

3. After making your selections, select the Print button. How do I print checks from the Select Employees to Pay window?
If you are paying direct deposit employees, once you close the window you are ready to sync the payroll transactions for
processing by the employees' direct deposit financial institutions.

Note: To ensure the accuracy of the information you will be syncing, you should always print the Direct Deposit Pre-Sync
report before you sync either pre-notes or direct deposit payroll transactions.

Payroll Entry
Use the Payroll Entry window (access from the Tasks menu) to create paychecks to print for individual employees. All entries made
here are posted both to general ledger and the employee record. This information for the selected employees is pulled from the
employee records, the payroll formulas, and employee defaults.

Note: You must subscribe to a Sage Business Care plan to have access to payroll formulas and to have payroll taxes and other
deductions calculated within Sage 50. If you don't subscribe, you will have to manually calculate and enter payroll taxes and other
deductions on your paychecks.

I got an error that says I've exceeded the number of employees that my payroll solution allows me to pay. Why did I get this
error and what should I do?
Your payroll subscription limits the number of employees that you can pay per month. For example, you may be subscribed to a
Sage Business Care plan that allows you to pay 50 employees per month. This means that during each calendar month you can
pay up to 50 employees as many times as you want to.
You have received this error because paying this employee will exceed the limit. You can only pay an employee that has already
been paid this month. Otherwise, you will need to upgrade your Sage Business Care plan or monthly subscription to allow you to
pay more employees.
To see which employees have been paid this month, you can view the Payroll Check Register. To do this, go to the Employees
& Payroll Navigation Center and click the Reports navigation aid. Double-click Payroll Check Register in the list of
Payroll reports. You can filter this report by different dates by selecting Options.
To see if you are subscribed to a Sage Business Care plan, go to Help>About Sage 50 Accounting.

Learn More
Do you want to pay a single employee or more than one?
If you want to pay a single employee, you've come to the right place. The Payroll Entry window lets you enter pay information
and print a paycheck for one employee at a time. (You pay a group of employees using the Select for Payroll Entry option on
the Tasks menu.) Also, if you have already issued payroll but want a historical record of the payment, use the Payroll Entry
window to enter manual paychecks covering the transaction.

Pay Employees
Enter Manual Paychecks
Are jobs or time-ticket hours involved in this payroll entry?
If your employee's hours need to be applied to a job, you can do that in the Payroll Entry window. You can tell Sage 50 the hours
and type of work (such as salaried or commission) that the employee did on the job. If the employee enters time-tickets for
Time & Billing projects, you can create a paycheck that reflects time-ticket hours worked.

Apply Payroll Expenses to a Job
Pay Employees Using Time-Ticket Hours
Printing and previewing paychecks
Sage 50 gives you the opportunity to review the information that will appear on forms before you print them. The Print button
in the toolbar of Payroll Entry gives you two options: Select Preview to look over a paycheck before printing; when you're
ready, select Print for a hard copy of the check.

Preview Forms Before Printing
Print a Form from a Task Window
Voiding a paycheck
Sometimes you need to void a paycheck. You'll be able to do this for any paychecks that have been posted but not cleared with
the bank. To void a paycheck:

1. Display it in the window.
2. Select the Delete button.
3. From the drop-down options, select Void.
Void a Paycheck
Recalculating the cash balance in Payroll Entry
If you see the word Uncalculated in the Balance field of the window, then the Recalculate cash balance automatically
in Receipts and Payments in Maintain Global Options is currently not selected. However, you can manually update cash
balance; click the link to find out how.

Why does Sage 50 print "duplicate" on my check when I know it isn't a duplicate?
Sage 50 will print "duplicate" on the check if a Check Number has already been assigned to the check, either because it was printed
before or because the Check Number field on the Payroll Entry window was filled in prior to printing. On the Payroll Entry window

l
l

Complete the Check Number field ONLY if the check was printed outside of Sage 50, such as by hand.
Leave the Check Number field blank if you plan to print the paycheck you are entering. Sage 50 will automatically assign
the next check number when you click Print and it will not print "duplicate" on the check.

Add an Attachment
You can attach files, such as Word or Excel documents, to a payroll entry.

Record Cash and Charge Tip Income During Payroll Entry
Use this procedure during payroll entry to enter cash and credit card tip income. It is important that you enter the gross pay
information first (number of hours worked or salary amount). Then, you need to enter your tip information. This way the Tip and
CCTips income will properly adjust from the gross pay.

Note: This procedure assumes you have already set up cash and charge tips payroll fields.
1. After selecting the employee ID during payroll entry, enter the number of hours worked or salary for the current payroll period.
2. Enter the credit card tips paid in the CCTips payroll field.
3. Enter the cash tips amount that the employee is reporting in the Tips payroll field.
Payroll taxes will adjust to include the combined tip income if you have subscribed to a (missing or bad snippet). However, the gross
pay amount does not change. The W2Tips payroll field should reflect the total of CCTips and Tips.

Note: If you have not subscribed to a (missing or bad snippet), you will have to manually adjust your payroll taxes. You may have
to adjust the W2Tips field as well.

Recording Charge Tips vs. Cash Tips
Some employers may handle charge tips differently from cash tips. Employers must distribute employee tips paid by customer
charge cards. You may want charge tips to be reported separately from cash tips to account for income the employer distributes to
the employee.
If this is the case, you must modify the tip reporting procedure. You must create two employee payroll fields: Tips (a memo field)
and CCTips (a non-memo field—see below). Tips, along with CCTips, must be included in the adjusted gross. If using both charge
tips and cash tips, you must set up a third employee payroll field called W2Tips. The W2Tips payroll field will add the Tips and
CCTips payroll fields together for W-2 purposes. Finally, you will associate Box 7 on the W-2 form with the new W2Tips payroll
field.

Note: If you are going to separate the cash and charge tip payroll fields, we recommend that you enter this information at the
beginning of the payroll tax year. This way the employee's W-2 form will accurately reflect the annual total of tip income (charge
and cash). It is not recommended that you change the tip reporting procedures in the middle of the payroll tax year because the
W-2 reporting will change (use a new field in Box 7) and not reflect an accurate annual tip income.

Setting up the charge tips payroll field
1. Set up the cash tips and credit card tips employee payroll fields.
2. Set up a formula that adds cash and charge tips together.
3. Set up a combined tips employee payroll field and apply the total tips formula to it.
Note: You must subscribe to a Sage Business Care plan in order to set up and use payroll formulas. If you do not subscribe, you
can set up the payroll field, but you will have to manually calculate your payroll taxes and deductions. You also will not be able to
print W-2s from within Sage 50.

What do you want to do next?

Record When Employees Use Vacation or Sick Time
Use this procedure during payroll entry to record hours used for vacation or sick time.

Note: The procedure below assumes that you have set up vacation- and/or sick-time defaults using the Payroll Setup wizard.

1. While entering payroll transactions, locate the Vacation or Sick payroll fields.
2. Enter the amount of time taken in either the VAC_Taken or SICK_Taken fields. Sage 50 will calculate the remaining hours and
update them on the paycheck if you have subscribed to a (missing or bad snippet).
For example, if the employee used one day of vacation, enter 8.0 in the VAC_Taken payroll field. The employee's paycheck
stub and earnings report reflect something similar to the following:

This
Check:

YTD

VAC_
Accrue

3.08

15.40

VAC_
Taken

8.0

8.0

-5.08

7.40

VAC_
Remain

In this example, the employee earns 3.08 vacation hours every two weeks (totaling 80 hours per year). The employee has
accrued 15.40 hours to date and used 8 hours during this payroll period. Therefore, the employee has 7.40 vacation hours
remaining.

Note: The VAC_Remain payroll field reflects only what is remaining in the current payroll period.
You must subscribe to one of the Sage Business Care plans in order for vacation to time be calculated within Sage 50.
Otherwise, you must calculate and keep up with vacation time manually.

Select for Payroll Entry
Use this to help you group the employees you want to pay by certain criteria in a batch. For example, you can select to pay only
those employees who are salaried. Or, you can pay only those employees who get paid weekly.

Windows
Select Employees to Pay
What do you want to do next?
l
Pay employees
l
Enter manual paychecks
l
Preview check forms before printing them

Select Employees to Pay
This window allows you to pay employees in a batch or group. If you selected the wrong batch or group of employees, you can
return to the filter window by choosing the Select button on the toolbar at the top of the window.
l

l

Select the Detail button to display the Paycheck Detail window for the employee. If you don't subscribe to a Sage Business Care
plan you will need to do this to enter the taxes and other deductions for each employee's check.
To print a "pre-check" register that lists all payments that you have currently selected in the window, click the drop-down arrow
next to the Print button, and then select the Report option. The pre-check register is a list of employee paychecks that will be
printed when you select the Print button. You can use this preview report to examine paycheck detail, approve selected
employee checks, and prepare the check order before the checks are actually printed and posted.

Note: If you select Close on this window, no paychecks will be printed or posted. You will lose all the selections you just made.
I got an error that says I've exceeded the number of employees that my payroll solution allows me to pay. Why did I get this
error and what should I do?
Your payroll subscription limits the number of employees that you can pay per month. For example, you may be subscribed to a
Sage Business Care plan that allows you to pay 50 employees per month. This means that during each calendar month you can
pay up to 50 employees as many times as you want to.

You have received this error because the employees you have selected to pay exceed the limit. You can either select fewer
employees or select employees that have already been paid this month. Otherwise, you will need to upgrade your (missing or
bad snippet).
To see which employees have been paid this month, you can view the Payroll Check Register. To do this, go to the Employees
& Payroll Navigation Center and click the Reports navigation aid. Double-click Payroll Check Register in the list of
Payroll reports. You can filter this report by different dates by selecting Options.
To see if you are subscribed to a Sage Business Care plan, go to Help>About Sage 50 Accounting.

Learn More
Do you want to pay a single employee or more than one?
If you want to pay a number of employees, you've come to the right place. The Select Employees to Pay window, together with
the Select Employees--Filter Selection window, lets you select a group of employees for payment and then create paychecks for
the group.
You pay a single employee using the Payroll Entry option on the Tasks menu. In Payroll Entry, you can also enter manual
paychecks for a historical record of previously written payroll checks.

Pay employees
Enter manual paychecks
Is your company set up for automatic calculation of payroll taxes?
If you just installed Sage 50, federal, state, and most local payroll taxes will not calculate automatically for you during payroll
entry. (In some cases, payroll tax amounts will be inaccurate or zero.) You must subscribe to a Sage Business Care plan and
install the latest tax update in order to have payroll taxes and other deductions calculated within Sage 50. Otherwise, you will
have to manually calculate and enter payroll taxes and other deductions on each paycheck.

Are time-ticket hours or jobs involved in this payroll entry?
If an employee is set up with the Hourly-Time Ticket Hours pay method (possible only in Sage 50 Complete Accounting and
Sage 50 Premium Accounting), then an asterisk (*) appears next to the employee's name in the Select Employees to Pay
list (for example, *Steve W. Austen). The total hours worked displays the total number of time ticket durations for each
employee recorded during the selected payroll period that have not been used to create paychecks.
If you need to apply an employee's salary to a specific job or jobs, select the Jobs button, and then fill in the information to
apply hours worked and payroll amounts to those jobs.

Apply payroll expenses to jobs
Printing and previewing paychecks
Sage 50 gives you the opportunity to review the information that will appear on forms before you print them. The Print button
in the toolbar of Payroll Entry gives you two options: Select Preview to look over a paycheck before printing; when you're
ready, select Print for a hard copy of the check.

Preview Forms Before Printing
Print a Form from a Task Window
Recalculating the cash balance in Select Employees to Pay
If you see the word Uncalculated in the Balance field of the window, then the Recalculate cash balance automatically
in Receipts and Payments in Maintain Global Options is currently not selected.

Enter Manual Paychecks
Manual paychecks are paychecks that will not be calculated within Sage 50. If you have historical payroll that needs to be recorded
(the employees have already been paid), you would enter manual paychecks. If you do not subscribe to a Sage Business Care plan,
you will have to manually enter your paychecks.

1. From the Tasks menu, select Payroll Entry. Sage 50 displays the Payroll Entry window.
2. Select the employee you want to pay. To display a list of existing employees, type ? in the Employee ID field, or select the
Lookup button.

3. When filling out the check, enter the check number if this check has already been printed or if you don't want to print this check
from Sage 50.

4. Make sure the distributions are calculated correctly if you are creating a new paycheck or entered correctly if you are recording a
paycheck that has already been paid.

5. Select Save when you're finished to record the transaction and update the employee file.

Direct Deposit (Maintain Employees/Sales Reps)
Select the Direct Deposit tab in the Maintain Employees/Sales Reps window to set up direct deposit accounts for your employees
as indicated on the Employee Authorization Agreement. You can set up as many as four separate bank accounts for each direct
deposit employee. Then you enter the percentage or fixed dollar amount of net pay that you want to distribute to each of the chosen
accounts.
For each account you set up, you enter the appropriate information in the fields that appear in the grid opposite the appropriate
Account field (that is, Account 1, 2, 3, or 4).

How do I set up direct deposit accounts for an employee?

Sign Up for the Sage 50 Direct Deposit Service
Sage Direct Deposit gives your company the flexibility of depositing payroll funds directly into participating employees' chosen bank
accounts. Using the WebSync wizard, you quickly and easily request approval of direct deposit for your company and synchronize
direct deposit payroll transactions with your company bank and your direct deposit employees' financial institutions.

To sign up for the Sage 50 Direct Deposit service, go to http://na.sage.com/us/sage-50-accounting .
What do you want to do next?
Learn more about Sage 50 Direct Deposit
l
Read the company direct deposit setup overview
l

Setting Up Direct Deposit for Your Company
As a method of paying employees, direct deposit has distinct advantages over traditional paychecks and is widely preferred by both
employers and employees. Among the advantages are that direct deposit
l

reduces the time spent processing and reconciling traditional paychecks

l

eliminates the need for check cashing services, which cost employees additional money and effort

l

reduces the time employees take to cash or deposit their checks, even at conventional banks

l

is flexible, because employees can choose more than one account into which funds are deposited

Funds are available on payday; the employee doesn't need to wait for the check to clear or wait in bank lines thereafter. What's
more, since funds are deposited directly into employees' bank accounts, cash shows up in the account even if the employees are
sick or on vacation, and the risk of stolen or misplaced paychecks is totally eliminated. Finally, record keeping is improved for the
employee, since the employer can issue a non-negotiable notice of direct deposit complete with an earnings statement.
Sage's direct deposit function was designed so that payroll is handled essentially as it's always been: You pay direct deposit
employees using the customary Payroll Entry and Select Employees to Pay windows. And setting up your company and employees
for direct deposit is easy as well; the setup process is brief and uses the automated WebSync wizard to streamline direct deposit
approval for your company.

Direct Deposit Setup—A Bird's Eye View
The following steps outline the process of setting up direct deposit for your company and employees.

1. Your company signs up with Sage for direct deposit, and Sage issues an authorization code. Next, using this code, you set up
direct deposit account information for your company. Once you save this information, Sage automatically creates a pre-note, a
zero-sum transaction used to verify the accuracy of your company's direct deposit account information.

2. Each employee who wants direct deposit should next fill out an Employee Authorization Agreement. The Agreement includes
information about the bank account(s) into which the employee's payroll funds will be deposited. You enter this account
information in the Maintain Employees/Sales Reps window. You also specify what percentage of the employee's paycheck to
allocate to each of the direct deposit accounts. When you save account information for an employee, the software automatically
creates an employee pre-note.

3. Using the Direct Deposit Confirmation window of the wizard, you synchronize both the company and employee pre-notes. They
are transmitted to Sage via ACH, a special network that connects financial institutions. Sage, in turn, sends the company pre-note

information to your company's financial institution for approval. Sage sends the employee pre-note information to your
employees' financial institutions for approval. In both cases, the approval process takes five banking days.

4. Following approval, use the WebSync wizard to sync the approval status to your Sage 50 desktop application. At the same time,
download a record of payment of the fee that is charged for processing pre-notes. This record appears as a general journal entry
in Sage 50.
Once you have received approval of all company and employee pre-notes, you are ready to process paychecks for direct deposit
employees.

Set Up a Direct Deposit Employee
Use the Direct Deposit tab of the Maintain Employees/Sales Reps window to set up direct deposit information for an enrolled
employee. You can establish as many as four direct deposit accounts to which the employee's payroll funds will be distributed. Follow
these steps:

1. From the Maintain menu, select Employees/Sales Reps.
2. In the Maintain Employees/Sales Reps window, use the Employee ID field to enter or select the ID of the employee you want to
set up.

3. Select the Direct Deposit tab.
4. Set up Account 1 first. In the Account Type field opposite Account 1 , use the drop-down list to choose the proper type, either
checking or savings.

5. In the Routing/Transit Number and Bank Acct Number fields, enter these two account identification numbers as supplied
by the employee on the Employee Authorization Agreement.

6. In the Allocation Method field, use the drop-down list to choose among Amount, Percent, or Remainder.
Important Note: When you set up accounts for an employee, you should set them up in the order in which you would like
deductions made from the employee's net pay. Sage 50 always allocates funds to direct deposit accounts in the order in which
they were set up. Therefore, when you set up an Amount account, in some cases there may not be enough net pay left to
distribute to this account if it is one of the last accounts to be set up.
For example, say you've set up Accounts 1 and 2 as Percent accounts, Account 3 as an Amount account, and Account 4 as a
Remainder account. You set up the accounts so that Sage 50 distributes 70 percent to Account 1, 20 percent to Account 2, and
a fixed amount of $300 dollars to Account 3. Say that net pay for the employee in a given pay period is $700. Sage 50 would
distribute 70% x $700 = $490 to Account 1 and 20% x $700 = $140 to Account 2, leaving only $70 to be distributed to Accounts
3 and 4—meaning a shortfall of $230 for Account 3.
Note that you can use the Up and Down arrow buttons to easily move an Amount account higher up in the list of direct deposit
accounts.

7. Do one of the following:
l

l

If you've chosen the Percent allocation method, in the % (Percentage) field, enter the percentage of employee net pay that
you want to distribute to Account 1. If you choose to distribute to only one account, enter 100%. Sage 50 keeps a running total
in the Total Distributed field at the bottom of the window.
If you've chosen the Amount allocation method, in the Fixed Dollar Amount field, enter the dollar amount of employee net
pay that you want to distribute to Account 1. Sage 50 keeps a running total in the Total Distributed field at the bottom of the
window.

8. If you want to set up additional accounts, set them up in order following steps 4 through 7.
9. When finished, select Save. A message appears telling you that a pre-note will be created for approval of direct deposit for this
employee. Click OK to dismiss the message.
You get approval by synchronizing the pre-note through the WebSync wizard. Approval can take up to six banking business
days. Until you sync the note, the Pre-Note Status field opposite the appropriate account will read "Not Sent." Once the note is
synced, the field will indicate that approval is "Pending." When the note is approved and approval notification synced to the Sage
50 desktop, the field will read "Approved." .

Note: To ensure the accuracy of the information you'll be syncing, you should always print the Direct Deposit Pre-Sync report
before you sync either pre-notes or direct deposit payroll transactions.

10. Repeat steps 2 through 8 for each additional direct deposit employee you want to set up.

Prepare Quarterly Payroll Reports
The quarterly reports you might want to print are the Quarterly Earnings report, the Employer Tax reports, and Quarterly 941 forms.

Note: Some payroll reports and forms are only available if you subscribe to a Sage Business Care plan .
What do you want to do next?
Print Quarterly Earnings report
l
Print Quarterly Employer Payroll Tax reports
l
Pay employees
l
Perform other payroll tasks
l
Perform other report, form, and financial statement tasks
l
Review payroll year-end procedures
l

Print Quarterly Earnings Report
The Quarterly Earnings report displays all paycheck information for each employee with subtotals for the selected quarter of the
calendar year. Each payroll field is displayed with totals. These totals are included in the 941 Worksheet, W-2, and other payroll tax
forms if you subscribe to a Sage Business Care plan .

To print the Quarterly Earnings report
1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Quarterly Earnings report. Then, select the Print button. Sage 50 displays the Filter window.
To display the current report on the screen, double-click the report in the report list. To display a quarterly report for an alternate
quarter, select the Options button.

3. Accept the default filter or choose which quarter to print in the Date drop-down list. Then, select OK twice to begin printing the
report.

What do you want to do next?
Print Yearly Earnings report
l
Print Quarterly Employer Payroll Tax reports
l
Print Payroll Exception report to correct differences between calculated withholdings and actual withholdings
l
Perform other payroll tasks
l
Perform other report, form, and financial statement tasks
l
Review payroll year-end procedures
l

Print Quarterly Employer Payroll Tax Reports
Note: You must subscribe to a Sage Business Care plan in order to print this report.
The Payroll Tax report displays each employee's gross pay, taxable (adjusted) gross, and the amount of tax levied for a specified
type of payroll deduction (FICA, FUTA, Medicare, and so on). This report is mainly used for employer payroll taxes (for example,
state unemployment). Using the information on this form, you can prepare (most) state payroll tax forms.

To print the employer tax reports
1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Payroll Tax report. Then, select the Print button or the Preview button to display the report. Sage 50
displays the Filter window.
If you double-click the report in the report list, it displays on the screen instantly. To change the payroll tax, select the Options
button.

3. Enter or select the tax ID of the payroll tax you want the report to appear.
Note: Only tax tables with Taxable_Gross in their formulas appear in this list.
4. Accept the default or choose which quarter to print. Then, select OK twice to begin printing the report.

Prepare Annual Payroll Reports
The annual payroll reports you might want to print include the exception report, the yearly earnings report, the 940 EZ form,
employee W-2 forms, and the company W-3 form.

Note: Some payroll reports and forms are only available if you subscribe to a Sage Business Care plan .

Print Payroll Exception Report to Correct Differences between Calculated Withholdings
and Actual Withholdings
Note: You must subscribe to a Sage Business Care plan in order to print this report.
The Payroll Exception report is intended to help you identify and correct employee records that reflect incorrect withholdings.
Incorrect withholdings are often the result of manually calculated paychecks that were figured incorrectly. Also, Sage 50 may make
a rounding error in some cases (usually by a penny). This report shows the actual amount withheld (as entered in Sage 50) as
opposed to the calculated amount withheld.
This report filters differently from other reports. First, you need to select Tax to Check from the drop-down list. This lists all
Employee and Employer payroll fields that use taxable (adjusted) gross in its formula. Additional filters you can select are Employee
ID, Employee Type, and whether the employees are active or inactive.

To print or display the Payroll Exception report
1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Exception report. Then, select the Print button to print the report or the Preview button to display the
report.
Sage 50 displays the Filter window.

3. In the Tax to check box, enter or select the ID of the payroll tax you want to check.
4. Accept the default or choose which quarter to print. Then, select OK to begin displaying or printing the report.
For the tax selected and quarter filtered, the default Exception report displays the following information:
l

Employee ID, Employee Name, Social Security Number, State: employee information found in the General Tab of
Maintain Employees window

l
l
l
l
l

Quarter: the quarter in which the payroll exception took place
Taxable Gross: total taxable gross amount for the quarter
Amount Withheld: total amount actually withheld of filtered payroll field
Calculated Amount: total amount of payroll field recalculated
Difference: the net change from Amount Withheld and Calculated Amount

To adjust payroll taxes using the Exception report
You can elect to have Sage 50 make correcting entries for you. We recommend you first not make corrections and simply display
the report to examine the differences.

5. Once you are comfortable with the differences, select the Prepare Correcting Entries check box in the Filter window.
If the report is displayed on the screen, select the Options button to display the Filter window.

Note: If you use the batch method of posting, and you decide to check the Prepare Correcting Entries box, make sure you
post Payroll before you continue.

6. Next, choose the tax to adjust to from the drop-down list.
This lists all Employee payroll fields available (even if they do not use a calculation). Notice that you cannot adjust to an Employer
payroll field.

7. Select the quarter for which the adjustment will need to be calculated and entered.
8. Optionally select additional filters such as Employee ID, Employee Type, and whether the employees are active or inactive.
9. Select OK to accept the filter and make the correcting entries.
The report will appear just as it did without selecting Prepare Correcting Entries. However, Sage 50 made general ledger
entries in the background adjusting the taxes you selected. You can examine these entries by selecting Payroll Entry from the

Tasks menu. Then, select the List toolbar button. Sage 50 displays an entry for the employee who is being adjusted. The
Reference Number will be something like "ExceptAdj." If there is an error, you can simply delete the transactions.

Print Yearly Earnings Report
The Yearly Earnings report displays all paycheck information for each employee with subtotals for each quarter of the payroll tax
year. Each payroll field is displayed with quarterly and annual totals. These totals are included in the 941 Worksheet, W-2, and other
payroll tax forms if you subscribe to a Sage Business Care plan .

To print the Yearly Earnings report
1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Yearly Earnings report. Then, select the Print button. Sage 50 displays the print Options window.
To display the report on the screen, double-click the report in the report list.

3. In the Options window, accept the default filter (This Year) or choose which quarter to print in the Date drop-down list. Then,
select OK twice to begin printing the report.

PR02_HDI
Adding or Editing a Payroll Tax
Most payroll taxes are supported by our Sage Business Care plans. However, if you need to add a state or local tax that is not
supported, follow these basic steps.

Note: You must subscribe to one of the Sage Business Care plans in order to add or edit payroll taxes in Sage 50
Step 1: Set up the tax payroll field
1. Contact your state or local taxing authority to make sure you have the latest rates and regulations for the tax you're adding or
changing.

2. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

3. Select the Employee or Company Fields tab, depending on who pays for this tax.
4. On a blank line, enter a name for the new payroll field. Enter or select a G/L account (liability) associated with the deduction. To
display a list of existing accounts, type ? in this field or select the Lookup button. To add a new account, type + or double-click the
field, which displays the Maintain Chart of Accounts window.

5. Select an expense account in the same way.
6. Select a formula for your new payroll field. You can enter a new formula if necessary; you will define the formula in a later step.
7. Select OK to establish the payroll field.
Step 2: Set up the payroll formula
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter a Formula ID. For example, a local Ohio income tax might be named OHLIT. If an OHLIT formula ID already exists, enter
OHLIT2.
3. Enter a tax name using the NAME[space]YEAR rule. For example, enter OHLIT 11 , where 11 is the current payroll year (2011).
4. The effect on Gross Pay is usually Subtracts from Gross.
5. Select the Filing Status that applies for this tax.
6. Select Tax as the formula classification.
7. The Tax Agency can be federal, state, or local. If it's state or locality, then you must select the state or locality.
Formula: Sage 50 has a very powerful engine for defining and calculating payroll amounts. Because of the flexibility and power
of the payroll formula commands, this is one of the more complex areas of Sage 50. We recommend that you look at examples of
payroll formulas that are similar to the ones you are trying to create. Sage 50's sample company--Bellwether Cleaning Services-is a good source for examples of formulas. Keep in mind, however, that changes to tax laws may cause the sample formulas to be
inaccurate; they are just examples.
If you need to create a new formula for your new tax field, click here for Help on creating a formula.

If this tax applies to some employees but not all (for example, an employee in a different state), you must bring up those employee
records and make sure the field is applied to that employee. (Use the Company Fields tab of the Maintain Employees window.)

Additional State Withholdings
In some cases, employees may request additional tax withholdings. Sage 50 supports state additional withholdings. In the Maintain
Employees/Sales Reps window, enter the additional amount in the Additional Withholding field of the Withholding Information
table, on the Withholding Info tab. During payroll entry, if you created your own formulas in User-maintained Formulas, please
remember to subtract additional withholding by using the EMP_STATE_NUMBER in your formula. .
If you subscribe to one of the Sage Business Care plans, additional withholding is automatically included in the tax calculations
provided as part of the service.
You must subscribe to Sage Business Care in order to use and set up payroll formulas in Sage 50.
For more detailed instructions on your state, select File, Payroll Formulas, Sage-Maintained. Select the appropriate tax
formula (for example, XXSIT 02 where XX is your 2 character state code). Please read the instructions in the Formula box at the
bottom of the screen.

Note: If you do not subscribe to a Sage Business Care plan , the Additional State Withholding amount will be used for
informational purposes only. Payroll calculations and access to payroll formulas within Sage 50 are only available when you
subscribe to one of the Sage Business Care plans.

What do you want to do next?
Set up additional state withholdings
l
Set up other payroll deductions
l
Perform other payroll tasks
l
Read the payroll setup overview
l

Add Pay Period Begin Date to Check Stubs
To add pay period begin dates to your payroll check stubs, you can use the form designer window.

Step
1.
2.
3.

1: Open the payroll check in Design Mode
From the Reports & Forms menu, select Forms, Payroll Checks.
In the Select a Report or Form window, select the check you want to modify from the Forms list.
Select the Customize button located below the sample image on the Select a Report or Form window to display the window
where you can design forms.

Step 2: Add the Pay Period Begin Date
1.
On the left of the Forms Design window, select the Add button and then select Data from Sage 50.
Select OK on the Add Data Confirmation dialog, if it appears. The Add Field dialog should appear.
Note: If you do not see the Add button on the Forms Design window, select the Options menu and then select Object
toolbar.

2. On the Add Field dialog, select Date Fields from the Field Type drop-down list. Then select Pay Period Begin Date
from the Field Name list. Click OK.
Note: There are three pay period begin date formats: short (9/7/12), medium (Sept. 7, 2012), and long (September 7, 2012).
Select the same format as the Pay Period End Date. To check the end date format, double-click the data field adjacent to Pay Period
End Date on your check stub. The Data Field Options window for that field opens and displays the format.

3. On the left of the Forms Design window, select the Add button and then select Text.
Select OK on the Add Text Confirmation dialog, if it appears.
4.
Type Pay Period Beginning: in the Text field and click out of the field. Position this field to the left of the
Pay Period Begin Date data field you added earlier.

Note: You will probably want to rearrange some of the existing fields to make room for the Pay Period Begin Date. To

do so, select the field with your mouse and drag it to its new position.

5. When you are finished designing the check, select Save, and then Close to exit the window.
You will probably want to print a sample check to see how everything lines up. To do so, select the check, and click
Customize. Select the Print button and then select Print from the drop-down menu. Click OK to print a sample check.

Bonus or Commission for Hourly Employees
Some companies offer a bonus or commission amount on employee paychecks. These are examples of lump-sum earnings. Other
examples of lump-sum earnings include retroactive pay, jury duty, maternity leave, and so on.
Salaried employees will simply use a pay level titled Bonus (or some other lump-sum earning pay level). In this case, just enter the
appropriate dollar amount in these pay levels during payroll entry.
However, hourly employee pay levels are based on time (hours), not a fixed amount. Since you cannot have both an hourly and
salary pay level on the same paycheck, this must be set up in another way.
There are two methods by which to accomplish this:
l

Create an hourly pay level with a rate of $1.00 per hour

l

Set up a lump-sum earnings payroll field for hourly employees

What do you want to do next?
Create an hourly pay level with a rate of $1.00 per hour
l
Set up a lump-sum earnings payroll field for hourly employees
l
Set up other payroll deductions
l
Perform other payroll tasks
l
Read the payroll setup overview
l

Change an Employee ID
Use this procedure to change an existing employee ID.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee ID you want to change. To display a list of existing employees, type ? in the Employee ID field, or
select the Lookup button.

3. Select the Change ID button on the window toolbar. Sage 50 displays the Change Employee ID window.
4. Enter the new ID that you want to use instead of the current ID.
5. When you are finished, select OK to change the ID and return to the Maintain Employees/Sales Reps window.
When you change an employee ID, all data records and transactions associated with this employee will reflect the new ID. This
includes both current and past transactions.

Note: This feature is useful if you want to change the way you identify data records. For example, suppose you currently use the
employee name as the employee ID. However, as your business and your staff both grow, it becomes necessary to use a scheme
that is more definitive than the employee name. Consequently, you decide to begin using the employee social security number as
the identifier. You can easily change this information using the Change ID option.

What do you want to do next?
Enter employee beginning balances
l
Enter employee 401(k) contribution rates
l
Set up common payroll deductions
l

l
l
l
l

Pay employees
Perform other payroll tasks
Read the employee setup overview
Read the payroll setup overview

Setting Up Common Payroll Deductions

Below is a list of examples you can follow to set up or track common payroll fields and deductions.
l
l
l
l
l
l
l
l
l
l
l
l

Set up a company 401(k) plan and track contributions
Track employee vacation or sick time
Record employee tips
Set up group health payroll deductions
Set up fringe benefits
Set up bonus or commission fields for hourly employees
Set up local payroll taxes
Set up multiple state withholdings
Track employee loan or advance
Set up labor tax or union dues deductions
Set up an employee garnishment
Set up Federal Earned Income Credit

Employee Garnishment
An employee garnishment can be set up a number of ways depending on your state requirements. Some garnishments are simply
percentages of adjusted gross. They can also be set up as a set percentage of the remaining net of the paycheck after taxes. Check
with your accountant on the proper method of calculating a garnishment in your area.
There are three steps to this procedure:

1. Set up the garnishment formula.
2. Set up the garnishment employee payroll field.
3. Apply the garnishment formula to the garnishment employee payroll field.
Note: If you do not subscribe to one of the Sage Business Care plansyou cannot set up or use payroll formulas within Sage 50.
You can still set up the garnishment employee payroll field, but you will have to manually enter the garnishment amount on the
paycheck.

Employee Loan or Advance
Typically when employers issue an employee advance, they deduct payments from their paychecks (possibly in installments). This
can be accomplished easily with Sage 50 if you subscribe to a Sage Business Care plan.
These are the two methods for setting up an employee loan or advance:
l

Employee loan paid back in automatic installments

l

Employee advance paid back in manual installments

Note: Whichever method you choose, you should consider setting up a loan repayment policy that sets an automatic minimum
repayment level for loans over a certain amount. For example, for all loans over $200.00, $50.00 is automatically deducted from
the employee's subsequent paychecks until the loan is repaid.) That way, you are certain to be repaid in a timely manner.

How Do I: Employees and Payroll
Setup and Maintain
Set up an employee
l
Set up a sales representative
l

l
l
l
l
l
l

Enter employee beginning balances
Enter employee performance review information
Enter employee raise history information
Change an employee ID
Set up a direct deposit employee
Update the employer state unemployment (SUI ER) formula to a new payroll tax year

Common Payroll Deductions
Set up a company 401(k) plan and track contributions
l
Track employee vacation or sick time
l
Record employee tips
l
Set up group health payroll deductions
l
Set up bonus or commission fields for hourly employees
l
Set up local payroll taxes
l
Set up multiple state withholdings
l
Track employee loans or advances
l
Set up labor tax or union dues deductions
l
Set up employee garnishment
l
Set up federal earned income credit
l
Set up fringe benefits
l

Tasks
Pay employees

l
l
l
l
l
l
l
l

Pay employees using time-ticket hours
Enter manual paychecks
Preview check forms before printing them
Preview paychecks
Apply payroll expenses to a job
Select and view payroll tax forms
Print employee mailing labels

Quarterly Payroll Procedures
l
Print Quarterly Earnings report
l
Print Quarterly Employer Payroll Tax reports
Year-End Payroll Procedures
l
Payroll year-end procedures (checklist)
l
Print Payroll Exception report to correct differences between calculated withholdings and actual withholdings
l
Print Yearly Earnings report
l
Print vendor 1099 forms
l
Close the payroll tax year

Labor Tax or Union Dues
In some cases you may have to set up an employee deduction that calculates the total hours worked and multiplies it by a specified
dollar rate or percentage. Common occurrences of this are labor and industry taxes, workers compensation taxes, and union dues.
Typically employees are required to pay an amount equal to their hours worked multiplied by a designated rate. The Washington
Industrial Insurance Tax is a good example of this type of payroll deduction.

Washington Industrial Insurance Tax
The Washington Industrial Insurance Act provides for three funds to be maintained for the benefit of employees working in the state
of Washington. The three funds are the Accident Fund, the Medical Aid Fund, and the Supplemental Pension Fund. The Department of
Labor and Industries periodically sends each employer a rate notice that specifies the employer and employee contribution rates for
these funds.

Note: The Sage 50 labor tax example demonstrates one method for using the Special 1 or Special 2 payroll fields within the
Withholding Information table of the Maintain Employees/Sales Reps window.
Use this example to set up similar employee deductions that your company may need.
There are three steps to this procedure:

1. Set up the labor payroll formulas.
2. Set up the employee labor payroll field.
3. Apply the appropriate labor formula to each employee's setup.
Note: You must subscribe to one of the Sage Business Care plansfor payroll taxes and deductions to be calculated within Sage 50.
What do you want to do next?
l
Set up the labor tax
l
Set up other payroll deductions
l
Set up an employee
l
Perform other payroll tasks
l
Read the payroll setup overview

Multiple State Withholdings
Many companies have employees who live outside the state in which they work. For example, if your business is located in Chicago,
you may have an employee who lives in Illinois, Indiana, or Wisconsin. Sage 50 uses the State field in the Withholding Information
table of the Maintain Employees/Sales Reps window to take advantage of the possibilities of multi-state companies. Most businesses
are typically required to pay only the state unemployment tax (SUI) in the state in which the company actually resides. Therefore,
we must adapt the state SUI ER formula to look at all state/localities and not just the one in which the company resides.
There are three steps to this procedure:
l

Modify the SUI formula to accept all states

l

Modify the SUI employer payroll field to accept all states

l

Verify each employee's individual state withholding information

Note: You must subscribe to one of the Sage Business Care plans in order to modify payroll formulas and to have withholdings
calculated within Sage 50.

Paying Your Employees - Overviews and Procedures
Setting up
l
l
l

Employees

Sales representatives
Enter employee beginning balances

Creating Common Payroll Deductions
l
l
l
l
l
l
l
l
l
l
l
l

Company 401(k) plan and track contributions
Track employee vacation or sick time
Record employee tips
Group health payroll deductions
Bonus or commission fields for hourly employees
Local payroll taxes
Multiple state withholdings
Employee loans or advances
Labor tax or union dues deductions
Employee garnishment
Federal earned income credit
Fringe benefits

Tasks

l
l
l
l

Pay employees
Pay employees using time-ticket hours
Enter manual paychecks
Apply payroll expenses to a job

Set Up a Tips Payroll Field (Manually)
If you selected Yes to recording tips when initially setting up payroll, Sage 50 automatically creates a Tips employee payroll field. If
you do not have a Tips payroll field, you can set one up manually.

Create the tips payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter Tips as the name of the new payroll field.
4.

If tip income is not paid directly to the employee on paychecks, select the Memo check box.
Memo fields log tips for reporting and tax calculations, but do not post an entry to the general ledger.

5.

Do not select the Calculate (Calc) check box. Employee tip earnings are added manually during payroll entry.
Now, you must add the Tips field to the taxable income for employee taxes such as: Fed_Income, Soc_Sec, Medicare, and
State.

6. Select Fed_Income (the default Federal Withholding payroll field), or any other tax field for which employee tip earnings
are required in computing taxable income.

7.

Select the Adjust button. Sage 50 displays the Calculate Adjusted Gross window. Make sure the Tips check box is selected,
as well as Gross.
Tips will be added to the gross pay when computing taxable wages. This ensures proper calculation of withholding as well as
proper taxable gross reporting on payroll tax forms.

Note: You must subscribe to one of the Sage Business Care plans for withholdings to be calculated within Sage 50.
8.

Do this for each applicable EE and ER field.
For example, select Soc_Sec (the default Social Security payroll tax) next. Then, select the Adjust button and add tips to
adjusted gross. Continue to do this for each employee payroll tax field and for each employer payroll tax field that needs to
be adjusted to include tip income.

9. Select OK to establish the payroll field.
Update W-2 Form
1. From the Maintain menu, select Payroll and then Payroll Settings.
2. In the left navigation area, click on Taxes and then Assign Tax Fields.
3. Select the W-2 Fields button. Sage 50 displays the Assign Tax Fields for W-2s window.
4. In the Allocated Tips field, enter or select the Tips payroll field from the list.
5. Select OK. Then, select Finish to close the Payroll Settings window.

Federal Earned Income Credit
If you have an employee who qualifies for Federal Earned Income Credit (FEIC), you can set up Sage 50 to make these types of
payments during payroll entry.
FEIC is a government program that allows eligible low-income individuals or families to receive a refund of a portion of their federal
income tax liability on each paycheck. To qualify for the credit on each paycheck, the employee must have a qualifying child and fill
out the Federal Form W-5. Married couples with a qualifying child are entitled to submit a W-5 form for each spouse (if both are
employed). If only one of the married persons is employed, that employee may file a single W-5 form for the family.

If you subscribe to a Sage Business Care plan, you receive multiple FEIC calculations based on marital status, working
status of each spouse, and who files the W-5 form. Read the instructions in the Formula box of the formula to make sure you select
the correct calculation for each employee's situation.

If you do not subscribe to a Sage Business Care plan, you will still set up the payroll field, but you'll have to manually
compute and enter the amount on the employee's paycheck.
There may be up to three steps to this procedure:

1. Set up the FEIC employee payroll field.
2. Apply the FEIC Sage-maintained formula to the FEIC employee payroll field if you subscribe to a Sage Business Care plan.
What do you want to do next?

Local Payroll Taxes
Many areas have a local income tax in addition to state or federal withholdings. If you let Sage 50 set up your payroll and you did not
copy payroll information from another company, you have the opportunity to set this up in Initial Payroll Field Setup. You are asked
to name the default locality, if there is one for your area, and the known percentage taxed. After leaving this window, Sage 50
creates a Local employee payroll field. It also creates a XXLIT formula in user-maintained payroll formulas (where XX is your postal
two-letter state abbreviation). Some special LIT calculations are already included in Sage-Maintained Payroll Formulas. These
include localities in Colorado, Delaware, Missouri, and New York. If your locality is not in one of these states, then Sage 50 will create
a tax formula for you. This will be a generic calculation based on the percentage entered in Initial Payroll Field Setup.
If you skipped this step in the Initial Payroll Field Setup, or copied payroll setup from another company, you may have to create the
employee payroll field, create the tax formula, or both on your own. If you have more than one locality, you will have to create a tax
formula for each area. These tables should be created in User-Maintained Payroll Formulas.

Note: If your company is located in the states of Alabama, Indiana, Kentucky, Michigan, Ohio, or Pennsylvania, and your locality's
income tax has exemptions or a maximum tax, the local formula we created for you may be incomplete. Refer to Sage 50 Online
Help "Special Localities" for special instructions on modifying the generic formula created to match these requirements.
To set up a local tax payroll field

1. Set up the local employee payroll field.
2. Set up the local formula.
3. Enter the employee locality and apply the local formula.
Note: You must subscribe to one of the Sage Business Care plans to have access to the payroll formulas and to have payroll
taxes calculated within Sage 50. Otherwise, you can set up the payroll field, but you will have to manually calculate and enter the
tax amount on the checks.

What do you want to do next?
Set up a local payroll tax

l

Print Employee Mailing Labels
1. From the Reports & Forms menu, select Forms, then Employee Labels and Letters. Sage 50 displays the Select a Report
or Form window.

2. The available forms for printing employee labels and letters will appear in the Forms list. Sage 50 comes with two predefined
employee mailing label forms. How do I purchase label forms?
l
Employee Labels 3x10: Prints mailing labels for employees in a standard 3x10-label format.
l
Employee Labels 1x10: Prints mailing labels for all your employees in one continuous column.
3. Double-click the form you want to print. Sage 50 displays the Filter window.
4. Choose to sort the employee labels by employee ID or employee name.
You can print mailing labels for all or a range of employees.

5. When finished selecting filter options, select OK.
Insert your blank label forms into your printer.

6. The default printer appears in the Print dialog. If you want to print to a different printer, select it from the Name drop-down list.
Otherwise, select OK to begin printing the labels.

Set Up Additional State Withholdings

In some cases, employees may request additional tax withholdings. Sage 50 supports state additional withholdings. In the Maintain
Employees/Sales Reps window, enter the additional amount in the State Additional Withholding field of the Withholding
Information table, on the Withholding Info tab. During payroll entry, if you created your own formulas in User-Maintained Payroll
Formulas, please remember to subtract additional withholding by using the EMP_STATE_NUMBER variable in your formula.
You must subscribe to Sage Business Care in order to use and set up payroll formulas in Sage 50.
If you subscribe, additional withholding is automatically included in the tax calculations provided as part of the service.
You can also see more detailed instructions on your state by selecting File, Payroll Formulas, Sage-Maintained. Select the
appropriate tax formula (for example, XXSIT 02 where XX is your 2 character state code). Please read the instructions in the
Formula box at the bottom of the screen. If you are not a Sage 50 tax subscriber, check with your state Department of Labor or your
accountant for special instructions.

Note: If you do not subscribe to a Sage Business Care plan , the Additional State Withholding amount will be used for
informational purposes only. Payroll calculations and access to payroll formulas within Sage 50 are only available when you
subscribe to one of the Sage Business Care plans.

Set Up and Track 401(k) Contributions (Manual Procedures)
This procedure is intended only for those who set up 401(k) payroll fields and contributions in a previous version of the product and
need to update their plans.

Important: If you have not set up a 401(k) plan and want to add one, do not follow this procedure; use the Payroll Setup wizard.
If you used the Payroll Setup wizard to set up your 401(k) plan, continue using the wizard when you want to update your plan.
If you choose to set up your company's 401(k) plan using the Payroll Setup wizard, employee and employer tax adjustments are
made for you automatically based on your state and locality. 401(k) payroll fields and formulas are also automatically updated as
part of a (missing or bad snippet), again only if you used the Payroll Setup wizard.

401(k) Payroll Field Example
The example below explains how to manually set up (or update) a 401(k) employee payroll field and tax calculation. If your
company matches these contributions, you will use the same procedure, but you will use a company or employer payroll field and
ER calculation.
While some steps may be optional, there can be up to seven steps to this procedure. Click any of the following headings to display its
corresponding procedure.

Note: You must subscribe to one of the Sage Business Care plans in order to calculate 401(k) amounts and access payroll
formulas within Sage 50Otherwise, you can set up the 401(k) payroll field, but you will have to manually calculate and enter the
amounts on paychecks.

Step 1: Set up the 401(k) employee payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter K401 as the name of the new payroll field. (Payroll fields must start with an alpha character.)
When you initially set up payroll, you were asked if you had a 401(k) plan. If you answered Yes, then K401 is already included as
the first payroll field.

4. Enter or select a G/L account (liability) associated with the deduction. To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.

5. Select OK to save the new field.
In the above step, we created the deduction payroll field. Since this field is a calculated one, it requires that a formula be set up.

Step 2: Set up the employee 401(k) formula
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window

2. Enter a tax ID. For example, enter 401K EE.

3. Enter a tax name using the NAME[space]YEAR rule. For example, enter 401K EE 10 , where 10 is the current payroll tax year
(2010).

4. Leave Filing Status at All Statuses. Clear the Appears in Payroll Tax Report Menus check box.
5. Select Local as the government type.
6. In the Formula box, enter the following: (To create a new line in the formula, press CTRL+J.)

"This 401(k) Employee contribution looks at the amount entered in the Maintain Employees
401K% field when calculating the percentage of gross wages to be deducted up to the
current Federal 401(k) limit of $16,500.00."
LIMIT=16500.00; "Current Federal 401(k) Contribution Limit."
A=EMP_401K_NUMBER%*ADJUSTED_GROSS;
B=-YTD(K401)+K401;
C=A-((A+B)-LIMIT);
D=IF((A+B)<LIMIT,A,C);
ANSWER=-D
This formula first looks at the current year-to-date total of the payroll field K401 to see if it is under the limit of $16,500 (the
federal limit as of 2010). If it is, then the formula sets the calculation as the Adjusted Gross times the information stored in the
EMP 401K_NUMBER field, divided by 100. As we will see next, this % field is located in the Maintain Employees/Sales Reps
window. There, we will enter the percentage each employee claims for 401(k) contributions.
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

7. Save the new formula.
Step 3: Apply the employee 401(k) formula to the employee 401(k) payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. For the K401 payroll field, select the Calculate (Calc) check box.
4. Next, enter or select the tax name that was set up in the previous step (401K EE).
This is neither a Memo nor Run field, so skip to the Adjust button.
5. Select the Adjust button to set the Adjusted Gross for this payroll field. Sage 50 displays the Calculate Adjusted Gross window.
6. Make sure the Gross check box is selected, then click OK.
In most cases, Gross is the only payroll field necessary for calculating 401(k). Check with your accountant if you are not sure
about your situation.
The next step continues in this section.

Step 4: Set up the adjusted gross and W-2 assignments
Use this procedure to define 401(k) contributions as pre-tax deductions and record the contributions on employee W-2 forms.

1. Select the Fed_Income payroll field on the Employee Fields tab of the Employee Defaults window. This is the default federal
withholding payroll field.

2. Select the Adjust button. Sage 50 displays the Calculate Adjusted Gross window.
3. Make sure the K401 check box is selected as well as Gross. Then, select OK to return to the Employee Defaults window.
Since K401 is a deduction (entered as a negative item), it will be subtracted from Gross in computing taxable wages (adjusted
gross). This ensures proper calculation of withholding as well as proper taxable gross reporting on payroll tax forms.

4. If 401(k) contributions can be deducted from gross pay prior to calculating your state's income tax, select the State payroll field
next. Click the Adjust button and include K401 in the Adjusted Gross. Then, select OK.
5. Continue to do this for each Employee payroll tax field and Employer payroll tax field that needs to be adjusted to include 401(k)
contributions. After making your adjustments, select the OK button to return to the Employee Defaults window.
Check with your accountant if you are not sure about your situation.

Note: If you choose to set up your company's 401(k) plan using the Payroll Setup wizard, these adjustments are made for you
automatically based on your state and locality. The payroll fields and formulas are also automatically updated as part of a
(missing or bad snippet), if you used the Payroll Setup wizard. Learn more about Sage Business Care.

6. Select OK to establish the payroll field.
7. Open the Employee Defaults window once again and select the General tab.
8. Select the W-2s arrow button beneath the Assign Payroll Fields for section. Sage 50 displays the Assign Payroll Fields for W2s window.

9. In the second column, select the first field (above box 13), enter or select the K401 payroll field. In the Code box, type D.
10. Select OK to close the W-2 window. Then, select OK again to save the employee default changes.
Step 5: Enter the employee 401(k) contribution rate
Use this procedure to enter the percentage of gross pay that each of your employees wants to contribute to your company's 401(k)
plan.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select an employee that wants to contribute to your company's 401(k) plan. To display a list of existing employees, type
? in the Employee ID field, or select the Lookup button.
3. On the Withholding Info tab, locate the 401K % field in the Withholding Information table.
4. Enter the percentage claimed by this employee for 401(k) contributions in the Additional Withholding column. Enter the
amount as a number, for example 4.00 (for 4%).
This field represents the EMP_401K_NUMBER identifier in the tax table formula.

5. Save the employee record.
Repeat this section for each employee that participates in your 401(k) plan.

Step 6: Set up the employer 401(k) formula
If your company elects to match the employee 401(k) contribution, then you must also set up an employer payroll field and formula.
Use this procedure to set up the employer formula.

1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter a formula ID. For example, enter 401K ER.
3. Enter a tax name using the NAME[space]YEAR rule. For example, enter 401K ER 10 , where 10 is the current payroll tax year
(2010).

4. Leave Filing Status at All Statuses. Clear the Appears in Payroll Tax Report Menus check box.
5. Select Local as the government type.
6. In the Formula box, enter the following:
Scenario A
If the employer matches exactly the employee contributions no matter what percentage the employee uses, then you would use
the following formula: (To create a new line in the formula, press CTRL+J.)

"This 401(k) Employer contribution matches the Employee 401k contribution dollar for
dollar regardless of 401(k) percentage entered in the employee Withholding Information
table."
ANSWER=K401
This formula uses the identical amount calculated in the K401 field on the Employee fields tab. It will only work if you have set up
the employee contribution (K401) previously discussed in this example.
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

Scenario B
If the employer matches the employee contribution up to a maximum percentage, then use the following formula: (To create a
new line in the formula, press CTRL+J.)

"This 401(k) employer contribution looks at the amount entered in the Maintain Employees
401K% field when calculating the percentage of gross wages to be deducted up to the
current Federal 401(k) limit of $16,500.00. This formula assumes the employer will match
dollar for dollar up to 4% of the adjusted gross; 50% for amounts higher than 4%, and a
matching cap of 6%."
LIMIT=16500.00; "The value specified by the user for the 401K limit fields."
A=50.00; "ER contribution % over the breakpoint % of EE contributions"
B=100.00; "ER contribution % up to the breakpoint % of EE contributions"
C=4.00; "EE contribution % breakpoint"
D=6.00; "ER maximum contribution %"
Z=EMP_401K_NUMBER%;
E=-YTD(K401)+K401;
F=IF(Z>(C%),B%*C%*ADJUSTED_GROSS,B%*Z*ADJUSTED_GROSS);
G=IF(Z>(C%),A%*ADJUSTED_GROSS*(Z-(C%)),0);
H=D%*ADJUSTED_GROSS;
I=F+G;
J=IF(H=0,I,IF(H<I,H,I));
K=E+J;
ANSWER=-IF(E>LIMIT,0,IF(K<LIMIT,J,LIMIT-E))
Adjust the percentage limits according to your company's matching offer.
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

Step 7: Set up the employer 401(k) payroll field and apply the employer 401(k) formula to it
1. From the Maintain menu, select Default Information , then choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employer Fields tab.
3. On a blank line, enter K401 ER as the name of the new payroll field. (Payroll fields must start with an alpha character.)
4. Enter or select both G/L accounts (liability and employer tax expense). To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.

5. Select the Calculated check box.
6. Next, enter the tax name that was set up in the previous step (401K ER).
7. Select the Adjust button to set the Adjusted Gross for this payroll field. Sage 50 displays the Calculate Adjusted Gross window.
In most cases, Gross is the only payroll field necessary for calculating 401(k). Check with your accountant if you are not sure
about your situation.

8. Make sure that the Gross check box is selected, then select OK.
9. Select OK to save the new employer payroll field.
Tip: Expand all the headings above and print this Help topic to use as a 401(k) setup checklist.
How it works
If you subscribe to one of the Sage Business Care plans, during payroll entry, the employee's 401(k) contribution will be
automatically calculated and subtracted from gross pay before calculating and deducting federal and state payroll taxes. The
employee contribution amount will be recorded and tracked in the K401 EE payroll field. If your company matches the employee
contributions, these amounts will be recorded and tracked in the K401 ER payroll field.
If you don't subscribe to a Sage Business Care plan , the contribution details are for informational purposes only since payroll
deductions will not be calculated. You will have to manually calculate and enter 401K amounts.

What do you want to do next?
Set up a company 401(k) plan (using the Payroll Setup Wizard)
l
Enter Employee 401(k) Contribution Rates
l

Set Up an Employee Garnishment
The following example illustrates a 30% garnishment of wages earned after taxes. Adjust these instructions accordingly.

Note: You must subscribe to one of the Sage Business Care plans to set up garnishment formulas and have the garnishment
amount calculated within Sage 50. If you have not subscribed, you can set up the garnishment employee payroll field, then
manually compute and enter the amount on the employee's check.

Step 1: Set up the garnishment formula
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter a formula ID (for example, GARNISH).
3. Enter a tax name using the NAME[space]YEAR rule. For example, enter GARNISH 11 , where 11 is the payroll tax year (2011).
4. Classify this formula as a Deduction .
5. Leave Filing Status at All. Clear the Use this formula as a filter on the Payroll Tax report check box.
6. In the Formula box, enter the following:

"The following garnishment formula takes the adjusted gross and subtracts the standard
taxed deductions of Fed_Income, Soc_Sec, Medicare, and State. It calculates 30% of the
resulting net amount."
ANSWER=-(ADJUSTED_GROSS+Fed_Income+Soc_Sec+Medicare+State)*.30
The above formula is based on the defaulted Sage 50 payroll setup. It assumes that you have set up in Employee Default
Information the payroll fields Fed_Income, Soc_Sec, Medicare, and State. If you have a local tax, the payroll field corresponding
to it needs to be added to the formula. Normally this is Local. If you modified the name of these payroll fields, you will have to
alter the formula to include the correct payroll fields (taxed deductions only). Your formula needs to reflect something similar to
the following:

ANSWER=-(ADJUSTED_GROSS+EE PAYROLL FIELD 1+EE PAYROLL FIELD 2+EE PAYROLL FIELD 3+. . .)
*.30
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

7. Save the tax table and close the window.
Step 2: Set up the garnishment employee payroll field
1. From the Maintain menu, select Default Information and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter Garnish as the name of the new payroll field.
Note: What you enter here will print on employee paycheck stubs in the deduction area.
4. Enter or select a G/L account (liability) associated with the garnishment. To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.

5. Click the Calculate button.
6. Select the GARNISH formula that we set up in Step 1.
7. Select OK to save the new payroll field.
Step 3: Apply the garnishment formula to the garnishment employee payroll field
Typically garnishment only applies to one or a few employees. So you should only apply the formula to them.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Select an employee whose wages are to be garnished. To display a list of existing employees, type ? in the Employee ID field,
or select the Lookup button.

3. Select the Employee Fields tab.
4. For the Garnish payroll field, clear the Use Defaults check box and select the Calculated check box.
5. Next, enter the tax name that was set up in the previous step (GARNISH).
This is neither a Memo nor Run field, so skip to the Adjust button.
6. Select the Adjust button to set the Adjusted Gross for this field. Sage 50 displays the Calculate Adjusted Gross window.
In most cases, Gross is the only payroll field necessary for calculating garnishments. Check with your accountant if you are not
sure about your situation.

7. Make sure the Gross check box is selected, then click OK.
8. Save the employee record, and close the window.
How it works
If you subscribe to one of the Sage Business Care plans, during payroll entry the employee will see a Garnish deduction that is
30% of the net amount after taxes. This deduction will continue to appear until the garnishment installments fulfill the debt. At that
time you should remove the garnishment formula assignment from the employee setup.
If you do not subscribe, you'll have to manually calculate and enter the garnishment amount on the employee's check.

Set Up a Cafeteria-Style Health Benefit
You should first try to set up your cafeteria plan using the Payroll Settings wizard. Many common types of plans are
supported. However, if your plan is not currently supported, you can still set it up using the procedure defined in this topic.
This deduction method uses a payroll field set up in Employee Defaults that requires no calculation. Its amount will be deducted from
the gross pay before calculating taxes. This type of pre-tax benefit is commonly called a Cafeteria plan. You can use this example for
pre-tax employee benefits such as group medical or dental insurance.

Step 1: Set up the employee payroll field
In this example a deduction called GrpHealth is used and each employee will have his or her own fixed rate.
1. From the Maintain menu, select Default Information , and choose Employees.
2. Select the Employee Fields tab of the Employee Defaults window.
3.
On a blank line, enter a new payroll field description (for example: GrpHealth ).
Note: What you enter here will print on employee paycheck stubs in the deduction area.
4.

Enter a G/L account (liability) associated with the deduction. To display a list of existing accounts, type ? in this field or select
the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.
Next, you must establish the tax-exempt status of the benefit.

5. Select Fed_Income (the default Federal Withholding payroll field) since GrpHealth is exempt when computing federal
taxable income.

6.

Select the Adjust button. Sage 50 displays the Calculate Adjusted Gross window. Make sure the GrpHealth check box is
selected as well as Gross.
Since GrpHealth is a deduction (entered as a negative item), it will be subtracted from Gross in computing taxable wages
(adjusted gross). This ensures proper calculation of withholding as well as proper taxable gross reporting on payroll tax
forms.

Note: You must subscribe to one of the Sage Business Care plans for taxes and withholdings to be calculated within Sage
50. If you do not subscribe, you should still set up the tax fields properly since you will need the fields to manually enter the
amounts. The fields will also be set up correctly if you decide to subscribe to a Sage Business Care plan later.

7. Repeat the above two steps for each applicable tax field (including ER payroll fields).
8. Click OK twice to save the field and defaults.
Step 2: Set up your employees

Since you are deducting a set amount that is different for each employee, then you would have to set this up in Maintain
Employees.

1. Go to Maintain menu and select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee ID. To display a list of existing employees, type ? in the Employee ID field, or select the
Lookup button.

3. Select the Employee Fields tab.
4.
Select the GrpHealth payroll field and clear the Use Defaults check box.
Standard is not used because this employee uses a unique deduction different from the default. The amount box will become
highlighted at this time.

5. In the Amount box, enter the flat rate the employee qualifies for (for example, -9.25 ).
6. Save the employee record. Follow this procedure for each employee that applies.
How it works
Each time you enter payroll, the employee will automatically receive a GrpHealth deduction of $9.25 that is subtracted from the
gross before calculating taxes.

Note: Taxes will not be calculated unless you subscribe to one of the Sage Business Care plans.

What do you want to do next?
Set up a standard health insurance benefit

l

Set Up a Company 401(k) Plan and Track Contributions (Overview)
401(k) contributions are generally pre-tax deductions in which a specified percentage of the employee's gross wages is taken out
prior to taxes and placed into a savings plan set up by the company. Both the savings plan and proceeds are tax-deferred by the
U.S. Government. As an incentive, some companies will also match a percentage of the employee 401(k) contributions.
To quickly set up 401(k) defaults and payroll tax adjustments, use the Payroll Setup wizard. You can then enter the percentages of
gross pay each employee wants to contribute to your company's 401(k) plan in their individual records.
Setting up a company 401(k) plan involves the following steps:

1. Set up a 401(k) plan using the Payroll Setup wizard.
2. Enter employee 401(k) contribution rates.
Note: If you don't subscribe to a Sage Business Care plan , the contribution details are for informational purposes only since
payroll deductions will not be calculated. You will have to manually calculate and enter 401K amounts.

What do you want to do next?
Set up a company 401(k) plan

l
l

Enter employee 401(k) contribution rates

Set Up a Company 401(k) Plan
To quickly set up a 401(k) plan for your company, use the Payroll Settings wizard. You can then enter the percentages of gross pay
each employee wants to contribute to your company's 401(k) plan in their individual records.

1. From the Maintain menu, select Payroll and choose Payroll Settings.
2. In the left navigation area, click on Benefits and then Summary of Benefits.
3.
4.
5.
6.
7.

Under the list of benefits, click Add Another Benefit.
On the Add a Benefit window, select Retirement Plan and click OK.
On the Retirement Plans window, select 401(k) .

Who contributes money to this plan? Select Employee, Company, or Both.
Company contributions are based on: a percentage of employee's contributions, a flat dollar amount per pay period, or an
advanced formula.

8. Contribution Formula: The format of the formula will change based on your previous answer. You can either enter a
percentage, a flat amount, or an advanced formula.

Advanced Formula: For example, many companies match 100% of the employee contribution amounts up to a certain limit.
They might match 50% on the employee contribution above that limit. In the example below, the company is matching 100%
(dollar for dollar) for all employee 401(k) contributions up to 4%. If an employee contributes a higher percentage (for example,
5%), the company will match 50% of the additional 1% amount. The company has set a matching cap at 6%.
If you don't subscribe to a Sage Business Care plan , the contribution details are for informational purposes only since payroll
deductions will not be calculated. You will have to manually calculate and enter 401K amounts.

9. Now you must enter the general ledger accounts for the expense and liability associated with the 401(k). If there is both an
employee- and company-paid amount, then you will need to enter accounts for both.

10. Click the Finish button to establish the new payroll defaults.
11. Now you just need to update each employee record with the amount they contribute to the 401(k). This is done on the Withholding
Info tab of the Maintain Employees window.

Set Up a Labor Tax (Example)
This example demonstrates how to set up a labor tax that requires computing the total hours worked before computing the tax rate.
It will work for both hourly and salaried employees. The Washington Industrial Insurance Tax is used as an example. Adjust
these instructions accordingly to match your own business needs.
Click the headings below to expand and display their respective procedure.

Note: You must subscribe to one of the Sage Business Care plans to have access to payroll formulas and to have payroll taxes
calculated within Sage 50. If you have not subscribed, you can set up the employee labor payroll field, but you will have to
manually calculate and enter the amounts on payroll checks.

Step 1: Set up the labor payroll formulas
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.
The salary formula will be set up first.

2. Enter a Formula ID (WALIS , for example).
3. Enter a formula name according to the rule of NAME[space]YEAR. For example, enter WALIS 11 , where 11 is the current payroll
tax year (2011).

4.
5.
6.
7.

Normally, a labor tax subtracts from gross. Leave Filing Status at All.
This would be classified as a Tax. In this example, select State as the government type and WA (Washington) as the state.
Clear the check box for Use this formula as a filter on the Payroll Tax Report.
In the Formula box, enter the following:

"The following formula represents the Washington Industrial Insurance Tax for SALARIED
employees. It multiplies 80 hours (salary for a bi-weekly payroll) by the employee's total
contribution rate to compute the tax for the current payroll period. Each employee's
contribution rate is entered (in cents per hour) in the Additional Withholding column for
the Special 1 field of the Maintain Employee/Sales Reps window."
ANSWER=-80*EMP_SPECIAL1_NUMBER/100
This formula is designed for a bi-weekly payroll. If you have a weekly payroll, the formula needs to read:

ANSWER=-40*EMP_SPECIAL1_NUMBER/100
If you have a semi-monthly payroll, the formula needs to read:

ANSWER=-88*EMP_SPECIAL1_NUMBER/100
The above formulas reference the EMP_SPECIAL1_NUMBER payroll identifier; this is the amount entered in the Additional
Withholding column for the Special 1 payroll field, which is located in the Withholding Information table of the employee's
setup.
The sentence within quotes above the actual format is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

8. Save the salary formula.
The hourly formula needs to be set up.

9. Enter a Formula ID (WALIH, for example).
10. Enter a formula name using the NAME[space]YEAR rule. For example, enter WALIH 11 .
11. Leave Filing Status at All. Again, our example would be classified as a tax for the state of Washington.Select State as the
government type.

12. In the Formula box, enter the following:

"The following formula represents the Washington Industrial Insurance Tax for HOURLY
employees. It adds up the total number of hours worked for the current payroll period and
multiplies it by the employee's total contribution rate to compute the tax for the current
payroll period. Each employee's contribution rate is entered (in cents per hour) in the
Additional Withholding column for the Special 1 field of the Maintain Employee/Sales Reps
window."
ANSWER=-(REGULAR+OVERTIME)*EMP_SPECIAL1_NUMBER/100
This formula assumes that the pay levels set up in Employee Defaults are the same as those created during the initial payroll field
setup. If you let Sage 50 set up your Payroll, by not copying Payroll information from another company, you will have the hourly
pay levels of Regular and Overtime. If you modified the name of these pay levels, or copied payroll setup from another company,
then you'd need to modify the formula with your pay level names.

Note: Some names cannot be used in User-Maintained Formulas because they are already used in standard identifiers or
related tax formulas. For example, "Hourly" and "Salary" cannot be used as Pay Level field names in User-Maintained Formulas.
.
The sentence within quotes above the actual format is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

13. Save the formula. In the bottom right corner of the window, click on Next Step: Add this formula to Employee Defaults.
Step 2: Set up the employee labor payroll field
1. On the Employee Defaults window, select the Employee Fields tab.
2. On a blank line, enter WALIEE as the name of the new payroll field.
3. Enter or select the G/L account (liability). To display a list of existing accounts, type ? in this field or select the Lookup button. To
add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts window.
4. If your company has only salaried employees or just hourly employees, select the Calculation (Calc) check box. Then, select
either the WALIS or WALIH formula. If this is the case, skip the next section (Step 3 below). The example deduction is set up.
If your company has both salary and hourly employees, do not select the Calculation (Calc) check box. The formula needs to be
applied in the individual employee setup. This will be done in the following section.

5. Select OK to save the new payroll field.
Step 3: Apply the appropriate labor formula to each employee's setup (optional)
This procedure is required only if you have both hourly and salaried employees and you are required to use the Washington
Industrial Insurance Tax.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select each employee who qualifies for this labor tax. To display a list of existing employees, type ? in the Employee ID
field, or select the Lookup button.

3. On the Withholding Info tab, locate the Special 1 field. (You may have to scroll down to find it.)
4. Enter the percentage claimed by this employee for labor contributions in the Additional Withholding column. Enter the
amount as a number. If the contribution rate is 0.04720, enter 4.72--not 0.04720 or 472.
This field represents the EMP_SPECIAL1_NUMBER identifier in the formula we set up in Step 1.

5. Select the Employee Fields tab.
6. For the WALI Field, clear the Use Defaults check box, and select the Calculated check box. Select a liability account.
Next, enter the tax name that was set up in the previous step.

7. If the employee is an hourly employee, enter or select WALIH as the formula. If the employee is a salaried employee, then
enter or select WALIS as the formula.
This is neither a Memo nor Run field, so skip to the Adjust button.
8. Select the Adjust button to set the adjusted gross for this payroll field. Sage 50 displays the Calculate Adjusted Gross window.
In most cases, Gross is the only payroll field necessary for calculating this tax. Check with your accountant if you are not sure
about your situation.

9. Make sure the Gross check box is selected, then select OK.
10. Save the employee record, and close the window.

Set Up a Local Payroll Tax
The payroll settings wizard will set up many local taxes for you. You should set them up there if you can, as it will save you a lot of
work. Click the link for a list of supported local taxes.
The following example illustrates how to create a local formula and apply it to the Local employee payroll field. The example uses the
local 1.2 % tax for Akron, Ohio. It duplicates the generic formula Sage 50 normally creates during the tax section of the Payroll
Setup wizard.
Use these procedures to set up local payroll taxes for your company, adjusting the setup to match your company's location.

Note: You must subscribe to one of the Sage Business Care plans to have access to payroll formulas and to have payroll taxes
calculated within Sage 50. If you have not subscribed, you can set up the local payroll field, but you will have to manually calculate
and enter the amounts on payroll checks.

Step 1: Set up the local employee payroll field
If you do not already have a Local employee payroll field, follow these steps:

1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter Local as the name of the new payroll field.
4. Enter or select a G/L account (liability) associated with the deduction. To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.

5.
6.
7.
8.
9.

Select OK to establish the payroll field.
Go to Maintain, Payroll, Payroll Settings. In the left-hand menu, select Taxes, Assign Tax Fields.
Select the button for W-2 Fields. Sage 50 displays the Assign Tax Fields For W-2s window.
For the box labeled Local income tax (box 21), enter or select the Local payroll field.
Select OK. Then, select Finish to close the Payroll Settings window.

Step 2: Set up the local formula
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter a formula ID (OHLIT, for example).
If an OHLIT tax ID already exists and you need to create a second one, enter OHLIT2.

3. Enter a tax name using the NAME[space]YEAR rule. For example, enter OHLIT 11 , where 11 is the current payroll year (2011).
4. The effect on Gross Pay should be Subtracts from Gross.
5. Leave Filing Status at All.
6. Select Tax as the formula classification, and Locality as the tax agency. In this case, you would set All Localities to No, since
this only applies to employees in Akron.

7. Enter a Locality Name of LOCAL.
Whenever this formula is used, you must have, in the Maintain Employees/Sales Reps window, OH listed as the State/Locality for
the State payroll field and Local listed as the State/Locality for the Local payroll field.

8. In the Formula box, enter the following: (To create a new line in the formula, press CTRL+J.)

E=0.00; "E is Exemption Amount per Local Allowance (for EE and Spouse in Indiana)"
D=0.00; "D is the Allowance Amount per Dependent (applies for Indiana only)"
M=0.00; "Maximum Tax (0 if no maximum)"
PERCENT=1.20;
A=PRORATE((ANNUAL(ADJUSTED_GROSS)-(E*EMP_LOCAL_ALLOWANCES)-(D*EMP_LOCAL_NUMBER))
*PERCENT%);
ANSWER=-IF(M=0,A,IF((ABS(YTD(Local)-Local)+A)>M,M-ABS(YTD(Local)-Local),A))
This formula first looks at the local percentage of 1.2% and prorates it based on the calculated annual adjusted gross. If your
local tax has an exemption amount, enter the amount in place of the zero in the equation E=0. When you are entering employees,
be sure to enter the correct number in the Local Allowances box in the Maintain Employees/Sales Reps window. If you have a
maximum tax, enter the annual maximum in place of the zero in the equation M=0.
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.
In some cases, your area may also have a set amount that is prorated over the course of the year. A good example of this is the
Pennsylvania Occupational Privilege Tax. In this case, add the following line to the end of the above formula: (Remember to put a
semicolon (;) at the end of the last line before creating the new line.)

ANSWER=ANSWER-PRORATE (0)
In this formula the tax is a fixed amount per year. Replace zero(0) with an amount (for example, (150.00). The PRORATE
expression divides the amount of $150.00 by the number of pay periods in a calendar (payroll) year.
If we hadn't already set up the payroll field, we would have to click on the link at the bottom right, Add this formula to Employee
Defaults, before we could save the formula.

Step 3: Enter the employee locality and apply the local tax table
For each employee that uses this locality, follow these steps:

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select an employee ID. To display a list of existing employees, type ? in the Employee ID field, or select the Lookup
button.

3. Select the Withholding Info tab.
4. Make sure OH is listed as the State/Locality for the State payroll field.
5. For the Local payroll field, enter or select Local as the State/Locality.
The State/Locality values have to be exactly what was entered in the State and Local requirement box created in the formula.
This field is case sensitive.

6. Select the Employee Fields tab.
7. For the Local payroll field, clear the Use Defaults check box and select the Calculated check box.
8. Next, enter or select the tax name that was set up in the previous step.
In our example it would be the OHLIT formula.
9. Select the Adjust button to set the Adjusted Gross for this field. Sage 50 displays the Calculate Adjusted Gross window.
In most cases, Gross is the only payroll field necessary for calculating local taxes. Check with your accountant if you are not sure
about your situation.

10. Make sure the Gross check box is selected, then select OK.
11. Save the employee record, and close the window.

Set Up a Standard Health Insurance Benefit
You can add a health insurance benefit through Payroll Settings (or the Payroll Setup Wizard).

1.
2.
3.
4.

From the Maintain menu, select Payroll and choose Payroll Settings.
In the left navigation area, click on Benefits and then Summary of Benefits.
Under the list of benefits, click Add Another Benefit.
On the Add a Benefit window, select Insurance Plan and click OK.

5. On the Insurance Plans window, select the type of plan.
6. Who pays for this plan? Select Employee, Company, or Both.
7. For most plan types, you must give the plan a name. Sage 50 will use the name you supply on employee screens and on reports.
The name is only used internally, within Sage 50. It must start with a letter, have at least 2 characters, and cannot have spaces or
special characters like asterisks.

8. Are the company expenses for this plan tracked per paycheck? Although money for insurance plans is usually paid
quarterly or monthly, the amount due accrues for each pay period. You can choose to put aside money for each paycheck in
order to track the amount you will have to pay.

9. Enter the standard amount employees pay per check. You can adjust this for individual employees later.
10. Indicate if the employee contribution should appear on the W-2. This is strictly informational; it has no effect on gross pay.
11. Now you must enter the general ledger accounts for the expense and liability associated with the 401(k). If there is both an
employee- and company-paid amount, then you will need to enter accounts for both.

12. Click the Finish button to establish the new payroll defaults.
13. Now you just need to update each employee record with the amount they contribute to the plan, if it is different than the standard
amount. This is done on the Withholding Info tab of the Maintain Employees window.

What do you want to do next?
l

Set up a cafeteria style health benefit that is deducted before payroll taxes

Set Up Employees with Different Accrued Vacation or Sick Time
If you have employees who earn a non-standard amount of vacation- or sick-time hours, you can adjust for these individuals in
Maintain Employees. For example, say most of your employees earn two weeks per year. However, some long-term employees can
earn more. You can tweak the hours for these employees in the employee record.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee ID of an employee who earns the non-standard number of hours. To display a list of existing
employees, type ? in the Employee ID field, or select the Lookup button.
3. Select the Vacation/Sick Time tab. Clear the This employee uses the company default settings... check box.
4. Enter any unique hours or information for this employee.
5. Follow this procedure for each employee that earns the unique number of vacation- or sick-time hours.
What do you want to do next?
Record when employees use vacation or sick time

l

Set Up Employee Vacation- and Sick-Time Defaults
To quickly set up vacation-time defaults, sick-time defaults, or both for your company, use the Payroll Setup wizard. If you have
employees with non-standard vacation or sick information, you can make adjustments for those individual employees in Maintain
Employees. Click here for more information.

1. From the Maintain menu, select Default Information and choose Payroll Settings.
2. On the left side of the menu, click Benefits to open the menu. Then select Vacation or Sick Time.
3. Select the standard vacation options that your company plans to offer.
Employees are given: This is the standard number of hours your company gives--or, what most people get. For example,
40 hours equals one week of vacation.
You can make adjustments for individual employees, if necessary, on the Maintain Employees screen.

Employees receive these hours: Check the standard method for determining when vacation hours start to accrue.
Again, this is the standard or default method.

Does the remaining time carry over... Check Yes if you allow vacation hours to carry over to the next year, or No if
they must be used or lost. If you enter Yes, then enter any maximum number of vacation hours an employee can have at any
one time.

4. Click Next to select the standard sick time options that your company offers. They are set up just like vacation hours.
5. Click the Next button to continue setting up standard information in the wizard.

What do you want to do next?
Set up employees with different accrued vacation or sick time
l
Record when employees use vacation or sick time
l

Set Up Federal Earned Income Credit (FEIC)
Use this procedure to set up Federal Earned Income Credit in payroll if you have employees who qualify for this government
program.

Note: You must subscribe to a Sage Business Care plan for the Federal Earned Income Credit to be calculated. Otherwise, you
can set up the field, but you will have to manually calculate and enter the amount on the employee's paycheck.

Step 1: Set up the FEIC employee payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter FEIC as the name of the new payroll field.
4. Enter or select a G/L account (liability) associated with the credit. To display a list of existing accounts, type ? in this field or select
the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts window.
5. Select the Calculate checkbox.
6. If you subscribe to a Sage Business Care plan , select an FEIC formula. If not, type FEIC in the Formula column.
7. Select OK to establish the payroll field.
8. Now we'll assign the field to the correct box on the W-2 form.
9. Select Maintain, Payroll, Payroll Settings.
10. In the left-hand navigation area, click on Taxes, then Assign Tax Fields.
11. Click on the W-2 Fields button. Sage 50 displays the Assign Tax Fields for W-2s window.
12. For the Advanced EIC payment field (box 9), enter or select the FEIC payroll field.
13. Select OK. Then, select Finish to close the Payroll Settings wizard.
Step 2: Apply the FEIC formula to the FEIC employee payroll field
Typically earned income credit only applies to one or a few employees. You should only apply the formula to them.

Before You Begin This Step
If you subscribe to a Sage Business Care plan you receive multiple FEIC calculations based on marital status, working

l

status of each spouse, and who files the W-5 form. Before you begin, go to Sage-maintained Payroll Formulas; read the
instructions in the Formula box of the tax formula to make sure you understand which calculation to select for each employee's
situation.
l

If you do not subscribe to a Sage Business Care plan,you can enter the amount for the FEIC. You must calculate this
yourself and make sure that it is correct on the paychecks when you create them.

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Select an employee who is eligible for earned income credit. To display a list of existing employees, type ? in the Employee ID
field, or select the Lookup button.

3. Select the Employee Fields tab.
4. For the FEIC payroll field, clear the Use Defaults check box.
5. Select the Calculated check box, then select the appropriate FEIC tax formula. (See "Before You Begin" above.)
6. Select a general ledger account for the field. This would normally be a liability account.
7. In the Formula column, select the appropriate supplied formula (if you subscribe to the tax service). Or, select the formula you
set up for FEIC for this employee's filing status.

8. Select the Adjust button to set the Adjusted Gross for this field. Sage 50 displays the Calculate Adjusted Gross window.
9. In most cases, Gross is the only payroll field necessary for calculating Earned Income Credit. Check with your accountant if you
are not sure about your situation.

10. Make sure the Gross check box is selected, then select OK.

11. Save the employee record, and close the window.
Repeat this procedure for each employee who qualifies for the Federal Earned Income Credit program.

How it works
During payroll entry the employee will see an addition (FEIC) to the net income.

Set Up Multiple State Withholdings (Example)
The following example demonstrates how a Chicago-based company would modify its payroll setup to accommodate employees
who live in Illinois, Indiana, and Wisconsin. It assumes that the Payroll Setup Wizard has already created an ILSUI ER calculation for
unemployment.
Use this procedure to set up multiple state withholdings for your company, adapting the setup to match your company's location.

Note: You only need to do this if you have subscribed to a Sage Business Care plan or a monthly subscription. If you have not
subscribed, you will have to manually calculate and enter the state withholdings.

Step 1: Modify the SUI formula to accept all states
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Select your state's SUI ER formula from the list.
For our example, we would select the ILSUI ER 11 formula (where 11 is the current payroll year--2011).
3. Click the arrow beside the Select a state field. Instead of the field having a specific state (IL) we want to select "All States".
When this SUI formula is used, whatever is in this State requirement field must match what is in the State field of the
Withholding Information table in the Maintain Employees/Sales Reps window. When you select All States, Sage 50 will look
for all states, ignoring the employee's state withholding setup. This will become clear in a moment.

4. Save the formula. Click the link in the bottom right of the window: Next Step: Add this formula to Employee Defaults.
Step 2: Modify the SUI employer payroll field to accept all states
1. The Employee Defaults window should be displayed.
2. Select the Company Fields tab and locate your SUI_ER payroll field.
If you used the Payroll Setup wizard, it will be the fourth field. The calculation check box is probably selected and possibly using
**SUI ER as the formula.

3. Delete the **SUI ER formula listed and enter or select your state's specific SUI formula. To look it up, right-click in the field and
select the formula from the list.
In our example we would delete **SUI ER and enter ILSUI ER as the new tax name.
Because we removed the state requirement from the state SUI ER formula in the previous step, the SUI ER tax will now ignore the
employee's state withholding setup and always calculate.

Note: The Payroll Setup wizard sets up **SUI ER so as to mask whatever value that is entered in the State field of the
employee's Withholding Information table in the Maintain Employees/Sales Reps window and look for that corresponding
state SUI ER formula. For example, if you entered GA in the employee's State field, then the **SUI ER formula mask would look
for and only use the GASUI ER calculation. The same is true for the State Employee field. The formula mask of **SIT would only
look for and use the GASIT calculation for state withholding.

4. Click OK to save the payroll field.
Step 3: Verify each employee's individual state withholding information
1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select each employee who lives in the same state in which your company resides. To display a list of existing employees,
type ? in the Employee ID field, or select the Lookup button.
For our example, we would select those employees who live in Illinois.
l

l

Select the Withholding Info tab and locate the State field in the Withholding Information table. The state code should
match your company's state. In our example, it should be IL .
Select the Employer Fields tab and locate the SUI_ER payroll field. Make sure the Use Defaults check box is selected and the
correct SUI ER tax name is listed. In our example, the Use Defaults check box is selected and ILSUI ER is listed.

3. Now select the employees who live in states different from the company's state.
For our example, we would select those employees who live in Indiana or Wisconsin.
l

l

Select the General tab and locate the State field in the Withholding Information table. The state code should match your
employee's respective state. In our example, it could be IN or WI .
Select the Company Fields tab and locate the SUI_ER payroll field. Make sure the Use Defaults check box is selected and
the correct SUI ER tax name is listed. In our example, the Use Defaults check box is selected and ILSUI ER is listed.

4. Save each employee, if changes were made.
How it works
During payroll entry (based on our example), the Illinois employee uses the ILSIT (state withholding) formula and the ILSUI ER
(employer state unemployment) formula. The Indiana employee uses the INSIT and ILSUI ER formulas.

Set Up and Record Employee Tips (Overview)
As with 401(k) deductions, companies may handle employee tips differently based on the type of business and local policies. In this
example, cash tips are not paid directly to the employee in the paycheck.

Setting up the tips payroll field
If you selected Yes to recording tips when initially setting up payroll, Sage 50 automatically creates a Tips employee payroll field. If
you do not have a Tips payroll field, you can set one up manually.
Recording employee cash tip income
During payroll entry, enter the total tip income that the employee is reporting over the current payroll period.

Recording employee charge tip income
Some companies may handle credit card tip income differently from cash tip income. Employers must distribute employee tips paid
by customer credit cards. You may want charge tips to be reported separately from cash tips to account for income the employer
distributes to the employee. .

What do you want to do next?
l
Set up a tips payroll field (manually)
l
Record employee cash tips during payroll entry
l
Learn about recording charge tips vs. cash tips (may be optional)
l
Set up other payroll deductions

Record Employee Cash Tip Income During Payroll Entry
During payroll entry, enter the total tip income that the employee is reporting for the current payroll period. You must have a Tips
payroll field already set up to record employee tip income in payroll.
It is important that you enter the gross pay information first (number of hours worked or salary amount); then enter your tip
information. This way the tip income will properly adjust from gross pay.

1. After selecting the employee ID during payroll entry, enter the number of hours worked or salary for the current payroll period.
2. Enter the total tip income that the employee is reporting for the current payroll period amount reported in the Tips payroll field.
If you subscribe to a Sage Business Care plan , payroll taxes adjust to include the tip income. However, the gross pay amount does
not change.
If you do not subscribe, you will have to calculate and enter the payroll taxes and other deductions.

Set Up Employee Charge Tips
Click the headings below to expand and display their respective procedures.

Note: You must subscribe to a Sage Business Care plan to have access to payroll formulas and to have payroll fields calculated
within Sage 50. If you don't subscribe, you can set up the payroll fields, but you will have to manually calculate and enter the
amounts on the paychecks.

Step 1: Set up the cash tips and credit card tips employee payroll fields

1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. If it is not already created, add a new payroll field on a blank line with the description of Tips. Make this a memo field and select
the Adjust button for the various taxes (federal income, state income, etc.) to make adjustments to the Adjusted Gross. Select
OK when completed.
4. On a blank line, enter CCTips as the name of the new payroll field.
This will be distributed to the employee, so leave the Memo check box clear. Not selecting this check box logs credit card tips for
reporting and tax calculations and posts an entry to the general ledger.

5. Enter or select the general ledger (liability) account associated with credit card tips collected that need to be distributed to
employees. To display a list of existing accounts, type ? in this field or select the Lookup button. To add a new account, type + or
double-click the field, which displays the Maintain Chart of Accounts window.

6. Do not select the Calculated check box.
7. Select Fed_Income (the default Federal Withholding payroll field), or any other tax field for which tips are required in
computing taxable income.

8. Select the Adjust button. Make sure CCTips check box is selected as well as Gross.
9. Repeat the above two steps for each applicable field (including ER payroll fields).
Tips and CCTips will be added to gross pay when computing taxable wages. This ensures proper calculation of withholding as
well as proper taxable gross reporting on payroll tax forms.

10. Select OK to accept the changes and close the window.
Step 2: Set up a formula that adds cash and charge tips together
The W-2 form has only one box for tips, so the two fields must be added together and the total reported.

1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter a formula ID (for example, W2TIPS ).
3. Enter a tax name using the NAME[space]YEAR rule. For example, enter W2TIPS 11 , where 11 is the current payroll tax year
(2011).

4.
5.
6.
7.

Select Adds to Gross as the Effect on gross pay.
Leave Filing Status at All. Clear the Appears in Payroll Tax Report Menus check box.
This formula should be classified as a Reimbursement.
In the Formula box, enter the following: (To create a new line in the formula, press CTRL+J.)

"This calculation adds Tips and Credit Card Tips together. Its sum will be reported on the
employee's W-2 form."
ANSWER=Tips+CCTips
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

8. Save the new calculation and close the window.
Step 3: Set up a combined tips employee payroll field and apply the total tips formula to it
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3.
4.
5.
6.

On a blank line, enter W2Tips as the name of the new payroll field.
Enter or select the general ledger (liability) account associated with tips collected that need to be distributed to employees.
Select the Calculated check box.
Next, enter or select the formula name that was set up in the previous step (W2Tips).

This is neither a Memo nor a Run field. Also, there is no need to adjust since this has already been done in the two other fields.
7. Select OK to establish the payroll field.

8.
9.
10.
11.

Now, go back to Payroll Settings. Select Taxes, and Assign Tax Fields.
Select the W-2 Fields button.
In the Allocated Tips field, enter or select W2Tips.
Select OK, then select Finish to close the Payroll Settings window.

Tip: Expand all the headings above and print this Help topic to use as a charge tips setup checklist.
What do you want to do next?
Record cash and charge tip income during payroll entry

l

Set Up an Employee Advance Paid Back in Manual Installments
Manual installment advances or loans are typically used when the loan amount doesn't meet your repayment policy or in special
situations.

Step 1: Set up the employee payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter Advance as the name of the new payroll field.
Note: What you enter here will print on employee paycheck stubs in the deduction area.
4. Enter a G/L account (other current asset) associated with the deduction. To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.
This is typically the same account that was used to issue the loan initially, so it can be offset when the employee pays the loan
back.

5. Select the Run check box.
This allows the employee to continue making loan payments in the following year (if needed).

6. Click OK to save the field.
Step 2: Enter the advance principle
During payroll entry, enter in the Advance payroll field a positive amount for which the loan is to be issued to the employee (for
example, 200.00 ).
Step 3: Repay the advance
During subsequent payroll entries, enter in the Advance payroll field a negative number each time the employee makes a loan
payment (for example, -50.00 ).

What do you want to do next?
Set up an employee loan paid back in automatic installments

l

Bonus or Commission for Hourly Employees:
Set Up Hourly Pay Level
Using this method, you will create a pay level field in Employee Defaults and apply a rate of 1.00 per hour for each employee.
This example uses a Commission pay level.

Step 1: Enter the employee default pay level
1. From the Maintain menu, select Payroll, and then Payroll Settings.
2. In the left navigation area, click on Company Information , then Pay Types.
3. In the Hourly table, enter Commission in the first blank pay level field.
Note: What you enter here will print on employee paycheck stubs in the pay level area.

4. Select or type in the G/L account (usually wages expense). To display a list of existing accounts, type ? in this field or select the
Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts window.
5. Select Finish to save the field.
Step 2: Enter the employee pay level rate
1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee ID. To display a list of existing employees, type ? in the Employee ID field, or select the Lookup
button.

3. Select the Pay Info tab, and choose the Hourly-Hours Per Pay Period pay method, if it isn't already selected.
4. Select the Commission pay level field and enter 1.00 as the hourly rate.
5. Save the employee record.
How it works
During payroll entry, enter the earned amount in the Commission pay level field as hours rather than a rate. For example, if the
employee earned $75.29 commission, you would enter 75.29 commission hours. The $75.29, which is taxable, would also be added
to the displayed Gross amount at the bottom of the Payroll Entry window.

What do you want to do next?
l

Set up a lump-sum earnings payroll field for hourly employees

Set Up an Employee Loan Paid Back in Automatic Installments
This method is to first issue a paycheck for the principle loan amount. Then, during payroll entry have Sage 50 automatically deduct
installments until the loan is paid off.
In this example we will assume the employer issued an employee loan of $210.00 which is to be paid back in five installments over
the next five payroll periods.
Click on the headings below to expand and display their respective procedures.

Note: You must subscribe to a Sage Business Care plan to have access to payroll formulas and to have payroll fields calculated
within Sage 50. If you have not subscribed, skip steps 2 and 3.

Step 1: Enter the employee payroll field
1. From the Maintain menu, select Default Information , and choose Employees. Sage 50 displays the Employee Defaults
window.

2. Select the Employee Fields tab.
3. On a blank line, enter Emp_Loan as the name of the new payroll field.
Note: What you enter here will print on employee paycheck stubs in the deduction area.
4. Enter a G/L account (other current asset) associated with the deduction. To display a list of existing accounts, type ? in this field or
select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of Accounts
window.
This is typically the same account that was used to issue the loan initially, so it can be offset when the employee pays the loan
back.

5. Click OK to save the field.
Step 2: Set up the loan formula
1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Enter EMP_LOAN as the tax ID.
3. Enter a tax name using the NAME[space]YEAR rule. For example, enter EMP_LOAN 11 , where 11 is the current payroll year
(2011).

4. The effect on gross should be Subtracts from gross.
5. Leave Filing Status at All.
6. Classify the formula as a Deduction .

7. In the Formula box, enter the following: (To create a new line in the formula, press CTRL+J.)

"The following is an example of an employee loan based on 'Emp_Loan' as the payroll field
setup in employee defaults. Limit stops payments when the loan balance equals zero. A is
the payment amount of $50.00."
LIMIT=0;
A=50;
B=-YTD(Emp_Loan)+Emp_Loan;
C=A-((A+B)-LIMIT);
D=IF((A+B)<LIMIT,A,C);
ANSWER=-D
Tax ID should be EMP_LOAN Tax Name EMP_LOAN xx where xx equals current payroll year (i.e., 11 equals year 2011)
The sentence within quotes above the actual formula is meant as a comment or reminder of how the calculation is set up. Adding
the comment is optional.

Note: This calculation works for loans with any loan balance, whether they add up to the principle exactly or not. (In our
example, there will be four payments of $50.00, and one payment of $10.00, to equal the loan of $210.00.)

8. Save the formula, and close the window.
Step 3: Amend the payroll field and tie it to the loan formula
1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee who is paying the loan back.
3. Select the Employee Fields tab.
4. Locate the Emp_Loan payroll field, clear the Use Defaults check box, select the Calculated check box. Standard is not used
because this calculation only applies to this employee.

5. Next, enter or select the calculation name EMP_LOAN that was set up in the previous step.
6. Save the change ,and close the window.
Step 4: Issue the loan principle
You have two options to issue the loan principle:
l
l

Include the Emp_Loan field with the loan amount (for example, $210.00) on the employee's next paycheck
Issue a separate paycheck with a gross amount of $0.00 and an EMP_Loan amount equal to the amount of the loan (for example,
$210.00)

Step 5: Recover the loan balance
If you have subscribed to a Sage Business Care plan , Sage 50 automatically deducts the amount you specified in the EMP_LOAN
formula from the employee's paycheck until the loan is fully recovered.
Otherwise, you will need to manually calculate and enter the amount on the employee's paycheck.

How it works
New employee loans will be repaid automatically if you have subscribed to a Sage Business Care plan . During the next four payroll
entries (in this example), -50.00 will appear in the Emp_Loan payroll field. On the fifth payroll run, it will be -10.00. Employee
loans that are not fully repaid at the end of the payroll tax year will continue without being reset to a zero balance (as long as the Run
check box is selected in Step 3). Employee paychecks will show the running balance of the loan in the Year To Date column, even
when a loan extends beyond a year end. Employees without loans will never see the loan field on their paycheck.
If you have not subscribed to a Sage Business Care, you will have to manually calculate and enter the amounts on the employee's
paychecks.

What do you want to do next?

Send an E-mail Message to an Employee or Sales Representative

1. From the Maintain menu, select Employees/Sales Reps. Sage 50 displays the Maintain Employees/Sales Reps window.
2. Enter or select the employee ID to whom you want to send the message. To display a list of existing employees, type ? in the
Employee ID field, or select the Lookup button.
3. If you have not already done so, enter the employee's e-mail address on the General tab.
4. Click the E-mail button to the right of the E-mail field. Your default e-mail program will start with this address applied in a new
message.

Note: You must have an e-mail program installed in Windows (for example, Microsoft Outlook or Eudora) and an account set up
with an Internet service provider for this procedure to work properly. Sage 50 does not send the message itself.

Bonus or Commission for Hourly Employees:
Set Up a Lump-Sum Earnings Payroll Field
If you want to calculate lump-sum earnings for an employee not based on hourly pay levels, you must create an Employee field in
Employee Defaults. Then, you must adjust the lump-sum earning payroll field to be included in gross wages because it is considered
to be taxable income. In this example, we will use the Bonus payroll field. Using this method you can also track bonus or
commission income separately on the employee W-2 forms, if desired.

Note: You could use this example to create other lump-sum payroll fields such as commission, jury duty, maternity leave, and so
on. (Keep in mind that lump-sum earnings may be taxed differently depending on your area. Therefore, you need to monitor
adjusted gross income accordingly.)
If you don't subscribe to a Sage Business Care plan, you can set up the employee payroll field, but you will have to manually
calculate and enter the amounts on the paychecks. You will not have access to payroll tax reports or forms.

Step 1: Set up the employee payroll field
1. From the Maintain menu, select Default Information, then choose Employees. Sage 50 displays the Employee Defaults window.
2. Select the Employee Fields tab.
3. On a blank line, enter Bonus as the name of the new payroll field.
Note: What you enter here will print on employee paycheck stubs in the deduction area.
4. Enter a G/L account (usually wages expense) associated with the payroll field. To display a list of existing accounts, type ? in this
field or select the Lookup button. To add a new account, type + or double-click the field, which displays the Maintain Chart of
Accounts window.

5. Select Fed_Income (the default Federal Withholding payroll field), or any other tax field for which Bonus is required in
computing taxable income.

6. Select the Adjust button. Sage 50 displays the Calculate Adjusted Gross window.
7. Select the Bonus check box so that it will be added to gross wages.
Do this for each applicable EE and ER field. For example, select Soc_Sec (the default Social Security payroll tax) next.
Select Adjust and add Bonus to Adjusted Gross. Continue to do this for each Employee payroll tax field and Employer payroll tax
field that needs to be adjusted to include Bonus.
Since Bonus is an addition (entered as a positive item), it will be added to gross pay when computing taxable wages (adjusted
gross). This ensures proper calculation of withholdings as well as proper taxable gross reporting on payroll tax forms.

8. When finished adjusting gross wages, select OK.
9. Select OK to save the payroll field.
How it works
During payroll entry, enter the number of hours the employee works for this payroll period. When ready to enter an employee
bonus, enter the amount in the Bonus payroll field under the Employee/Company Fields section. For example, if the employee
earned a $75.00 bonus, you would enter 75.00 in the Bonus payroll field. The $75.00 will not be added to the visible Gross amount
at the bottom of the Payroll Entry window. However, if you subscribe to one of the Sage Business Care plans, it will be added in the
background to the adjusted gross and taxed properly. The adjusted gross will appear correctly as taxable wages in payroll tax
reports.

Step 2: Include bonus (or commission) income on W-2 forms (optional)
If you are using the Bonus (or Commission) employee payroll field, you may want to note this on the employee's W-2 form as

additional income. This is optional at the employer's discretion. Commission or bonus amounts are already included in the total
taxable wages in boxes 1, 3, and 5. Using box 14, you can isolate the total commission or bonus earned for additional record
purposes. Sage 50 allows only one payroll field to be assigned to box 14 on the W-2 form. If you already have
another Sage 50 payroll field assigned to box 14 on the W-2 form, you cannot add the commission or bonus field.

1.
2.
3.
4.
5.

From the Maintain menu, select Payroll and then Payroll Settings.
Select Taxes, then Assign Tax Fields.
Select the W-2 Fields button. Sage 50 displays the Assign Payroll Fields For W-2s window.
In box 14, click on the drop-down arrow button to open the list of fields. Select the Bonus payroll field from the drop-down list.
Select OK, then select Finish to close the Payroll Settings wizard.

What do you want to do next?
Create an hourly pay level with a rate of $1.00 per hour

l

Set Up and Record Group Health Payroll Deductions
Some employers participate in a group health plan. These plans commonly include such deductions as medical insurance, dental
insurance, life insurance, long-term disability, and many others. If the deduction is tax exempt (deducted before calculating taxes),
it is commonly called a Cafeteria plan. These deductions can be set up using either of the following scenarios:
l
l

Standard Health Insurance Benefit: Variable or flat rate for employees deducted after taxes
Cafeteria Style Group Health Plan: Variable or flat rate for employees deducted before taxes

What do you want to do next?
l
Set up a standard health insurance benefit
l
Set up a cafeteria style health benefit that is deducted before calculating payroll taxes

Void Paychecks
This can be used to void payroll checks that have been posted but not cleared. You can void paychecks either from the Tasks menu
or directly from the Payroll Entry window.

To void paychecks from the Tasks menu
1. From the Tasks menu, select Void Checks. The Void Existing Checks window appears.
2.
At Account ID, enter or select the G/L cash account number used on the check you want to void.
The window displays a list of the posted checks from the cash account you specified.

3.
4.
5.
6.

At Void Date, Sage 50 offers the system date as default. Accept or change the date as needed.
Scroll through the list to the check you want to void, and highlight the check.
Select the Void button.
Sage 50 asks you to confirm that you want to void this transaction. To void the paycheck, select Yes.

7. If you want to void any more checks from this cash account, then repeat steps 3 through 6. Otherwise, select Close.
To void paychecks from the Payroll Entry window
1. From the Tasks menu, select Payroll Entry. The Payroll Entry window appears.
2. Use the List button to find and display the paycheck you want to void.
3.
Next, select the Delete button, and from the drop-down list of options, select Void.
The Void Existing Checks window appears with the selected paycheck highlighted.

4. Enter or select the Void Date if different from the displayed system date.
5. Select the Void button.
6. Sage 50 asks you to confirm that you want to void this transaction. To void the paycheck, select the Yes button.
7. If you want to void any more paychecks from this cash account, then highlight it in the list of checks, and repeat steps 4
through 6. Otherwise, select Close.
When you void a check

l
l

The original check will be marked as cleared in Account Reconciliation .
A copy of the original check with negative amounts will be generated. The copy will be given a number of the original check, plus a
V. (For example, if the original check was 2055, then the copy will be 2055V. See the illustration below.)

l

When you view the check onscreen, the word Void appears in large red letters.

l

The new check will be marked as cleared in Account Reconciliation.

l

You will not be able to edit either the original check or the voided counterpart.

What happens if I delete the original check after it has been voided?
If you delete the original, both it and the voided counterpart will be deleted.

What happens if I delete the voided counterpart?
It will reinstate the original check.

How do I edit a voided check?
1. Select the voided counterpart and click Delete to delete it. This will reinstate the original check and make it editable.
2. Make your changes to the original and save.
3. Re-void it if necessary.

Managing Inventory & Services
Overview
Typically, inventory is made up of the items that you have in stock to sell to your customers. In Sage 50, in addition to the items that
you keep in stock, you can also enter other things that you sell, such as services, for easy data entry and reporting purposes. You
may want to enter non-stock items for things that you purchase, but don't sell, such as office supplies. This allows you to easily enter
these items on purchase transactions such as purchase orders or purchase invoices.

Tracking
l

l

l
l

Sage 50 has various inventory reports and the Inventory & Services Navigation Center that you can use for tracking and
managing your inventory.
You can keep track of quantities of stock items so you know how much you have on hand to sell to your customers and when
you need to order more. In Sage 50 Premium Accounting and higher, you can use serialized inventory to keep track of
inventory items that have serial numbers.
You can track information related to service and non-stock items in addition to your stock items.
If you have assembly items, you can build and unbuild them as necessary from other items (components) that you have on
hand.

Customizing
l

l

If you don't see a field on the Maintain Inventory Items screen for the information that you want to track, you can set up
custom fields that will allow you to enter this information.
You can have multiple prices for your inventory items. In Sage 50 Pro Accounting, you can have 5 prices for each inventory
item. In Sage 50 Complete Accounting and higher, you can have 10 prices for each inventory item.

Reporting

l

l

You can use the Inventory Profitability Report to see how profitable your different items are and to make decisions about what
you sell.
Worksheets such as the Inventory Reorder Worksheet and the Physical Inventory List can help you manage your inventory
quantities.

Creative Uses for Inventory
In addition to tracking costs and quantities for traditional stock-type inventory items, using inventory items makes entering
transactions easier. You can set up all the known constants for any item that you might include on an invoice. That information will
automatically appear, once you select the item code. This saves data-entry time.
For example, you can set up freight charges as an inventory item. Most likely this would be a non-stock item, because you would
want to track default accounts as well as a description and a unit price (which can be changed on the invoice). The item class you
choose depends on how much information is constant for the "item."
Be sure to enter items such as freight as non-commission. (That is, don't select the Subject to Commission check box on the
Maintain Inventory items window.) Then, sales representatives won't receive commission on these sales.

Related topics
Inventory item classes
What do you want to do next?
Set up an inventory item
l
Set up an assembly item
l

Things to Think About Before You Enter Inventory Items
Before you start entering your inventory items, there are a few things you may want to think about.

General
It's a good idea to familiarize yourself with the Maintain Inventory Items screen before you get started. Take a look around the
screen and at the different tabs. Choose different item classes; certain fields and tabs are available depending on the item class. Use
the Sage Advisor located on the right-hand side of the Maintain Inventory Items screen. Simply, click in a field to get advice about
what to enter in the field and how that information is used in Sage 50.
To get to the Maintain Inventory Items screen, click the Inventory Items navigation aid on the Inventory & Services
Navigation Center and select New Inventory Item.

Item ID
Each item is required to have a unique ID to identify it in Sage 50. This ID is used when selecting the item in lists, on transactions,
and in filters for reports. You should think about how you want to create IDs for your items before getting started.

Item Class
Think about the items that you sell and services that you offer. Also think about any items that you purchase that you don't keep in
inventory, but want to easily be able to add to purchase transactions. This will help you determine which item classes you need to
choose for your items.

See "Understanding Item Classes" for more information about item classes.
Item Type
Item types can be used to help you further identify and group your inventory items. You can use whatever types make sense for
your business. You may want to decide if you want to use item types and what they are before you enter your items.

GL Accounts
You also want to think about your GL accounts for financial reporting purposes. GL accounts are used to record the purchase and
sale of your inventory items. They are also used to record the value of any inventory that you have in stock. For example, if you
have a bookstore and want to track all items that are books separately from other items, you might set up an income account called
Sales-Books, a cost of sales account called Cost of Sales-Books, and an inventory account called Inventory-Books. Then you would
select these GL accounts for any items you enter that are books. Notice that the GL account options on the screen change depending
on the item class you have selected. To use the Sage Advisor (on the right-hand side of the Maintain Inventory Items screen), select
an item class and then click in a GL account to get advice about the account you should enter and how it is used in Sage 50.

Cost Method

The cost method is used to determine the value of your current inventory and the cost of sales when you sell your inventory items.
You should determine the cost method that you want to use for your inventory before you start entering inventory items because
you can't change the cost method once you have saved the item. The cost method is only used for items that you keep in stock. It
doesn't apply to non-stock, service, or labor items.

Price Levels
Decide if you want to use multiple price levels for your items. For example, you might want to enter a regular price and a sales price
for an item.

See "Setting Up Price Levels" for more information about price levels.
Information You Want to Keep Track of or Use to Manage Your Inventory
Many different fields are available for helping you manage and track your inventory. These include the stocking unit of measure,
location, weight, minimum stock quantity, reorder quantity, preferred vendor, and buyer ID.

Inventory Item Defaults
Inventory item defaults allow you to set up information so that it automatically appears on the Maintain Inventory Items screen
when you set up your items. This makes data entry easier and reduces data entry errors. It also allows you to customize and set up
different elements of Sage 50 that are related to inventory. You should set up your inventory item defaults before you begin entering
your inventory items. To set up your inventory item defaults, click the Inventory Items navigation aid on the Inventory & Services
Navigation Center and select Set Up Inventory Defaults.

See "Why You Should Set Up Item Defaults" for more information about setting up item defaults.
Tips
l
l

l

l

l

If you are going to specify a preferred vendor for your items, you should set up your vendors first in Maintain Vendors.
If you are going to specify a buyer for your items, you should set up your employees and sales reps first in Maintain
Employees/Sales Reps.
Sage 50 can automatically create purchase orders when your stock reaches a certain level. You select to use this feature in
Inventory Item Defaults. You will also need to enter a preferred vendor, minimum quantity, and reorder quantity for items you
want to use this feature. (Not available in Sage 50 Pro Accounting)
If you have several items that are the same except for some attribute such as color or size, you can create a master stock item to
easily set up these items. (Not available in Sage 50 Pro Accounting)
Use the Sage Advisor to get assistance when setting up your inventory items. Simply click in a field to get advice about what to
enter in that field and how that information is used in Sage 50. The Sage Advisor is located on the right-hand side of the Maintain
Inventory Items screen.

Inventory Item Defaults
To set up or review inventory item defaults, select Default Information from the Maintain menu, and choose Inventory
Items.
Sage 50 lets you set up default information for inventory items. Use this feature like a template or model upon which to build all your
item records. You enter the most common information. Then, when you set up new inventory items and enter transactions, the
default information is automatically included. In most cases, you won't have to enter anything.

Learn More
Maintaining item prices
In Maintain Inventory Item Defaults, you can set up default-level price calculations that determine the prices you generally
charge for items. However, the Maintain Item Prices window (Sage 50 Complete Accounting and higher only) then let you
change these default calculations for individual items or a range of items.

Setting up a new item
Once you've entered the default information that governs how Sage 50 treats inventory items generally, you're ready to set up
individual items in Maintain Inventory Items.

Set up an inventory item
Setting up a new inventoryitem
Once you've entered the default information that governs how Sage 50 treats inventory items generally, you're ready to set up
individual items in Maintain Inventory Items.

Set up an inventory item
Help with specific fields or folders
Besides settings that determine how Sage 50 handles general issues such as out-of-stock warnings, dDefault information for
inventoryitems includes:
l

General Ledger Accounts and Costing Methods for each item class

l

Item Tax and Shipping Information

l

Item Custom Fields

l

Item Sales Price Levels

All of this information is set up in New Company Setup. Or, you can add or modify defaults through the Maintain , Default
Information menu.

Understanding Item Classes
Item classes define what type of inventory item you are setting up. These are selected on the General tab of the Maintain Inventory
Items window. Item classes determine how an item's costing information is recorded. Once an item class is established (saved) for
an inventory item, it cannot be changed. For help selecting the right classes for your business,
You can select from the following classes of inventory items:

Non-stock: Use this class for items, such as service contracts and office supplies, that you buy or sell but do not put into your
inventory. Quantities, descriptions, and unit prices are printed on invoices and purchase orders, but quantities on hand are not
tracked. You can assign a cost of goods General Ledger account to non-stock items, but it is not affected by a costing method.

Stock: Use this item class for traditional inventory items that are tracked for quantities, average costs, vendors, low stock points,
and so on. Once an item is assigned this class, it cannot be changed.

Master Stock Item: (available in Sage 50 Complete Accounting and higher) Use this item class when you want to set up a group
of related stock items that have similar characteristics or attributes. A master stock item is a special item that does not represent
inventory you stock but rather contains information (item attributes ) shared with a number of substock items generated from it. For
information on setting up master and substock items, see "Set Up Master Stock and Substock Items" on page 202 .

Substock Item: (available in Sage 50 Complete Accounting and higher) This item class represents the substock items generated
from a master stock item. You can only display a substock item and its characteristics in the Maintain Inventory Items window; you
cannot directly set up a substock item. Similarly, you cannot delete a substock item in Maintain Inventory Items. The only way to
delete a substock item is by deleting the master stock attributes from which the substock item is created. For information on setting
up master and substock items, see "Set Up Master Stock and Substock Items" on page 202 .

Serialized Stock Item: (available in Sage 50 Premium Accounting and higher) Use this class for stock items that will have a serial
number associated with them. Serial numbers are typically used for expensive items, items that are under warranty, and items that
by law require you to record serial numbers. Serialized items cannot be included as part of an assembly or serialized assembly.In
addition, serialized inventory items cannot be used to create Item Multi-Packs.

Description only: Use this item class when nothing is tracked except the description. For example, "comments" that can be added
to sales or purchase transactions are description-only items.

Assembly: Use this class for items that consist of components that can be built or dismantled. For each assembly item, select the
Bill of Materials tab, and define the components of the assembly before you click the Save button on the Maintain Inventory
Items window. Once a transaction uses an assembly, it cannot be changed. You can make revisions to it, though.

Serialized Assembly Item: (available in Sage 50 Premium Accounting and higher) Use this class for assembly items that will
have a serial number associated with them. Serial numbers are typically used for expensive items, items that are under warranty,
and items that by law require you to record serial numbers. In addition, serialized inventory items cannot be used to create Item
Multi-Packs.

Service: Use this item class for services you perform and sell, such as monthly maintenance work. You can enter a cost for the
service, which would include your employee's wage, overhead, materials, and such used in the course of performing the service.

Labor: Use this item class for labor that is part of an assembly item or for outside labor that you use for projects; you can enter a
cost for the service. In the case of assembly items, this labor will become part of the cost of goods for the assembled item.

Activity: (available in Sage 50 Complete Accounting and higher) Use this item class for different types of work that are performed
for a customer or job. These are very useful for professional businesses, such as law firms, that want to track employee time for a
customer an job and then bill the customer. Activity items are used in Time & Billing and are recorded on employee or vendor time
tickets.

Charge : (available in Sage 50 Complete Accounting and higher) Use this item class to identify items that are expenses recorded
by an employee or vendor when various services are performed for a customer or job. Charge items are used in Time & Billing and
are recorded on employee or vendor expense tickets. Use charge items when you plan on billing customers for reimbursable
expenses, such as parking fees, mileage, and so on.

Beginning Balances for Inventory Items
The beginning balance for inventory items includes the quantity, unit cost, and total cost of the inventory. You only use this when you
first enter beginning balances. However, if you enter an incorrect unit cost for a beginning balance, this is the only place where you
can change it.
To enter beginning balances for stock and assembly items, select the Beginning Balances button on the General tab of the
Maintain Inventory Items window.
You can enter a single quantity and unit cost for each inventory item, provided you have a password that allows you to enter
beginning balances (if one is required). Do not use the Inventory Beginning Balances window to make adjustments to inventory for
spoilage or theft; instead, use the Inventory Adjustments option from the Tasks menu.
You can modify the beginning balance whenever you like, until you close the fiscal year. Once you close the fiscal year, you can no
longer change beginning balances for any item that was used in any transaction in the closed year. You could, however, do an
inventory adjustment on the first day of Period 1.
The total amount of your inventory beginning balances entered here needs to be the same amount you entered in your chart of
accounts beginning balance for inventory accounts. If you don't do this, your general ledger and financial reports will not match your
inventory reports.
If you want to adjust the quantity, enter an inventory adjustment instead. How do I do this?
The toolbar at the top of the window contains the following buttons: Cancel, OK, Find, Next, Serial No, and Help.

Item ID: This is the item for which you want to enter or change the beginning balance.
Quantity: This is the number of items you have in stock.
Unit cost: Enter the cost of the item per unit. If you want to calculate the unit amount, leave this blank and enter an amount in
the Total Cost entry box.
Total cost: This is calculated by multiplying the quantity by the unit amount. If you want to calculate the unit amount, enter an
amount here.

What do you want to do next?
l
Enter inventory beginning balances
l
Enter inventory adjustments
l
Set up an inventory item
l
Set up an assembly item
l
Change an item ID
l
Change item sales prices

Enter Beginning Balances for Inventory
Use this procedure to enter inventory beginning balances for stock items and assemblies. This establishes the quantity on hand of
items when you started using Sage 50.

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New Inventory
Item.
2. On the General tab, select the Beginning Balances button.
3. From the item list, enter or select an item ID that you want to record a beginning balance. To display a list of existing items, type ?
in this field, or select the Lookup button.
If you select a serialized item, the Serial No button will become available. You will need to enter serial numbers for these items
after you have entered a quantity.

4. For each item, enter two of the three fields: quantity (on hand), unit cost, and total cost. The third or remaining field will
automatically be calculated.

If the item that you are entering beginning balances for is a serialized item, select the Serial No button to enter serial numbers
for this item. The Serial Number Entry window appears. Enter the serial numbers you need and select OK when you're finished
to return to the Inventory Beginning Balances window.

5. When finished entering beginning balances for all your inventory items, select OK.

Why You Should Set Up Item Defaults
Setting up item defaults makes it easier for you to enter your item inventory information and to ensure that it is entered accurately.
It also allows you to customize some areas of Sage 50 that are related to items inventory.
l

Improve Ease and Accuracy of Data Entry: Defaults are the standard selections that apply to the majority of your items.
The default information you set up here is automatically filled in for new items you set up in Maintain Inventory Items. You can
change this information for an individual item if necessary.

l

Manage Your Inventory Stock Levels: You can specify if you want to have warning messages appear when you save
transactions and you don't have enough of an item in stock. You can also specify if you want purchase orders to automatically be
created when you save certain transactions and are out of stock. (Auto-creation of purchase orders is available in Sage 50
Complete Accounting and higher).

l

Customize Tax Types: Tax types are used to classify sales taxes for reporting purposes. You can set up 10 tax types. You can
select a tax type for an item when you set it up and when you add it to a sales transaction.

l

Customize Shipping Methods: Sage 50 has set up some common shipping methods for you, but you can change these if you
want to. The shipping methods available in the Ship Via fields throughout Sage 50 come from Inventory Item Defaults.

l

Enter More Information About Your Items: You can enter additional information about your items in Maintain Inventory
Items by setting up Custom Fields.

l

Set up Price Levels: If you want to have more than one price for your items, you can set them up here. This just sets up the
price levels (such as Full Price, Sales Price, Clearance Price). The actual prices for items are entered in Maintain Inventory Items.

To set up item defaults, click the Inventory Items navigation aid on the Inventory & Services Navigation Center and
select Set Up Inventory Defaults.

Set Up an Inventory Item
Use this procedure to set up a new inventory item record.

1. Click the Items and Services navigation aid on the Customers & Sales Navigation Center and select New Item.
2. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New Inventory
Item.
Tip: From any task (transaction) window, you can type + or double-click inside the Item ID field to set up a new inventory
item.
The Maintain Inventory Items window is displayed.

3. Enter a new item ID, and complete the necessary item information. You can use the Setup Advisor located on the right-hand side
of the screen as a guide.

4. When you're finished filling in the item information, click Save.

Change an Item ID
Use this procedure to change an existing item ID.

1. Click the Items and Services navigation aid on the Customers & Sales Navigation Center and select New Item.
2. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New Inventory
Item.
3. Enter or select the item ID you want to change. To display a list of existing items, type ? in the Item ID field or select the Lookup
button.

4. Select the Change ID button on the toolbar. The Change Item ID window is displayed.
5. Enter the new ID that you want to use instead of the current ID.
6. When you are finished, select OK to change the ID and return to the Maintain Inventory Items window.
When you change an item ID, all data records and transactions associated with this item will change to reflect the new ID. This
includes both current and past transactions.

Note: This is useful if you want to change the way you identify data records. For example, suppose you currently use the item
name as the item ID. However, as your business grows, it becomes necessary to use a scheme that is more definitive than the
item name. For example, an item may have two colors or sizes. Consequently, you decide to begin using item numbers as the
identifier. You can easily change the item ID to meet your needs.

Delete an Inventory Item
You cannot delete an inventory item if it is used in a transaction or has an established beginning balance. If that is the case, you can
make the item inactive to designate that it shouldn't be used and make it eligible for purging. To do this, select the inactive checkbox
and save the item.
To delete an item:

1. Click the Items and Services navigation aid on the Customers & Sales Navigation Center and select New Item.
2. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New Inventory
Item.
3. Enter or select the ID of the item you want to delete. To display a list of existing items, type ? in this field, or select the Lookup
button.

4. Select the Delete button. The system displays a warning message, asking if you're sure you want to remove this record.
5. Select Yes.

Purchase an Inventory Item
To record the purchase of an inventory item:

1. From the Tasks menu, select Purchases/Receive Inventory. The Purchases/Receive Inventory window is displayed.
2. Enter the purchase information including vendor you're purchasing from, quantity, and item purchased.
3. Click Save.
When you save purchases for inventory items:non-stock items, the default inventory account is debited to offset the credit to
Accounts Payable.
l

The amount of the item in stock is updated (both stock items and assemblies).

l

The inventory value is updated.

l

For stock items, the inventory account is debited to offset the credit to Accounts Payable.

The cost is computed at the time the sale of the item is recorded using the costing method you chose when you set up the inventory
item.

Sell Inventory Items
To sell an inventory item using an invoice
1. From the Tasks menu, select Sales/Invoicing. The Sales/Invoicing window is displayed.
2. Enter the quantity sold and the item ID. If necessary, enter the price.
3. Save the invoice. Sage 50 calculates the cost of sales.
To sell an inventory item without creating an invoice
1. From the Tasks menu, select Receive Money. The Receive Money window is displayed.
2. After you enter the information in the top section of the window, select the Apply to Revenues tab.
3. Enter the quantity sold and the item ID. If necessary, enter the price.
4. Save the receipt. Sage 50 calculates the cost of sales.

Multiple Sales Price and Billing Rate Levels
In Sage 50 Pro Accounting, you can have up to five different price levels for any single item. In Sage 50 Complete Accounting and
higher, you can have up to ten different price levels for any single item and the ability to calculate these price levels.
Item sales price levels are set up when you select the price level button on the General tab of the Maintain Inventory Items window.
Enter the amount to appear on your customer quotes, sales orders, and sales invoices.

Sales price levels correspond with those you assign your customers, so make sure that you enter the price levels in consistent order
(for example, from lowest to highest or highest to lowest), or select from the different prices when invoicing your customers. You
can specify a default price level for customers in the Maintain Customers/Prospects window. You can disable each price level and
customize the price level names in the Inventory Item Defaults window.
If you are setting up an activity item used in Time & Billing (possible in Sage 50 Complete Accounting and higher only), Sales Price
Level fields are replaced with Billing Rate levels. Billing Rate levels correspond to the ones you set up for your employees when
working with time-ticket hours.

Note: In Sage 50 Complete Accounting and higher, when you see prices displayed in red in the Price column, it's an indication
that changes have been made to item prices and that the related item price levels don't reflect these changes. Let's say, for
example, that you have changed the value of Price Level 1 on the General tab of Maintain Inventory Items, but price levels with
calculations based on Price Level 1 do not yet reflect this change (for instance, a price level based on the calculation Price Level 1
+ 10.00 ). If this is the case, select the Recalculate button to update price levels to match the price changes that have occurred.

What do you want to do next?
Set up an inventory item
l
Set up an assembly item
l
Enter inventory beginning balances
l

Change Item Prices
You change item prices by typing in a price on the Maintain Inventory Items window. In Sage 50 Complete Accounting and higher,
you can also use the Maintain Item Prices window to change sales and billing prices for a single item, a range of items, or all
inventory items.

Manually Changing Item Prices
The following procedures are for manually changing item prices in all Sage 50 products.

1. Click the Items and Services navigation aid on the Customers & Sales Navigation Center and select View and Edit
Items and Services.
2. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select View and Edit
Inventory Items.
3. Select the item that has the prices you want to change and click Open .
4. On the General tab of the Maintain Inventory Items screen, select the arrow button next to the item's sales price.

The Multiple Price Levels window is displayed.
5. Type over existing prices with the changes you want to make.

Note: In Sage 50 Complete Accounting and higher, you can also adjust price level calculations. Click the Edit button to display
the Calculate Price Levels window.

6. Select the OK button to accept the new price levels, or select the Cancel button to reset the prices to the beginning levels.
Calculating New Item Prices
In Sage 50 Complete Accounting and higher, you can have up to ten price levels for each item. You can change a group of item
prices or price levels, using the Maintain Item Prices window.

1. From the Maintain menu, select Item Prices. The Maintain Item Prices (Filter Selection) window is displayed.
2. Enter or select a range of items that you want to adjust. When finished, select OK. The Maintain Item Prices window is displayed.
3. Select each price level that you want to recalculate.
4. Select the method of adjustment:
l
Level's current calculation and new cost information: If this option is chosen, selected price levels and items that use
cost or level one in calculating the price are recalculated based on the current cost or the updated level-one price.
Recalculations using this option first look at any item-level calculations you have set up (in Maintain Inventory Items); if there
are no item-level calculations, default-level calculations (set up in Inventory Item Defaults) are used.

If price level one is selected as a level to adjust, the value for price level one is recalculated first and new prices for the fields
that reference level one are then recalculated.

Level's default calculation: If this option is chosen, each price level and item selected are recalculated using the

l

calculation in Inventory Item Defaults. Any customized calculations you may have set up for individual items (in Maintain
Inventory Items) are overridden.

Calculation selected below: If this option is chosen, any existing calculations for the selected price levels and items are

l

overridden, based on the parameters you choose here.
Place a checkmark in the Select box of the items you want to recalculate prices for. To change the group of listed items, click
the Select (Items) toolbar button.

5.
6.
7.
8.

To adjust item prices based on the options selected, select the Recalculate toolbar button.
Enter or change item prices manually in the New Price field, if desired.
To print a report of your proposed price adjustments, select the Print button.
To record your price adjustments, select the Save button. When finished, close the window.
All new sales transactions will use the new item prices.

Set Up Item Prices
In Sage 50 Complete Accounting and higher, you can us the Maintain Item Prices screen to set up and adjust prices for your
inventory items. To do this:

1. From the Maintain menu, select Item Prices.
2. Use the filter screen to select the items whose prices you want to adjust. The filters allow you to select one item, a range of items,
or all items.

3. Click OK.
4. The items that met the filter criteria are shown in the list at the bottom of the screen. If you decide that you don't want to change
the price for a particular item, simply uncheck the Select box. Price adjustments will only be made for items that are selected.
If you want to choose a different group of items, click the Select toolbar button and change your filter selections.

5. Select the price levels you want to adjust.
6. Select how you want to adjust the price levels. The possible adjustments are:
l
Level's current calculation and new cost information: If this option is chosen, selected price levels and items that
use cost or level one in calculating the price are recalculated based on the current cost or the updated level-one price.
Recalculations using this option first look at any item-level calculations you have set up (in Maintain Inventory Items); if there
are no item-level calculations, default-level calculations (set up in Inventory Item Defaults) are used.
If price level one is selected as a level to adjust, the value for price level one is recalculated first and new prices for the fields
that reference level one are then recalculated.
l

Level's default calculation: If this option is chosen, each price level and item selected are recalculated using the
calculation in Inventory Item Defaults. Any customized calculations you may have set up for individual items (in Maintain
Inventory Items) are overridden.

l

Calculation selected below: If this option is chosen, any existing calculations for the selected price levels and items are
overridden, based on the new calculation parameters you choose here.

7. To adjust item prices based on the options selected, select the Recalculate toolbar button.
Note: This allows you to see what the prices will be based on the options you've selected. The prices are not actually changed
until you select the Save button.

8. You can enter or change item prices manually in the New Price field, if you want to.
9. If you want to print a report of your proposed price adjustments, select the Print button.
10. To record your price adjustments, select the Save button. When finished, close the window.
All new sales transactions will use the new item prices. Existing sales transactions will not be affected.

Setting Up Price Levels

To set up sales price levels for your items, select the Price Levels tab on the Inventory Item Defaults window. Price levels offer
you a way to charge different prices to different customers. For example, a regular customer who buys large quantities of an item
may get a better price than the occasional customer who only buys one of that same item.
You can customize price level names and disable/enable levels in Sage 50 Pro Accounting for up to five price levels. Instead of
"Price Level 1," "Price Level 2," and so on, you can set up your own price level names. For example, you can set up "Retail," "10%
Sale," "20% Sale," "Wholesale," and "Employee Price" price level names. You can do the same in Sage 50 Complete Accounting and
higher, for up to ten price levels.

Set Up Price Level Names
You can customize sales price level names and disable/enable levels in Sage 50 Pro Accounting for up to five price levels. Instead of
"Price Level 1," "Price Level 2," and so on, you can set up your own price level names. For example, you can set up "Retail," "10%
Sale," "20% Sale," "Wholesale," and "Employee Price" price level names. You can do the same in Sage 50 Complete Accounting and
higher, for up to ten price levels.

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select Set Up
Inventory Defaults.Click the Items & Services navigation aid on the Customers & Sales Navigation Center and
select Set Up Item Defaults. The Inventory Item Defaults window is displayed.
2. Select the Price Levels tab.
3. Enter a description for each price level.
These descriptions will appear in the Maintain Inventory Items window (when setting up the item's default price level) and the
Item ID lookup field in all sales transaction windows.

4. When you are finished, select OK.

How Do I Set Up A Price Level Calculation for an Individual Item?
This procedure is possible only in Sage 50 Complete Accounting and higher.
These instructions are for setting up a price calculation for price levels for an individual item. This is done by clicking the arrow
button next to the sales price for an item on the Maintain Inventory screen. Price level calculations that will apply to multiple items
should be set up from the Price Levels tab in Inventory Item Defaults.

1. Choose what you want to use as the base price for the calculation. You can use Price Level 1, Last Cost, or Current Price.
Current price is the existing price for this price level.
You cannot choose Price Level 1 if you are calculating Price Level 1.

2. Choose how to calculate the price - whether you want to increase or decrease the base price by a certain amount or percent. Then
enter the amount or percent.

3. Choose if you want to round the price. You can round the price to the next dollar or a specific cent. If you choose "specific cent",
you will need to enter what that is - for example, .99.

Note: As you make your selections, the calculated price is shown in the field in the lower right part of the screen.
If you decide you just want to enter the price, choose No Calculation in the Use drop-list. Then you can enter the price in the field
shown in the lower right part of the screen.

Learn More
Setting Up Price Level Names
Setting Up Default Price Calculations

Set Up a Calculated Price Level for an Individual Item
In Sage 50 Complete Accounting and higher, you can have up to ten price levels for each item. You can set up calculations for these
price levels on the Calculate Price Levels window. To set up a calculated price level for an individual item:

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select View and Edit
Inventory Items.
2. Select the item you want to add a price calculation for and click Open .
3. Select the arrow button next to the sales price. The Multiple Price Levels window is displayed.

4. Select the price level you want to enter a calculation for, and click the Edit button.
The Multiple Price Levels window displays the system name for each price level, (customized in Inventory Item Defaults). To
learn how set these up, see "Set Up Price Level Names" on the previous page.

5. Select the Edit button. The Calculate Price Level window appears.
6. Calculate the new price using the options in the drop-down menus:
l
Use: Select a price level value on which to base the calculation. Select from price level one, current price, last cost, or no
calculation.

Tip: On new inventory items, it may be helpful to set up your first price level as your base price. That way when you set up a
calculation for another price level, you can use the base price as a part of your calculation.
l

And: Select the type of mathematical formula you want the calculation to perform. Select from increase or decrease by
amount (enter the specific amount in the next field), or increase or decrease by percent (enter the specific percent in the next
field).

l

Round New Price to: Select a custom rounding operation for this calculation. Select from no rounding, round to specific cent
(enter the cent value in the next field), or round to next whole dollar.

7. Select OK to accept the new calculation, or Cancel to reset the calculation to the beginning value.
8. If you are finished with your changes, select OK on the Multiple Price Levels window. Select Edit to edit other price levels.

Default Price Level Calculation
This feature is available only in Sage 50 Complete Accounting and higher.
Sage 50 allows you to set up default pricing-level calculations in Inventory Item Defaults that will be available on every new
inventory item you enter. (Existing items and their prices are not affected.) The calculations you set up act as templates or models
and should contain commonly used pricing values. Creating default price level calculations saves you time and effort. Later, when
you select a pricing level for inventory items (in the Maintain Inventory Items window), you can simply select the appropriate pricing
level, and you're done.
To access the Default Price Level Calculation window, do the following:
From the Maintain menu, select Default Information , and choose Inventory Items. In the Inventory Item Defaults
window, select the Price Levels tab, and click the Edit button next to each price level that you have defined.
In the Default Price Level Calculation window, you can set up a default calculation for a specific price level. Initially, the
calculation is set to “No Calculation.” You can set up a calculation based on Last Cost or Price Level One. The calculation can be
increased or decreased by an amount or a percentage of the base price. In addition, you can round the price to either a specific cent
or the next dollar amount.

What do you want to do next?
Change item sales prices
l
Set up an inventory item
l

l
l
l

Set up an assembly item
Delete an inventory item
Change an item ID

How Do I Set Up A Default Price Level Calculation
This procedure is possible only in Sage 50 Complete Accounting and higher.
These instructions are for setting up default price calculations for your price levels from the Price Levels tab of Inventory Defaults.
You can set up price calculations for price levels for individual items from the Multiple Item Prices screen accessed from the Maintain
Inventory Items screen.

1. Choose what you want to use as the base price for the calculation. You can use Price Level 1 or Last Cost.
You cannot choose Price Level 1 if you are calculating Price Level 1.

2. Choose how to calculate the price - whether you want to increase or decrease the base price by a certain amount or percent. Then
enter the amount or percent.

3. Choose if you want to round the price. You can round the price to the next dollar or a specific cent. If you choose "specific cent",
you will need to enter what that is - for example, .99.
If you decide you just want to enter the price for your items, choose No Calculation in the Use drop-list.

Learn More
Setting Up Price Level Names
Default Price Levels
Setting Up Price Calculations for Individual Items

Set Up a Calculated Default Price Level
In Sage 50 Complete Accounting and higher, you can set default price calculations for each sales price level. Setting default price
level calculations does not affect existing inventory items, only new items that you add. These calculations can be overridden at the
inventory item level, if desired.

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select Set Up
Inventory Defaults.Click the Items & Services navigation aid on the Customers & Sales Navigation Center and
select Set Up Item Defaults. The Inventory Item Defaults window is displayed.
2. Select the Price Levels tab. To learn more about price level names and how to set them up, see "Set Up Price Level Names" on
page 190 .
3. Select the price level that you want to set up a calculation for, and click the Edit button (to the far right).

The Default Price Level Calculation window appears.
4. Calculate the new price using the options in the drop-down menus:
l
Use: Select a price level value on which to base the calculation. Select from Price Level One, last cost, current price, or no
calculation.
l

And: Select the type of mathematical formula you want the calculation to perform. Select from increase or decrease by
amount (enter the specific amount in the next field), or increase or decrease by percent (enter the specific percent in the next
field).

l

Round New Price to: Select a custom rounding operation for this calculation. Select from no rounding, round to specific
cent (enter the cent value in the next field), or round to next whole dollar.

5. Select OK to accept the new calculation, or Cancel to reset the calculation to the beginning value.
6. If you are finished with your changes, select OK on the Inventory Item Defaults window. Select Edit button to change other price
levels.

Maintain Quantity Discounts
The Maintain Quantity Discounts window allows you to set up discounts for items based upon the quantity sold. You can set up your
inventory so that when a customer purchases a specified amount of an item, its sales price is discounted by a percentage or a set
amount. For example, you could give customers a 10% discount if they purchase 50 or more of a certain inventory item.
When you set up a quantity discount, you can specify up to five different quantity ranges and corresponding discounts. For example,
you could create a quantity discount that gives a 5% discount if 25 or more widgets are purchased, 10% if 50 or more widgets are
purchased, 20% if 100 or more widgets are purchased (and so forth), until you've created up to five ranges of discounts.

Learn More
Creating quantity discounts
Create as many quantity discounts as you need. You can create a unique quantity discount ID for each item in your inventory, or
create one quantity discount and apply it to whichever inventory items you choose. For example, you could create a discount for
a seasonal sale and apply the discount to your seasonal inventory items. You could also create a separate discount specifically
for lawn mowers. Quantity discounts are available for stock, master stock, non-stock, service, labor, and assembly item

classes.
After you set up the quantity discounts and apply them to inventory items, the sales prices will be automatically discounted on
quotes, sales orders, sales invoices, receipts, credit memos (Apply to Sales tab), memorized quotes, and memorized
invoices.

Note: Quantity discounts are calculated separately for each line of a transaction. If you create a quantity discount where
purchasing 40 widgets discounts the widgets by 5%, all 40 widgets must be entered on the same line in order for the discount to
be calculated.

Create a new quantity discount
Selling multi-pack units with a quantity discount
When you sell items in multi-pack units, Sage 50 checks to see whether the number of units in the multi-pack meets the criteria
for a quantity discount. For example, if you create a quantity discount where selling six items gives customers a discount, selling
one six-pack of the item (a multi-pack unit that you created) would be treated the same as six individual units. The customer will
receive the quantity discount.

Set up an item multi-pack

Create Quantity Discounts
Use this procedure to set up discounts based upon the quantity sold.

Creating New Quantity Discounts
1. From the Maintain menu, select Quantity Discounts. The Maintain Quantity Discounts window appears.
2. Enter a new ID in the Qty Discount ID field. (An ID can be created from the Description you enter, provided that option is
selected in Maintain Global Options.)

3. Type a description in the Description field.
4. From the Calculation Method drop-down list, select whether you'd like to calculate the discount as a percentage or as a flat
amount.

5. From the Rounding Method drop-down list, choose a rounding method by which to round up the unit price. Select from No
Rounding, round to a Specific Cent (which you define in the field that appears to the right when this option is selected), or to
the Next Dollar amount.
6. In the Minimum Qty for Discount field, enter the minimum quantity that must be purchased in order to receive a discount.
7. Enter the discount in the Discount Amount/Discount Percent field to the right of the Minimum Qty for Discount you
just entered.

8. If desired, enter up to five different ranges of quantities and corresponding discounts.
9. From the Price Levels grid, select the price levels to which you want to apply the Quantity Discount. By default, all price levels are
selected.

10. When you're finished entering discount information, click the Save button.
After creating Quantity Discounts, you can apply them to selected inventory items by following the procedure below.

Applying Quantity Discounts to Inventory Items
1. From the Maintain menu, select Inventory Items. The Maintain Inventory Items window appears.
2. Enter or select the item ID to which you want to apply a Quantity Discount.
3. In the Qty Discount field on the General tab, enter or select the Quantity Discount ID you want to apply to the selected
inventory item. To display a list of existing Quantity Discount IDs, type ? in this field, or select the Lookup button.
4. Select the Save button.
Once you have created the Quantity Discounts and applied them to inventory items, the sales prices will be automatically discounted
on transactions when the minimum quantity of an item is sold. Quantity Discounts are calculated on quotes, sales orders, sales
invoices, receipts, credit memos (Apply to Sales tab), memorized quotes, and memorized invoices.

What do you want to do next?

Enter an Inventory Return
To enter a return, you should enter an inventory adjustment to add the item back into inventory. See "Enter Inventory
Adjustments" .

Inventory Adjustments
You use the Inventory Adjustments selection to make changes to on-hand quantities of inventory items, and also track those
changes. If you use job costing and purchase stock items for inventory, you can also use this to remove items from inventory and
apply them as an expense to a job. This procedure is necessary for stock or assembly items you used in a job and did not enter on
the customer's sales/invoice.

Learn More
Entering inventory adjustments
The Inventory Adjustments window lets you make two different types of inventory adjustments, increases in quantity and
decreases in quantity.

Enter inventory adjustments
Want to know the quantity of inventory items on hand?
Sage 50 offers several different ways to determine how much of an item you have in stock.

Enter Inventory Adjustments
Occasionally, you may need to record adjustments to on hand quantities of inventory items. The Inventory Adjustment task makes
it easy to make these adjustments and to track them.
There are two types of inventory adjustments, increases in quantity and decreases in quantity.
l

For an adjustment up, you will enter a positive quantity and can also enter a unit cost. This will increase your quantity on hand
and total inventory value much as a purchase would. If you previously miscounted your inventory and now have more units on
hand than you thought you had, you could adjust up.

l

For an adjustment down, you will enter a negative quantity, but you can't enter a unit cost. Sage 50 will figure out the cost
value of the adjustment, much like a sale. An inventory adjustment down will decrease the quantity on hand as well as the total
value. If something was stolen or broken or if inventory was previously miscounted, you could adjust down.

To record an inventory adjustment
1. Click the Inventory Adjustments navigation aid on the Inventory & Services Navigation Center. The Inventory
Adjustment window is displayed.
2. Enter or select the item ID you want to adjust. To display a list of existing items, type ? in this field, or select the Lookup button. To
add a new item, type + or double-click the field, which displays the Maintain Inventory Items window.
This can only be an item classified as a stock item, serialized stock item, assembly item, or serialized assembly item. If the item is
serialized, the Serial No button will become available when you select the item ID. You will need to enter or select serial
numbers after you have entered an adjustment quantity in Step 7.

3. Enter anything you like in the Reference field up to 20 alphanumeric characters.
For example, you could enter your initials or the date in this field.

4. Enter or select the date the change in inventory occurred or the date of the physical inventory count.
5. If this adjustment is being made to account for inventory used in a job, enter or select the job.
6. If necessary, enter or select a G/L account to take this adjustment out of, and enter a unit cost for the inventory item (for positive
adjustments only).
The default G/L source account is the Cost of Goods Sold Account. The other account affected by adjustments is the inventory
account. To change the account ID, type ? in this field, or select the Lookup button.
The Unit Cost default is the current cost of the item and must be positive.
7. Enter the amount to adjust the quantity by.
The Quantity on Hand is already filled in, and the New Quantity is calculated after you enter the adjustment.
If this adjustment is being made to a serialized inventory item, select the Serial No button. Depending upon whether you enter a
positive or negative quantity, either the Serial Number Entry or the Serial Number Selection window will appear. After
you have entered or selected serial numbers, click OK to return to the Inventory Adjustments window.

8. If you know the reason for the adjustment, enter it.
For example, Found in warehouse or Theft.
9. Click Save.

Build/Unbuild Assemblies
You use the Assemblies selection to build or unbuild quantities of assembly items in inventory. Assembly items are created using the
Bill of Materials tab in the Maintain Inventory Items window. In Maintain Inventory Items, you name and create the assembly. In
Build/Unbuild Assemblies, you actually put together or "build" the assembly from its component inventory items. You can also take
apart or "unbuild" assemblies here.

Learn More
Setting up an assembly item
Before you can build assemblies, you must first set up and define the items that will make up the assembly. You do this in
Maintain Inventory Items.

Set up an assembly item
Building or unbuilding assemblies
The Build/Unbuild Assemblies window lets you either put together or take apart assemblies.

Build an assembly item
Unbuild an assembly
Changing components in an assembly item
Once you set up an assembly item and have entered transactions that use the assembly item, you will not be able to change the
Bill of Materials for that assembly item. However, you can create a new assembly item and copy the Bill of Materials from the
original assembly item.

Change the components in an assembly

Bill of Materials (Maintain Inventory Items)
To tell Sage 50 what items you want to use in an assembly, select the Bill of Materials tab in the Maintain Inventory Items window.
(This tab is only available if an assembly item ID is selected.) Once you have transactions that use an assembly, such as purchases
or sales invoices, you cannot change the components in the assembly. However, you can copy an assembly and modify the copy as
a new assembly.Once you have transactions that use an assembly, such as purchases or sales invoices, and you need to make
changes the components in the assembly, you will need to enter a revision. You can create a revision by selecting the Revisions
button from this tab. Once you enter the components on the Bill of Materials tab and select Save, you need to "build" the
assembly.
The cost of building the assembly is posted when you actually create quantities of an assembly item, using Build/UnBuild
Assemblies from the Tasks menu.

Components of the Assembly
Item ID: You can enter a ? or click the right mouse button to select an existing inventory item from the look-up list.
Description: This is the short description of the inventory item. You cannot change this description once the assembly item is
saved for the first time.

Quantity Needed: This is the amount of this item needed to build one assembly item.
Print Components on Invoice: Select this check box if you want all of the components of an assembly to print on quotes, sales
orders, invoices, and credit memos. If this box is not selected, then only the assembly prints on invoices and on quotes, sales
orders, invoices, and credit memos.

Add: Select this button to add an inventory item to the assembly. Note: You cannot modify the components of an assembly once
you have purchased or sold the assembly.

Remove: Select this button to remove an inventory item from the assembly.
Revisions: Select this button to make a revision to the bill of materials for this assembly. Revisions can only be entered if the
assembly has been used in a transaction. .
If you no longer want to use this specific assembly, you can unbuild it so there are no quantities of the assembly in stock. Then you
can copy the assembly to a new one and modify the new assembly. You could then make the old assembly inactive (by selecting the
inactive check box on General tab of Maintain Inventory Items) so you will be warned when selecting it for a transaction.

Set Up an Assembly Item

An assembly is made up of other items in your inventory; so when you build an assembly item, you can only build as many as you
have components. For example, if you were putting together 200 TV/VCR assemblies and you only have 50 VCRs, you'll only be
allowed to build up to 50 TV/VCR assemblies.
There are two steps to creating an assembly item: 1) define the items (components) the assembly contains, and 2) build the
assembly. Additionally, you can purchase prebuilt "assemblies."

To set up and define an assembly item
1. Click the Assemblies navigation aid on the Inventory & Services Navigation Center and select Set Up Items for
Assembly.
2. Enter an item ID and description for the assembly item, and select Assembly as the item class.
3. Enter any other information about the assembly item. You can use the Setup Advisor located on the right-hand side of the screen
to guide you.

4. After you finish filling out the item information, select the Bill of Materials tab. Don't select the Save button ; saving the
item at this point will cause it to become a stock item instead of an assembly item.

5. Select item IDs for existing stock items or assemblies only, and enter the quantity. Press ENTER. Do this for each item that makes
up the assembly.

6. When you're finished entering the assembly item, select the Save button.

Build an Assembly Item
1. Click the Assemblies navigation aid on the Inventory & Services Navigation Center and select Build New Assembly.
The Build/Unbuild Assemblies window is displayed.
2. Enter or select the item ID for the inventory assembly that you want to build. To display a list of existing items, type ? in this field,
or select the Lookup button. To add a new item, type + or double-click the field, which displays the Maintain Inventory Items
window.
If you select a Serialized Assembly, the Serial No button will become available. You will need to enter serial numbers for these
items after you have entered a Qty to Build in the steps that follow.

3. Enter anything you like in the Reference field up to 20 alphanumeric characters. For example, you could enter your initials or
the date in this field.

4. Enter or select the date you built the item.
5. Make sure Build is selected as the Action.
6. Enter the quantity you want to build for this assembly. You cannot build more assembly items than you have components for.
If the assembly that you are building is a serialized assembly, select the Serial No button to enter serial numbers for this item.
The Serial Number Entry window appears. Enter the serial numbers you need and select OK when you're finished to return to
the Build/Unbuild Assemblies window.

6. Select the employee who will supervise the building of this item if necessary.
7. Enter a reason for building the assembly.
8. Click Save.
Note: In Sage 50 Manufacturing Accounting, Sage 50 Distribution Accounting, and Sage 50 Quantum Accounting, you can also use
work tickets to build assembly items. For information about work tickets, refer to help within Sage 50.

Change the Bill of Materials for an Assembly Item
Once you set up an assembly item and have entered transactions that use the assembly item, you will not be able to change the Bill
of Materials for that assembly item. The relationship between an assembly item and its components must be maintained by the
system so that if you add, edit, or delete transactions for a component of that assembly item, then the assembly item can be
properly reposted and maintained.

Exception: In Sage 50 Manufacturing Accounting, Sage 50 Distribution Accounting, Sage 50 Construction Accounting, and Sage 50
Quantum Accounting, you can use revisions to change the bill of materials for an assembly item. For information about revisions,
refer to help within Sage 50.
Although you cannot change the Bill of Materials for an assembly item, you can create a new assembly item and copy the Bill of
Materials from the original assembly item. To copy the Bill of Materials for an assembly item, you need to:

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select View and Edit
Inventory Items.
2. Select the original assembly item and click Open .
3. Select the Bill of Materials tab.
4. Type in the ID you want to use for the new assembly item. The program may ask you if you want to save the record first. Select
No.

5. Select the Save button. Now the new assembly item will contain the same Bill of Materials as the original item, but you will be able
to edit and make changes to the new bill of materials.

6. After making the necessary changes, save the new record again.

Copy an Assembly Item
To copy the contents of an assembly into a new assembly, you need to:

1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select View and Edit
Inventory Items.
2. Select the item you want to copy and click Open .
3. Change the item ID to the new ID that you want to use for the new assembly item.
4. Make any necessary changes to the new assembly including the Custom Fields tab and on the Bill of Materials tab. Once you
post a transaction that uses this new assembly, you won't be able to make any changes to the components in the Bill of Materials
for this assembly. (Exception: In Sage 50 Manufacturing Accounting, Sage 50 Distribution Accounting, Sage 50 Construction
Accounting, and Sage 50 Quantum Accounting, you can change the components using revisions.)

5. When you're finished making changes to the new assembly, select Save.

Unbuild an Assembly Item
You can break an assembly into its component items by unbuilding it. When you unbuild (disassemble) an assembly, Sage 50
creates a new entry for that unbuilt assembly instead of looking for a previously built entry and deleting that entry. At the time that
you unbuild an assembly, Sage 50 will decrease the quantity and value of the assembly item and increase the quantities and values
of the components. Components will be put back at their most recent cost value, and any value difference between the per unit value
of the assembly item and the composite value of the components will be adjusted to the Cost of Goods Sold account.
To unbuild an assembly item:

1. Click the Assemblies navigation aid on the Inventory & Services Navigation Center and select Build New Assembly.
The Build/Unbuild Assemblies window is displayed.
2. Enter or select the item ID for the inventory assembly that you want to unbuild. To display a list of existing items, type ? in this
field, or select the Lookup button. To add a new item, type + or double-click the field, which displays the Maintain Inventory Items
window.
If you select a Serialized Assembly, the Serial No button will become available. You will need to select serial numbers for these
items after you have entered a Qty to unbuild in the steps that follow.

3. Enter anything you like in the Reference field up to 20 alphanumeric characters. For example, you could enter your initials or the
date in this field.

4. Enter or select the date you disassembled the assembly.
5. Select Unbuild as the Action.
6. Enter the number of assemblies you want to unbuild in the Qty field. You cannot unbuild more assembly items than you have in
the assembly's quantity on hand.
If the assembly that you are unbuilding is a serialized assembly, select the Serial No button to select serial numbers for this
item. The Serial Number Selection window appears. Select the serial numbers and click OK when you're finished to return to
the Build/Unbuild Assemblies window.

6. Enter a reason for unbuilding the assembly.
7. Click Save.

Work Tickets

Work tickets allow you to bring together all of the materials, both labor and parts, needed to build an assembly. Work tickets act as
both information sources and tracking devices. After you select an assembly item and enter the quantity that you need, the work
ticket provides valuable information about what’s required to complete the job. Work tickets list the quantity of materials needed to
complete the job, the amount you have on hand, and the amount that is available. If you do not have enough materials to build an
assembly, you can order them right on the Work Tickets window.

Learn More
Entering and updating work tickets
Once you enter a work ticket, you'll want to keep the assembly information updated. This includes tracking the number of hours
it takes to complete the assembly and comparing them to your forecasted hours. As materials are received or labor items are
completed, you can check them off as finished.

Enter a work ticket
Update a work ticket
Closing work tickets
Once all of the assembly materials have been received or finished, you can close the work ticket.
When a work ticket is closed, a build record is automatically created behind the scenes, saving you time and effort. However,
you will not have access to assembly build records created by work tickets. If you need to unbuild assemblies created by work
tickets, you can either clear the Close Ticket checkbox on a closed work ticket or unbuild the items in the Build/Unbuild
Assemblies window.

Printing work tickets
You can use a printed work ticket to keep track of materials needed to build an assembly. Print out a closed work ticket and send
it down to the shop floor when the assembly is ready to be build.

Print a work ticket

Enter a Work Ticket
Work tickets let you bring together all of the materials, both labor and parts, needed to build an assembly. Work tickets act as both
information sources and tracking devices.

How do I get to the Work Tickets window?
From the Tasks menu, select Work Tickets.
Enter item IDs, ticket date/number, and quantities to build
1. In the Assembly To Build field, enter or select the item ID of the assembly item that you plan to build. Once you select the
assembly to build, the materials or components needed to build the assembly will be automatically filled in.

Sage 50 Premium Accounting and higher: If you select a Serialized Assembly, the Serial No button will become available.
You will need to enter serial numbers for these items after you have entered a Qty to Build in the steps that follow.

3. Enter the work ticket date if it is different from the date displayed.
4. Enter a work ticket number if you want to change the one Sage 50 automatically enters. If this is the first work ticket to be
entered, the work ticket number field will be blank. After you enter the first work ticket number, subsequent work tickets will
be automatically numbered.

5. In the Qty to Build field, enter the number of this assembly item that you need to build. After you enter the quantity to build,
the materials required to build this quantity of items will be updated in the component list.

Sage 50 Premium Accounting and higher: If the assembly that you are building is a serialized assembly, select the Serial
No button to enter serial numbers for this item. The Serial Number Entry window appears. Enter the serial numbers you need
and select OK when you're finished to return to the Work Tickets window.
Enter supervisor ID and time information; save
1. Enter or select the ID of the employee who will supervise this work ticket.
2. Enter or select the date that you need the items and the date work began on this work ticket in the Needed By and Ticket
Started fields, respectively.
3. If you are tracking the time it takes to complete a work ticket, enter the number of hours you think it will take to complete the
work ticket in the Total Est Hours field.

4. When you are finished entering the work ticket information, select Save.

What do you want to do next?
Update a work ticket
l
Print a work ticket
l
Read the work tickets overview
l

Update a Work Ticket
From time to time, you will need to update work tickets with your progress. Follow the steps below to update a work ticket.

1. From the Tasks menu, select Work Tickets. The Work Tickets window appears.
2. Click the Open button and select the ticket that you want to update and click OK. The selected work ticket information appears in
the Work Ticket window.

3. Update any of the information that has changed on the work ticket.
4. If you have finished or received items in the component list, select the corresponding Finished check box and enter the Act
Hours, if you are tracking hours.
5. Then, click Save. After you have marked one item in your component list as finished, your work ticket is given a status of In
Progress.

Print a Work Ticket
Work tickets can be printed and used in various ways. Printed work tickets may be used in your Inventory department to gather the
materials needed to build an assembly. Likewise, copies of closed work tickets may be sent along with the necessary materials to
authorize the shop to build an assembly.
In Sage 50, you can print work tickets in two ways:

1. By clicking the Print button in the Work Tickets window
2. By selecting Work Tickets from the Form Types list in the Select a Report or Form window
If you are interested in printing just one work ticket and you already have the Work Tickets window open, print the ticket by
selecting the Print button. However, if you are interested in printing a number of work tickets, print the work tickets from the Select a
Report or Form window. Use the following procedure to print work tickets in the Select a Report or Form window.

Printing Work Tickets in the Select a Report or Form window
1. From the Reports & Forms menu, select Forms, then Work Tickets. The Select a Report or Form window appears with the
Work Ticket form type selected and Work Ticket forms displayed in the Forms list.

2. In the Forms list, double-click the Work Ticket Traveler Plain form. The Work Ticket Traveler Plain filter window appears.
3. Using the filter options, select the work tickets that you need to print and click Print/E-mail.
4. Close the Select a Report or Form window when you have finished.

Working With Serialized Inventory
Serial numbers are often used as an added identification for big-ticket items like computers, electronics, automobiles, jewelry, and
so on. In addition to being used for identification, serial numbers offer a way for you to keep detailed records about a specific item’s
warranty and, if necessary, recall information.
In Sage 50 Premium Accounting and higher, you can specify two types of serialized inventory: serialized stock items and serialized
assemblies. These items are set up in the Maintain Inventory Items window and use the specific unit costing method. Additional
options are available for serialized inventory items and can be accessed by selecting the Serial Numbers tab.

On the Serial Numbers tab, you can set up warranty information, view all of the serial numbers created for the item, including the
status of the serial number and warranty, and search for a specific serial number (useful when the item has a significant number of
serial numbers).

Note: Once a serialized inventory item is set up, you’ll be able to enter and select serial numbers for the item on various task
windows in Sage 50. Serial numbers are alphanumeric and can be up to 30 characters long.
When working with serial numbers, there are three types of transactions that you will encounter: transactions that initially add items
to your inventory (originating transactions), transactions that return previously removed items back to your inventory (intermediary
transactions), and transactions that remove items from your inventory (ending transactions). These transactions include:
Sales/Invoicing, Receipts, Credit Memos, Purchases/Receive Inventory, Payments, Vendor Credit Memos, Inventory Adjustments,
Work Tickets, Assemblies, and Beginning Balances.

Serial Number Entry
This feature is available only in Sage 50 Premium Accounting and higher.
The Serial Number Entry window allows you to add new serial numbers for items that are being added to your inventory (originating
transaction). On this window, you can enter serial numbers in two ways.

1. You can type each individual serial number in the serial number field and select Add to add the serial number to the list.
2. You can type one serial number in the serial number field and have Sage 50 add the next consecutive serial numbers. Click the
Add check box and enter or select the number of consecutive serial numbers you would like Sage 50 to add. Then, click Add.
Tips for entering serial numbers.
Removing serial numbers from the list
If, after you have added a serial number to the list, you decide you no longer need it, you can remove the serial number. To remove
a serial number, select the number and click Remove. (You can use the Shift key to select a range of serial numbers or the Ctrl key
to select multiple serial numbers to remove.)

Sorting serial numbers in the list
You can sort the serial number list by either serial number or status. Click either the Serial Number or the Status button at the top
of the list to sort. In addition to sorting, you can rearrange the placement of the columns. For example, you might want Status to be
the first column in the list. To change the placement of the columns, click the heading and drag it to the new position and drop it.
When you drop the heading into the new position, you’ll see a blue line indicating the placement.

Verifying the number of serial numbers entered
The status line at the bottom of the window lets you see how many serial numbers are needed and how many you have added. If the
two numbers match, you have entered the correct number of serial numbers. If the numbers don't match, you have entered either
too few or too many and will receive an error message when you select either OK or OK/Next.

Saving serial number entries
After you have added the serial numbers that you need, select OK. If the underlying transaction has more than one line item that
contains serialized inventory, you can select the OK/Next button to save the current entry and move to the next serialized item.
Using the OK/Next button will save you time by allowing you to enter/select all of the serial numbers you need, eliminating the need
to go back and forth between the Serial Number Entry/Selection window and the transaction window. When you save the underlying
transaction, the serial numbers that you added will be saved.

What do you want to do next?
Learn about serialized inventory
l
Set up a serialized inventory item
l

l

Learn how to select a serial number

Serial Numbers (Maintain Inventory Items)
This feature is available only inSage 50 Pro Accounting and higher.
After you set up or open a serialized inventory item on the General tab of the Maintain Inventory Items window, the Serial
Numbers tab becomes available. You can do several things on the Serial Numbers tab. Let's take a look.

What can I do on the Serial Numbers tab?
Search for Serial Numbers--You can use the Find button to search the list of serial numbers for a specific number. Enter the
serial number that you are looking for in the field and click the Find button. Sage 50 will search the list and highlight the serial

l

number if a match is found. If no match is found, Sage 50 will display a message telling you that the search is complete.
l

View Serial Numbers associated with this item--You can view all of the serial numbers that have been entered for this
item. The serial number list can be sorted and/or filtered. The list can be sorted by Serial Number, Status, or Warranty. To sort the
list, click the appropriate button at the top of the list. The serial number list can be filtered by status. The statuses are: Available,
Sold, Adjusted, Returned, In Progress, and Error. To filter the serial number list, select the appropriate status from the View
drop-down list.

l

Set up warranty information--If you provide a warranty with this item, you can set up the warranty period here. Select the
This item is covered under warranty check box and then enter the warranty period. You can set up the warranty period in
terms of days, months, or years.

l

Open the Serial Number History Report--When you are on the Serial Numbers tab, you can select the Detail button to
open the Serial Number History report. The report only lists information for the serial number that is selected (highlighted). To
open the Serial Number History report, select a serial number from the list and then select the Detail button.

Serial Number Selection
This feature is available only in Sage 50 Premium Accounting and higher.
The Serial Number Selection window appears when you select the Serial No. button for line items or transactions that remove items
from your inventory. It allows to you to select and assign serial numbers to items that are being taken from inventory. For example,
if you enter a sales invoice that includes a serialized inventory item, you must choose the serial numbers that will be associated with
these items before you save the invoice.

Selecting a serial number
To select a serial number, click the check box next to the number you want. If you have a long list of serial numbers, you might use
Find to search through the list. Type the serial number you're looking for in the field and select Find. If a match is found the serial
number will be highlighted.

Sorting serial numbers in the list
You can sort the serial number list by either serial number or status. Click either the Serial Number or the Status button at the
top of the list to sort. In addition to sorting, you can rearrange the placement of the columns. For example, you might want Status to
be the first column in the list. To change the placement of the columns, click the heading and drag it to the new position and drop it.
When you drop the heading into the new position, you’ll see a blue line indicating the placement.

Verifying the number of serial numbers selected
To make sure you have selected enough serial numbers, check the status line at the bottom of the window. The status line looks like
this: Selected: Serial Number X of Y for item1, where X is the number of serial numbers you have selected and Y is the number of
serial numbers you need. When X and Y are equal, you have selected enough serial numbers.

Saving serial number selections
After you have selected the serial numbers that you need, select OK to save and close the window. If the underlying transaction has
more than one line item that contains serialized inventory, you can select the OK/Next button to save the current entry and move
to the next serialized item. Using the OK/Next button will save you time by allowing you to enter/select all of the serial numbers
you need, eliminating the need to go back and forth between the Serial Number Entry/Selection and the transaction window.

Note: Make sure you save the underlying transaction to add your serial number selections to the system.

Tips for Entering Serial Numbers
You have a great deal of flexibility when entering serial numbers in Sage 50 Premium Accounting and higher. Here are some tips to
follow when entering serial numbers:
l

Serial numbers can be up to 30 characters long.

l

Duplicate serial numbers are not allowed.

l

Serial numbers cannot begin or end with a spaces. If beginning or trailing spaces are entered, they will automatically be
deleted prior to saving the serial number.

Set Up a Serialized Inventory Item
When you set up serialized inventory items in Sage 50 Premium Accounting and higher, you have the option to add a warranty to the
item. Warranty information is set up on the Serial Numbers tab of the Maintain Inventory Items window. The steps below guide you
through setting up a serialized inventory item with a warranty.

To set up and define a serialized inventory item with a warranty
1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New Inventory
Item.
2. Enter an ID for the item, and select either Serialized Stock item or Serialized Assembly as the item class.
3. Fill out the item information.
If this is a serialized stock item, skip to step 6.

4. For a serialized assembly item, select the Bill of Materials tab. Don't select the Save button ; saving the item at this point
will cause it to become a stock-item type.

5. Select item IDs for existing stock items or assemblies only, and enter the quantity. Press ENTER. Do this for each item that makes
up the assembly.

6. Select the Serial Numbers tab. To set up a warranty, select the This item is covered under a warranty check box. Then
enter a warranty period in terms of either days, months, or years.

7. When you're finished entering the serialized item, select the Save button.

Item Attributes (Maintain Inventory Items)
To set up master stock items and create related substock items, select the Item Attributes tab in the Maintain Inventory Items
window. To create a master stock item, you enter the item ID and description and then select Master Stock Item as the item
class.

Primary Attributes: These are sets of item characteristics that you designate as primary ones. Attributes could include size,
length, color, price range, and so forth.

Name: Enter the name of the primary attribute set.
ID: Enter the identifier of each individual attribute in the set.
l
Description: Enter a brief description for each individual attribute in the set.
Secondary Attributes: These are sets of item characteristics that you designate as secondary ones. Attributes could include size,
l
l

length, color, price range, and so forth.

l

Name: Enter the name of the primary attribute set.
ID: Enter the identifier of each individual attribute in the set.

l

Description: Enter a brief description for each individual attribute in the set.

l

Created Substock Items: Once you save a new master stock item, this table lists by item ID all substock items generated from
the master. The table displays the primary and secondary attributes that govern each substock item, the quantity on hand for each
listed item, and whether or not each item is active.

Set Up Master Stock and Substock Items
In Sage 50 Complete Accounting and higher, use this procedure to set up a master stock item and the substock items automatically
generated from it. This is a two-step process:

Step 1: Set up a master stock item
1. Click the Inventory Items navigation aid on the Inventory & Services Navigation Center and select New
Inventory Item. The Maintain Inventory Items window is displayed.
2. In the Header Fields section, enter an item ID and description for the new master stock item.
3. Use the Item Class drop-down list to select Master Stock Item.
4. On the General and Custom Fields tabs, enter any needed information about the item you're setting up.
Step 2: Set up item attributes

Once you've created your master stock item, you're ready to create item attributes. Do the following:

1.
2.
3.
4.
5.

Select the Item Attributes tab.
In the Primary Attributes group box, enter the name of the primary attribute set (for example, Color).
In the ID field, enter an identifier for the first attribute you want to add.
In the Description field, enter a description for the first attribute.
Now, to add the attribute to the list of primary attributes, select Add.

Note: To remove an attribute after it has been added, select it in the attribute list box, and then select the Remove button.
6. Repeat steps 2 through 5 for any additional attributes you want to add to the list.
7. To add secondary attributes for the master stock item, repeat steps 2-6 in the Secondary Attributes group box.
8. When finished adding attributes, save the master stock item.
Note: The Created Substock Items table at the bottom of the window lists by item ID all substock items that are
automatically generated when you save the new master stock item. This table displays the primary and secondary attributes
that govern each substock item and also shows the quantity on hand for each listed item. To make any of these substock items
inactive, select the Inactive check box in the last column.

Important: Substock items are created only from a related master stock item; they cannot be created independently of a
master stock item. Also, you can't delete a substock item once created. The only way to delete a substock item is to remove
the master stock item attribute or attributes that define the substock item. Say the substock item is based on a master stock
item size attribute (for example, LARGE). To delete the substock item, you would have to remove the LARGE attribute from the
master stock item; see the note to step 5 above.

Maintain Units/Measures
The Maintain Units/Measures window allows you to set up new units/measures (U/M), other than the Stocking U/M, for purchasing or
selling inventory items. In this window, you can set up new units/measures, change the ID for, and delete existing units/measures.

Note: You can access this window only if you have selected the option to Enable Multi-Packs and buying and selling
items in different units/measures in the Inventory Item Defaults window.
If you purchase or sell items in bulk or in multi-pack units, create new units/measures to accommodate bulk sales or purchases. This
saves you time because you won't have to enter a new item for each unit/measure of an item that you buy or sell. By creating a new
unit/measure based on the stocking unit, you can purchase and sell the multi-pack unit and the single units contained in the multipack.

Learn More
Setting up a unit/measure
When you create a new unit/measure, it can either be generic or item specific. For example if you sell various size boxes of
items, like a box that contains 10 items, you might create a generic BX-010 unit/measure. This could be used for any item that
you sell as a box of ten. Likewise, you could set up a unit/measure that is used only for one specific inventory item. While you
have a great deal of flexibility in naming units/measures, you cannot change the number of stocking units contained in a
unit/measure once it has been saved.
You can set up as many units/measures as you need, but you can only assign two U/Ms to an inventory item: one for sales and
one for purchases.

Set up a unit/measure
Change a unit/measure ID
Assigning unit/measures to inventory items
Once you've set up units/measures, you assign them to individual inventory items in the Item Multi-Packs window, which is
available by selecting the U/M button next to the Stocking U/M field in the Maintain Inventory Items window. After you
assign units/measures to an inventory item, they will be available for selection for line items on the following windows: Quotes,
Sales Orders, Sales/Invoicing, Receive Money, Credit memos, Purchase Orders, and Purchase/Receive Inventory.

Set Up a Unit/Measure (U/M)
Follow the steps below to set up a new unit/measure.

1. From the Maintain menu, select Units/Measures. The Maintain Units/Measures window appears.
2. In the U/M ID field, type an ID code for this unit of measure. For example, if you are creating a unit/measure for a box of 10
items, you might enter BX-010 as the ID. When you are creating the U/M ID, we suggest that your code helps describe the
unit/measure. This will be helpful when you use the unit/measure on purchases, invoices, and so on. An ID can be created from
the Description you enter, provided that option is selected in Maintain Global Options.

3. In the Description field, type a short description of the unit/measure. For example, you might enter Box of 10 as the
description.

4. In the Number of Stocking Units field, enter the number of stocking units that make up this unit/measure. The stocking unit
is the Stocking U/M that was set up for each inventory item in the Maintain Inventory Items window.

5. When you have finished, select the Save button to save the unit/measure.
What do you want to do next?
Change a U/M ID
l
Set up an item multi-pack
l

Change Units/Measures (U/M) ID
The Change U/M ID window allows you to rename an existing U/M ID. When you change the ID, the old ID is deleted and replaced
with the one you type in the Enter New U/M ID field. All transactions and records that were associated with the old ID will be
updated with the new ID. Follow the steps below to change the U/M ID.

Changing the U/M ID
Use this procedure to change an existing unit/measure ID. If you already have the Change U/M ID window open, start at step 4.

1. From the Maintain menu, select Units/Measures. The Maintain Units/Measures window appears.
2. Enter or select the U/M ID that you want to change. To display a list of existing Units/Measures, type ? in the U/M ID field, or select
the Lookup button.

3. Select the Change ID button on the toolbar. The Change U/M ID window appears.
4. Enter the new ID that you want to use instead of the current ID.
5. When you are finished, select OK to change the ID and return to the Maintain Units/Measures window.
When you change a U/M ID, all data records associated with this Unit/Measure will reflect the new ID.

Why Should You Use Multi-Packs?
Multi-packs are available in Sage 50 Premium Accounting and higher.
Use multi-packs if you buy and sell items in different quantities. For example, you buy items in a case, but you sell them individually.
Units of Measure (U/M) are set up in Maintain Units/Measure.

Learn More
Setting up Multi-packs
Setting up Units/Measure

Set Up an Item Multi-Pack
If you want to purchase or sell an inventory item in bulk units or units other than the Stocking U/M, you need to set up the item to use
multi-packs. You can set up two multi-pack units per inventory item;one for purchases and one for sales. Follow the steps below to
set up an Item Multi-Pack.

1. From the Maintain menu, select Inventory Items. The Maintain Inventory Items window appears.
2. Select the Item ID of the item that you want to purchase or sell in multi-packs. You can only set up multi-packs for Stock,
Substock, Master Stock, Non-stock, and Assembly items.

3. Click the U/M button (arrow button) next to the Stocking U/M field to open the Item Multi-Packs window.
4. If necessary, change the Stocking U/M.

5. Select the Purchase and sell in different quantities check box. This will make the other options in the window available for
selection.

6. To set up a Purchasing Multi-Pack, select the U/M that you usually purchase this item in. Then, if necessary enter the
weight and the UPC/SCC code for the item. Select the Use as default for all purchases check box to make this the default
U/M on task windows. Otherwise, the Stocking U/M will be set as the default.

7. To set up a Sales Multi-Pack, select the U/M that you usually sell this item in. Then, if necessary enter the weight and the
UPC/SCC code for the item. Select the Use as default for all sales check box to make this the default U/M on task windows.
Otherwise, the Stocking U/M will be set as the default.

8. When you have finished, select the OK button. Then select Save in the Maintain Inventory Items window to save your changes.
The selections that you made in the Item Multi-Packs window are only saved when you select Save in Maintain Inventory Items.

9. Repeat these steps for each item you plan to purchase or sell in multi-packs.
What do you want to do next?
Learn about quantity discounts
l
Create quantity discounts
l

Tracking Costs by Project
Overview
In Sage 50, you can manage your projects by using jobs. Revenue and expenses for your jobs can be tracked and compared with
estimates. You can also use phases and cost codes to break down your jobs into smaller components.
You can create custom fields and statuses for your jobs in Job Defaults. Job statuses can be used to track the progress of your jobs.
You can see these statuses on the Job List View and Job List report.
Sage 50 has various job reports that can be used to help you track and make decisions about your jobs. You can access job-related
screens by clicking the Jobs navigation aid on the Customers & Sales Navigation Center.
Sage 50 Quantum Accounting has a Jobs Navigation Center where you can get at-a-glance job information including the Job
Management Center where you can see detailed information about a specific job. The Jobs Navigation Center also gives you quick
access to job-related screens, tasks, and reports. To get to the Jobs Navigation Center, select Jobs on the left side of the main Sage
50 screen.

Note: Phases and cost codes are not available in Sage 50 Pro Accounting.

Advantages of Using Jobs
There are several advantages to using jobs in Sage 50:
l

l

l

l

Using jobs allows you to track your income and expenses for each project your company undertakes. You can create estimates for
each job. As you enter materials or services used in the job on bills through accounts payable, they can optionally be assigned to a
job so you can compare your actual costs with your job estimates.
You can exercise greater control over your costs and revenues by tracking customer invoices and payments received for each
job.You can print reports throughout a job's duration to find out the total amount spent and net revenues due for each job.
You can also maintain statistics on various jobs including starting date, completion date, and the progress of each job and view
these by printing various job reports.
If you use phases or cost codes, you can generate reports to display this information, showing you if a job is over or under budget
for any phase or task involved. This can help you control your costs by adjusting one phase or task prior to the job's completion.

In sum, you can get greater insight into all your jobs or projects so that you know what you are spending, how long it is taking, and
how much money you are estimated to make for each job.

Why You Should Set Up Job Defaults
Setting up job defaults makes it easier for you to enter your job information and to ensure that it is entered accurately. It also allows
you to customize some areas of Sage 50 that are related to jobs.
l

Improve Ease and Accuracy of Data Entry: Defaults are the standard selections that apply to the majority of your jobs.
Some of the default information you set up here is automatically filled in for new jobs you set up in Maintain Jobs. You can change

this information for an individual job if necessary.
l

Keep Track of Your Jobs: Job statuses are used to keep track of your jobs in Sage 50. You can select a status for a job in
Maintain Jobs. The statuses that are available for selection are set up in Job Defaults. Sage 50 provides you with some typical job
statuses, but you can change these or add more to track jobs in a way that makes sense for your company.

l

Enter More Information About Your Jobs: You can enter additional information about your jobs in Maintain Jobs by setting
up Custom Fields.

Set Up Job Defaults
To set up job defaults:
Click the Jobs navigation aid on the Customers & Sales Navigation Center and select Set Up Job Defaults.
General Tab
Do you typically assign jobs to the line items on your customer or vendor transactions? On the General tab for Job Defaults, you
can choose to be warned if you save a transaction that has line items that have not been assigned to a job. You can choose to see
this warning for Customer transactions, Vendor transactions, or both.

Customer transactions are:
Quotes, Sales Orders, Proposals, Sales Invoices, Receipts, and Customer Credit Memos
(Proposals are available in Sage 50 Premium Accounting and higher)

Vendor transactions are:
Purchase Orders, Purchases, Payments, and Vendor Credit Memos

Note: You cannot assign jobs to stock or assembly items on Vendor transactions. Here's why:
When you purchase an item that goes into inventory, you are increasing your assets, not increasing your expenses. So, to apply
a job to a purchase-related transaction would be inappropriate. When you eventually sell your inventory, Sage 50 will make an
entry that decreases (credits) inventory and increases (debits) Cost of Goods Sold (which is a type of expense account). This
expense can be associated with a job if you assign a Job ID to the item at the time of the sale. The amount of
the expense will be based upon the costing method chosen for that item (LIFO, FIFO, or Average).

Statuses Tab
Use this tab to view and edit your job statuses. Sage 50 provides you with statuses that you can use to manage your jobs. However,
you can change these and add your own to suit your needs. You can determine the status names, icons, and order that they appear
for selection in drop-lists.
Job statuses are assigned to jobs in Maintain Jobs. You can view information about your jobs, including statuses, on the Job
Management tab in the Jobs navigation area. You can also view the statuses of your jobs on the Job List View and Job List report.

Billing & Retainage Tab
Select the Billing & Retainage tab to specify the Receivable and Payable Retainage accounts and the default Billing Method for
Progress Billing. The retainage accounts should be set up in General Ledger and each should be set up with either the Accounts
Receivable or Accounts Payable Retainage Account Type. These accounts will be used when Retainage is calculated on Purchases,
Sales Invoices, Credit Memos, or Vendor Credit Memos. .
If you are using Cash for your accounting method, only the Billing Method field is available. Retainage is available only in Accrual
method companies.

Note: Retainage fields will not appear unless you have created a general ledger account with Account Type of either Payables or
Receivables Retainage first.

Learn about the fields on the Billing & Retainage tab
l
Billing Method: Select the default billing method for Progress Billing. You can change this setting at the job level. You have
four options here: No Progress Billing, Percent of Proposal, Percent of Contract, or Percent Completion.
l

Retainage Percent: Enter the default retainage percent for your jobs. This value will be entered on the Retainage % field
on the Maintain Jobs window for all new jobs.

l

Receivable Retainage Account: Enter or select the appropriate default account for Accounts Receivable Retainage.

l

Payable Retainage Account: Enter or select the appropriate default account for Accounts Payable Retainage.

Warning: Only accounts that have an Account Type of either Receivable or Payable Retainage will appear in the drop-down lists. If
there are no accounts in your chart of accounts that have these account types, the list box will be empty.
Tell me more about setting up Sage 50 to handle retainage.

Labor Burden Tab
Select the Labor Burden tab to enter a default Labor Burden Percentage and default labor burden accounts. You can change the
labor burden percentage at the job level and the labor burden accounts should be set up so that your labor burden ends up in the
appropriate section of your income statement. .

Learn about the fields on the Labor Burden tab
l
Labor Burden Percent: Enter a flat percent for labor burden. This information will be used to fill the Labor Burden Percent
field in each new job record. You can change the percentage at the job level if you want.
l

Labor Burden Cost of Sales Account: Enter the account to be debited when labor burden is calculated during payroll
entry.

l

Applied Labor Burden Account: Enter the account to be credited when labor burden is calculated during payroll entry.

Custom Fields Tab
Select the Custom Fields tab in the Job Defaults window to set up custom field names for your job records. Custom fields offer you
a way to keep track of specific information about your jobs. Each business is unique. While we already provide fields to record the
most common business data, you probably require other information from time to time. Custom fields let you set up and store that
data.
What are custom fields and how can I use them?
You use the custom fields to set up fields that aren't available in the Maintain Jobs window. For example, you may want to record
the site location, second contact person, and so on.
Select the Enabled check box to enter or change the field label. If you decide not to use a field, simply clear the Enabled
check box. The data will remain, but it will not be accessible. If you decide you want to use the field label again, select the
Enabled check box, and the program will make the data available.
There are three steps to setting up and recording custom fields:

1. Set up and enable custom field names in Job Defaults.
2. Enter custom field data for each job record in Maintain Jobs.
3. View and print the data in Job reports.
Examples:
Custom Fields let you use your imagination. What do I really need to know about my jobs? Below are examples of job custom
fields you could set up.

Field
Name

Data Entered

Location

enter a sales territory, a county, or a specific borough or part of your
city

Contact #

enter a phone number to use to contact someone about the job

Alternate
Contact

who to ask for when your primary contact isn't available

Set Up a Job
Use this procedure to set up a new job record.

1. Click the Jobs navigation aid in the Customers & Sales Navigation Center and select New Job.
Sage 50 displays the Maintain Jobs window.

2. Enter a new job ID and complete the necessary job information. You can use the Setup Advisor located on the right-hand side of
the screen as a guide.

3. In Sage 50 Complete Accounting and higher, select the Use Phases to track jobs in more detail check box if you want to
use phases for this job. You can access this option later, if you are undecided at this time.

4. If you want to enter another job, click Save and New. Otherwise, click Save and close the window.
Note: Marking the Inactive check box in the Maintain Jobs window indicates that the job is no longer used. This field is checked
to make the job available for year-end purging. Sage 50 will display a warning message if you try to use an inactive job.

Enter Beginning Balances for a Job
You can enter beginning balance information for jobs, phases, and cost codes. You can make entries by phase and/or cost code, or
simply enter one figure for the job's beginning balance if the job does not use phases. The entries you need to make will depend on
how you set up the job.
To enter beginning balances, do the following:

1.
2.
3.
4.

Click the Jobs navigation aid on the Customers & Sales Navigation Center and select New Job.
On the General tab, select the Job Beginning Balances button.
Select a job on the Job Balances tab.
Select the Job Entries for tab to make the detail entries for a specific job. If the job does not use phases or cost codes, you will
skip over those columns.

5. If you used a phase ID that uses cost codes, you must also enter a cost code.
6. Enter the beginning date for the job beginning balance amount. You can enter multiple balances for each job.
7. Enter an amount for the expenses or an amount for the revenues. This figure should be the net balance between what you have
spent and earned on the job. You can't enter an amount for an expense and an amount for a revenue on the same line.

8. To enter beginning balances for additional jobs, select the Job Balances tab. Select a job and select the Purchases from tab.
9. When you are finished, select the Save button, and close the window.

Enter Estimated Revenue and Expenses for a Job
Use this procedure to enter estimated expenses and revenue for a job.

1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Jobs.
2. Select the job and click Open .
3. If the job uses phases, be sure to select the Use Phases to track jobs in more detail check box so that you can enter
estimate amounts for the phases and cost codes of the job. If the job does not use phases, then you can only enter a single
estimate for revenues and a single estimate for expenses. If you are selecting this option for a job that did not use phases before,
you should note the existing estimates for expenses and revenues before selecting this check box.

4. Select the Estimated Expenses & Revenue tab.
5. Do one of the following:
l
l

If the job does not use phases, enter amounts in the Revenues and Expenses fields.
If the job uses phases, the Revenues and Expenses fields will be replaced by a table containing phases, cost codes, and
other columns so you can enter more detail.

Note: You cannot enter the same phase or phase/cost code more than once in the estimate. If you should accidentally do so,
you will receive a message asking you to remove the duplicate phase or phase/cost code line. To do so:

1. Highlight the duplicate phase.
2. Click the Backspace button on the keyboard.
3. Then, hit TAB. This will clear the cost code field as well.
4. Finally, clear the fields for No. of Units, Expenses, and Revenue and click Save.
If you have selected a Billing Method of Percent of Proposal for this job, Sage 50 will control the Estimated Revenues fields
based on accepted Proposals entered for the job. Phases and Cost Codes for which there are no accepted proposal amounts will
display "No Proposals." Tell me more about Proposals.

6. When finished entering job estimates, select Save, and close the window.

Note: In Sage 50 Premium Accounting and higher, you can use change orders to make changes to estimates and keep a record of
these changes. An Estimates History section will appear at the bottom of the Estimated Expenses and Revenue tab if the job has
change orders. This section will show any changes made to the original estimates as a result of change orders.

Copy Job Information to a New Job
You can create similar jobs including estimates (but excluding beginning balances) from a job that you have already set up using the
following method:

1.
2.
3.
4.

Click the Jobs navigation aid in the Customers & Sales Navigation Center and select View and Edit Jobs.
Select the job you want to copy and click Open .
Change the job ID to the new ID you want to use for the new job.
Select Save. The new job is saved with information from the job you copied from. You can make any changes you want to the
new job's information.

Change a Job ID
Use this procedure to change an existing job ID.

1. Click the Jobs navigation aid in the Customers & Sales Navigation Center and select View and Edit Jobs.
2.
3.
4.
5.

Select the job with the ID you want to change and click Open .
Click the Change ID button.
Enter the new ID that you want to use instead of the current ID.
When you are finished, select OK to change the ID and return to the Maintain Jobs window.

When you change a job ID, all data records and transactions associated with this job will change to reflect the new ID. This includes
both current and past transactions.

Note: This is useful if you want to change the way you identify data records. For example, suppose you currently use the customer
name as the job ID. However, as your business grows, it becomes necessary to use a scheme that is more definitive than the
customer name. For example, you may be doing several jobs for the same customer. Consequently, you decide to begin using job
numbers as the identifier. You can easily change the job ID to meet your needs.

Delete a Job
To delete a job you need to:

1. Click the Jobs navigation aid in the Customers & Sales Navigation Center and select View and Edit Jobs.
2. Select the job you want to delete and click Open .
3. Select the Delete button.
Note: If transactions are applied to this job, you will not be able to delete it. If that is the case, you can make the job inactive to
designate that it shouldn't be used. To do this, select the inactive checkbox and save the job.

4. Click Yes on the message asking if you are sure you want to delete the job.
5. When you are finished, close the window.

Using Job Statuses
Job statuses help you keep track of and manage your jobs more effectively.
To use job statuses in Sage 50:

1. Set up job statuses, if necessary. Sage 50 provides you with 4 statuses to start out (In progress, Pending, Completed, and
On hold). In progress is the default status. If you want to change these statuses or add more, you can do this on the Statuses tab
in Job Defaults.

2. Assign statuses to jobs. Statuses are assigned to jobs in Maintain Jobs. You can change the status for a job as necessary. To
do this:

1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Jobs.
2. Select a job and click Open .

3. Select the status in the Job Status field.
4. Click Save.
3. Use the Job Management tab in the Jobs Navigation Center to view information about your jobs. You can add sections to the
Job Management tab so that you can quickly view information about your jobs, including statuses, start and end dates, sales
orders and invoices that have been created for jobs, and information about the customers for the jobs.
You can also view statuses for your jobs on the Job List View and the Job List report.

3. You can view statuses for your jobs on the Job List View and the Job List report.

Set Up Job Statuses
You can add, edit, or delete job statuses on the Statuses tab in Job Defaults. To open Job Defaults:
l

l

Click the Jobs navigation aid on the Customers & Sales Navigation Center and select Set Up Job Defaults. Select the
Statuses tab on the Job Defaults screen.
You can also select the Customize job statuses link on the Maintain Jobs window.

Add a New Job Status
1. Click Add New.
2. Select an icon to identify the status, if you want to.
Note: This is not required, but gives you a way to provide more information about the status than just the name. It also helps
you to easily distinguish the status in lists and Job Management sections.

3. Enter a name for this status.
4. Select the Use as default checkbox if you want this status to automatically be assigned to new jobs when they are created.
Note: This saves you data entry time if you usually assign the same status to jobs when they are first created. You can always
change the status on a job when it is created or later.

5. Click Save.
6. The status now appears in the Job Status List. Use the Move up/Move down buttons to change the order of the status in the
list. This is how statuses will appear in selection drop-lists.

Edit an Existing Job Status
Warning: Any changes you make to a status will show up on jobs that are currently assigned this status. If this isn't what you
want, you should create a new status.

1. Select the status you want to edit in the Job Status List.
2. Change the icon, name, or both.
3. Click Save.
If a message confirming you want to save appears, click Yes. Check the Do not display this message again checkbox if you don't
want to get this message when you edit statuses.

4. Notice the status now appears with the changes in the Job Status List. Use the Move up/Move down buttons to change the
order of the status in the list. This is how statuses will appear in selection drop-lists.

Delete an Existing Job Status
Warning: When you delete a status, it will be removed from any jobs that it is currently assigned to. You might want to check to
see if there are any jobs this status is assigned to and change the status before deleting this one.

1. Select the status in the Job Status List.
2. Click Delete.
If a message confirming you want to delete appears, click Yes.

Using Phases and Cost Codes
l

Phases and cost codes are available in Sage 50 Complete Accounting and higher.

l

Phases are set up on the Maintain Phases window. A phase is simply a specific part of the job.

l

l

You can use phases alone, or you can use phases and cost codes. The level of detail is up to you. If your phases have associated
costs that you want to track separately, you should use phases and cost codes.

Cost codes are set up on the Maintain Cost Codes window. A cost code identifies a specific cost (or category/task) within a phase
and provides a greater level of detail for the job.

l

If you do not need details regarding the cost of each resource or item in a job, you may not want to use cost codes.

l

Setting up phases and cost codes (Example)
For example, let's say you have a landscaping company. A landscaping job can be divided into Grading, Planting, and Maintenance
phases. You should try to define phases that are independent of a specific project. In this example, each of the above phases
could be used in multiple landscaping jobs.
There are different costs associated with these phases: labor, materials, and equipment rental. These different costs can be set up
as cost codes in Sage 50. Note that cost codes can be used with more than one phase. You may have equipment rental costs for
both the Grading phase and the Maintenance phase of a job.

l

l

As you enter transactions and assign them to jobs, you can compare your actual data with estimates entered on the Estimated
Expenses & Revenue tab of the Maintain Jobs window. To get up-to-date information throughout a job's time frame, you can
generate the Job Estimates, Estimated Job Expenses, and Estimated Job Revenue reports.
Remember that you can create detailed estimates for jobs only if you use phases or phase and cost code combinations in your
jobs.

Using Cost Types
Cost types are categories used to classify expenses applied to a job.
You must assign a cost type to:
l

each cost code you define

l

any phase that does not use cost codes

The cost types in Sage 50 are:
l

labor--work performed by your employees, temporary help, and so on

l

materials-- materials used in any part of the job

l

equipment-- private or rental equipment used to perform the job

l

subcontractors--work performed by subcontract labor

l

miscellaneous other costs--miscellaneous expenses such as permits, training costs, transportation, overhead, and so on.

You can print some job reports with the data organized by the cost type. This can help you determine how your money was used
while completing a certain job.

Set Up a Phase
You can use phases to divide jobs into distinct sections. Once you set up a phase you can apply it to any job (this is done as you enter
a transaction that will be applied to a job). To enter a phase you need to:

1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select New Phase.
2. Enter the phase ID and description. The description can be up to 30 characters long.
Note: You can use the Setup Advisor located on the right-hand side of the screen as a guide when setting up your phases.
3. If you want to use cost codes with this phase, select This phase uses cost codes.
Otherwise, select This phase uses the cost type and select a cost type from the drop-down list. Sage 50 requires you to
specify a cost type if the phase does not use cost codes. If you select This phase uses cost codes, the cost type selected for
the cost code will be used for reports.

4. If you want to enter another phase, click Save and New. Otherwise, click Save and close the window.
Note: Marking the Inactive check box in the Maintain Phases window indicates that the phase is no longer used. This field is
checked to make the phase available for year-end purging. Sage 50 will display a warning message if you try to use an inactive
phase.

Copy Phase Information to a New Phase

If you have phases that are very similar, you can set up the information for one phase and copy that information into other phases.
To copy phase information from an existing phase to a new one, you need to:

1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Phases.
2. Select the phase that you want to copy and click Open .
Sage 50 displays the phase information.

3. Change the Phase ID to the new ID you want to use for the new phase.
4. Select Save. The new phase is saved with information from the phase you copied from. You can make any changes you want to
the new phase's information.

Change a Phase ID
Use this procedure to change an existing phase ID.

1.
2.
3.
4.
5.

Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Phases.
Select the phase with the ID you want to change and click Open .
Click the Change ID button.
Enter the new ID that you want to use instead of the current ID.
When you are finished, select OK to change the ID and return to the Maintain Phases window.

When you change a phase ID, all data records and transactions associated with this phase will change to reflect the new ID. This
includes both current and past transactions.

Note: This is useful if you want to change the way you identify data records. For example, suppose when your company was new
you performed two different jobs: residential roofing and siding. So, for example, you identified the phases of a roofing job as R1,
R2, and R3. Now, however, your company does both residential and commercial roofing and siding, so you want to change your
phase IDs to reflect the differences: RR1, RR2, and RR3 for a residential roofing job and CR1, CR2, and CR3 for a commercial
roofing job.

Delete a Phase
1. Click the Jobs navigation aid in the Customers & Sales Navigation Center and select View and Edit Phases.
2. Select the phase you want to delete and click Open .
3. Select the Delete button.
Note: If this phase is being used by a job, you will not be able to delete it. If that is the case, you can make the phase inactive to
designate that it shouldn't be used. To do this, select the inactive checkbox and save the phase.

4. Click Yes on the message asking if you are sure you want to delete the phase.
5. When you are finished, close the window.

Set Up a Cost Code
Cost codes can be applied to any phase, not just a specific one. To set up a cost code:

1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select New Cost Code.
2. Enter the cost code ID and description. The description can be up to 30 characters long.
Note: You can use the Setup Advisor located on the right-hand side of the screen as a guide when setting up your cost codes.
3. Select a cost type from the drop-down list.
4. If you want to enter another cost code, click Save and New. Otherwise, click Save and close the window.
Note: Marking the Inactive check box on the Maintain Cost Code window indicates that the cost code is no longer used. This field
is checked to make the cost code available for year-end purging. Sage 50 will display a warning message if you try to use an
inactive cost code.

Copy Cost Code Information to a New Cost Code

If you have cost codes that are very similar, you can set up the information for one cost code and copy that information into other
cost codes. To copy cost code information from an existing cost code to a new one, you need to:

1.
2.
3.
4.

Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Cost Codes.
Select the cost code you want to copy and click Open .
Change the Cost Code ID to the new ID you want to use for the new cost code.
Select Save. The new cost code is saved with information from the cost code you copied from. You can make any changes you
want to the new cost code's information.

Change a Cost Code ID
Use this procedure to change an existing cost code ID.

1.
2.
3.
4.
5.

Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Cost Codes.
Select the cost code you want to change and click Open .
Click the Change ID button.
Enter the new ID that you want to use instead of the current ID.
When you are finished, select OK to change the ID and return to the Maintain Cost Codes window.

When you change a cost code ID, all data records and transactions associated with this cost code will change to reflect the new ID.
This includes both current and past transactions.

Note: The ability to change cost code IDs is useful because they are often complex, reflecting information such as job phase and
item used (for example, equipment or material), as well as a number for the specific item. As you work on a job, you might want to
change the structure of the cost codes you use, either to add or subtract layers of information or to reflect another type of
information altogether. .

Delete a Cost Code
1. Click the Jobs navigation aid on the Customers & Sales Navigation Center and select View and Edit Cost Codes.
2. Select the cost code you want to delete and click Open .
3. Select the Delete button.
Note: If this cost code is being used by a job, you will not be able to delete it. If that is the case, you can make the cost code
inactive to designate that it shouldn't be used. To do this, select the inactive checkbox and save the cost code.

4. Click Yes on the message asking if you are sure you want to delete the cost code.
5. When you are finished, close the window.

Using Change Orders
Change orders are used to keep track of changes made to estimates for a job. (Change orders are available in Sage 50 Premium
Accounting and higher.)
You can only enter change orders for existing jobs. If you need to enter estimates for a new job, you should enter the job and the
original estimates in Maintain Jobs.

Where do I enter change orders?
To enter a change order, click the Jobs navigation aid on the Customers & Sales Navigation Center and select New
Change Order.

How change orders work
Enter the change order details and change amounts on the change order window. When the change order is approved, you can
return to the change order and mark it as approved. If the change order is approved, you can update the job estimates. This
updates the estimates on the job record for the change amounts in the change order. It will also update the projected end date if
Change in schedule is checked on the change order.
You can also note if the change order has been applied to a transaction. This means that this change is reflected on a transaction
such as a proposal or invoice. This is for informational purposes only. The change order is not automatically applied to any
transactions.

Important: The primary purpose of change orders is to update estimated revenues. For this reason, you can only save change
orders for jobs that have estimated revenues, even if the change orders are for updating estimated expenses or the projected end
date.

Do I have to use a change order to change the estimates for a job?
No, you can change the estimate on the Estimated Expenses and Revenues tab in Maintain Jobs. However, using change orders
gives you a way to keep track of details regarding the estimate change such as when the estimate changed, how much it
changed by, and who approved the change.

Important: Once you have saved a change order for a job, you must use change orders to change the estimated expenses and
revenues for that job.

Printing and E-mailing Change Orders
To print a change order, open it on the Change Orders screen and click the Print button. To e-mail a change order, open it on the
Change Orders screen and click the E-mail button.
If you want to customize the Change Order form, click the Form Design button on the dialog that appears after you click the Print or
E-mail button. You can also customize the form by going to Reports & Forms>Forms>Change Orders and clicking the Customize
button.
The change order form shows changes to the estimated revenues and the projected end date. Those are the changes that your
customers would need to know about. Changes to estimated expenses are not shown on this form.

Change Orders for Jobs with Percent of Proposal billing method
Estimated revenues for jobs with the Percent of Proposal billing method are applied to the job from proposals. Change orders
cannot be used to update estimated revenues for these jobs. You must enter or update a proposal to change the estimated
revenues.

Note: You can use change orders to update other estimates for jobs with the Percent of Proposal billing method, just not
estimated revenues.

You can't print or e-mail change orders for jobs with the Percent of Proposal billing method. Why not?
Change orders are sent to customers to inform them of changes to estimated revenues. Since you can't use a change order to
change the estimated revenues for a job with the Percent of Proposal billing method, there is nothing to print on the form.

Enter Job Expenses
Different types of costs that you incur in the course of working on a job are entered into Sage 50 in different ways. Below is a table
explaining how to get the most common types of job costs into Sage 50.
Inventoried Materials

Inventory Adjustments: Use this routine when you do not
bill based on the sales price of the inventoried item. If
necessary, you will be able to bill by the item later in Sales
Invoicing by clicking the Apply Tickets/Expenses link.

Sales Invoicing: Use this method if you bill by the part and
bill based on the regular sales price of the item.
Non-inventoried Materials

Purchases/Receive Inventory: Enter the costs in
Purchases/Receive Inventory when you get the bill from the
vendor.

Direct Labor

Payroll Entry: If you use Sage 50's Payroll, enter the jobs
and hours on the Labor Distribution to Jobs window in Payroll
Entry. You can open the Labor Distribution to Jobs window by
clicking the Jobs button on the toolbar.

General Journal Entry: If you outsource your payroll, you
can enter lump sums for jobs using the General Journal Entry
window.
Sub-Contracted Labor

Purchases/Receive Inventory: Use this window to enter
amounts when you are billed by the contractor or vendor.

Equipment

Purchases/Receive Inventory: Enter these costs when
you receive the bill from the vendor.

Overhead

General Journal Entry: Enter your overhead costs here.

Purchase Items for Jobs
You can purchase items that you will need for a certain job; however, you cannot purchase a stock item and assign it to a job on a
transaction. You can enter the information for the purchase using the Purchases window or the Payments window and assign it to a
job using the Job ID field.
If you are receiving stock items, see "Apply Inventory Items to Jobs" below.

Apply Purchases to Jobs
1. From the Tasks menu, select Purchases. Sage 50 displays the Purchases window.
2. Enter the information as you normally would.
3. In the distribution section, enter or select the Job ID for every transaction line that directly applies to the job. To display a list of
existing jobs, type ? in this field or select the drop-down button.
Note: You cannot apply a stock-type item to a job on this window.
4. When you are finished entering the transaction, select Save.
You can apply a cash purchase to a job if it has not been applied to purchases.

1. From the Tasks menu, select Payments. Sage 50 displays the Payments window.
2. Enter the cash purchase as you normally would.
3. In the distribution section, enter or select the Job ID for every transaction line item that directly applies to the job. To display a list
of existing jobs, type ? in this field or select the drop-down button.
You cannot apply a stock-type inventory item to the job.

4. When you are finished entering the transaction, select Save.

Apply Inventory Items to Jobs
If you have already purchased and entered a stock item that you want to use for a job or you have the item in stock, you can use the
Inventory Adjustments window for recording the usage of that item. At this time, you can specify the job information for costing
purposes.

Note: The cost applied to the job is determined by the item's costing method.
You don't need to do this if you'll bill your customers for the inventory item by selecting it as a line item with the job on the sales
invoice. The cost will be applied at the time the invoice is saved. See "Apply Sales to Jobs" for steps to bill customers for inventory
items used for jobs.
To adjust inventory for a job:

1.
2.
3.
4.

From the Tasks menu, select Inventory Adjustments.
Enter or select the item ID.
Enter or select the job ID for which you need this item. Select a phase and cost code, if necessary.
In the Adjust Quantity by field, enter the number of units you are applying to the job with a minus sign in front of the
number.

5. Enter a Reference number and Reason to Adjust for reporting purposes.
6. Select Save.

Overview of Labor Burden
Labor burden is the cost that a company incurs in the course of performing a job, in addition to the hourly amount or salary that the
employee is paid. This can include health insurance, employer paid taxes, benefits, vacation time, and so on. Businesses that

perform jobs usually want to add these labor burden or payroll overhead costs to jobs to more accurately assess the actual cost of
their jobs and to bill customers accordingly.
Sage 50 allows you to create a flat percentage that will be added automatically to the costs of a job when you pay your employees.
This percentage can be set up at either the company or job level. When you pay your employees and assign their wages to jobs,
Sage 50 will automatically calculate the appropriate amounts and update job costs and general ledger accounts specified by you in
Job Defaults.
Labor burden cost calculated by Sage 50 can only be approximate. An example is how FICA is applied. Since labor burden is
calculated on regular earnings, there is no way for the calculation to tell whether or not an employee has reached their FICA limit.
Hence, FICA may not be applied correctly to the job.

Learn More
Setting up labor burden
You can set up your labor burden on a company wide or specific job basis.

Company wide
1. To set up your labor burden percentage, select Maintain , Default Information , Job Defaults.
2. Select the Labor Burden tab.
3. Enter your labor burden percentage and the appropriate general ledger accounts. .
4. Click OK.
Job Specific
1. If you need to vary your labor burden percentage by job, select Maintain , Jobs, Jobs.
2. Select the appropriate job record, and enter the correct percentage in the Labor Burden Percent field. Save the record.
Continue with other jobs.

Calculating labor burden
1. On either the Payroll Entry or Select for Payroll Entry windows, click the Jobs button. This will open the Labor
Distribution to Jobs window.
2. In the Hours Assigned to Jobs area, select the job/phase/cost code and enter the number of hours (for hourly employees) or
the amount and/or hours (for salary employees). Sage 50 will automatically calculate the labor burden based on the percent
entered in the Labor Burden Percent field in the job record for the particular job. If you want to change the percentage on this
window, you may do so. Sage 50 will automatically recalculate the amount. .

Reimbursable Expenses and Labor Burden
When you bill your customers for work done on jobs, Sage 50 will automatically add the amount of labor burden to the employee
cost on the Reimbursable Expenses tab of the Sales Invoicing window. In this way, you can quickly bill your customer for not
only the direct wages of the employee but also the labor burden.

Apply Payroll Expenses to Jobs
You can apply an employee's salary to up to 30 different jobs. For hourly employees, you can apply hours worked to a job. For
salaried employees, you can apply amounts to a job. To do so, select the Jobs button from the toolbar of the Payroll Entry
window. On the Labor Distribution to Jobs window, you can specify the hours and amounts that should be applied to jobs.
To apply payroll expenses to jobs:

1. From the Tasks menu, select Payroll Entry. Sage 50 displays the Payroll Entry window.
2. Enter or select the employee ID. To display a list of existing employees, type ? in the Employee ID field or select the drop-down
button.

3. Select the Jobs button. Sage 50 displays the Labor Distribution to Jobs window.
4. Select the Job field beside the type of salaried or hourly work the employee did on this particular job (Salaried, Bonus,
Commission, and so on).

5. Enter or select the Job ID to which you want to apply hours (for hourly employees) or an amount (for salaried employees). To
display a list of existing jobs, type ? in this field, or select the drop-down button.
6. Enter values in the Amount field as follows:

l

l

For hourly employees, enter the hours worked for each job. Don't forget to use a decimal. The Amount field displays a running
subtotal of the hours charged to this job.
For salaried employees, enter the portion of this employee's salary that should be charged to the job.

Only the hourly and salaried fields that have amounts entered for them in the Payroll entry window are displayed.

7. Change the Labor Burden percentages or amounts if necessary.
8. Repeat steps 5 and 6 and 7 as many times as necessary for this employee. Then select OK to save your entries or Cancel to
cancel.

9. Finish entering the payroll information for this employee as usual.

Enter Job Revenue
Revenues for a job are entered in Sales Invoicing or Receive Money. Only when you enter a sales invoice or receipt for the customer
who is associated with the job will the job reports be updated to show revenues received for the job. Entering Quotes, Sales Orders,
or Proposals will not update job reports with revenue until they are converted to or applied to Sales Invoices.
Here are two key things to remember about getting revenues for a job entered into Sage 50:
l

Make sure the customer is entered in the job record on the General tab in the For Customer field.

l

Select the job on the line item of the transaction you are entering for the customer.

Apply Sales to Jobs
1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Enter the sale or invoice as you normally would.
3. In the distribution section, enter or select a Job ID for every transaction line item that directly applies to the job. To display a list
of existing jobs, type ? in this field or select the drop-down button. If you need to select a phase, click the plus sign next to the job
to open the list of phases for the job. Click the phase you want. If you need to select a cost code, click the plus sign next to the
phase to open the list of cost codes for that phase. Click the cost code you want.
If you assign a job to a line with a stock-type item, a cost of sales entry is also posted to the job.

4. When you are finished entering the transaction, select Save.
You can also apply a direct sale to jobs using the Receive Money window.

1. From the Tasks menu, select Receive Money. Sage 50 displays the Receive Money window.
2. Enter the receipt as you normally would.
3. In the distribution section, enter or select a Job ID for every transaction line item that directly applies to the job. To display a list
of existing jobs, type ? in this field or select the drop-down button. If you need to select a phase, click the plus sign next to the job
to open the list of phases for the job. Click the phase you want. If you need to select a cost code, click the plus sign next to the
phase to open the list of cost codes for that phase. Click the cost code you want.
If you assign a job to a line with a stock-type item, a cost of sales entry is also posted to the job.

4. When you are finished entering the transaction, select Save.

Apply Job-Reimbursable Expenses to Sales Invoices
To bill customers for reimbursable expense transactions incurred from a job, you need to create a sales invoice and select expenses
to bill by clicking the Apply Tickets/Expenses link. On the tabs, you can consolidate these expenses and write them up or down.
To bill a customer for job-reimbursable expenses:

1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Enter or select the customer you want to invoice for the expenses incurred for a job.
If this customer is associated with a job and you have entered related job expense transactions, you can apply reimbursable
expenses to the invoices.

Note: To use reimbursable expenses, you must have entered the customer's identification in the For Customer field in the
Maintain Jobs window or selected a phase or cost code associated with a job for this customer.

3. Select the Apply tickets/expenses link to include job-expense transactions related to this customer on the invoice.
Sage 50 lists all unused reimbursable expense transactions (purchases, payments, or payroll) associated with jobs for this
customer.

4. If you would like to see the detailed description of the transaction, select the transaction; then select the Detail button. Sage 50
displays the Reimbursable Expense Detail window. Select OK when finished.
5. Choose a sort method from the Sort List By drop-down list. You can sort the reimbursable expense transactions listed in this
window using several different methods. This can be useful when consolidating expenses.

6. To consolidate the reimbursable expense transactions that are listed, select an option from the Consolidate by drop-down list.
This determines the organization of the selected line items on the invoice. Consolidation will combine separate items into one line
item on the invoice based on your consolidation method.

7. To apply the reimbursable expense item to the sales invoice, select the Use check box.
To select a range of reimbursable expense transactions that need to be applied to this invoice, select the Use button, which will
display the Select Reimbursables to Use window. You can select reimbursable expense transactions to apply based on the
following criteria: all reimbursable expenses, by job, by item, or by date range. After choosing your selection filter, select OK.

8. If you do want the reimbursable expense to no longer appear in this window again, select the Delete check box.
To select a range of reimbursable expenses to remove for this customer, select the (Select to) Delete Expenses button, which will
display the Select Reimbursables to Delete window. You can select reimbursable expense transactions to remove using the
following criteria: all jobs, by job, by item, or by date range. After choosing your selection filter, select OK.

Note: When a reimbursable expense transaction for a job is deleted, you only remove its eligibility for use in Sales/Invoicing.
The actual transaction will not be deleted. Also, once a reimbursable expense is removed in this window, it can no longer be
applied to any future sales invoice, even if you delete this invoice.
9. To write up or write down the expense, manually change the invoice amount.
10. To write up or write down a group of expenses by a common dollar amount or a percentage, select the Write Up button. Sage 50
displays the Select Reimbursables to Write Up/Down window. You can specify which items to write up (all items, by job, by item,
or date range). Enter the write-up figures in the boxes provided, and select OK.
You can write up line items by a common dollar amount or a percentage. If you want to give the customer a discount, enter a
negative percentage.

11. If you want to apply time tickets associated with this customer (possible only in Sage 50 Complete Accounting and higher), select
the Time Tickets tab. If you want to apply expense tickets, select the Expense Tickets tab.
12. When you have finished making your selections to apply to the invoice, select OK to return to the invoice.
Time tickets, expense tickets, and reimbursable expenses selected to use appear as individual line items in the invoice based on
the consolidation method and write up/down amounts. You can manually enter or change line descriptions to identify the billed
transaction to your customer.

Overview of Retainage
Retainage is an amount of an invoice that is withheld until a customer is satisfied that a job or part of a job has been completed
satisfactorily. Retainage gives the customer some leverage for ensuring that a job is completed to satisfaction.
Retained amounts of invoices are not treated as aged payables or receivables until they are released. Once they are released, they
are treated as normal receivables or payables.
Sage 50’s retainage feature allows you to withhold retainage on invoices from your vendors and automatically calculate the amount
of retainage your customers withhold on your invoices. You can then track the amount of retainage on the Job Retainage report to
quickly see what your customers owe you when the job is complete. You can also track the retainage withheld on your vendor
bills/invoices and quickly see what your obligations are when the retainage is released.
Retainage is available only in companies using Accrual based accounting.

Retainage and your Accounting
Retainage for customer invoices is considered to be revenue, even though you do not treat it as an aged receivable until it is
released. Hence, retained amounts are still taxed at the time of invoicing and retained amounts are debited to an Asset account
(Accounts Receivable Retainage) and the corresponding credit is applied to an Income account. When the retainage is released,
your Retainage Receivable account will be credited and your standard Accounts Receivable account will be debited, and the released
retainage will be handled as an aged receivable.

Correspondingly, retainage on vendor bills/invoices is considered to be an expense, even though it is not treated as an aged payable
until it is released. When you enter retainage on vendor bills/invoices, you create a credit to your Accounts Payable Retainage
account and a debit to the expense account for the line item. When you release retained amounts, you will debit your Accounts
Payable Retainage account and credit your standard Accounts Payable account, creating an aged payable.

Learn More
Set up Sage 50 to handle retainage
Several setup options are available.

How to set up Sage 50 for retainage
l
Entering default retainage accounts
Process retainage for your customers
l

You can enter and release retainage for your customer invoices.

How to enter retainage to your customer invoices
How to release retainage for your customer invoices
Process retainage for your vendors
l
l

You can enter and release retainage for your vendors.
l

How to enter retainage for your vendor bills/invoices

l

How to release retainage for your vendor bills/invoices

How to Set Up Sage 50 to Handle Retainage
Setting up Sage 50 to handle retainage is easy and can be accomplished in three steps.
You must have created general ledger accounts with Account Types of Payables Retainage and Receivables Retainage before
retainage fields will be visible on various windows throughout Sage 50 Quantum Accounting.
1. Create General Ledger accounts for Accounts Receivable Retainage and Accounts Payable Retainage. Step-by-step instructions
a. Select Maintain , Chart of Accounts. This will open the Maintain Chart of Accounts window.
b. Enter an appropriate Account ID and Account Description .
c. Select the appropriate Account Type, either Receivable Retainage or Payable Retainage.
d. Save the new accounts.
You must use these special Account Types to have the Job Retainage report properly track retainage.
2. Enter the correct retainage General Ledger accounts in Job Defaults. Step-by-step instructions
a. Select Maintain , Default Information , Jobs.
b. Select the Billing & Retainage tab.
c. Select or enter the appropriate accounts.
d. You may also enter a company-wide default Retainage % here.
e. Click OK.
3. Enter the appropriate percentage for retainage for each job. Step-by-step instructions
a. Select Maintain, Job Costs, Jobs to open the Maintain Jobs window.
b. Select the job record
c. Enter the appropriate percentage in the Retainage Percent field. It will default to the value set in Job Defaults, if any.
d. Save the record.
Once you have set up these fields, Sage 50 will automatically calculate the correct amounts for retainage on your customer invoices,
based on each job, and assign these amounts to the correct general ledger account.
Note that there is no default percentage for retainage on vendors. The percentage or amount of retainage for each job will be
entered manually from each purchase invoice (vendor bill).

How to Enter Retainage for Your Customers

Once your system is set up to calculate and handle retainage, processing retainage on a customer’s invoice is easy. To do so

1. Open the Sales Invoicing window and select the customer.
2. Enter the Header information for the invoice, and the appropriate line items and job IDs for billing.
3. Select the Withhold Retainage tab. If you have entered a value in the Percentage field on the Maintain Jobs window for your
jobs, Sage 50 will already have calculated the amount of retainage on a per-job basis for each job and will display it on the tab.
You can change the amount of retainage at this time if you want to.

4. Save, print, or e-mail the invoice. Sage 50 will display the retainage amount as a line item on the invoice and update the total
billed amount for the invoice. There will be one line item per job listed on the invoice. The retained portion of the invoice will NOT
be considered a receivable until it is released. Tell me more about releasing retainage.
Selecting the Summarize Progress Billing Invoices by Job option will cause retainage withheld to be included on the
summarized line item so that it does not display individually for the customer. If you are printing from the Sales Invoicing window,
this function will work only if you are billing for a proposal or editing an invoice created during Select for Progress Billing.

Releasing Retainage for customer invoices
Once your jobs are complete, you can release retained amounts for the job by producing a final invoice for the customer. You can
release retainage for your customer invoices in one of two ways. The first method shows you how to use the Progress Billing feature
of Sage 50 to release retainage. The second method shows you how to release retainage manually using the Sales Invoicing
window.

Using Progress Billing
1. Select Tasks > Select for Progress Billing.
2. On the Select for Progress Billing - Filter Selection window, select the range of jobs that you want to release
retainage for.
3. Check Release Retainage.
4. Click OK.
5. On the Select for Progress Billing window, select the Release Retainage tab. .
6. Select which retained amounts you want to release and then choose if you want to save the invoices for later printing and
processing or if you want to print or email the invoices. When the retainage is released, the released amounts will be handled as
standard receivables and aged accordingly.

Using the Sales Invoice window
1. Create a Service inventory item for retainage, specifying the correct General Ledger account for Retainage Receivable in the
GL Sales Account Field. Also, you should specify an Exempt Item Tax Type for this inventory item since retained portions of
invoices have been taxed already. Although this step is optional, we recommend it because it ensures that the correct general
ledger account will be credited for the release of the retainage and it allows you to track the invoices by this item.
a. Select Maintain > Inventory Items.
b. Enter an Item ID and Description.
c. Select Service as the Item Class.
d. Leave Price Levels set to 0.00 and enter the Receivables Retainage account in the GL Sales Account field.
e. Select the appropriate non-taxable Item Tax Type.
f. Click Save.
2. Determine the total retainage for the job using the Job Retainage report.
3. Enter a sales invoice selecting the appropriate customer and the Retainage Service inventory item using the Apply to Sales
tab.
4. Enter the amount of the retainage as a positive amount on the line item.
5. Enter the correct ID in the Job ID field. Do not select a phase or cost code.
5. Verify that no additional retainage is calculated for this invoice using the Withhold Retainage tab.
6. Print the invoice. The retainage will now show as a receivable and be aged based on the date of the invoice or its due date.

How to Enter Retainage on Vendor Invoices

You can enter and track retainage that you withhold from vendor bills, particularly subcontractor invoices. This will allow you to track
the retained amounts of vendor bills without having the retained amount be handled as an aged payable. To enter retainage on
vendor bills

1. Enter the Invoice information for the vendor bill on the Purchases/Receive Inventory window as you would normally enter a
vendor invoice. Be sure to enter all Job IDs in their appropriate fields.

2. Use the Withhold Retainage tab to enter the retained amount(s) as listed on the vendor’s bill.
You must enter the retained amount on a per job basis.

3. Save the invoice. The retained amounts will appear on the for tracking purposes. The retained amounts will not be treated as
aged payables until they are released.
Retainage is not available for Cash basis accounting companies.

What do you want to do next?
l
Set up Sage 50 to handle retainage
l
Release retainage for vendor invoices
l
Read an overview of retainage
l
Enter a vendor invoice

Releasing Retainage for Vendor Invoices
When your vendors have completed their jobs, they will release the retainage by sending you a statement or an invoice for the
retained amounts. To release the retainage in Sage 50 follow these steps:

1. Create a Service item in Inventory for Payables Retainage. Make sure that the Payables Retainage general ledger account is
entered in the GL Salary/Wages Acct field for the Service item. Although this step is optional, it will ensure that when you
use this item on your purchase invoices the correct general ledger account is selected automatically. Step-by-step instructions
a. Select Maintain > Inventory Items. This will open the Maintain Inventory Items window.
b. Enter an Item ID and Description .
c. Select Service as the Item Class.
d. Leave Price Levels set to 0.00 and enter the Payables Retainage account in the GL Salary/Wages Acct field.
e. Select the appropriate Item Tax Type.
f. Click Save.
2. Create a purchase invoice selecting the appropriate vendor, date, and so on.
3. In the line items, select the Payables Retainage Service item and enter the amount of released retainage on the vendor’s
bill.

4. Save the invoice. The retainage will now be handled as an aged payable and you will be able to pay the vendor accordingly.
What do you want to do next?

Using Jobs Reports
You can use job reports for many purposes that can include:
l

Printing a list of jobs, phases, and cost codes you have created for your job ledger

l

Creating and reviewing estimated revenues and expenses

l

Comparing estimates with actual expenses and revenues on jobs

l

Viewing detailed information on the Job Ledger, Job Register, and Job Profitability reports

l

Applying reimbursable expenses for jobs to invoices

l

Viewing unbilled job expenses for account reconciliation

You can display only as much detail in a report as you have maintained for each job; so if you have jobs at differing levels of detail,
some information fields may be blank for certain jobs.
To view or print job reports, go to Reports & Forms>Jobs.

Tracking Your Time

Time & Billing Overview
This feature is available only in Sage 50 Complete Accounting and higher.
Time & Billing can track time spent on various activities and record internal use of company resources associated with customers or
jobs. If you choose, recorded time and expenses can later be billed to customers on sales invoices. If you use payroll, timed
activities can be applied to an employee's paycheck. Time & Billing can also be used to effectively manage administrative activities
and overhead expenses for your business.

Who Did What for Whom?
There are many components of Time & Billing. Each affects different areas of Sage 50 in a unique manner.

Who records time and expense?

Either employees or vendors record time and expenses.

For Whom or Why is time and
expense being recorded?

Time and expenses are recorded for customers, jobs, or administrative purposes.

How is time and expense recorded?

Timed activities are recorded on time tickets. Expenses are recorded on expense
tickets.

What time or expense is being
recorded?

Time is recorded using activity items, while expenses are recorded using charge items.
Both items are set up in inventory.

Related topics
Which should I use: Time & Billing or reimbursable expenses?
What are time tickets?
How inventory works with Time & Billing
How payroll works with Time & Billing
How job costing works with Time & Billing
How accounts receivable works with Time & Billing
What do you want to do next?
l
Set up activity or charge items in inventory
l
Set up an employee to be paid based on time-ticket hours
l
Enter time tickets
l
Enter expense tickets
l
Read the getting started overview

Which Should I Use: Time & Billing or Reimbursable Expenses?
This feature is available only in Sage 50 Complete Accounting and higher.
Time and expense tickets are records that do not directly affect the general ledger. Reimbursable expenses are payroll, accounts
payable, and general journal transactions associated with jobs. For example, if you enter a purchase or pay an employee and
associate it with a customer's job, you can directly apply these transactions to the sales invoice, countering the expense or cost of
sale. When you apply time and expense tickets, only revenue is recorded. The expense is assumed to already be recorded. (For
example, the expense is recorded in accounts payable but not associated with a job.)

If you are...

Use...

Recording billable employee or vendor activities that can be applied to sales invoices

Time Tickets

Recording billable employee or vendor expense items that could be billed to a customer to record revenue

Expense Tickets

Record billable purchase, payroll, or general journal transactions that are for a specific customer or job that
can later be applied to a sales invoice

Reimbursable
Expenses

Related topics
Who Records Time and Expense?
How Is Time and Expense Recorded?

What Time or Expense is Being Recorded?

Who Records Time and Expense?
This feature is available only in Sage 50 Complete Accounting and higher.
Time and expenses are recorded by either employees or vendors set up in Sage 50.

Employees
Employees (hourly or salaried) record most time and expenses. Sage 50 can help an individual track time spent for services
performed for a customer, for a job, or for administrative purposes. An employee can also record out-of-pocket expenses that may
be reimbursable by the business. For more information, see Payroll and Time & Billing.

Vendors (Contract Labor)
Most businesses traditionally do not track time or expenses for vendors. However, if you contract people or other businesses to do
additional work for your company, you may want to record their expenses or hours worked for reporting purposes. Advantages to
using vendors in Time & Billing include:
l

Listing all vendor-timed activities and charged expenses in reports for management and profitability purposes.

l

Comparing recorded time and expense amounts with purchase invoices.

Related topics
How Is Time and Expense Recorded?
What Time or Expense is Being Recorded?
Which should I use: Time & Billing or reimbursable expenses?

What Time or Expense Is Being Recorded?
This feature is available only in Sage 50 Complete Accounting and higher.
Sage 50 uses inventory items to identify what type of activity or expense is being recorded. It uses two special inventory item
classes for time and expense items: activity items and charge items.
Inventory items are not associated with inventory cost of sales. When you bill an activity or charge item to a customer, only
income is credited in the general ledger when posting a sales invoice.

Related topics
Inventory and Time & Billing
Who Records Time and Expense?
How Is Time and Expense Recorded?
Which should I use: Time & Billing or reimbursable expenses?

How Is Time and Expense Recorded?
This procedure is possible only in Sage 50 Complete Accounting and higher.
Sage 50 uses tickets to track time and expenses. Time, whether employee time or vendor time, is entered using Time Tickets.
Expenses incurred while working on a project are entered using Expense Tickets.

Time Tickets
A time ticket records time spent performing activities, such as the following:
l

talking on the phone or meeting with a client

l

researching information for a project

l

designing and writing proposals

l

developing or completing tasks for a project

Sage 50 allows you to manually enter time or start and stop a timer that runs while you perform the activity. When you use the
timer, Sage 50 calculates the duration for you. You can even account for breaks--such as lunches, telephone calls, or other
interruptions--in the activity that should not be included in the total time.
There are two methods for entering time tickets. You can enter single daily time tickets in the Time Ticket window. Or, you can enter
several time tickets at once using a weekly time sheet format. This is done in the Weekly Timesheet window.

Expense Tickets
An expense ticket records expenses incurred while working on a project, such as the following:
l

copying, printing, or faxing document expenses

l

travel and meal expenses

l

expert advice

l

court fees

Related topics
Who Records Time and Expense?
What Time or Expense is Being Recorded?
Which should I use: Time & Billing or reimbursable expenses?

Tracking Your Time (Time & Expense) - Overviews and Procedures
This feature is available only in Sage 50 Complete Accounting and higher.

Setting up
Time and expense items in inventory
l
Employees to be paid based on time-ticket hours
l

Tasks
l

Time Ticket tasks
l
l
l
l
l
l

l

Enter time tickets
Edit time tickets
Delete time tickets
Create paychecks using time-ticket hours
Use time tickets again in payroll
Apply time tickets to sales invoices

Expense Ticket tasks
l
l
l
l
l

Enter expense tickets
Edit expense tickets
Delete expense tickets
Track reimbursable expenses from employees
Apply expense tickets to sales invoices

Setting Up Time & Billing
This feature is available only in Sage 50 Complete Accounting and higher.
Setting up Sage 50 to use time/expense tickets and bill customers for them is easy.
l

First, you need to create Activity items (to be used on Time Tickets); then you need to create Charge items (to be used on expense
tickets). These are set up in Maintain Inventory. They describe all of the various activities that employees or contract labor will do
in the course of carrying out a project, as well as the expenses they will incur.

l

l

Next, if you plan to pay employees based on time tickets that are entered for them, you will want to create their employee
records. Be sure that you specify that they are to be paid based on Time Ticket Hours. In this way, Sage 50 will automatically
calculate their hours based on the tickets for them and their pay frequency.
Last, you will want to set up customer records so that you can bill your customers for the work recorded on time and expense
tickets. You can also create jobs so that you can track the costs you incur while carrying out a project.

Billing Time Tickets, Expense Tickets, and Reimbursable Expenses
You can easily bill your customers for time tickets, expense tickets, and reimbursable expenses by going to Tasks>Invoice Time and
Expenses. You can create multiple invoices at the same time instead of having to create invoices one at a time to bill tickets and/or
reimbursable expenses for each customer.

Note: You can't write up or write down your ticket or expense amounts when billing them through Invoice Time and Expenses.
However, you can manually adjust the amounts on the invoices after they are created.
If you want to create invoices one at a time or if you want to write up/write down the billing amounts at the time the invoice is
created, you can do this by applying tickets/reimbursable expenses on the sales/invoicing screen.
To use Invoice Time and Expenses to bill customers for time tickets, expense tickets, and/or reimbursable expenses:

1. Go to Tasks>Invoice Time and Expenses.
2. The Invoice Time and Expenses -Filter Selection screen will appear.
3. Make any necessary filter selections to narrow down the time tickets, expense tickets, or reimbursable tickets that you want
to invoice.
Keep in mind that invoices can only be created for jobs that have customers associated with them. You can associate a
customer with a job on the Maintain Jobs screen.

4. Click OK.
5. The Create Invoices for Time and Expenses screen will appear.
6. In the Selection Grid, select the customers that you want to invoice. Some customers may have messages in the Warning
column of the grid. Look carefully at these customers before selecting to create invoices for them.
If you do not see the desired customers or amounts in the Selection Grid, click the Return to filter screen link to return to
the filter screen where you can change your filter selections.

7. Enter a date for the invoices in the Invoice Date field.
8. Click Create. This will save the invoices without invoice numbers so that you can print them later.
A message will appear showing the number of invoices that you just created and giving you the option to print the invoices.

9. Click Print to print these invoices. The Preview and Print Invoices and Packing Slips screen will appear with the invoices you
just created selected in the grid. You will be able to select other unprinted invoices to print also.
Click Print/E-mail to print the invoices.

Why do I see Qty and Unit Price amounts on the invoice when I bill reimbursable expenses from Invoice Time and Billing, but
not from Sales/Invoicing?
This is because you can write up or write down the amounts when you bill from Sales/Invoicing. The quantity and unit price
come from the purchase transaction. It would be confusing to see an amount that didn't equal the qty times unit price because
the amount had been written up or down. You can't write amounts up or down when billing from Invoice Time and Billing.

Learn More
Create Invoices for Time and Expenses screen

Time Tickets
This feature is available only in Sage 50 Complete Accounting and higher.
Time tickets are used to record time spent by individual employees or vendors for activities performed. Time tickets record
activities that have a time associated with them. These times can be associated with customers, jobs, or administrative projects. You
can include billable time tickets on customer sales invoices. Employee time tickets can also be applied to Payroll if the employee is
set up to be paid based on time-ticket hours.

Sage 50 allows you to manually enter times or start and stop a timer that runs while you perform the activity. When you use the
timer, Sage 50 calculates the duration for you. You can even account for breaks in the activity—such as lunch breaks, telephone
calls, or other interruptions—that should not be included in the time.
Time ticket amounts are not posted to the General Ledger. However, when you apply time tickets to Payroll or Sales/Invoicing,
transactions are generated and posted to the General Ledger.
There are two methods of entering time tickets:
Daily Time Tickets
Weekly Timesheet

What do you want to do next?
Enter time tickets
l
Record daily time tickets
l
Record time tickets on a weekly time sheet
l
Print weekly time sheet for an employee or vendor
l
Edit time and expense tickets
l
Set up activity or charge items in inventory
l

l
l

Set up an employee to be paid based on time-ticket hours
Read the Time & Billing overview

Enter Time Tickets
This feature is available only in Sage 50 Complete Accounting and higher.
Time tickets record time spent performing activities for customers, jobs, or administrative projects. You can include billable
time tickets on customer sales invoices. Employee time tickets can also be applied to payroll if the employee is set up to be paid
based on recorded time-ticket hours.
There are two methods for entering time tickets. You can record time tickets individually or several at one time using a weekly
timesheet.

Record Daily Time Tickets
This procedure is possible only in Sage 50 Complete Accounting and higher.
Time tickets are used to record time spent performing activities by either an employee or vendor. There is no limit to the number of
daily time tickets you can record for an employee or vendor.

1. From the Tasks menu, select Time/Expense, then Time Tickets.
2. Select whether this activity is to be recorded by an employee or vendor.
3. Enter or select either the employee ID or vendor ID that corresponds to this time ticket.
A ticket number is automatically assigned for you.

4. Select whether this time ticket is being completed for a customer, for a job, or for administrative purposes.
5. Enter or select either the customer ID or job ID associated with this ticket. If you selected Administrative in the previous step, this
field will not be available.

6. Enter or select the Activity Item set up in inventory that identifies the event to be timed or recorded.
7. Enter a brief Invoice description if you want this to print on the sales invoice.
8. Enter or select the Ticket Date that corresponds to when this activity is to be recorded.
9. Choose a timing option, and record the ticket duration.
l
l

l

Select Enter Time and type in the length of time in the Duration field.
If you intend to manually enter the time duration, select Calculate Time. You can enter a start time, end time, and break time (if
necessary). Sage 50 will calculate the duration for you.
If you want Sage 50 to actively clock the duration of the activity, select the Start Timer button to activate the timer. While the
timer is running, the duration increases. Select the Stop Timer button to halt the duration from increasing. You can start the

timer again, if you like, to continue adding more time to the duration. If you do not want to use the timer, you can just enter a
duration.

Note: You cannot select Save or close the Time Ticket window while the time ticket timer is running.
10. Select a Billing Type for this time ticket. There are up to four billing types available depending on whether this is an employee or
vendor time ticket: Employee Rate, Activity Rate, Override Rate, and Flat Fee.

11. Enter or select a Billing Rate for this time ticket. Options for entering or selecting the billing rate depend on what Billing Type you
selected or whether this is an employee or vendor time ticket.

12. Select the Billing Status for this time ticket. There are four billing statuses available: Billable, Non-Billable, No Charge, and Hold.
If you selected Flat Fee as the billing type, then you can enter an amount in the Billing Amount field. Otherwise, Sage 50 will
calculate the billing amount based on what was entered in previous fields.

13. If an employee is recording this ticket, then you can select a pay level associated with the employee's setup.
14. If you want to add an internal note to this ticket, click the Note button in the toolbar. There is a 2,000-character limit.
15. Select Save to record the time ticket.
If this is an employee time ticket and the employee is set up to be paid based on time-ticket hours, you can apply the time-ticket
hours in payroll.
If you selected either Billable or No Charge billing status, the time ticket can now be applied to a customer's sales invoice.

Record Time Tickets Using a Weekly Timesheet
This procedure is available only in Sage 50 Complete Accounting and higher.
Using the Weekly Timesheet Entry screen , you can record and maintain individual time tickets using a weekly time-sheet
format.

1.
2.
3.
4.

From the Tasks menu, select Time/Expense, then Weekly Timesheet.
Select whether to display an Employee or Vendor weekly timesheet.
Enter or select either the Employee ID or Vendor ID that corresponds to this weekly timesheet.
Enter or select the Week Including date to display the appropriate days in which you want to maintain or enter time tickets. If you
want to change the first day of the week, click the Settings button and use that dialog box.

Note: you can use the Copy Last Week button to copy all information for this employee, excluding the actual hours worked.

5. Select whether the time tickets being completed in this row are for a Customer, for a Job, or for Administrative purposes.
6. Enter or select the Activity item ID that identifies the event to be recorded for this row.
Tip: To navigate through the weekly timesheet, press the TAB or ENTER key.
7. Enter or select either the customer ID or job ID associated with the time tickets entered in this row. If you selected Administrative
in the previous step, this field will not be available.

8. Select the Billing status for the time tickets entered in this row. There are four billing statuses available: Billable, Non-Billable, No
Charge, and Hold.

9. Select a Billing type for the time tickets entered in this row. There are four billing types available: Employee Rate, Activity Rate,
Override Rate, and Flat Fee.

10. Enter or select a Billing rate for time tickets entered in this row. Options for entering or selecting the billing rate depend on what
billing type you selected or whether these are employee or vendor time tickets.

11. If an employee is recording tickets entered for this week, then you can select a Pay level associated with the employee's setup. If
this is a vendor weekly timesheet, then the Pay Level field will not be available.
12. Enter the number of hours spent each day of the week on the activity. Enter the duration in decimal format, using the
HOURS.MINUTES format. For example, 1.5 represents one hour and 30 minutes. For each daily duration that you enter, Sage 50
will create a separate time ticket.
Select Save to record the time-ticket durations entered for the week.

If employee time tickets are created and the employee is set up to be paid based on time-ticket hours, you can apply the timeticket hours in payroll.
If you selected either Billable or No Charge billing status, the time tickets can now be applied to a customer's sales invoice.
Select Print to print ticket data currently displayed.

Apply Time Tickets to Sales Invoices
This procedure is possible only in Sage 50 Complete Accounting and higher.
To bill customers for recorded time tickets, do the following:

1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Enter or select the customer you want to invoice for the recorded time.
Note: To apply time tickets to a sales invoice, you must have selected the customer ID in the Time Tickets window when you
created the ticket. To apply time tickets completed for a job, you must have entered the customer's ID in the For Customer
field in the Maintain Jobs window or selected a phase or cost code associated with a job for this customer.

3. Select the Apply tickets/expenses link. Sage 50 displays the Apply Tickets/Reimbursable Expenses window.
4. Select the Time Tickets tab. Sage 50 lists all unused time tickets (those with a billable or no-charge billing status) associated
with this customer.

5. Choose a sort method from the Sort List By drop-down list. You can sort tickets listed in this window using several different
methods. This can be useful when consolidating expenses.

6. To consolidate the tickets that are listed, select an option from the Consolidate by drop-down list.
Consolidation will combine separate items into one line item on the invoice based on your consolidation method.

7. To apply a ticket to the sales invoice, select the Use check box.
To select a range of tickets that need to be applied to this invoice, select the Use button, which will display the Select Tickets to
Use window. After choosing your selection filter, select OK.

8. To write up or write down the time ticket amount, manually change the invoice amount.
To write up or write down a group of tickets by a common dollar amount or a percentage, select the Write Up button. Sage 50
displays the Select Tickets to Write Up/Down window. Enter the write-up figures in the boxes provided, and select OK.
You can write up line items by a common dollar amount or a percentage. If you want to give the customer a discount, enter a
negative percentage.

9. To insert each ticket description as the line-item description on the invoice, select the Use Ticket Description for Invoicing
option. To insert the associated ticket's activity-item description as the line-item description on the invoice, select the Use Item
Description for Invoicing option
The options for ticket description or item description are available only if No Consolidation is selected.

10. When you have finished making your selections to apply to the invoice, select OK to return to the invoice.
Time tickets display as individual line items in the invoice based on the consolidation method and write up/down amounts. You can
manually enter or change line descriptions to identify the billed transaction for your customer.

Edit Previously Calculated Time Ticket Hours (Weekly Timesheet)
This feature is available only in Sage 50 Complete Accounting and higher.
If, on the Weekly Timesheet, you edit hours that were previously calculated from a daily time ticket, the daily time ticket is
changed to a Timed Duration -type of ticket. The edited hours you enter on the Weekly Timesheeet are stored in the Daily
window's Duration field.

1.
2.
3.
4.

From the Tasks menu, select Time/Expense, then Time Tickets. Sage 50 displays the Time Tickets window.
Select the Weekly Timesheet .
Select whether to display an employee or vendor weekly time sheet.
Enter or select either the employee ID or vendor ID that corresponds to this weekly timesheet. To display a list of existing
employees or vendors, type ? in this field, or select the Lookup button.

5. Enter or select the Week Including date to display the appropriate days in which you want to maintain or enter time tickets.
6. Click in the cell for the day and activity item you want to change.
7. Enter the new duration, in decimal format.
For example, entering 4.5 means four hours and thirty minutes.

8. Select Save to save changes to the weekly timesheet.

Delete Time Tickets
This procedure is available only in Sage 50 Complete Accounting and higher.
You can delete any time ticket that is not marked as having Been Used in Payroll or having been used in Sales/Invoicing.
In this case, you must purge the ticket.
Tip: If the time ticket's Has this ticket been used in Payroll check box on the Time Tickets window is selected, you can clear
the check box to delete the ticket.

Note: If you delete a line item that references the ticket on the sales invoice, the ticket will still indicate that it has been used in
Sales/Invoicing. You will not be able to apply it to another invoice. If you want to apply the ticket to another invoice, you must recreate the ticket.

Tip: If you delete the entire invoice without deleting a line item that includes an applied ticket, then all time and expense tickets
applied to this invoice will no longer be marked as having been used in Sales/Invoicing. Then, you can apply these tickets to a new
sales invoice.

1.
2.
3.
4.

From the Tasks menu, select Time/Expense, then Time Tickets.
Select the List toolbar button. Sage 50 displays the list of Time Tickets.
Select the ticket you want to delete by highlighting it and selecting Open .
To remove the ticket, select the Delete toolbar button.
If the Delete button is disabled (gray and unavailable), this means either the Has this ticket been used in Payroll check
box is selected or the ticket has been used in Sales/Invoicing. If the Has this ticket been used in Payroll check box is
selected and the ticket is not used in Sales/Invoicing, you can clear the check box. The Delete button becomes available. If the
ticket has been used in Sales/Invoicing and you want to remove the ticket, you must purge the ticket or follow the steps in the Tip
above.

What do you want to do next?
l
Delete expense tickets
l
Edit time and expense tickets
l
Purge time and expense tickets with the Purge wizard
l
Enter time tickets
l
l

Enter expense tickets
Read the time tickets overview

Print Weekly Timesheet
This procedure is available only in Sage 50 Complete Accounting and higher.
A quick method to print weekly time ticket data for an employee or vendor is selecting the Print button on the Time Ticket Weekly
Timesheet Entry window.

1.
2.
3.
4.

Open the Time Ticket Weekly Timesheet Entry window.
Select whether to display an employee or vendor weekly timesheet.
Select the employee ID or vendor ID.
Enter or select the Week Including date.
If the employee or vendor has time entered for the week, Sage 50 displays the ticket data. Otherwise, enter the ticket data.

5. Select the Print button.

Note: If you entered new ticket information or modified existing tickets without selecting the Save button, these tickets will
automatically be saved prior to printing the report.

What do you want to do next?
Record time tickets on a weekly time sheet
l
Record daily time tickets
l
Edit time and expense tickets
l
Set up activity or charge items in inventory
l
Set up an employee to be paid based on time-ticket hours
l

Entering Expense Tickets
This feature is available only in Sage 50 Complete Accounting and higher.
Expense tickets record the use of company resources for a customer, a job, or administrative purposes. You can bill your customers
or jobs for Charge items included on billable expense tickets.

1. From the Tasks menu, select Time/Expense, then Expense Tickets.
2. Select whether this expense is to be recorded by an Employee or Vendor.
3. Enter or select either the Employee ID or Vendor ID that corresponds to this expense ticket.
A Ticket number is automatically assigned for you.

4. Select either Administrative, Customer, or Job.
5. Enter either the Customer ID or Job ID. If you selected Administrative in the previous step, this field will not be available.
6. Enter or select the Charge item.
7. Enter a brief Invoice description for billing purposes.
8. If necessary, you can enter a 2,000-character Internal memo describing the expense item and other notes associated with this
particular expense ticket. Just click the Note button in the toolbar.
9. Enter or select the Ticket date. This should be the date that the expense was incurred, not necessarily the date that you are
creating the Expense ticket.

10. If this is an employee expense ticket and the employee should be reimbursed for the expense, select the Reimbursable to
employee check box. You can print the Reimbursable Employee Expense
report to list all expenses that employees should be reimbursed for.
11. Enter a quantity (the number of charge items used), if applicable.
12. Enter the Unit price.
13. Select a Billing status for this expense ticket.
14. The Billing amount should be calculated for you depending on whether you included a charge item, quantity (if needed), unit
price, and billing status. You can change the billing amount in all cases except when selecting the No Charge billing status.

15. Select Save.
If you selected either Billable or No Charge billing status, the expense ticket can now be applied to a customer's sales invoice.

What do you want to do next?
Track reimbursable expenses from employees

l

Delete Expense Tickets
This procedure is available only in Sage 50 Complete Accounting and higher.
You can delete any time or expense ticket that is not marked as having been used in Sales/Invoicing. In this case, you must purge
the ticket.

Note: If you delete a line item that references the ticket in the sales invoice, the ticket will still indicate that it has been used in
Sales/Invoicing. You will not be able to apply it to another invoice. If you want to apply the ticket to another invoice, you must recreate the ticket.

Tip: If you delete the entire invoice without erasing a line item that includes an applied ticket, then all time and expense tickets
applied to this invoice will no longer be marked as having been used in Sales/Invoicing. Then, you can apply these tickets to a new
sales invoice.

1.
2.
3.
4.

From the Tasks menu, select Time/Expense, then Expense Tickets.
Select the List toolbar button. Sage 50 displays the list of existing Expense Tickets.
Select the ticket you want to delete by highlighting it and selecting Open .
To remove the ticket, select the Delete toolbar button.
If the Delete button is disabled (gray and unavailable), this means the ticket has been used in Sales/Invoicing." In order to
remove the ticket, you must purge the ticket, or follow the procedure in the Tip above.

What do you want to do next?
Delete time tickets
l
Purge time and expense tickets with the Purge wizard
l

Finding and Editing Time and Expense Tickets
This procedure is available only in Sage 50 Complete Accounting and higher.
There may be times when you would like to review and possibly change information on an existing time or expense ticket. There are
several methods for searching or finding time and expense tickets. These searching and editing methods are essentially the same as
with any other Sage 50 transaction.

Note: You can add or modify time-ticket and expense-ticket information. However, if you adjust ticket information after it has
been used in Payroll and/or Sales/Invoicing, your Time/Expense reports may display information that conflicts with Payroll and
Accounts Receivable reports. Changes made to tickets after they have been applied to Payroll and/or Sales/Invoicing do not
update the employee paycheck or sales invoice.
Below are two methods for finding and editing transaction records in Sage 50.

To find and edit a ticket using the List toolbar button
1. From the Tasks menu, select Time/Expense, then either Time Tickets or Expense Tickets (depending on which ticket type you
want to review or edit).

2.
3.
4.
5.

Select List to open the list of tickets.
Highlight the item you want to review and edit.
Select Open .
Make the changes to the ticket and click Save.

To find and edit a ticket using reports
1. From the Reports & Forms menu, select Time/Expense. Sage 50 displays the Select a Report or Form window.
2. Select either Time Ticket Register or Expense Ticket Register (depending on which ticket type you want to review or edit). Then,
select the Preview button.

3. In the Filter window, select a date range that includes the date when you suspect the ticket was entered.
Tip: if you are unsure of the date of the ticket, in the Date lookup list, select All. (You will need to scroll up to select this option in
the Date field.)
4. Place your mouse cursor over the ticket you would like to review or edit. A box appears around the ticket transaction, and the
mouse cursor changes to a magnifying glass. This indicates that you can drill down to display the ticket detail.

5. With the magnifying glass cursor visible, double-click the ticket transaction to display the ticket detail in the Time (or Expense)
Tickets window.

6. Make the changes to the ticket and click Save.

Accounts Receivable and Time & Billing
This feature is available only in Sage 50 Complete Accounting and higher.

Recorded time and expense tickets can be applied to a customer's sales invoice so that your company can be reimbursed for various
activities performed or expenses incurred while completing a particular service or job.
You can
l

Write-up time and expense items on the sales invoice, allowing you flexibility in billing amounts.

l

Consolidate multiple time tickets into a single group, which would then appear as one line item on the invoice.

l

Consolidate expense ticket items into a single group.

Once time and expense items are applied to a sales invoice, the items are marked as used and cannot be applied to a second
invoice. When you view the ticket on a list, you can see that it was invoiced, and you can see the invoice number that the ticket was
applied to.
Only billable and no-charge time and expense items are available to apply to sales invoices. You cannot apply administrative time
and expense items to sales invoices since they are not associated with a customer or job.

Related topics
Inventory and Time & Billing
Payroll and Time & Billing
Job Costing and Time & Billing
What do you want to do next?
l
Apply time tickets to sales invoices
l
Apply expense tickets to sales invoices

Applying Time Tickets To Customers
This feature is available only in Sage 50 Complete Accounting and higher.
To apply a daily time ticket to a customer:
When you fill out a daily time ticket, in the Why Is This Ticket Being Recorded section, select To a Customer Invoice in the To Be
Applied field and select the customer in the Customer ID field.
To apply a weekly time ticket to a customer:
When you enter time on a row of a weekly time ticket, select Customer in the Customer/Job/Administrator field and then select
the customer in the Customer/Job ID field.
Time tickets that have been applied to a customer are available to be selected from the Sales/Invoicing screen so that customers
can be billed for this time.

Another Option
If you have created jobs that are assigned to a customer, you can apply a time ticket to a job and then bill the customer for time
tickets for that job from the Sales/Invoicing screen.

Create Invoices for Time and Expenses
This is the list of invoices that will be created based on the criteria you entered on the Invoice Time and Expenses-Filter Selection
window. All invoices that do not have any warnings associated with them will be selected.

How do I create invoices from this window?
Make sure the checkboxes are selected for each invoice you want to create. If you don't see the invoices you expected, click
Return to filter window to go back and make your selections again. You may need to choose a different date, jobs, or customers
than in your original selection.

Tip: The number of invoices you have selected to create appears below the left side of the grid.
Once you have selected the invoices, click the Create button. You will have the option to print the invoices after they are
created.

What are warnings?
These are the same messages that would appear if you were creating sales transactions, such as sales invoices, sales orders,
quotes, and proposals. You should look carefully at any customers that have these warning messages before selecting to create

invoices for them.

Inactive: This appears if the customer is inactive.
Job Inactive: This appears if a job on the sales transaction is inactive.
Over credit limit: This appears if the customer's balance is over the credit limit and you have selected "Notify Over Limit" as the
Credit Status for this customer on the Maintain Customers window.

Notify on invoicing: This appears if you have selected "Always Notify" as the Credit Status for this customer on the Maintain
Customers window. You can change this warning message for individual customers by going to the Maintain Customers window >
Payment & Credit tab. In the Terms and Credit section, select 'Customize terms for this customer.' You can also customize this
warning message for all customers by going to the Customer & Sales Navigation center > Customers > Set Up Customer Defaults >
Terms and Credit tab. When you select 'Notify Over Limit' as the Credit Status, a Message field will appear allowing you to enter a
custom message.

Hold: This appears if you have selected "Always Hold" as the Credit Status for this customer on the Maintain Customers window. You
will not be able to create a sales transaction for this customer until you change the credit status.

Hold (over credit limit): This appears if the customer is over the credit limit and you have selected "Hold Over Limit" as the
Credit Status for this customer on the Maintain Customers window. You will not be able to create a sales transaction for this customer
until the customer balance is below the credit limit or you change the credit status.

Can I create invoices that have warnings?
Yes, unless the warning is Hold or Hold (over credit limit). You'll need to select the checkbox for any invoices with warnings that
you want to create.

Why are the invoice amounts estimated and not actual amounts?
The invoice amounts are considered estimated because they do not include any sales tax or retainage. Sales tax and retainage
will be included when the invoice is created, if applicable.

Learn More
Billing Tickets and Reimbursable Expenses Overview

Apply Expense Tickets to Sales Invoices
This feature is available only in Sage 50 Complete Accounting and higher.
To bill customers for recorded expense tickets, do the following:

1. From the Tasks menu, select Sales/Invoicing. Sage 50 displays the Sales/Invoicing window.
2. Enter or select the customer you want to invoice for the recorded expenses.
Note: To apply expense tickets to a sales invoice, you must have selected the customer ID in the Expense Tickets window
when you created the expense ticket. To apply expense tickets completed for a job, you must have entered the customer's ID
in the For Customer field in the Maintain Jobs window or selected a phase or cost code associated with a job for this customer.

3. Select the Apply tickets/expenses link. Sage 50 displays the Apply Tickets/Reimbursable Expenses window.
4. Select the Expense Tickets tab. Sage 50 lists all unused expense tickets (those with a Billable or No-charge billing status)
associated with this customer.

5. Choose a sort method from the Sort List By drop-down list. You can sort tickets listed in this window using several different
methods. This can be useful when consolidating expenses.

6. To consolidate the tickets that are listed, select an option from the Consolidate by drop-down list.
Consolidation will combine separate items into one line item on the invoice based on your consolidation method.

7. To apply a ticket to the sales invoice, select the Use check box.
To select a range of tickets that need to be applied to this invoice, select the Use button, which will display the Select Tickets to
Use window. Select OK.

8. To write up or write down the expense ticket amount, manually change the invoice amount.
To write up or write down a group of tickets by a common dollar amount or a percentage, select the Write Up button. Sage 50
displays the Select Tickets to Write Up/Down window. Enter the write-up figures in the boxes provided, and select OK.

You can write up line items by a common dollar amount or a percentage. If you want to give the customer a discount, enter a
negative percentage.

9. To insert each ticket description as the line-item description on the invoice, select the Use Ticket Description for Invoicing
option. To insert the associated ticket's charge-item description as the line-item description on the invoice, select the Use Item
Description for Invoicing option
The options for ticket description or item description are available only if No Consolidation is selected.

10. When you have finished making your selections to apply to the invoice, select OK to return to the invoice.
Expense tickets display as individual line items in the invoice based on the consolidation method and write up/down amounts. You
can manually enter or change line descriptions to identify the billed transaction for your customer.

Inventory and Time & Billing
This feature is available only in Sage 50 Complete Accounting and higher.
Activities performed and expenses incurred while working on projects are set up in Inventory using two inventory item classes:
l
l

Activity items: These describe the type of work performed and the price per unit. They are used on time tickets. .
Charge items: These describe expenses incurred while working on projects. They are used on expense tickets. .

Related topics
Payroll and Time & Billing
Job Costing and Time & Billing
Accounts Receivable and Time & Billing

Set Up Activity or Charge Items for Time & Billing
This feature is available only in Sage 50 Complete Accounting and higher.
Activity items and charge items are used in Time & Billing. Activity items are used when recording time tickets. Charge items are
used when recording expense tickets. Both can later be applied to invoices when billing your customers. Activity and charge items
are set up as inventory items from the Maintain menu or the Navigation Aid.

To set up an activity or charge item:
1. Select Inventory Items from the Maintain menu.
2. Enter a unique item ID for the charge item or activity item.
3. Select either Activity item or Charge item as the item class.
4. Enter a short description of the activity or charge item.
5. Enter a detailed description for Sales. This description will appear on the sales invoice in the Description column for nonconsolidated line items. You cannot enter a description for purchases when using activity or charge items.

6. If you are creating an activity item, enter the billing-rate levels. If you are entering a charge item, enter the sales-price levels.
7. Enter the Stocking U/M, Item Type, and Location for the item.
8. The default G/L income account is displayed. If this is not correct, you can change the account to something more appropriate for
this particular item.

9. Select the Item Tax Type code (this determines whether or not the item is exempt from taxes).
10. If sales reps will be selling the item, you can select the Subject to Commission box.
11. Select the Custom Fields tab, and enter information (if applicable). Otherwise, select the Save button.
What do you want to do next?
Set up an employee to be paid based on time-ticket hours

l

Job Costing and Time & Billing
This procedure is available only in Sage 50 Complete Accounting and higher.

If you use jobs to track projects for customers, you can also use time and expense tickets to track service-related activities and
expenses used to complete a project. In this way, you can effectively track job profitability and labor (whether by an employee or
vendor).
Advantages to using Job Costing include:
l

You can record billable and non-billable time spent or expenses incurred while completing a job, phase, or cost code.

l

You can invoice a customer for billable time spent or expenses incurred based on an individual job, phase, or cost code.

l

You can record and track labor costs in payroll for timed activities performed in order to complete a job, phase, or cost code.

l

You can manage employee- and vendor-activity expenses by jobs using Time/Expense reports.

l

You can consolidate time and expense tickets on sales invoices into single line items by job.

Related topics
Inventory and Time & Billing
Payroll and Time & Billing
Accounts Receivable and Time & Billing

Payroll and Time & Billing
This feature is available only in Sage 50 Complete Accounting and higher.

Using Time Tickets in Payroll
When using Time & Billing, you can apply time-ticket durations (hours) recorded by employees to their paychecks. Using time-ticket
hours on an employee's paycheck provides an additional method of tracking labor costs based on services performed. Both hourly
and salary employees can record time-ticket hours. However, only employees set up to use the Hourly-Time Ticket Hours pay
method can use time-ticket hours in payroll.
An employer could conceivably use time tickets to record employee administrative activities such as bookkeeping, receptionist,
receiving, PBX, counting month-end inventory, and so on. Non-worked hours such as vacation or sick time can also be recorded on
employee time tickets. However, only hourly employees set up to be paid using time-ticket hours can actually be paid base on these
activities.

Note: Activity detail is only available in reports and does not appear on the employee's paycheck. You can record activities for
salary employees and other hourly employees (not paid using time-ticket hours). Again, the activity detail will only be available in
reports, but this information can act as an effective management tool.

Using Expense Tickets in Payroll
Time & Billing allows you to track employee expense tickets as reimbursable to the employee. For example, an employee may have
to pay for parking fees or lunch for a client. Expense tickets marked as reimbursable to the employee are recorded on the Employee
Reimbursable Expense report. Expense tickets that are reimbursable to employees are recorded for reporting purposes only and
cannot be directly applied to payroll or accounts payable. You will have to include the expense in payroll as a non-taxable employee
field during payroll entry or pay the employee using an accounts payable disbursement check. How do I track reimbursable

expenses from employees?
What do you want to do next?
Set up activity or charge items in inventory

l

Set Up an Employee to Be Paid Based on Time-Ticket Hours
This feature is available only in Sage 50 Complete Accounting and higher.
If you have an hourly employee that works on Time & Billing projects, you can pay the employee based on recorded time-ticket
hours. Once an employee records hours worked on a daily time ticket or weekly time sheet, those hours can be totaled and included
in the employee's paycheck.

Note: Salary employees cannot be paid based on time-ticket hours. However, you can still enter and maintain time tickets for
salaried employees for billing purposes.

1. From the Maintain menu, select Maintain Employees/Sales Reps. Sage 50 displays the Maintain Employees Sales Reps window.
2. Select the Pay Info tab.

3. Enter or select the employee ID. To display a list of existing employees, type ? in this field, or select the Lookup button.
4. Select Hourly-Time Ticket Hours from the Pay Method list.
5. If you intend to bill your customers for hours worked by this employee (those recorded on time tickets), enter an hourly billing
rate for this employee.

6. Verify or enter appropriate pay rates for each hourly pay level.
These are the pay rates to be used during payroll entry.

Note: Defined pay levels must contain an established pay rate in order to be available when you enter employee time tickets.
If a pay level contains an undefined rate and that pay level is selected for a time ticket, the time ticket will not be available to
use in Payroll.

7. When you are finished, select Save.
During payroll entry, you can optionally add or modify hours worked if the employee worked additional hours (non-time-ticket
hours) during the payroll period.

Create Paychecks Using Time-Ticket Hours
This procedure is available only in Sage 50 Complete Accounting and higher.
If you have employees who enter time tickets for hours worked on projects, you can create paychecks based on the hours recorded
on time tickets during a payroll period.
To enter time-ticket-based paychecks, the employee must be set up with the Hourly - Time Ticket Hours payment method
before you begin payroll entry.

1. From the Tasks menu, select Payroll Entry. Sage 50 displays the Payroll Entry window.
2. Enter or select the employee ID you want to pay.
If the employee is set up to be paid based on time ticket hours, Uses Time Tickets Hours will appear in red to the right of the
employee name. The time-ticket hours worked will appear in the appropriate hourly pay level based on how the time ticket was
entered.

3. Verify that the total hours worked is correct for each hourly pay level. Make appropriate changes.
Note: If an employee works overtime, you may need to adjust hours to the appropriate hourly pay levels. For example, if a
weekly employee records time tickets adding up to 45 hours, all using the same pay level, all 45 hours will appear in the single
pay level during payroll entry. If this is the case, you will need to adjust the hours to 40 Regular pay level and 5 Overtime pay
level.
If time tickets use a pay level that contains a pay rate undefined in Maintain Employees/Sales Reps, then the time ticket will not
be included when calculating total time-ticket hours worked in payroll entry.

4. If some or all of the employee time tickets were based on jobs rather than customers, select the Jobs button. Sage 50 displays
the Labor Distribution to Jobs window. All time tickets recorded by this employee during the payroll period that are posted to jobs
are listed. Verify that the job assignments and hours are accurate. Then, select OK.

Note: You can optionally add or modify hours worked if the employee worked additional hours (non-time-ticket hours) during
the payroll period. However, if you adjust the totals of time-ticket hours recorded for this payroll period, your Time/Expense
reports may display conflicting information. Also, changes made to the labor distribution to jobs do not affect existing time
tickets.

5. When finished, select Print to begin printing the paycheck. If you are not ready to print the check, select Save. This will still post
the check to the general ledger.
Once the paycheck is saved, all time tickets used by this paycheck are marked as Has Been Used in Payroll in the Time
Ticket window. These time tickets cannot be used again unless you manually clear the Has this ticket been applied to
Payroll check box.

Note: Changes made to the hours in the Payroll Entry window do not affect existing time tickets. These time tickets will still
reflect the original durations.

Track Reimbursable Expenses from Employees

This procedure is available only in Sage 50 Complete Accounting and higher.
You can track employee expense tickets that are reimbursable to the employee (for example, mileage and parking fees).

To mark an expense ticket as reimbursable to an employee
1. From the Tasks menu, select Time/Expense, then Expense Tickets.
2. Enter a new expense ticket for the employee, or select the List toolbar button to display an existing employee expense ticket.
3. Select the Reimbursable to Employee check box.
4. When the expense ticket is complete, select Save.
Expense tickets selected as Reimbursable to the Employee are recorded for reporting purposes only. You cannot apply
expense tickets to payroll. However, you can use the Reimbursable Employee Expense report to determine what needs to be paid to
the employee.

To manage employee reimbursable expenses from reports
1. From the Reports & Forms menu, select Time/Expense.
2. Select the Reimbursable Employee Expense report.
3. Enter or select a filter for this report. For example, you may want to enter or select a single employee or an employee range to
display.

4. To display the report, select OK.
5. Examine the report. If there are expenses owed to the employee, manually enter these items in either payroll or accounts
payable.

To pay an employee for recorded reimbursable expenses
To manually enter an expense in Payroll, you must first set up an employee field in Maintain Default Information for Employees (for
example, Reimb_Exp). Select the Adjust button, and remove the new reimbursable expense field from Adjusted_Gross. Then,
save the new field. During payroll entry, enter the amount of the expense in the new reimbursable expense employee field. Make
sure to enter the expense here as a positive amount. The reimbursable expense will be added to the paycheck and not considered
part of taxable wages.
You may want to write employee expense checks in accounts payable rather than payroll. You can enter a disbursement check in the
Payments window. You will still have to enter the expenses manually, matching the Employee Reimbursable Expense report.

Using Time Tickets for Non-Worked Payroll Hours
This feature is available only in Sage 50 Complete Accounting and higher.
Non-worked hours can be used when employees record time off during a payroll period. Common examples of non-worked hours
include vacation, illness, holidays, personal time, jury duty, maternity leave, and so on.
Sage 50 provides two methods for recording non-worked hours in payroll. One method is to set up Vacation or SickEmployee
payroll fields. Payroll fields provide the flexibility of calculating amounts or setting common amounts to be recorded per pay period.
The advantage to using payroll fields is that the year-to-date totals appear on paychecks and payroll reports. How do I set up these

fields?
Time tickets provide an alternate method to recording non-worked wages. However, this method is limited to hourly employees who
are paid based on time-ticket hours. The following describes how to record vacation time using time tickets:

1.
2.
3.
4.

Set up a Vacation hourly pay level in Employee Defaults.
Set up a Vacation activity item in Maintain Inventory Items.
Record an employee time ticket using the Vacation activity item and link the ticket to the employee's Vacation pay level.
Pay the employee (with the recorded vacation time displayed in the Vacation hourly pay level).

The non-worked hours are tracked in Time/Expense reports. This method does not affect employee payroll fields or
calculations, only hourly pay-level wages. Also, year-to-date totals are not available for employee paychecks or payroll
reports.
Vacation and sick time can be tracked for salary employees using time tickets. However, the time ticket durations are recorded for
report purposes only and cannot be used in payroll. You can set up sick, vacation, jury duty, and maternity leave activity items in
inventory. Then, customize one of the Time/Expense reports to filter out all time tickets that use the non-worked activity item to
determine employee totals.

Use Time Tickets Again in Payroll
This procedure is available only in Sage 50 Complete Accounting and higher.
If a time ticket has already been used in payroll, it is normally not used again. However, if you need to use it again, open the time
ticket, and clear the Has this ticket been used in Payroll check box.

1.
2.
3.
4.

From the Tasks menu, select Time/Expense, then Time Tickets.
Select the List toolbar button.
Select the ticket that you have already used in payroll. Then, select Open .
Clear the Has this ticket been used in Payroll check box. Then, select Save.
These time-ticket hours are now available again to use in payroll entry for this employee.

Note: If the Has this tickets been used in Payroll check box is disabled, you do not have security access to the
Employees & Payroll area of Sage 50. Check with your system administrator to obtain password rights to Payroll.

Working with Bank Accounts
Adding a Bank Account
Sage 50 tracks bank accounts and balances just as it tracks accounts in your general ledger chart of accounts. So, to set up a bank
account, you simply create or modify a general ledger account, usually in the Cash area of the general ledger chart of accounts. To
add a new account

1. Select Chart of Accounts from the Maintain menu. Sage 50 displays the Maintain Chart of Accounts window.
2. Enter an account ID..
The account ID determines how the account is identified and sorted in the chart of accounts list. Most charts of accounts are set up
with specific account types grouped together.

3. Enter a Description for the bank.
4. Select an account type from the drop-down list.
5. Select Save.
What do you want to do next?
l
Enter G/L beginning balances
l
Enter prior-period adjustments
l
Delete an account from the chart of accounts

Add an Account to an Established Chart of Accounts
To set up an account using the Setup Guide
1. From the Sage 50 main window, select Help>Setup Guide.
2. Click the Chart of Accounts page, and select the Next button. In the following window, select Add New Accounts. Sage 50
displays the Maintain Chart of Accounts window.

3. Enter an account ID and description for the account.
The account ID determines how the account is identified and sorted in the chart of accounts list. Most charts of accounts are set up
with specific account types grouped together.

4. Select an account type from the drop-down list.
5. When you're finished filling in the window, select the Save button.
To set up an account using the menu
1. Select Chart of Accounts from the Maintain menu. Sage 50 displays the Maintain Chart of Accounts window.
2. Enter an account ID and description for the account.
The account ID determines how the account is identified and sorted in the chart of accounts list. Most charts of accounts are set up
with specific account types grouped together.

3. Select an account type from the drop-down list.

4. Select Save.
Note: Since this is a new account, Sage 50 assumes a beginning balance of zero. You can immediately assign transactions to
the account. If you try to enter a beginning balance, Sage 50 assumes this is a prior-period adjustment and will prompt you for
the prior period.

To set up an account from most windows accessed from the Tasks menu
1. Type + or double-click in the Account ID field. Sage 50 displays the Maintain Chart of Accounts window.
2. Enter an account ID and description for the account.
The account ID determines how the account is identified and sorted in the chart of accounts list. Most charts of accounts are set up
with specific account types grouped together.

3. Select an account type from the drop-down list.
4. Select Save.

Delete an Account from the Chart of Accounts
In order to delete an account from the chart of accounts, there must be no transactions posted to the general ledger that reference
the account ID. If an account has a nonzero balance, you must delete or remove transactions associated with it. These can include
beginning-balance entries.
If an account has a nonzero balance, you can enter an adjusting G/L transaction in the General Journal to bring the account's
balance to zero. Then, after two year-end closings, you can purge or delete the account.

To make the account inactive
You can make the account inactive to ensure that no further transactions are associated with it. Then after two year-end closings,
you can purge the account.

1. From the Maintain menu, select Chart of Accounts. Sage 50 displays the Maintain Chart of Accounts window.
2. Select the account you want to make inactive. To display a list of existing accounts, type ? in the G/L Account ID field, or select
the Lookup button.

3. Select the Inactive check box to the right of the account ID. (There is an X in the check box when it is selected.)
To delete an account immediately
1. From the Maintain menu, select Chart of Accounts. Sage 50 displays the Maintain Chart of Accounts window.
2. Enter or select the account ID you want to remove. To display a list of existing accounts, type ? in the G/L Account ID field, or
select the Lookup button.

3. Select the Delete toolbar button to remove the account.
If the account has a nonzero balance in any accounting period within the two currently open fiscal periods, Sage 50 displays a
message stating that you cannot delete the account.
If you still want to remove an account that has had a nonzero balance at one time, examine the history of the account in the Maintain
Chart of Accounts window. Then, display the General Ledger report including a date range of the two open fiscal years. Locate the
account transactions; then double-click to display the corresponding task window where the transactions originated. Finally, delete
these transactions, and return to the general ledger. To remove an account beginning-balance entry, select the Beginning
Balances button in the Maintain Chart of Accounts window.

What do you want to do next?
Record a General Journal entry
l
Drill down on transactions in displayed reports
l
Add an account to an established chart of accounts
l

l

Read about the Sage 50 Purge wizard

Change an Account ID
As your business changes and grows, your chart of accounts may need to change as well, including the IDs of existing accounts. Use
the following procedure to change a general ledger account ID.

1. From the Maintain menu, select Chart of Accounts. Sage 50 displays the Maintain Chart of Accounts window.
2. Enter or select the account ID you want to change. To display a list of existing general ledger accounts, type ? in the Account ID
field, or select the Lookup button.

3. Select the Change ID button on the toolbar. Sage 50 displays the Change Account ID window.
4. Enter the new ID that you want to use instead of the current ID.
5. When you are finished, select OK to change the ID and return to the Maintain Chart of Accounts window.
When you change an account ID, all data records and transactions associated with this account will reflect the new ID. This includes
both current and past transactions.

What do you want to do next?
l
Enter and allocate budgets for your chart of accounts
l
Read the getting started overview

Beginning Balances for General Ledger Accounts
Select the Beginning Balances button on the General tab of the Maintain Chart of Accounts window to enter beginning balances
for general ledger accounts. You use this to enter the beginning balance for the account or to adjust the balance for an account in a
previous period.
Although you enter beginning balances on the Chart of Accounts Beginning Balances window and prior period adjustments on
the Chart of Accounts Prior Year Adjustments window, the fields on the two windows are the same. The columns where you
enter amounts for accounts on these two windows are set up to give you a better feel for how the different accounts in your chart of
accounts affect the balance of your finances. When you finish entering balances for all of your accounts, the total of the amounts in
the Assets, Expenses column must equal the total of the amounts in the Liabilities, Equity, and Income column.
Notice that the Trial Balance keeps a running total, or trial balance, of your entries. In addition, totals for your income and
expenses are calculated.
The toolbar at the top of the window contains the following buttons: Cancel, OK, New, Find, Next, and Help.

Account ID: This is an alphanumeric code that identifies the account. To enter a new account, select the New button.
Description: This is the description of the account entered in the Maintain Chart of Accounts window. You can edit this description
by selecting the New button, entering the ID of the account whose description you want to edit, and then making any changes you
want to the description.

Account Type: This is the type of the account entered in the Maintain Chart of Accounts window.
Assets, Expenses or Liabilities, Equity, Income: Depending on the Account Type specified for this account in Maintain Chart
of Accounts, you will either have to enter an amount in the Assets, Expenses column or in the Liabilities, Equity, Income
column. Sage 50 tells you the column where you enter the amount by graying out the other column. Enter a positive amount in the
column, unless circumstances warrant a negative amount.
For example, if you enter $5,000 as a beginning balance for your checking account in the Assets, Expenses column, to offset this
entry, you might enter $5,000 in the Liabilities, Equity, Income column for a capital account such as retained earnings. For
normal balances, you will just enter positive numbers.

Enter General Ledger Account Beginning Balances
If you are just starting out with your company and have not posted any transactions, Sage 50 assumes that you are entering
beginning balances for your accounts when you select the Beginning Balances button. If you have posted transactions, Sage 50
assumes that you are entering adjustments to your accounts for a period in a prior year. If you enter a new account, Sage 50
assumes that this account has a zero balance. You may find it easier to add all necessary accounts and then create one cumulative
beginning-balance entry.

1.
2.
3.
4.
5.
6.

From the Maintain menu, select Chart of Accounts. Sage 50 displays the Maintain Chart of Accounts window.
Select the Beginning Balances button. Sage 50 displays the Select Period window.
Select the period in which you want to enter beginning balances. You can select from previous, current, or future periods.
Select OK. Sage 50 displays the Chart of Accounts Beginning Balances window.
Click or tab to any of the white cells in the grid to add an amount. (The gray cells are for viewing purposes only.)
Enter all the beginning balances for the accounts. Scroll the list box to make sure the account amounts are correct. If necessary,
you can enter a negative amount; just type a minus sign before the number. Note that for each period, a running beginning

balance is kept. Thus, if you change an amount in Period 1, the amounts for subsequent periods are also changed. However, if
you change an amount in Period 2, the same account balance in Period 1 is unchanged.

7. Select the OK button when you're finished.

Enter Prior-Period Adjustments
In addition to general ledger account beginning balances, Sage 50 allows you to adjust existing account balances. If you are just
starting out with your company and have not posted any transactions, Sage 50 assumes that you are entering beginning balances
for your accounts. If you have posted transactions, Sage 50 assumes that you are entering adjustments to your accounts for a
period in a prior year. If you enter a new account, Sage 50 assumes that this account has a zero balance. You may find it easier to
add all accounts and then create beginning-balance entries.

1. From the Maintain menu, select Chart of Accounts. Sage 50 displays the Maintain Chart of Accounts window.
2. Select the Beginning Balances button to enter prior-period adjustments. Sage 50 displays the Select Period to Adjust window.
3. Select the accounting period in which you want to enter or adjust balances. For prior-period adjustments, you can select from
previous periods.

4. Select OK. Sage 50 displays the Chart of Accounts Prior Year Adjustments window.
5. Click or tab to any of the white cells in the grid to change or add an amount. (The gray cells are disabled.) If necessary, you can
enter a negative amount; just type a minus sign before the number. Note that for each period, a running beginning balance is
kept. Thus, if you change an amount in Period 1, the amounts for subsequent periods are also changed. However, if you change
an amount in Period 2, the same account balance in Period 1 is unchanged.
Examples of when to enter a negative balance

6. Select OK when you are finished.

GL Defaults-Account Segments
You can partition your General Ledger Account ID into segments using the fields on this tab. Segmenting your chart of accounts
allows you to take advantage of Sage 50's powerful reporting tools. Tell me how to use account segments.

See an example of using account segments.
You can also use this tab to alter segments that were established during New Company Setup. How do I set up account segments

during New Company Setup?
The fields on this tab allow you to define up to five segment sections, their lengths and the separator to divide each segment from
the segment following it. As you enter a description for a segment, the fields for the next segment will become available.
l

l

l

Segment Description: Enter a description (up to 10 characters) for the segment. This description could be department,
division, or any other designator for that segment of your Account ID. This description will appear on all windows that
reference account segments. For instance, General Ledger report and Financial Statement filtering options.
Length: Enter the length of the segment. For example, if this segment of the account ID is two characters in length, enter 2
in this field.
Separator: Specify a separator between this segment and the segment following it (if any). The default separator is a
hyphen (-), but you can select other values from the drop-down list. In addition, you can type in any other character as a
separator, with the exception of the asterisk (*), question mark (?), plus sign (+), and a blank space.

As you enter values for the Length and Separator fields for each segment, Sage 50 updates the Account Structure field and
shows you how the Account ID is structured, with a capital X used to represent each space in the segment length. Moreover, Sage 50
updates the Total Account Length field, telling you how long the account ID is. The maximum length is 15.
When you have finished creating your segments, click OK.
Sage 50 Premium Accounting and higher will allow you to change the segment structure for an existing company, but account IDs
that do not match the structure will not function in the same way as those that do match the structure. If you do change the structure
on this tab, Sage 50 will tell you the number of accounts in your chart of accounts that do not match the new segment structure. You
will need to change the ID for the appropriate accounts to use the account segment filtering options for them. How do I change

Account IDs?
What do you want to do next?
l
Read the account segments overview

Example of Using Account Segments
In Bellwether Garden Supply (for Sage 50 Premium Accounting and higher only), one of the sample companies provided with Sage
50, the income accounts in the General Ledger have been departmentalized. Two account segments have been created: one for the
account portion, and a second for the department code, which is a two letter code. This is how it looks on the Account Segments tab
in General Ledger Defaults:

When Bellwether wants to produce an Income Statement that shows only amounts for the Aviary department, it will filter the
information for income by selecting only the Aviary department. This is how the Options screen for the Income Statement will
appear:

When the report prints, only accounts that have AV in the Department segment will appear, as shown below:

Account Reconciliation
Sage 50 reconciles the selected G/L account against your monthly statement. You can reconcile any general ledger account in Sage
50. Typically, you would reconcile bank accounts, cash accounts (such as petty cash), and credit card accounts. You should
systematically reconcile accounts each period so that you can quickly detect bank errors, match real-world data with Sage 50 data,
and identify possible fraudulent activity.
To avoid fraud and quickly detect errors, strive to have your bank send statements toward the end of a period or month. Then
always reconcile your account as soon as it arrives.

You can apply (or clear) transactions in three different categories:
l

deposits in transit

l

outstanding checks

l

other outstanding items (such as General Journal entries)

Online Banking
This feature is available only in Sage 50 Complete Accounting and higher.
Online banking lets you electronically import statements directly from your bank into Sage 50, where they can be reconciled just as
you do with information manually entered from a paper statement. Once imported, the financial transactions contained in these files
can be matched against existing Sage 50 transactions. And once successfully matched, they are marked clear in the Account
Reconciliation window.

Learn More
Reconciling bank statements
To reconcile an account, you enter the bank statement date and the ending bank balance. Then, you need to clear transactions
that are reported on the bank statement. Each time you clear a transaction, the difference is reflected in the Outstanding
Checks, Deposits in Transit, and Unreconciled Difference fields.

Reconcile an account
Importing and reconciling bank statements with Online Banking (Sage 50 Complete Accounting and higher only)
Sage 50 can electronically import bank statements that are in OFX format. A wizard lets you connect with your bank and import
the statement into Sage 50. The import process brings in any debit or credit transactions contained in the statement, as well as
any interest or service charge items.

Autoclear: When you're working in Account Reconciliation and select a general ledger account containing electronically
imported transactions that have not been matched to existing Sage 50 transactions, Sage 50 tries to make a match. Any
imported records that are successfully matched this way are listed as autocleared. Sage 50 also gives you the ability to
manually match and clear any transactions that can't be autocleared.
Once all transactions are cleared, including the electronic transactions, the account can be reconciled in the usual manner.

Making an adjustment
If you need to make an adjustment because an amount is different or you forgot to record a transaction, use the Add
Newbutton at the top of the window. This will open a menu where you can choose what you want to add. You can make an
adjustment by selecting General Journal Entry. You can add a new check by selecting Write Check or Account Register. You can
add a new receipt by selecting Receipt or Account Register.

Record a General Journal Entry
Enter a Write Check
Enter a Receipt
Use the Account Register
Finding transactions in the Account Reconciliation window
To search for a specific transaction in the Account Reconciliation, select the Find button. The search is completed in a separate
window.

How are void transactions treated in Account Reconciliation?
If you void a check in Sage 50, the original check will appear in the Checks and Bank Debits section of the Account
Reconciliation window. The void (reverse) transaction will appear in the Deposits and Bank Credits section.

Enter Beginning Transactions in Account Reconciliation
Beginning transactions provide a way to account for transactions made prior to starting Sage 50 that have not yet cleared the bank
(not appeared on the bank statement). They are primarily used to resolve unreconcilable differences during the first account
reconciliation.

1. From the Tasks menu, select Account Reconciliation . Sage 50 displays the Account Reconciliation window.
2. Enter or select the account you want to reconcile. To display a list of existing accounts, type ? in the G/L Account ID field, or
select the Lookup button.

3. Reconcile the account. How do I do this?
If you just started entering data in Sage 50, if this is your first reconciliation of this account, and if you have a nonzero
unreconciled difference, you may need to enter beginning transactions to resolve the reconciliation.
Beginning transactions should include each of the following criteria:
l

The outstanding transaction amount was originally entered as part of the general ledger account beginning balance.

l

The outstanding transaction is dated prior to the general ledger beginning-balance date.

l

The outstanding transaction has not cleared the bank as of this statement (the first statement you are attempting to reconcile in
Sage 50).

4. To enter beginning transactions, select the Beginning Transactions button at the bottom of the Account Reconciliation
window. Sage 50 displays the Beginning Transactions window.

5. Enter an amount, description, and reference for each outstanding transaction not listed the statement.
6. Enter the date when the outstanding transaction took place. The date must be in the current or previous accounting period.
Beginning transactions are typically dated prior to the general ledger beginning-balance date (usually just prior to the first day of
the first period when you are entering data in Sage 50).

7. When you are finished entering beginning transactions, select OK.
Each beginning transaction will appear in either the Checks and Credits or Deposits and Debits section and be added to the
Outstanding Checks or Deposits in Transit totals.

8. Do not select the Clear check box next to these items (since they were not listed on the bank statement). When you reconcile the
next monthly statement (the following period), select the Clear check box when the bank statement indicated that the
transactions have cleared.

Note: Beginning transactions are not posted to the General Ledger. They are used only when initially reconciling an account.
Once you have reconciled an account in two or more periods, the beginning transactions should be cleared.

9. When you have successfully reconciled the account (the unreconciled difference is zero), select OK to close the window.
Tip: If you are interrupted in the middle of reconciliation, select OK, and exit the window. Later, while still in the same
accounting period, you can resume where you left off. All your cleared items and other reconciliation information for the account
will remain. You can also change accounting periods to edit previous account reconciliations, if necessary.

What do you want to do next?
Reconcile an account (bank statement reconciliation)
l
Read the account reconciliation overview
l

Clear Transactions (Account Reconciliation)
The Account Reconciliation window lets you clear, for a chosen account, multiple transactions that meet certain criteria. After
clicking the Multiple button on the Account Reconciliation screen, do the following:

1. Use the Type drop-down list to select the type(s) of transactions you want to clear. You have these options:
l
All transactions (credits and debits)
l

Checks and Bank Debits

l

Deposits and Bank Credits

2. Now, to clear the transactions of the chosen type or types, select one of the option buttons at the left side of the window:
l
Reference Number: Use this to clear transactions by entering a range of reference numbers. In the From box, enter the
starting number in the range; in the To box, enter the ending number.
Date Range: Use this to clear transactions that fall within a range of dates. In the From box, enter the starting date, or select
it using the calendar button. In the To box, enter the ending date, or select it with the calendar button.
3. When you have entered your criteria, select OK.
l

Sage 50 clears the transactions that fall within the chosen range. You'll return to the Account Reconciliation window.

What do you want to do next?
l
Enter beginning transactions for first account reconciliation

Reconcile an Account (Bank Statement Reconciliation)
Sage 50 allows you to reconcile any account in your chart of accounts. Typically, you would reconcile bank accounts, cash accounts
(such as petty cash), and credit card accounts.

Important: If you are using the batch posting method, post your accounts to the General Ledger before you reconcile. This
ensures that you are using up-to-date information.

1. From the Tasks menu, select Account Reconciliation . Sage 50 displays the Account Reconciliation window.
2. Enter or select the account you want to reconcile. To display a list of existing accounts, type ? in the Account to Reconcile
field, or select the Lookup button.

3. Enter the closing date from the bank or credit card statement as the Statement Date.
4. Enter the Statement Ending Balance (the ending balance amount included on the bank statement) in the lower section of the
window.
Transactions that are available to be cleared are listed at the center of the window; you can use the Show drop-down arrow
button to select which transactions you would like to appear. For each transaction, reference information such as check numbers,
amounts, dates, and vendor/payees or descriptions are listed. By default, checks are sorted by check number. You can change
the sort order by clicking the heading of the column you want to sort by.

5. Enter interest income:
l

You may need to expand the lower section

where the Statement Ending Balance is located to see the Interest Income

fields.
l

In the Interest Income box, enter any interest earned by the account.

l

In the Date box, enter the date when the interest was earned.

l

In the Account box, enter or select the appropriate interest income account to act as offsetting account for the interest. Do not
choose the account you are reconciling.

When you select OK, this information will be saved as a general journal entry.
6. Enter service charges:
l

You may need to expand the lower section

where the Statement Ending Balance is located to see the Service Charges

fields.
l

In the Service Charges box, enter any charges incurred by the account.

l

In the Date box, enter the date when the charges were incurred.

l

In the Account box, enter or select the appropriate service charge account to act as the offsetting account for the charge.

When you select OK, this service charge information will be saved as a general journal entry.

7. Sage 50 Complete Accounting and higher only: The Imported Interest and Imported Charges fields indicate amounts
imported electronically into Sage 50 along with bank statements.
Check to see if these amounts are correct. Select the arrow button next to the field; the Imported Interest / Charges window will
list information about the imported item(s). If any items represent duplicate entries or bank errors, you can delete them in this
window.

8. Select the Clear check box next to each item that is included on the bank statement. You can also use the right-click menu or
Quick Action buttons that appear when you select a row; both give you additional options.
In addition, you can select the Clear button and then All to select all transactions as cleared. Or you can select the Multiple button
to choose a range of checks or deposits to clear. To unclear all transactions, select the Clear button and then None.
Sage 50 keeps track of how many transactions recorded in the general ledger are cleared, how many are not, and the associated
totals.
When all transactions listed on the bank statement are entered and cleared in Sage 50 and outstanding transactions have been
accounted for, the unreconciled difference should be zero (0.00). If not, check the bank statement to make sure that each
transaction listed is also entered in Sage 50. For example, a service charge listed on the statement may need to be entered in
Sage 50.

9. Sage 50 Complete Accounting and higher only: If the list of transactions includes bank records imported electronically, some
may not have been autocleared by Sage 50. These transactions will need to be manually matched to existing Sage 50 records
and cleared. How do I do this?

If any unmatched bank records represent duplicate entries or bank errors, delete them using the Banking toolbar button, rightclick menu, or Quick Action buttons.

10. If this is the first reconciliation for the selected account, you might have outstanding transactions not listed on the bank
statement that also do not appear in the Account Reconciliation window because these amounts were entered as a lump-sum
beginning balance in the general ledger. This may cause you to have an unreconciled difference. Select the Beginning
Transactions button to enter these outstanding transactions so that they can be reconciled.

11. Select the Add New button to enter adjusting journal entries, checks, or receipts that the bank statement included but which are
not included in Sage 50's general ledger.
To make an adjusting journal entry, select General Journal Entry. To enter a check. select Write Check or Account Register. To
enter a receipt, select Receipt or Account Register. Once the adjustment is entered and saved, you can close the transaction
window and return to Account Reconciliation.
For example, you may have a small discrepancy between the amount noted on a customer check and what the bank reports to
you as credit on this transaction; say the bank rounds off to $10 a check for $10.10. Rather than contact the bank to make the
change, losing more time and money than the discrepancy is worth, you'll probably want to make the adjustment using a general
journal entry instead.

12. If you added new items, select the Clear check box next to each of these items.
13. When you have successfully reconciled the account (the unreconciled difference is zero), select OK to close the window.
Tip: If you are interrupted during the middle of reconciling, select OK, and exit the window. Later, you can resume where you
left off. All your cleared items and other reconciliation information for the account will remain.

General Journal Entry
You use the General Journal to enter those types of transactions that are not readily categorized in the Tasks menu. Depreciation
would be an example of something that would be entered into the General Journal.
In General Journal Entry, you can also enter withdrawal and deposit adjustments you need to make during account reconciliation.
Sometimes adjustments must be made to account for errors, service charges, check charges, or unrecorded withdrawals or
deposits; such adjustments are necessary to help keep your bank account balanced. When you select the Add New button and then
choose General Journal Entry in Account Reconciliation , the General Journal Entry window opens so you can enter this adjustment
data.

Learn More
Recording General Journal entries
Unlike other screens in Sage 50, you provide all the accounting distributions in the General Journal. At other times, Sage 50
automatically distributes certain amounts, based on the default General Ledger accounts you set up in maintenance windows.
In the General Journal, you enter both debits and credits, and when the amounts balance, you can post the General Journal by
selecting the Save button if you're using the real-time posting method. If you are using the batch-posting method, select the
Save button; then use the Post option from the System selection of the Tasks menu. If you are using the SmartPosting
posting method, select the Save button; SmartPosting will automatically post the General Journal for you.

Record a General Journal entry
Making reversing General Journal entries
Reversing entries are made to the General Journal on a temporary basis. They're often used to reflect the expenses of a
business as shown on a monthly financial statement.

Enter a reversing General Journal entry
Is this an entry you make on a regular basis?
Sage 50 has different methods for handling General Journal entries that you make on a consistent basis. Memorized
transactions are like a template that you can quickly flesh out for specific transactions. They are not posted to the general
ledger. Recurring transactions are complete transactions you set up to happen on a set timetable—monthly, quarterly, yearly,
etc. An example would be if you have a contract with someone to provide a monthly service. You can also create a new journal
entry by copying an existing one.
Printing a General Journal entry
Select the Print button to print the journal entry that is shown on the General Journal Entry screen.

If you want to print multiple journal entries, such as all journal entries in a certain period or for a certain account, you can print
the General Journal report from Reports & Forms>General Ledger.

Record a General Journal Entry
The General Journal is used to enter those types of transactions that are not readily categorized in the Tasks menu. Typical General
Journal entries include chart of account beginning balances, depreciation, and account transfers.
Here, you also enter adjustments you need to make during Account Reconciliation . Such adjustments are necessary to account for
errors, service charges, check charges, or unrecorded withdrawals or deposits. When you select Add New, then General Journal
Entry in Account Reconciliation, the General Journal Entry window opens.
Unlike other screens in Sage 50, you provide all the accounting distributions in the General Journal. At other times, Sage 50
automatically distributes certain amounts, based on guidelines you set in Maintain menus.

1. From the Tasks menu, select General Journal Entry. Sage 50 displays the General Journal Entry window.
2. Enter or select the date of the transactions you want to enter.
Sage 50 defaults this date to the Sage 50 system date. If you are in an accounting period that is different from the system date,
then Sage 50 displays the first day of that period.
You can also select the List toolbar button to edit a General Journal entry in the current or alternate accounting period.

3. Select the Reverse check box to have the transaction automatically reversed the first day of the next accounting period.
Reversing means that debits become credits and credits become debits.

4. Enter a reference for the transaction up to 20 characters.
If you enter a number reference, Sage 50 will increase future General Journal entries by one while this window is open.

5. For each line enter or select an account ID. To display a list of existing accounts, type ? in the G/L Account ID field, or select
the Lookup button.

6. For each line enter an amount in either the Debit or Credit columns.
7. For each line enter a description for the transaction.
The description will appear in General Ledger and various reports.

8. If the transaction is associated with a job, enter or select a job ID. You can later apply the General Journal entry to a customer
invoice, if needed.

9. Once the Out of Balance field is zero (0.00), select Save to record the transaction in the General Journal.
What do you want to do next?
Enter a reversing General Journal entry

l

Create a Recurring General Journal Entry
Do you find yourself making some of the exact same journal entries on a regular basis, such as every month or every quarter? In
Sage 50, you can recur a journal entry so that it is automatically created for the time periods that you specify.
To do this:

1.
2.
3.
4.
5.
6.

Go to Tasks>General Journal Entry.
Enter the journal entry information.
Click the drop-down arrow next to the Copy button and select Create recurring.
Select how often you want to recur this journal entry.
Select the date for the first journal entry.
Select when you want to quit recurring the journal entry. You can choose to end on a certain date or when a certain number of
journal entries have been created.

7. Click OK. The journal entries will be created.

Enter a Reversing General Journal Entry
Reversing entries are commonly used to adjust G/L accounts temporarily or record estimates. When a General Journal entry is
selected to be reversed, Sage 50 automatically enters a second, reversing entry on the first day of the following accounting period,
negating the original adjustment.

Reversing entries are optional and relate to bookkeeping technique. Reversing entries are commonly used to show the expenses
incurred by a business as reflected on [a monthly] financial statement. For example, you may want to include payroll tax liabilities in
December but enter the paycheck itself in January.

Note:

You cannot access or edit the reversing entry that Sage 50 generates. However, the reversing entry is present in the
General Journal for the following period.

1. From the Tasks menu, select General Journal Entry. Sage 50 displays the General Journal Entry window.
2. Enter or select the date of the transactions you want to enter.
Sage 50 defaults this date to the Sage 50 system date. If you are in an accounting period that is different from the system date,
then Sage 50 displays the first day of that period.

3. Select the Reverse check box to have the transaction automatically reversed the first day of the next accounting period.
Reversing means that debits become credits and credits become debits.

4. Enter a reference for the transaction up to 20 characters.
5. For each line enter or select an account ID. To display a list of existing accounts, type ? in the G/L Account ID field, or select
the Lookup button.

6. For each line enter an amount in either the Debit or Credit columns.
7. For each line enter a description for the transaction.
The description will appear in general ledger and various reports.

8. If the transaction is associated with a job, enter or select a job ID. You can later apply the General Journal entry to a customer
invoice, if needed.

9. Once the Out of Balance field is zero (0.00), select Save to record the transaction in the General Journal.
Note: The Recur button is disabled for reversing transactions.

Maintain Budgets
In Sage 50 Premium Accounting and higher, you can maintain as many different budgets as needed. In Sage 50 Complete
Accounting and Sage 50 Pro Accounting, you can maintain a single budget, for up to four years of information (the two open years
and the year before and after).
The Maintain Budgets window lets you build a forecast of dollar amounts for selected accounts for each fiscal period. You can filter
the accounts you budget for by account type (income statement accounts, expenses, etc.). In Sage 50 Premium Accounting and
higher, you can also filter by account segment. In Sage 50 Complete Accounting and Sage 50 Pro Accounting, you can filter by
department mask.

How Do I Get There?
l

From the Maintain menu, select Budgets.

When you close the year in Sage 50, your budgets automatically "roll over." That is, a new budget is created for the current year,
based on the previous year's budget. You can then tweak the new budget as needed.
Learn More
Creating a new budget (Sage 50 Premium Accounting and higher only)
You can create a new budget from scratch, by copying an existing budget, or by using actual data.

Creating a budget from scratch
Creating a budget from actual data
Copying from an existing budget
Copying a budget to Excel
You can copy a budget to a Microsoft Excel worksheet (.xls). Simply open the budget in Maintain Budgets and click the Excel
button in the toolbar.
Formulas and most formatting are preserved. You can also copy and paste a range of cells between Sage 50 and Excel.

Copying a budget to Excel
Importing and exporting budget data
You can import and export budget data in a comma-separated format (.CSV) that can be read by spreadsheet programs or text

editors.

Filtering the accounts for this budget
Use the Account Filters to determine the accounts that display for your budget. You can filter by account type (income, expense,
etc.). You can also filter by account segment (Sage 50 Premium Accounting or above) or department mask (Sage 50
Complete Accounting or lower). Check the box to show Inactive accounts, or accounts scheduled to be purged at year-end.

Selecting , adjusting, and allocating budget data
When working with budgets, it's easy to copy and paste cells, adjust and round amounts, allocate amounts, or select rows,
columns, or cells.

Selecting and Copying/Pasting/Clearing Cells
l

Click on the cell in one corner of the range of cells with your left mouse, and drag to the opposite corner. The range you've
highlighted will be shaded.
-OR_

l

Click on the cell in one corner of the range of cells. Hold down the Shift key, and click on the opposite corner.

l

Use the Copy Quick Action Button, or right-click and select Cut, Copy, Paste, or Clear.

Adjusting/Rounding Budget Amounts
l
l

Once you've selected a group of cells, click the Adjust Quick Action Button, or right-click and select Adjust.
You can enter a dollar amount or percentage to adjust amounts by. You can also round the selected cells to the nearest dollar,
hundreds, or thousands.

Allocating Budget Amounts
l

You can easily allocate a total amount for an account across the whole year. Click on the Total cell for the account in the grid.
Right-click and choose Allocate Total Amount. Enter the total amount you want to allocate across the whole year. Click
OK.

Note: You can also select Allocate Total Amount from the Edit menu.
l

l

The amount is evenly distributed over all periods of the year for that account. For example, if you have 12 periods and the
total amount is $7500, the amount for each period will be $625.
If the amount cannot be evenly distributed, any rounding differences will be adjusted in the last period. For example, if you
have 12 periods and the total amount is $5000, the amount for periods 1 - 11 is $416.67 and the amount for period 12 is
$416.63.

Setting alerts for budgets
You can set up alerts to let you know when specific accounts are over or under budget, for the current period or year.

Troubleshooting budgets
If you create a budget using actual amounts for balance sheet accounts, beginning balance amounts may not come across. This
is because Sage 50 tracks activity for balance-sheet accounts, not balances.
To correct this, you could do one of two things:
l

Add the missing beginning balance into the first period of the first year of your budget.
-OR-

l

From an existing budget with a correct prior-year balance, use the Save As button to create a new budget. Then use the
AutoFill button to fill in your budget with actual amounts.

Add an Attachment
You can attach files, such as Word or Excel documents, to a budget.

Create a Budget - Copy an Existing Sage 50 Budget
This feature is available only in Sage 50 Premium Accounting and higher.

You can create a budget by copying an existing Sage 50 budget. Once you create the budget this way, you can always tweak any
amounts based on expectations for the current year.

1. Enter a Budget Name for the new budget. A budget name can be automatically created based on the description, provided this
option is checked in Maintain Global Options. The description is optional.

2. Select "Copy amounts from another Sage 50 budget" and click Next.
3. Select the existing budget you want to copy from.
4. Select the accounting periods to copy from and paste to; click Finish.

Create a Budget - Start with a Blank Budget
Steps 1 through 3 below are only available in Sage 50 Premium Accounting and higher.
While it is probably easier to start by copying from an existing budget or using actual data, you can start from scratch if necessary--if
you are just starting out on Sage 50, for example.

1. From the Maintain Budgets window, select the New button.
2. Enter a Budget Name and Description. A budget name can be automatically created based on the description, provided this option
is checked in Maintain Global Options. The description is optional.

3. Make sure "Start with a blank budget" is checked and click Finish.
4. Use the Account Filters to determine the accounts that display for your budget. You can also filter by account segment (Sage 50
Premium Accounting or above) or department mask (Sage 50 Complete Accounting or lower).
5. You can view and enter data for four fiscal years--the two currently open years, and the year before and after them.
6. After you've begun working with a budget, you can still use actual data or an existing budget to complete the budget, by using the
Autofill feature.

Create a Budget - Use Actual Amounts
This feature is available only in and higher.
You can create a budget using actual amounts from last year. Once you create the budget, you can always tweak these amounts
based on expectations for the current year.

1. Select the New button from the Maintain Budgets window.
2. Enter a Budget Name for the new budget. A budget name can be automatically created based on the description, provided this
option is checked in Maintain Global Options. The description is optional.

3. Select "Use actual amounts from Sage 50" and click Next.
4. Select the previous accounting periods to use to build the new budget.
5. Select the starting period for the new budget. The end period is determined by the range of periods selected in Step 4.
6. Click Finish.
Troubleshooting budgets from actual amounts
If you create a budget using actual amounts for balance sheet accounts, beginning balance amounts may not come across. This
is because Sage 50 tracks activity for balance-sheet accounts, not balances.
To correct this, you could do one of two things:
l

Add the missing beginning balance into the first period of the first year of your budget.
-OR-

l

From an existing budget with a correct prior-year balance, use the Save As button to create a new budget. Then use the
AutoFill button to fill in your budget with actual amounts.

Save Budget As
Use the Save As button to create a new version of an existing budget, that you can tweak by putting in actuals, projections, etc.
How Do I Get There?

l

From the Maintain menu, select Budgets.

l

Click the New button.

What do you want to do next?
Create a new budget from actual data
l
Create a new budget from an existing budget
l
Create a new budget from scratch
l

Edit a Budget
You can use actual amounts to fill in your budget, or copy from an existing or open budget.
Enter a budget name (up to 30 characters) and description (up to 50 characters).
You have up to three choices for creating a budget.

Use actual amounts
1. From an existing budget, select the Autofill button.
2. Select "Use actual amounts from Sage 50" and click Next.
3. Select the previous accounting periods to use to build the new budget.
4. Select the starting period for the new budget. The end period is determined by the range of periods selected in Step 4.
5. Click Finish.
Copy amounts from the open budget
1. From an existing budget, click the Autofill button.
2. Select "Copy amounts from the open budget" and click Next.
3. Select the year and accounting periods you want to copy from.
4. Select the starting period for where to paste these amounts. The end period is determined by how many periods were
selected in the previous step.

5. Select Finish.
Copy amounts from another budget(Sage 50 Premium Accounting and higher only)
1. From an existing budget, click the Autofill button.
2. Select "Copy amounts from another budget" and click Next.
3. Select the budget you want to copy from.
4. Select the year and accounting periods you want to copy from.
5. Select the starting period for where to paste these amounts. The end period is determined by how many periods were
selected in the previous step.

6. Select Finish.

Change Accounting Period (Window)
Accounting periods define segments of your fiscal year. Sage 50 permits you to operate within two open fiscal years. The Change
Accounting Period window serves two purposes. First, it informs you of your company's current fiscal year and payroll tax year
setup. Second, this window permits you to move to an alternate account period. Typically, you'll do this at the beginning of each new
accounting period.
To open the Change Account Period window, do one of the following:
From the Tasks menu, select System, then Change Accounting Period.
Click the Accounting Period button on the on the Button Control Bar at the top of the main Sage 50 window.

If the Change Accounting Period option is not available, then your user profile does not have security access to this area. Tell
me more about user security.

Open Accounting Periods: A list of accounting period numbers and dates for your company's two open fiscal years. Accounting
period dates are defined during the New Company Setup process and cannot be changed once they are set up. Most companies

operate with twelve accounting periods per fiscal year. To move to a new accounting period, select the period from the drop-down
list box. You can change this to any other period in the one or two fiscal years for which you have set accounting periods. How do I

change accounting periods?
You can create or edit transactions in a prior period without changing the Accounting Period. However, the transaction date cannot
be prior to the first period of the first open fiscal year.

Note: If you have security rights activated in Sage 50, a lock icon appears next to prior accounting periods. You can restrict users
from editing transactions in prior accounting periods by giving them View Only access to Transactions in Prior Periods. This
setting is made in the Selected Access window, under the Company/Tasks program area; choose Company in the menu at
left, and then find the Tasks subarea.
Current Accounting Period: Identifies the accounting period number and dates Sage 50 is currently operating in. If the current
system date is within the current accounting period date range, Sage 50 dates new transactions automatically based on your system
date.
It also displays the current dates for the first and second fiscal years as well as the first and second open payroll tax (calendar)
years.

Open Fiscal Years: Identifies the two open fiscal years in which you can enter new or edit old transactions. The first fiscal year is
typically referred to as the current year, the second is referred to as the next fiscal year. To change the dates, you must close a
fiscal year using the Year-End wizard.
Open Payroll Tax Years: Identifies the two open payroll (calendar) tax years used in payroll transactions and reports. To change
the dates, you must close a fiscal year using the Year-End wizard.
The toolbar at the top of the window contains the following buttons: OK, Cancel, and Help.

Note: If you are using the batch posting method, you must post all your transactions before Sage 50 will let you continue.
Tip: Print invoices and/or checks before you change the accounting period.
What do you want to do next?
Learn how to change accounting periods
l
Back up company data
l

Change Accounting Periods
Typically, you'll change accounting periods at the end of each period to move to the next.

Note: If operating on a network, all users must exit the Sage 50 company before changing accounting periods.
If you are in Batch mode, you must post all journal transactions before changing accounting periods. For both batch and Real-Time
modes, you should print invoices and/or checks before changing the accounting period.
You should always make a backup of your company data before changing accounting periods.

1. Do one of the following:
From the Tasks menu, select System, then Change Accounting Period.
Click the Accounting Period button on the on the Button Control Bar at the top of the main Sage 50 window.

If the Change Accounting Period option is not available, then your user profile does not have security access to this area.
Tell me more about user security.

2. Select the period from the drop-down list box. You can change this to any other period in the one or two open fiscal years for
which you have set accounting periods.

3. To begin changing accounting periods, select OK.
If Sage 50 determines that you have checks or invoices that need printing (checks or invoices that are dated in the current
accounting period exist without a reference number), you will be prompted to print them before changing the accounting period.
You are also prompted to print reports prior to changing accounting periods, which is recommended.
After printing is complete, Sage 50 checks for unposted transactions, then adjusts the accounting period date at the top of the
main Sage 50 window.

Banking Reports
Banking reports give you information on the status of your bank accounts.
l
l
l
l
l

Account Reconciliation
Account Register
Bank Deposit Report
Deposits in Transit
Outstanding Checks

What do you want to do next?
l
Display a report on the screen
l
Filter a report, form, or financial statement
l
Select data records to filter a report
l
Print a report or financial statement
l
Perform other report or form tasks

Account Reconciliation Report
The Account Reconciliation report lists the last bank reconciliation you've done. You have the choice of printing either a summary
report or a detail report that shows you outstanding transactions.

Options
Select the Options button--either from the Select a Report window or from the displayed report--to determine the data criteria for
the reports you want to see or print. For this report Sage 50 offers the following unique options:

GL Account ID: Select the G/L Account for which you would like to see the bank account information.
Columns
Select the Columns link to choose which data fields to include and where the columns break on your report. .
Fonts
Select the Fonts link to set the font styles for the heading and body of the report. You can also have the titles of the report show
special codes, such as the current period, today's date, an as-of date, and the company name. .

Account Register (Report)
The Account Register lists your transactions for the selected account by check, deposit, or other bank transaction, or all, as well as
by the transaction clear status.

Options
Select the Options button--either from the Select a Report window or the displayed report-- to determine the data criteria for the
reports you want to see or print. For this report Sage 50 offers the following unique options:
l
l
l

Cleared Status: You can elect to see all transactions or only those which have cleared or not cleared.
Transaction Type: Have the report list checks, deposits, other transactions, or all types.
GL Account ID: Select the G/L Account for which you would like to see the bank account information.

Columns
Select the Columns link to choose which data fields to include and where the columns break on your report. .
Fonts
Select the Fonts link to set the font styles for the heading and body of the report. You can also have the titles of the report show
special codes, such as the current period, today's date, an as-of date, and the company name. .

Bank Deposit Report
The Bank Deposit report groups together all deposits with the same deposit ticket ID. Sage 50 defaults the deposit ticket ID to the
deposit ticket date so that you can use this ID to match with the same date on your bank statement. The Bank Deposit report is
available in both summary and detail format.

Options
Select the Options button to determine the data criteria for the reports you want to see or print. For this report Sage 50 displays the
following filter options:
l

Date: You have the choice of All, Range, Today, This Period, and the week, month, period, quarter, and year to date. If you select
range, you can enter a beginning and ending date.

l
l
l

Sort by: You can sort by deposit ticket ID or date.
Summarize report: This shows totals for each deposit ticket rather than list each receipt associated with each deposit.
Select a filter: First, select a filter on the left. Then, define the options for that filter on the right. The options differ based on the
filter selected. .

l

GL Account ID: Select the G/L cash account for which you would like to see the bank account information.

Columns
Select the Columns link to choose which data fields to include and where the columns break on your report. .
Fonts
Select the Fonts link to set the font styles for the heading and body of the report. You can also have the titles of the report show
special codes, such as the current period, today's date, an as-of date, and the company name. .

Deposits in Transit Report
The Deposits in Transit report lists all outstanding deposits that have not cleared the bank.

Options
Select the Options button to determine the data criteria for the reports you want to see or print. For this report Sage 50 displays the
following filter options:
l
l
l

Dates: You can select to show this period or a selected period.
Sort by: You can sort by transaction number or transaction date.
Select a filter: First, select a filter on the left. Then, define the options for that filter on the right. The options differ based on the
filter selected.

l

GL Account ID: Select the G/L Account for which you would like to see the bank account information.

Columns
Select the Columns link to choose which data fields to include and where the columns break on your report. .

Fonts
Select the Fonts link to set the font styles for the heading and body of the report. You can also have the titles of the report show
special codes, such as the current period, today's date, an as-of date, and the company name. .

Outstanding Checks Report
The Outstanding Checks report lists any outstanding checks that have not cleared the bank.

Options
Select the Options button to determine the data criteria for the reports you want to see or print. For this report Sage 50 displays the
following filter options:

l

As of: You can select to show this period or a selected period.
Sort by: You can sort by transaction number or transaction date.

l

Select a filter: First, select a filter on the left. Then, define the options for that filter on the right. The options differ based on the

l

filter selected.
l

GL Account ID: Select the G/L Account for which you would like to see the bank account information.

Columns
Select the Columns link to choose which data fields to include and where the columns break on your report. .
Fonts

Select the Fonts link to set the font styles for the heading and body of the report. You can also have the titles of the report show
special codes, such as the current period, today's date, an as-of date, and the company name. .

Using Reports to Get Insights about my Business
How Do I: Reports, Forms, and Financial Statements
Basics
Print a report or financial statement from the Select a Report or Form window
l
Display a report on the screen
l
Display a financial statement on the screen
l
Filter a report, form, or financial statement
l
Select data records to filter a report
l
Search for information within a report or financial statement
l
Set up a displayed report or financial statement for printing
l
Print a displayed report or financial statement
l
Print a report to a file
l

l
l
l
l
l
l
l
l
l
l
l
l
l
l
l

E-mail a displayed report or financial statement
E-mail a report, report group, form or financial statement
Preview a form before printing it
Print a single form
Print and/or e-mail a batch of forms from the Select a Report or Form window
Print a batch of forms from a navigation aid
Select and view payroll tax forms
Drill down on transactions in displayed reports
Print a form from a task window
E-mail a form from a task window
Copy Sage 50 report data to a Microsoft Excel spreadsheet
Copy Sage 50 report data to the Windows Clipboard
Create a PDF version of a report or financial statement
Delete a report, report group, form or financial statement
Print a report group

Financial Statement Design
l
l

Design a financial statement
Copy a financial statement format from one company to another

Print a Report or Financial Statement
1. Open Sage 50 and your company.
2. From the Reports & Forms menu, select the Report area.
The Select a Report or Form window appears.

3. Select your report, then select the Print button.
4. Set any Filter options that you require.
5. Select OK to print.
The Print dialog appears.

6. Select OK to print the report or financial.

Tip: You can also select and then print a report/financial statement from the Sage 50 Business Status page (Sage 50 Complete
Accounting and Sage 50 Premium Accounting only).
What do you want to do next?
Filter a report, form, or financial statement
l
Display a report on the screen
l
Display a financial statement on the screen
l
Set up a displayed report or financial statement for printing
l
Print a displayed report or financial statement
l
Design a financial statement
l
Perform other report or form tasks
l

Display a Report on the Screen
1. From the Reports & Forms menu, select the type of report (Accounts Payable, Accounts Receivable, Financial Statements, and
so on) you want to appear on the screen.
Sage 50 displays the Select a Report or Form window with your report area selected. Click on a new report area to display a
different group of reports.

2. From the report list, scroll down to select the report you want to appear on the screen.
3. There are two methods for displaying a report on the screen:
Double-click the specific report in the report list. Sage 50 displays the report using the filter, fields, and font options
saved for the report.
or

Select the specific report. Then, select the Display button in the top of the Select a Report window. Sage 50 displays the
report on the screen.

4. To filter or sort the data on the report differently, select the Options button.
5. To set print properties (such as page size and orientation) before printing a report displayed on the screen, select the (Page)
Setup button.

6. To print a report displayed on the screen, select the Print button.
7. To add or remove fields on the report, select the Columns button.
8. When finished viewing the report, select Close to return to the Select a Report or Form window.

Display a Financial Statement on the Screen
1. From the Reports & Forms menu, select Financial Statements.
Sage 50 displays the Select a Report or Form window with the Financial Statements report area selected.

2. From the report list, scroll down to select a financial statement you want to appear on the screen.
3. There are two methods to displaying a financial statement on the screen:
Double-click the specific financial statement in the report list. The report Options window displays. Accept the default options by
clicking OK.
Select the specific report or financial statement. Then, select the Display button in the top of the Select a Report or Form
window.

4. To print a financial statement displayed on the screen, select the Print button.
5. To design a financial statement displayed on the screen, select the Design button.
6. To display alternate financial statement filter information, select the Options button. If you change the financial statement
options, you will be prompted to save the new report when closing the report window.

7. When finished viewing the financial statement, select Close to return to the Select a Report or Form window.

Filter a Report, Form, or Financial Statement

When you select a report, form, or financial statement, you will be able to filter the document by choosing the range of data to print
or view on a report or the range of forms to print. The filter options are different depending on whether you select a report, form, or
financial statement.

Filter a Report or Financial Statement
When you select a report, you can change the Filter or Sort options in the Options window.

1. From the Reports & Forms menu, select the type of report (Accounts Payable, Accounts Receivable, Financial Statements, and
so on) you want to display or print.
Sage 50 displays the Select a Report or Form window with your report area selected. Selecting a new report area displays a
different list of reports.

2. From the report list, scroll down to select a report, form, or financial statement you want to display or print. Click once to select or
highlight a report name.

3. Select the Options button in the top of the Select a Report or Form window.
Sage 50 displays the Options window. The options are different for a report versus a financial statement.

4. Select OK to display or print the report or financial statement.
Filter a Form
1. From the Reports & Forms menu, select Forms, then select the type of form that you want to use.
Sage 50 displays the Select a Report or Form window with the type of form you selected shown in the Forms list.
There are many types of forms. You can select a different Form Type to see other forms in the list.

2. From the Forms list, select the form you want to use and click the Preview and Print button which is located below the sample
form.

3. The filter window opens for the form that you have selected.
For assistance on working with each of the different form filters, select the Help button or press F1 when you are on the form
filter screen.

4. Select Print/E-mail to print or e-mail the forms after making your filter selections.
Select Print Preview if you want to preview the forms before printing them.

Select Data Records to Filter a Report
The Options window in Reports lets you filter the data that appears on the report. For example, you can limit a report to a range of
customers.

All/Range
When you choose your filter on the left, you get a different set of options on the right.

For some records you can choose to display all records or a range of records. If you choose the Range option, the From and To
boxes become available. The From box reads First Record, and the To box reads Last Record. In these boxes you can either enter
the desired range or use the drop-down buttons to select the range. If you select only a From record,
then the range will go to the last item in the list. If you select only a To record, all records from the beginning of the file up to and
including the chosen To record will be displayed.

One or More
For some filter types, the All/Range filter option includes a One or More option. This allows you to select multiple contiguous or
non-contiguous data records to appear on the report. For example, in the illustration below One or More has been chosen as the
type for the Customer ID field.

Just click with your mouse in the box beside those records you want to include on your report.

All/Equal To
Some filter types have an All or Equal To option. You can either include all entries that fit the filter type, or select a specific entry.

For example, if you select Accounts Payable Account ID as the filter, selecting All would include all general ledger accounts with an
Account Type of Accounts Payable. Selecting Equal To lets you specify a single Accounts Payable account.

Find on Report
Use this window to search for text within a report or financial statement.

1. With a report or financial statement displayed, select the Find button.
Sage 50 displays the Find on Report window.

2. In the Find what text box, enter the text you want to locate.
Note: Sage 50 stores the last 20 values you entered in the Find what text box. You can choose one of your previously entered
values by selecting it from the drop-down list. The list is stored until you close Sage 50.

3. Select the Search forward or Search backward option.
4. If you want your search to be case sensitive, select the Match case check box. Sage 50 will search only for text that matches
the case of whatever you enter in the Find what text box. For example, if you enter "SMITH" in all capital letters and select
Match case, Sage 50 will search for any occurrence of "SMITH" in all capital letters. It will not search for "smith" or "Smith."
5. Select the Use wildcards check box if you'd like to use wildcards in your search. For more information, see the topic about
wildcards in the Learn More section below.

6. If you want to search for a complete word, select the Find complete words only check box. For example, if you have this
option selected and you enter "age" in the Find what text box, only the word "age" will be located-- not "Sage" or "aged."
7. Click the Find Next button to start your search.
Sage 50 will locate and highlight the first instance of text that matches what you entered in the Find what text box.
8. To find additional text, click the Find Next button.
9. When finished, click the Cancel button to close the Find on Report window.
Learn More
Would you like to learn more about using wildcard characters?
In your search you can use two wildcard characters: ? and *.
l

Use the ? wildcard character to find text that contains any single character in the position taken by the wildcard. For example,
typing in SM?TH would find both SMITH and SMYTH.

l

Use the * wildcard to find a string of characters. For example, typing in account* would find accounts, accounting, and
accountant.

Learn about various ways to print or send a displayed report or financial statement
When a report or financial statement is displayed on the screen you can print it, e-mail it, create a PDF of the report, or copy it to
a Microsoft Excel spreadsheet. Click the appropriate topic below for more information.

Send a report or financial statement to the printer
E-mail a displayed report or financial statement
Create a PDF of the displayed report or financial statement
Copy a report or financial statement to a Microsoft Excel spreadsheet
Why is there a blue box surrounding a transaction on the report or financial statement?
When certain reports or financial statements are displayed, you may notice a thin blue rectangle surrounding a line that contains
a transaction. When you move your cursor over the transaction line, the cursor changes from an arrow into a magnifying glass
with a "Z" in the center. This is referred to as the "drill down" feature.
You can click these transactions to drill down to the task window that includes the original transaction information. From financial
statements, you can drill down to the General Ledger report, where you can drill down to original transaction detail. How do I do

this?
How can I customize or design a report or financial statement?
For reports, you can click and drag the blue lines around the column titles to change the column width. For financial statements,
you can click the Design button when a financial statement is displayed and customize the information to fit your specific needs.
For more information, click the appropriate topic below.

Design a financial statement

Set Up a Displayed Report or Financial Statement for Printing
When a report or financial statement is displayed on the screen, you can choose Page Setup options that determine how the report
or statement will print.

1. With the report or statement displayed on the screen, select the (Page) Setup button.
The Page Setup window appears.

2. To choose the printer you want to use, select the Printer button.
The second Page Setup window appears.

3. Do one of the following:
l
In the Name field, use the drop-down list to select the correct printer.
l
If you are working on a network and need to find a printer there, select the Network button; then use the
Connect to Network window to find and select the printer you want.

4. If you need to set special print properties, such as printing on two sides of the paper, select the Properties button; then
make your selections in the Document Properties window.

5. Once you have chosen the printer and any needed document properties, select OK to return to the first Page Setup window.
6. In the Size field, use the drop-down list to select the size of the paper the report will print on—for example, letter, legal, A4.
7. In the Source field, use the drop-down list to select the place in your printer where the paper is located—for example, upper
paper tray, lower paper tray, manual form feed.

8. Select the option button corresponding to the orientation of your paper. That is, choose whether the top of the report should be
printed along the short edge (portrait) or long edge (landscape) of the paper.

9. When finished, select OK.
Your report or statement should now print as desired.

Print a Displayed Report or Financial Statement
You can print a report or financial statement whenever it is displayed on the screen.

1. With the report or statement either displayed on the screen or highlighed on the Select a Report window, select the Print button.
The standard Windows Print dialog appears.

2. If you need to print to an alternate printer, use the drop-down list in the Name field to select the printer.
Sage 50 prints using the current default printer unless the report was previously customized to use a specific printer. If you need
to use an alternate printer, select it from the drop-down list. These are printers set up in the Windows Control Panel.

3. Select the number of copies you would like to print and a page range if needed.
4. If you need to change the page orientation or choose special document properties, such as printing on two sides of the paper,
select Properties.
5. When finished making selections, if any, select OK to return to the Print dialog.
6. Select OK to print.
7. The report or statement begins to print.

Print a Report to a File
If you have set up the proper printer driver for your system, you can print a report or a group of reports to a file, which you can then
import into another program. Once the report is printed to file, you can open the report using any word processor. To print to a file,
follow these steps:

1. Open Sage 50 and your company.
2. From the Reports & Forms menu, select the Report area.
The Select a Report or Form window appears.

3. Select your report, then select the Print button.
4. Make sure the Generic/Text-Only printer is selected.
5. Select OK to print.
The Print dialog appears.

6. Select OK again.
7. The Print To File window appears asking for a file name.
Enter a filename for the report and select OK.
The default location of reports printed to a file is in the company data directory.
When finished, you can open the file using any word processor. Formatting may have to be reapplied.

E-Mail a Displayed Report or Financial Statement
You can e-mail a report or financial statement to a customer whenever it is displayed on the screen.

Note: In order to e-mail reports/statements from Sage 50, you must have a default MAPI-compliant e-mail application installed
on your computer. Also, you need to set up e-mail delivery options. You set up e-mail delivery options for customers on the Sales
Info tab of the Maintain Customers/Prospects window.

Important Note: AOL is not a fully MAPI-compliant e-mail application. If your default e-mail system is AOL, you will not be able
to e-mail reports/statements from Sage 50.

1. With the report or statement displayed on the screen, select the E-mail button.
Your e-mail application opens (if it is not already open), and Sage 50 opens and populates an e-mail message, adding a subject
line featuring the company name and the name of the report/statement you want to send. The body of the message will repeat
this information, as well as include the date when the report/statement was generated. The document itself will be attached to the
e-mail message in PDF format.

2. If desired, make changes to the subject line, body text, or both.
3. To e-mail the report or statement, select your e-mail application's Send (or equivalent) button.

E-mail a Report, Report Group, or Financial Statement
You can e-mail a report, report group, or financial statement to a customer directly from the Select a Report or Form window.

Note: In order to e-mail reports/statements from Sage 50, you must have a default MAPI-compliant e-mail application installed
on your computer. Also, you need to set up e-mail delivery options. You set up e-mail delivery options for customers on the Sales
Info tab of the Maintain Customers/Prospects window.

Important Note: AOL is not a fully MAPI-compliant e-mail application. If your default e-mail system is AOL, you will not be able
to e-mail reports/statements from Sage 50.

1. Open Sage 50 and your company.
2. From the Reports & Forms menu, select a report area.
The Select a Report or Form window appears.

3. Select your report, report group, or statement; then select the Send To button.
4. Select E-mail from the Send To drop-down list.
A report options window appears.

5. Set your report options and then select OK.
Your e-mail application opens (if it is not already open), and Sage 50 opens and populates an e-mail message, adding a subject
line featuring the company name and the name of the report, report group, or statement you want to send. The body of the e-mail
message will repeat this information, as well as include the date when the document was generated. The document itself will be
attached to the e-mail message in format.

6. If desired, make changes to the subject line, body text, or both.
7. To e-mail the report, report group, or statement, select your e-mail application's Send (or equivalent) button.
Note: If you are e-mailing a report group and your company has users and passwords set up to restrict access to certain areas
of Sage 50, the reports included in the report group which you do not have access to will not be e-mailed.

Preview Forms Before Printing Them
To see what a form will look like when it prints, select the Preview button or the Print Preview menu selection in various task and
design windows.
l

l

l

You can preview forms from all of the task windows that have an associated form— Quotes, Sales Orders, Sales/Invoicing,
Receive Money, Select for Purchase Orders, Purchase Orders, Select for Payment, Payments, and Write Checks, Select
Employees to Pay, and Select for Payroll Entry.
You can preview forms from the Select a Report or Form window, using the Filter screen to establish which form(s) you want to
preview.
You can also preview forms from the Forms Design window, to see the layout of the form. Placeholder text or field names serve as
placeholders where actual data will go.

Previewing Forms from Task Windows
1. From a task window, with valid data displayed, click the Print drop-down button. Select the Preview button or the Print Preview
menu option depending on which task screen you are using.

2. In most cases, you need to select the type of form you want to print. (For example, for credit memos you can select a plain credit
memo or a plain credit memo with no graphic.)

3. In many cases, enter the starting form number (for example, check number or invoice number).
4. In certain cases, you may need to specify the Last Check Date (the last date for which you want to print checks) or the cash
account.

5. View the form. You can magnify the form (zoom in) or print from this window. When multiple forms are present (Select for
Payment, Select for Payroll Entry), you can view the next form or the previous form.
For more information, see Print Preview.

Previewing Forms from the Select a Report or Form window
1. From the Reports & Forms menu, select Forms and then select the type of form you want to preview.
2. In the Select a Report or Form window, highlight the form in the Forms list, and select the Preview and Print button.
3. Select the Filter options for the form(s) you want to preview.
4. Select the Print Preview button.
Previewing Forms from Forms Design
With the form displayed in the Forms Design window, select the Print button and then select Preview.

Print a Single Form
There are different methods for printing forms:
l

You can print a batch of forms from the Select a Report or Form window.

l

You can print a batch of forms from a navigation aid.

l

You can print a batch of forms from some task windows.

l

You can print an individual form from a task or maintenance window.

The method below describes how to print an individual form from various Sage 50 task or maintenance windows.

1. Depending on the type of form you want to print, open and display the transaction in its corresponding window.
l
To print a new transaction's form, open and display the corresponding task window, then enter the new transaction
information.
l

To display a previously entered transaction , you can select the Open or List toolbar button in its respective task window
to search and display the transaction. You can also double-click the transaction in a displayed report to display the transaction
in its corresponding task window.

Drill down on transactions in displayed reports
2. With the transaction displayed, select the Print button to print the transaction's corresponding form.
The Print\Preview Forms window appears. It displays the number of the next form to print.
l

l

If you have not entered a form number (for example, an invoice or check number) for the transaction, Sage 50 will use the next
sequential form number based on the last form printed. You can change this number unless the form is a sales order, in which
case you won't be able to change the number.
If you have entered the form number in the task window, or if you are working with a preexisting form that already has a form
number assigned to it, then Sage 50 will use this number; you will not be able to change it.

3. To choose a form to print, select the Select Form button.
The Form Selector window appears, letting you choose from a list of available forms.

Note: Once you have printed a form for the first time, the Use this form field will display the name of the last form type
printed—for example, Invoice Continuous.
4. To change printers or print properties, select the Printer Setup button.
5. To redesign the form, select Form Design .
The Forms Design window appears.

6. To print a sample form using placeholder text instead of actual data, select Print Sample. This allows you to verify the
alignment of the form before you print the actual form.

7. To print an actual copy of the form, select Print.
After the form is printed, the transaction is posted (or saved). Then, Sage 50 displays a blank task window.

Print and/or E-Mail a Batch of Forms from the "Select a Report or Form" window
There are two methods for printing or e-mailing forms. You can print or e-mail an individual form from various task windows. The
method below describes how to print or e-mail a batch of forms from the Select a Report or Form window.

Note: You can also print a batch of forms from any of the navigation aids (Sales and Purchasessuch as Sales, Purchases, or
Payroll) that permit form printing. How do I do this?
However, you cannotprint receipts in a batch. Instead, you will have to print them one at a time from the Receive Money window.
For more information, see Print a Receipt.

1. From the Reports & Forms menu, select Forms and then the type of form (Invoices and Packing Slips, Checks, Credit Memos)
you want to print.
Sage 50 displays the Select a Report or Form window with the form type selected. The Forms list displays forms pertaining to the
respective form type selected.
There are many form types. You can switch among them at any time in this window. Selecting a new form type displays a
different list of forms.

2. Select the desired form in the Forms list; then select the Preview and Print button located below the sample image on the

Select a Report or Form window.

3. The form Preview and Print filter window appears. Enter your filter selections, then select Print/E-mail.
l
For assistance on each form filter, select the Help button or press F1 when the Options window is displayed.
l
For information about the E-mail Options tab—which lets you set up print/e-mail options for forms you generally send to
customers or vendors—click here .
In the Preview and Print window, you also have the opportunity of aligning the form on the Print Setup tab.

4. Sage 50 displays the Print dialog indicating the current default printer setting. To change the printer selection, use the drop-down
list in the Name field. Otherwise, select OK to begin printing the forms based on your filter selection.
If the transaction does not have a reference number assigned (for example, an invoice number or check number), then the
transaction will be assigned the next available reference number before printing. If the transaction already has a reference
number assigned, the form will print with the word "Duplicate" included. In the case of duplicate checks, "Void" will print in the
signature area.

5. After the forms finish printing, Sage 50 prompts with a print and/or e-mail confirmation message. If the forms printed and/or emailed properly, select Yes to save the transactions.

Print a Batch of Forms from a Displayed Navigation Center
There are two methods to printing forms. You can print an individual form from various task windows. You can also print a batch of
forms from either the Select a Report or Form window or any of the Navigation Centers available from the Navigation Bar (such as
Customers & Sales or Vendors & Purchases) that permit form printing.

1. From the desired Navigation Center, select the form you want to print. For example, from the Customers & Sales Navigation
Center, you might go to the Customers & Sales Tasks section, select Sales Invoices, and then Print Invoices.

Sage 50 displays the Select a Report or Form window with the related form type selected and the appropriate forms shown in the
Forms list. (For example, in the case of invoices, the Invoices and Packing Slips form type would be selected and the
available invoice and packing slip forms would be shown in the Forms list.)

2. From the Forms list, select the desired form—for example, Invoice w/Freight; then select the Preview and Print button
located below the sample image on the Select a Report or Form window.

3. The form Preview and Print options window appears. Enter any necessary information, then select Print/E-mail.
For assistance on each form filter, select the Help button or press F1 when the Preview and Print options window is displayed.
Note: In the Preview and Print options window, you also have the opportunity to aligning the form. Select the Align button on
the Page Setup tab; the Align Form with Printer window appears. Here, you can tell Sage 50 how to move objects on the form so
they'll align with the printer.

4. Sage 50 displays the Print dialog indicating the current default printer setting. To change the printer selection, use the drop-down
list in the Name field. Otherwise, select OK to begin printing the forms based on your filter selection.
If the transaction does not have a reference number assigned (for example, an invoice number or check number), then the
transaction will be assigned the next available reference number before printing. If the transaction already has a reference
number assigned, the form will print with the word "Duplicate" included. In the case of duplicate checks, "Void" will print in the
signature area.

5. After the forms finish printing, Sage 50 prompts a print confirmation message. If the forms printed properly, select Yes to save
the transactions.

Select and View Payroll Tax Forms
The Payroll Tax Form Selector window lets you print federal and state tax forms on plain paper (cannot print on dot-matrix printers).
These Print-n-Sign forms will make your life easier come tax-filing time. The instructions below tell you how to select tax forms for
viewing, editing, and/or printing.

How do I get to the Payroll Tax Form Selector?
To open the Selector window, do the following:

1. On the Sage 50Reports & Forms menu, select Forms, then Tax Forms.
2. In the Forms List, double-click Payroll Tax Forms.
Choose form and filing period
1. Use the option buttons to select the appropriate form: Federal, State, or Existing Form.
l
If you choose Federal, the available ones appear in the Available Forms box. Select the desired form in the list.
Proceed to step 2 below.
l

l

If you choose State, you must first use the drop-down list to select the appropriate state; the available state forms appear
in the Available Forms box. Select the desired form in the list. Proceed to step 2 below.
If you've already worked on and saved a payroll tax form or forms, select Existing Form, and click OK.
The Open Report window appears. Here, you can select the report or report you want to view onscreen. Skip the remaining
steps below.

2. In the Select filing period group box, use the Frequency drop-down list to choose the appropriate period covered by the
filing. You have the following choices:
l

Yearly—Select the appropriate year from the Year drop-down list. Available choices will depend on your open payroll tax
years.

l

Quarterly—A Quarter drop-down list will be available. Select the appropriate quarter (1st, 2nd, 3rd, 4th) that you want
the form to cover.

l

Monthly—A Month drop-down list will be available. Select appropriate month (January through December) that you want
the form to cover.

l

Daily—A Date drop-down list will be available. Drop down the list, and a calendar appears; the current date is circled in
red. Navigate through the calendar, and select the appropriate date you want the form to cover.

l

Date Range—Start Date and End Date drop-down lists will be available. Drop down the list, and a calendar appears;
navigate through the calendar, and select the appropriate starting and ending dates for the date range you want the form
to cover.

If this is a W-2, choose employees covered
If you chose Federal Form W-2, in the Select employees for W-2s group box, use the Type drop-down list to choose the
number of employees you want to file for:
l
l

l

All—Select this if you want to file W-2s for all employees of the company.
Range—Select this if you want to specify a range of employees. From and To drop-down lists will be available; use them to specify
the range of employees.
Equal to—Select this if you want to specify a single employee. Then use the From drop-down list to choose the appropriate one.

Click OK to open the Form Viewer
Once you've made all selections, click OK. A special form viewer will appear displaying the chosen tax form on the computer
screen. For directions on working in the viewer, use the Help menu.

Drill Down on Transactions in Displayed Reports
You can display and edit transaction detail in certain reports. Double-clicking a transaction listed in a report displays the original
transaction in its respective task window. This is called "drilling down." You can modify the transaction (if allowed), save or post the
new transaction, and return to the report window. This feature is quite useful if you need to display or edit detail for a filtered group
of transactions.

1. Display a report on the screen. How do I do this?
Only certain reports that display transactions (journal entries) have drill-down functionality.

2. Move your mouse pointer over the list of transactions. You'll notice a box around the lines containing transactions.
When you move the cursor over transaction lines, Sage 50 displays the box, and the cursor changes from an arrow into a
magnifying glass with a "Z" in the center.

3. Double-clicking a transaction with the magnifying glass displays the original transaction in its respective task window. You can
choose to view or modify the transaction here.

4. If you edit the transaction, select Save. Then, close the task window.
When you close the respective task window, Sage 50 displays the Report window once again.

Note: If you modified the transaction you drilled down to, the report is updated for you.
5. Select another transaction to drill down in the displayed report or close the report window.

Print a Single Form from a Task or Maintenance Window
How Do I...
You can print forms directly from the following windows:

l

Quotes

l

Sales Orders

l

Proposals
Sales/Invoicing

l

Credit Memos

l

Receive Money (Receipts)

l

Select for Deposit

l

l

Select for Purchase Orders
Purchase Orders
Payments
Select for Payment
Write Checks
Payroll Entry and Select Employees to Pay

l

Change Orders

l
l
l
l
l

Follow these steps:

1. With the transaction you want to print (such as an invoice or payment) displayed in the window, select the Print button.
The Print\Preview Forms window appears. It displays the number of the next form to print.
l

l

l

If you have not entered a form number (for example, an invoice or check number) for the transaction, Sage 50 will use the next
sequential form number based on the last form printed. You can change this number unless the form is a sales order, in which
case you won't be able to change the number.
If you have entered the form number in the task window, or if you are working with a preexisting form that already has a form
number assigned to it, then Sage 50 will use this number; you will not be able to change it.
If you are printing Quotes, Sales Orders, Proposals, Invoices, Credit Memos, Receipts, Purchase Orders, or Payments from a
task window, you can change how items are identified on these form. From the Replace Item ID with field select either
Item ID, UPC/SKU, or Part Number.

2. To choose a form to print, select the Select Form button.
The Form Selector window appears, letting you choose from a list of available forms.

Note: Once you have printed a form for the first time, the Use this form field will display the name of the last form type
printed—for example, Invoice Continuous.
3. To change printers or print properties, select the Printer Setup button.
4. To redesign the form, select Form Design .
The Forms Design window appears.

5. To print a sample form using placeholder text instead of actual data, select Print Sample. This allows you to verify the
alignment of the form before you print the actual form.

6. To print an actual copy of the form, select Print.

E-Mail a Form from a Task or Maintenance Window
How Do I...
You can e-mail forms to customers from the following task or maintenance windows:
l

Quotes

l

Sales Orders

l

Proposals
Sales/Invoicing

l

Credit Memos

l

Receive Money (Receipts)

l

Change Orders

l

You can e-mail forms to vendors from the following task windows:

l
l

Select for Purchase Orders
Purchase Orders
Note: In order to e-mail forms to your customers or vendors from Sage 50, you must have a default MAPI-compliant e-mail
application installed on your computer. Also, you need to set up e-mail delivery options for them. You set up e-mail delivery
options for customers on the Sales Info tab of the Maintain Customers/Prospects window. You set up delivery options for vendors
on the Purchase Info tab of the Maintain Vendors window.

Important Note: AOL is not a fully MAPI-compliant e-mail application. If your default e-mail system is AOL, you will not be able
to e-mail forms from Sage 50.
Follow these steps to e-mail forms from task windows:

1. With the transaction you want to e-mail (such as an invoice or purchase order) displayed in the window, select the E-mail button.
The Print\Preview E-Mail Forms window appears. It displays the number of the next form to e-mail.
l

l

If you have not entered a form number (for example, an invoice or check number) for the transaction, Sage 50 will use the next
sequential form number based on the last form printed or e-mailed. You can change this number unless the form is a sales
order, in which case you won't be able to change the number.
If you have entered the form number in the task window, or if you are working with a preexisting form that already has a form
number assigned to it, then Sage 50 will use this number; you will not be able to change it.

2. To choose a form to e-mail, select the Select Form button.
The Form Selector window appears, letting you choose from a list of available forms.

Note: Once you have e-mailed a form for the first time, the Use this form field will display the name of the last form type emailed—for example, A/R Invoice - Plain Paper.
3. To redesign the form, select Form Design .
The Forms Design window appears.

4. To e-mail a copy of the form, select Send.

Copy Sage 50 Report Data to a Microsoft Excel Spreadsheet
Use this procedure to copy data from a Sage 50 report or financial statement to a Microsoft Excel spreadsheet.

Note: You must have Microsoft Excel 2003 or a subsequent version installed on your computer for this procedure to work
properly. Copying to Excel may work with earlier versions of Microsoft Excel (for example, Excel 2000), but this ability is not
specifically supported by Sage 50.
For more information on using Excel, refer to Microsoft Excel Help.

1. Do one of the following:
In the Select a Report or Form window, select the report or financial statement that you want to copy from the list, and then
click the Excel toolbar button at the top of the window.
Get detailed instructions on selecting a report.
Display the report or financial statement that you want to copy on the screen, then click the Excel toolbar button.

Get detailed instructions on displaying a report.
The Copy Report to Excel window appears.

2. Select the desired File option :
l
Create a new Microsoft Excel workbook: Select this option to create a new file.
Add a new worksheet to an existing Microsoft workbook: Select this option to append an existing file. Click the
Browse button to choose the desired Microsoft Excel file.
3. Check or uncheck the Excel options check boxes as desired:
l
Use freeze panes (headers and labels are visible): Check the check box if you want the column titles in your Sage 50
report to be treated as freeze panes in the Excel worksheet. When you use freeze panes, the elements within these panes
l

remain visible whenever you scroll up or down in the worksheet.

l

Enable automatic column filtering (Auto-filter): Check the check box if you want to be able to AutoFilter columns of
data in the Excel worksheet. AutoFilter arrows will appear in columns that can be filtered to display a range of data. For
example, if you enable AutoFiltering for the Aged Receivables report, in the Excel worksheet you'll be able to filter the report by
customer ID.

Note: The Enable automatic column filtering option will be available only when you select the Raw data layout option.
4. Select the desired Report header option :
l
Send header to Page Setup in Excel: Select this option if you want the Sage 50 report header information to appear on
the Header/Footer tab of the Excel Page Setup window but not appear in the onscreen version of the worksheet. On the
Header/Footer tab, you can use the Custom Header option to customize the header, if desired, before printing the
worksheet. The header will appear on the printed version of the worksheet. Note that all column header information (column
titles) will be exported to and appear on the Excel worksheet.
l

Show header in Excel worksheet: Select this option if you want the report header to appear in the onscreen version of
the worksheet but not be available for customizing in the Excel Page Setup window. You'll be able to edit the header right on the
worksheet, if desired, before printing. Note that all column header information (column titles) will be exported to and appear
on the Excel worksheet.

Note: These options will not be available if you've chosen to hide the header (title) information on the Sage 50 report.
5. Select the desired Report layout option (Sage 50 Complete Accounting and higher only):
l
Sage 50 report layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows
formatted as in the original Sage 50 report.
l

Raw data layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows unformatted
regardless of the formatting in the original Sage 50 report.

Note: If you select Raw data layout, the Enable automatic column filtering option will be available.
6. When finished making selections, click OK.
Sage 50 will start the Microsoft Excel program, then copy the Sage 50 report data into a blank worksheet. The worksheet name
will be the same as the Sage 50 report name.
To add Microsoft Excel data into Sage 50, use the Import facility.

What do you want to do next?
Copy Sage 50 report data to the Windows Clipboard
l
Print a report or financial statement
l
Perform other report or form tasks
l
Read the Microsoft Office compatibility overview
l

Copy Sage 50 Report Data to the Windows Clipboard
You can copy a displayed Sage 50 report or financial statement to the Windows Clipboard. You can then paste the report data into
other applications, such as a spreadsheet or word-processing program.

1.
2.
3.
4.

With the report displayed, select the Edit menu from the Sage 50 main menu.
Select the Copy option.
Open the other Windows application, and position the cursor or arrow at the proper location.
Select the Paste option.

Note: If you hide title information when displaying a report, the title information will still be copied to the clipboard. Report title
information includes your company name, the date, and filter criteria.

Create a PDF Version of a Report or Financial Statement
Sometimes you will want to create and store an Adobe PDF version of a Sage 50 report or financial statement. The advantage of the
PDF version is that you can easily attach it to an e-mail message for delivery to a customer, and the report will appear exactly as it
does when you display or print it in Sage 50, with all formatting (including page breaks) intact.

To create a PDF from the Select a Report or Form window:

1. Open Sage 50 and your company.
2. From the Reports & Forms menu, select the Report area.
The Select a Report or Form window appears.

3. Select your report or statement.
4. Click the Send To button; then select PDF.
The appropriate Options window appears, letting you choose filter options that determine how the document will appear. Tell me
more about filtering reports and statements.

5. When filter options are set as desired, select OK.
The standard Windows Save As dialog appears.

6. By default, the PDF version will be saved in your company directory. To change the default, use the drop-down list in the Save in
field to find and select a new location for storing the file.

7. Again by default, the PDF version will be saved under the name of the original report/financial statement,
with the day's date appended, and a .pdf extension (for example, Customer Ledgers 03232011.pdf). To change the default, use
the drop-down list in the File name field to select a different name for the PDF file. OR type in a new name of your own choosing.
8. Now, to save the report or statement in PDF format, select Save.
To create a PDF with a report/financial statement in display or design mode:
1. With the report or statement either displayed on the screen or in design mode, select the PDF button.
The standard Windows Save As dialog appears.

2. By default, the PDF version will be saved in your company's Reports directory. To change the default, use the drop-down list in
the Save in field to find and select a new location for storing the file.
3. Again by default, the PDF version will be saved under the name of the original report/financial statement but with a .pdf extension
(for example, Customer Ledgers.pdf). To change the default, use the drop-down list in the File name field to select a different
name for the PDF file. OR type in a new name of your own choosing.

4. Now, to save the report or statement in PDF format, select Save.

Delete a Report, Report Group, Form or Financial Statement
You can only delete a customized report or financial statement that you have saved with a new name. You cannot delete the
standard reports that ship with Sage 50.
This icon indicates that the report, statement, or form has been customized.
This is a report group. All report groups are customized.

Delete a Report, Report Group or Financial Statement
1. From the Reports & Forms menu, select the type of report (Accounts Payable, Accounts Receivable, Financial Statements, and
so on) you want to appear on the screen.
Sage 50 displays the Select a Report or Form window with your report area selected. The report list displays reports or financial
statements pertaining to the respective report area selected.
There are several report areas. You can switch among them at any time in this window. Selecting a new report area displays a
different list of reports.

2. From the report list, scroll down to select a report or financial statement you want to delete.
3. Select the Delete button at the top of the Select a Report or Form window.
Delete a Form
1. From the Reports & Forms menu, select Forms and then select the type of form (Invoices and Packing Slips, Checks, Credit
Memos, and so on) you want to delete.
Sage 50 displays the Select a Report or Form window with the form type selected. The Forms list displays forms pertaining to the
form type selected.
There are many form types. You can switch among them at any time in this window. Selecting a new form type displays a
different list of forms.

2. From the Forms list, select the form that you want to delete.
3. Select the Delete button at the top of the Select a Report or Form window.

Print a Report Group
1. From the Reports & Forms menu, select Report Groups. Sage 50 displays the Select a Report or Form window.
If the Select a Report or Form window is already displayed, select the Report Groups report area on the left.
2. From the report list, scroll down to select the report group you want to print. Then, select the Print button at the top of the Select a
Report or Form window.
Each report set up in the report group selected prints according to its current filter and option settings.

Note: If your company has users and passwords set up to restrict access to certain areas of Sage 50, the reports included in
the report group which you do not have access to will not print.

FINSTAT
Reading Financial Statements
Financial statements in Sage 50 always show the expected or most-common balance. Therefore, if an amount is normally a
negative (as Accumulated Depreciation on a Balance Sheet), Sage 50 shows it as a positive (multiplies by -1). Therefore, when you
read your financial statements, you can look for negative numbers as warning signs.
Negative numbers on Sage 50's financial statements mean one of two things:
l

there was a posting error

l

something is wrong (you had a bad month)

To catch a posting error, print the general ledger, and study it for possible mistakes.

Related topics
Ratio analysis of financial Statements

Financial Statement Design Window
When you design a financial statement, use this window. It has three major areas: the a toolbar at the top of the window, the design
toolbar at the side of the window where you select the type of fields you want to place on the designer, and the a design area where
you actually create make changes to the financial statement. Using the design window, you will be able to change font properties of
certain financial statement objects in the window.
When you create work on a financial statement, you work with five basic areas:

At the side of the designer window, you'll note that each row has next to it a button that defines the row. For each row, you'll be able
to change the font properties of the text appearing in the row.

Financial Statement Design Tools
Use the Property tool to work with the properties window for the selected row type. For example, if you select a text
row, the Text window will open.
Use the Text tool to insert text that will not change from statement to statement (for example, section headings.)

Use the Column tool to define columns, enter a title for each column, select the alignment of each column title (left,
right, or center) and select the style, size and color of the text.

Once the columns are defined, use the Line tool to define what data to put in each row of a column. Line objects are
placed below column objects.
Use the Total tool to tell the program how to calculate totals and subtotals.

Use the Cut tool to remove the selected row and copy it to the Windows Clipboard.

Use the Copy tool to copy the selected row to the Windows Clipboard.

Use the Paste tool to insert the current row from the Windows Clipboard.

Use the Up tool to move a selected row up one position in the list of rows.

Use the Down tool to move a selected row down one position in list of rows.

Note: You can select multiple rows in the window and then apply the cut, copy, and paste functions to change the font for all of
them. To select multiple rows, hold down the Ctrl key, and then with the cursor select the buttons that define the rows you want.
Note that in the following illustration, the three rows in the center have been selected.

Related topics
Read financial statements

Design a Financial Statement
Sage 50 has a powerful tool called the Financial Statement Design window. With this tool, you can create customized financial
statements. Or, you can just tweak the existing financial statements to make them fit your business better. With this tool you can
customize a financial statement by changing the font properties of the text appearing on the statement.

Note: While the Financial Statements Design window gives you more individual control over each aspect of the financial design
process, it’s probably a good idea to start designing with the Financial Statement Wizard. That way, you’ll have a better grasp of
the basic elements of a statement and how to put them together effectively. Once you learn how the wizard builds a statement,
designing financial statements on your own will become less of a challenge.

To customize an existing financial statement
You cannot design financial statements from scratch; but, you can customize any of the pre-defined financial statements to meet
your business needs. This feature has many formatting options such as user-selectable fonts, customized headers and footers, and
text alignment.

1. From the Reports & Forms menu, select Financial Statements. Then in the Select a Report or Form window, select the
statement from the report list. .

2. Select the Design button at the top of the Select a Report or Form window to display the window where you can design customize
financial statements.

Note: You can also display the financial statement in design mode while it is displayed onscreen by selecting the Design button
in the Report window.
In the Financial Statement Design window you have several options available in which to modify existing statements. There are
two areas in which to work: Header and Body areas. Each area contains rows representing the various elements of the financial
statement, such as header text, column descriptions, or body text. Each row has a button next to it that defines the row.
l
l

Each row has a button next to it that defines the row.
To the left of the design window are design tools. These assist in selecting and adding various types of design elements (types
of rows).

3. To move a row, do one of the following:
l

l

To move a row up or down a single position in the series of rows, use the Up and Down buttons. Just select the row button for
the row you want to move. Then select the Up button to move the row up one position, or select the Down button to move the
row down one position.
To move a row or rows multiple positions, select the corresponding row button(s) with your mouse pointer; then select the Cut
button. Now, with the mouse pointer, select the row button above which you want to insert the row(s), and select the Paste
button.

4. To make changes to a rowTo modify a row's properties, select the row button. The Font window appears, letting you change the
font of the text appearing in the row., or move your mouse pointer over the row in the design window. Then, right-click your
mouse to display the design menu.
You can change the font or row properties using this method. There are properties for text objects, column objects, line objects,
and total objects.

5. To delete any unwanted rows, select the row button for the row you want to remove, and then select the Cut button.
Note: If you remove a row in error, you can restore it by selecting the Undo option from the File menu or by using the
keyboard shortcut CTRL+Z.

6. Select the Options button at the top of the Design window to display financial statement options.
7. When finished selecting the form options, select OK to return to the Financial Statement Design window.
8. When finished designing your statement, select Save. Enter or select a name for your form and a description. Then, select OK.
Note: You cannot modify a standard financial statement (those included with Sage 50) and save it to the same name. If you
modify a standard statement, Sage 50 will prompt you to enter an alternate name.

9. Select Close to return to the Select a Report or Form window.
Sage 50 displays the new statement in the report list within the Select Report or Form window.

Related topics
Department Masking
Read financial statements
Ratio analysis of financial Statements

Drill Down from Amounts in Displayed Financial Statements
In financial statements, including customized statements, you can drill down to the General Ledger report. Double-clicking an
amount listed in a financial statement displays the appropriate General Ledger report in detail form. This is called "drilling down."
From the General Ledger report, you can further drill down to the task windows where pertinent transactions were created. For
example, if you double-click a sales amount in the financial statement, the General Ledger report will show the transactions whose
totals add up to that sales amount. You can then drill down to a transaction in its original task window, modify the transaction (if
allowed), save or post the new transaction, and return to the General Ledger Report window.
Now, to return to the financial statement from which you drilled down, simply close the General Ledger Report window. This feature
is quite useful if you need to display or edit detail for a filtered group of transactions.
Note, however, that there are some amounts you will not be able to drill down from:
l

amounts when you have filtered the financial statement to include only summary and roll-up information

l

amounts when you have filtered the financial statement to include only debit or credit information

l

budget amounts

l

amounts from transactions that fall in closed financial years

To drill down from financial statement amounts, do the following:

1. Display a financial statement on the screen. How do I do this?
2. Move your mouse pointer over the list of amounts. When you move over an amount from which you can drill down, the cursor
changes from an arrow into a magnifying glass with a "Z" in the center.

3. Click on such an amount, and a colored box appears around it.

Note: Whenever you view a financial statement on screen, the first statement amount that you can drill down on always
appears with a colored box around it. For instance, the amount shown above appears with a box around it as soon as the
Standard Income Statement is displayed.

4. Double-clicking an amount within a box displays the appropriate General Ledger report.
5. To drill down on a transaction within this report, follow the instructions under Drill Down on Transactions in Displayed Reports.
6. If you edit the transaction, select Save. Then, close the task window.
When you close the respective task window, Sage 50 displays the General Ledger Report window once again.

Note: If you modified the transaction you drilled down to, the report is updated for you.
7. To return to the original financial statement, close the General Ledger Report window.
8. Select another amount to drill down on, or close the Financial Statement window.

Ratio Analysis of Financial Statements
One method of analyzing financial statements is by ratios. These comparisons of different areas of the financial statement are
expressed as percentages or ratios like 2 to 1, 2:1, or 2/1.
There is usually a target or comparative general rule to measure against your business. For example, in the Current Ratio, a 2:1
ratio is considered adequate. However, keep in mind that all businesses are different, and that one bad ratio doesn't necessarily
mean your business is in trouble. This is just one way of analyzing your business.
There are several ratios, but four of the most commonly used are below:

Current Ratio
The current ratio is defined as Total Current Assets divided by Total Current Liabilities. A good ratio is 2 to 1 or higher.

Return on Equity
This ratio is defined as Net Profit divided by Equity. The ratio needs to be compared against other investment opportunities.
Generally, 10% or higher is good.

Debt-to-Equity Ratio
This ratio is defined as Total Liabilities divided by Equity. A ratio of one or lower is good. (The lower the ratio, the more stable your
position.)

Average Collection Period
This ratio is defined as Accounts Receivable divided by Average Sales Per Day. (To determine the Average Sales Per Day, divide Net
Yearly Sales by 365.) A good measure is that the average collection period must not exceed 1.33 times your credit terms.
Therefore, if you allow 30 days for payment terms, your Average Collection Period must not exceed 40 days.

Note: A similar ratio for Average Days Outstanding (although computed differently) is provided on the Graph of the Collection
Manager.

Copy a Financial Statement Format from One Company to Another
To copy a financial statement

1.
2.
3.
4.

Open the company in Sage 50 to which you want to copy a financial statement.
From the Reports & Forms menu, select Financial Statements. Sage 50 displays the Select a Report or Form window.
Select the Copy button. Sage 50 displays the Copy Reports & Financial Statements window.
Select the Source Company to copy from.
This is the company that contains the original financial statement. When you select a source company, Sage 50 displays a list of
financial statements in that company.

5. Select financial statements from the drop-down list.
6. Select the financial statement you want to copy.
7. Type a name for the statement (for example, G/L Account Summary). You can also include a description.
The list only shows custom financial statements attached to the company you chose in Step 4. To display standard financial
statements in the list, select the Include Standard Financial Statements check box.

8. Select Copy.
The report is copied into your company report list under Financial Statements.

INTELLIGENCE_REPORTING
Using Sage 50 Intelligence Reporting
The most common ways you'll use Intelligence Reporting are:

Opening a Intelligence Reporting report in Excel
1. Go to Reports & Forms>Intelligence Reporting.
2. If you haven't already installed Sage 50 Intelligence Reporting, you will be prompted to do so.
3. Select the folder for the type of report you want to view.
4. Double-click on the report.
Intelligence Reporting will open.

5. Put in the date range or year as prompted.
6. The report will open in Excel.
Customizing a Intelligence Reporting report in Excel
To customize a Intelligence Reporting report in Excel, simply open the report like you normally would. After you make changes
to the report, such as changing filters and adding/removing fields, save the report with a new name. These changes only affect
this report and will not appear the next time you open the report from within Sage 50.

Creating a new Intelligence Reporting report
You'll use the Report Manager to create a new Intelligence Reporting report.

1. Go to Reports & Forms>Intelligence Reporting Setup>Report Manager.
2. You'll see the same report folder structure in the Report Manager that you see in Sage 50.
3. Make a copy of an existing report that you want to modify. You may need to copy this report into a new folder. You cannot
modify reports that are in the standard Sage 50 Intelligence Reporting reports folders.

4. Right-click on the report and click Design .
5. Customize the report in Excel.
6. Save the report.
After you save the report, you can open it from within Sage 50.

What is the difference between customizing an Intelligence Reporting report in Excel and creating a new Intelligence Reporting
report?
When you customize an Intelligence Report in Excel, you create a new report with the data that is in that report. This happens
when you open the report in Excel and then make changes to it.
The Excel report is saved as .xls file. You'll know you're saving a new Excel report because it will have data in it.
When you use the Report Manager to create a new Intelligence Reporting report, this makes a new report that you can use to
generate future reports. This happens when you open Report Manager and choose to design an existing report.

A new Intelligence Reporting report is created using the Report Manager. The report is saved as an .xlt file. You'll know you're
saving a new Intelligence Reporting report because it will not have data in it. When you open the report from within Sage 50, it
will have data.

What if I want to create a new Intelligence Reporting report from scratch or if I want to create a report with information from
more than one database?
You can use the Connector to create a new Intelligence Reporting report from scratch or to create a report that contains
information from different databases. This is an add-on component and is used for more advanced customizing of reports.
The Report Designer is a component that helps you design your reports in Microsoft Excel. It allows you to drag and drop fields
and use a What If Analyzer to change data and see the impact. It also contains a Formula Builder to help you create additional
calculated fields. (Microsoft Excel 2007 or higher is required to use the Report Designer.)
Refer to help in the Report Manager and in Microsoft Excel for additional assistance with creating Intelligence Reporting reports.

Learn more about help for using Intelligence Reporting.
Some Sage 50 Intelligence Reporting reports were not designed for companies that have a 13 period calendar year. If your
company has a 13 period calendar year, your Intelligence Reporting reports may have columns that do not display the way you
expect and may need to be adjusted.

Learn More
Intelligence Reporting licensing
Intelligence Reporting security
Intelligence Reporting components
Intelligence Reporting help

Activate/Upgrade Sage 50 Intelligence Reporting reports
The Activate screen appears if you are using the trial version of Sage 50 Intelligence Reporting or your trial period has expired.
Here you'll find the information you need to purchase and activate the full version of Sage 50 Intelligence Reporting.
To view the report you selected using the trial version, click Continue. If you did not get this screen by selecting a report or if your
trial period has expired, you will not have this option.
The Upgrade screen appears if you have already purchased and activated the full version of Sage 50 Intelligence Reporting. This is
where you can activate additional licenses and functionality related to Sage 50 Intelligence Reporting.

How do I get an activation code?
When you purchase Sage 50 Intelligence Reporting or additional licenses and functionality, the Customer Service
representative will provide you with an activation code. You'll enter this code on the Activate/Upgrade Sage 50 Intelligence
Reporting screen and then click Activate Now to activate your full version of Sage 50 Intelligence Reporting or to activate
additional licenses and functionality.

How do I purchase Sage 50 Intelligence Reporting or additional functionality?
Simply follow the instructions on the Activate/Upgrade Sage 50 Intelligence Reporting screen to purchase Sage 50 Intelligence
Reporting and additional licenses and functionality.

What additional functionality is available for Sage 50 Intelligence Reporting?
Sage 50 Intelligence Reporting automatically comes with one license. You can purchase more licenses if you want to.
The Connector is an add-on component that allows you to do more advanced customization of your Intelligence Reporting
reports than you can do with the Report Manager.

Learn more about the components of Sage 50 Intelligence Reporting.
Where do I enter my activation code?
Enter the code in the Activation Code field located near the bottom of the Activate/Upgrade Sage 50 Intelligence Reporting
screen. Then click Activate Now.

Do I have to install the full version of Sage 50 Intelligence Reporting?
Yes, you can install Sage 50 Intelligence Reporting by going to Reports & Forms > Intelligence Reporting.

How long does the trial period last?
The trial version of Sage 50 Intelligence Reporting can be used for 60 days. After that, you must purchase a full version if you
want to continue to use Sage 50 Intelligence Reporting.

What versions of Sage 50 can use Sage 50 Intelligence Reporting?
The trial version is available in all versions of Sage 50. The full version of Sage 50 Intelligence Reporting is available in all
versions of Sage 50.

How do I get to the Activate/Upgrade Sage 50 Intelligence Reporting screen?
Go to Reports & Forms>Intelligence Reporting Setup>Activation Manager.
The Activate screen will appear automatically when you select to display a Sage 50 Intelligence Report if you have 15 days or
less before your trial period expires or if your trial period has expired. This screen will appear periodically when you select to
display a Sage 50 Intelligence Report when you have more than 15 days left until your trial period expires.

Sage 50 Intelligence Reporting
Sage 50 Intelligence Reporting is a powerful tool that allows you to view pre-formatted reports and create your own reports in
Microsoft Excel. You can install the trial version of Sage 50 Intelligence Reporting for 60 days. After that, if you want to continue
using Sage 50 Intelligence Reporting, you'll have to purchase the full version.

Note: You must have Microsoft Excel 2003 or later to use Sage 50 Intelligence Reporting.
How do I get to the Intelligence Reporting reports?
l
Go to Reports & Forms>Intelligence Reporting.
l

l

You can also access these reports from the task flow sections in the Navigation Centers. Just look for the Intelligence
Reporting navigation aid.

You can follow the prompts to install Sage 50 Intelligence Reporting.

I can already send Sage 50 reports to Excel. How is Intelligence Reporting different?
This is much more powerful than simply sending a report to Excel. Intelligence Reporting sends a report to Excel that has
extensive filtering capabilities, data containers, and pivot tables you can use to customize the report. You can use the Report
Manager to create new reports so you don't have to customize the report in Excel every time you run it.
There are additional add-on components that allow you to create your own data containers and include data from different
databases in the same report.
Go ahead. Try it out and see for yourself how Intelligence Reporting can help you get the information you need to run your
business. It's free for 60 days!

Learn More
How do I use Sage 50 Intelligence Reporting?
What are the components of Intelligence Reporting?
How do I get help with using Intelligence Reporting?

Sage 50 Intelligence Reporting Components
There are different components that make up the Sage 50 Intelligence Reporting reporting tool. If a component is not an extra addon, it is included as part of the full version of Sage 50 Intelligence Reporting.

Component

Description

Intelligence Reporting
Reports

Standard Intelligence Reporting reports are included for you. To view these reports, go to
Reports & Forms>Intelligence Reporting. Click on a report to use Intelligence Reporting to open
the report in Microsoft Excel. You'll be able to filter the report and add fields to the report in
Excel.

Report Manager

This allows you to create your own Intelligence Reporting reports that you can access from
within Sage 50. You can copy an existing report and then modify it to create your new report.
You can access the Report Manager by going to Reports & Forms>Intelligence Reporting Setup
or by clicking the Report Manager toolbar button from the Intelligence Reporting area of Reports
& Forms.

License Manager

This allows you to control who is using Intelligence Reporting. You can see who is using your
Intelligence Reporting license(s) and free up licenses for other users. Go to Reports &
Forms>Intelligence Reporting Setup to access the License Manager.

Security Manager

This allows you to set security access to any custom Intelligence Reporting reports you have
created. You can also control the access to any reports from within the Report Manager. Security
for the standard Intelligence Reporting reports and the Intelligence Reporting Setup options
from within Sage 50 is handled through Sage 50 security.

Scheduler

You can schedule Intelligence Reporting reports to be run automatically. You'll use the Report
Manager to set the output file destination and to get the command you'll need to put in your
scheduler tool (such as Microsoft Scheduler).

Import/Export Reports

You can import Intelligence Reporting reports that someone else has created. You can also
export Intelligence Reporting reports that you have created so other people can use them.

Report Designer

This is a component that helps you design your reports in Microsoft Excel. It allows you to drag
and drop fields and use a What If Analyzer to change data and see the impact. It also contains a
Formula Builder to help you create additional calculated fields.
Note: You must have Microsoft Excel 2007 or higher to use the Report Designer.

Connector*

This component allows you to create custom Intelligence Reporting reports from scratch. You
can create your own data containers for creating reports and create reports from multiple
databases. This provides more advanced customization options than the Report Manager alone.
*This is an add-on component that is not included in the trial or full-version of Sage 50
Intelligence Reporting.

Sage 50 Intelligence Reporting Connector
The Connector allows you to create custom Intelligence Reporting reports from scratch. You can create your own data containers for
creating reports and create reports from multiple databases. The Connector allows you to access the database tables you need to
create reports. It also allows you to configure the metadata to make it easier to create reports. This provides more advanced
customization options than the Report Manager alone.
This is an extra add-on component for Sage 50 Intelligence Reporting. Learn more.

Sage 50 Intelligence Reporting Licensing
When you purchase Sage 50 Intelligence Reporting, you automatically get one license. You may purchase additional licenses, if
you want to.

A license is assigned to a Sage 50 user and computer when Intelligence Reporting is accessed. The license must be deleted in
License Manager to be used on a different computer or by another user.
For example, if User1 accesses Intelligence Reporting on PC1, a license is now assigned to User1 on PC1. User1 cannot use that
same license on another PC. Another user cannot use that license at all. For User1 to use this license on another computer or for
another user to use this license, the license must be deleted in License Manager.
Don't worry. Deleting a license does not get rid of it. It just un-assigns it so it is available for the next user that accesses
Intelligence Reporting.

Because License Manager is part of Intelligence Reporting, someone who has an assigned license must go in to delete an assigned
license. Can I delete a license if it is assigned to me? Yes. This frees up the license so you can use it on another computer or
another user can use it.

Important: Once a license is assigned to a Sage 50 user and computer, it stays assigned to that user and computer unless it is
deleted in License Manager.

How do I get to the License Manager?
Go to Reports & Forms>Intelligence Reporting Setup>License Manager.
How can I tell how many licenses I have?
Go to Reports & Forms>Intelligence Reporting Setup>License Manager.
How do I purchase Intelligence Reporting or additional licenses?
Go to Reports & Forms>Intelligence Reporting Setup>Activation Manager.
How many licenses do I get during the trial period?
Five

Sage 50 Intelligence Reporting Security
There are two parts to security in Sage 50 for Sage 50 Intelligence Reporting. One part is security for the Intelligence Reporting
Setup options. The other part is for the Intelligence Reporting reports.

Where do I set up security in Sage 50?
Go to Maintain >Users>Set Up Security
Intelligence Reporting Setup
Access to the Intelligence Reporting Setup options is specified in the Company area of Sage 50 security setup.
The Administrator role is automatically set up to allow full access to the Intelligence Reporting Setup options.

Intelligence Reporting Reports
The security for the standard Intelligence Reporting reports is set up using the same settings for Sage 50 reports.

Financials
To run the standard Intelligence Reporting Financials reports, you must have the following Sage 50 security access:

Banking & General Ledger>Reports: Full Access
The following roles are automatically set up to allow access to the Financials reports:
l

Accountant

l

Administrator

l

View Only

Purchases
To run the standard Intelligence Reporting Purchases reports, you must have the following Sage 50 security access:

Vendors & Purchases>Reports>Master Lists: Full Access
Vendors & Purchases>Reports>Transaction Lists: Full Access
Vendors & Purchases>Reports>Other Reports: Full Access
The following roles are automatically set up to allow access to the Purchases reports:
l

Accountant

l

Administrator

l

AP Manager

l

AP Specialist

l

Banking Manager

l

Purch Specialist

l

View Only

Sales
To run the standard Intelligence Reporting Sales reports, you must have the following Sage 50 security access:

Customers & Sales>Reports>Master Lists: Full Access
Customers & Sales>Reports>Transaction Lists: Full Access
Customers & Sales>Reports>Other Reports: Full Access
The following roles are automatically set up to allow access to the Sales reports:
l

Accountant

l

Administrator

l

AR Manager

l

AR Specialist

l

Sales Manager

l

Sales Rep

l

View Only

Note about custom reports: Sage 50's security does not affect custom Intelligence Reporting reports. You will need to set
access to these reports though the Intelligence Reporting Security Manager. This can be accessed by going to Reports &
Forms>Intelligence Reporting Setup>Security Manager.
Important! Users who have full access to the Report Manager in Intelligence Reporting Setup will be able to access all of the
standard Intelligence Reporting reports through the Report Manager even if they can't access them from Sage 50's Select a Report
window. If a user has access to the Report Manager, but you don't want them to have access to all of the standard reports, be sure
to use the Intelligence Reporting Security Manager to limit their access. To do this, go to Reports & Forms>Intelligence
Reporting Setup>Security Manager.

Sage 50 Intelligence Reporting User Assistance Resources
There are multiple resources available to help you understand, use, and get the most out of Sage 50 Intelligence Reporting.

Sage 50 Help
This helps you understand Sage 50 Intelligence Reporting in general. You can find out what Sage 50 Intelligence Reporting is
and how to purchase and activate it. It also tells you about the standard reports, security, and licensing for Sage 50 Intelligence
Reporting.

Sage 50 Intelligence Reporting Help
This gives you detailed step-by-step information about using Sage 50 Intelligence Reporting and its components. This includes
creating reports, importing and exporting reports, scheduling reports, and setting up report security. There are also tutorials
available that guide you through using Sage 50 Intelligence Reporting.
To use this help, open the Intelligence Reporting Report Manager, then click the Help button or Help menu option.

Other Resources
Sage 50 Intelligence Reporting training
Sage 50 Intelligence Reporting community
Sage 50 Intelligence Reporting product information

Preparing for Year-End
Sage 50 Year-End Guide
The purpose of this guide is to assist you in managing year-end activities in Sage 50.
l
l
l
l

Review payroll year-end procedures
Review General Ledger year-end procedures
Use the Year-End wizard
Purge unnecessary data with the Purge wizard

Getting Help

If there is a procedure that you are not sure how to handle within Sage 50, visit the Support & Training Center at the Sage 50 Web
site. There are many frequently asked questions and procedures available at our Web site.

What do you want to do next?
Perform other payroll tasks

l

Payroll Year-End Procedures
Payroll Year-End Checklist
If your company records payroll transactions in Sage 50, payroll year-end procedures consist of the following:
l
l
l
l
l

Install the latest Sage 50 tax service update (must be subscribed to a Sage Business Care plan.
Verify that your state unemployment wage limit and percentage rates are correct
Print reports or forms needed for auditing, adjusting, or year-end closing purposes
Make a complete backup of your company data
Close the current payroll tax year (may not be required)

After-the-Fact Payroll and Payment Information
The following procedures may be required if you need to enter after-the-fact information before you print payroll forms and close
the payroll tax year.
l
l

Enter after-the-fact payroll information to print employee W-2 forms
Enter after-the-fact payment information to print vendor 1099 forms

After Closing the Payroll Year
You will need to update the employer's state unemployment (SUI ER) tax table and adjust new limits and rate percentages.
l

Update the employer state unemployment (SUI ER) tax formula to a new payroll tax year

What do you want to do next?
l
Read about the Sage 50 Year-End wizard
l
Perform other payroll tasks
l
Read the year-end overview

Close Payroll Tax Year
Sage 50 refers to the payroll tax year as the calendar year in which payroll transactions take place. Sage 50 keeps two years of
payroll activity open at one time. For tax purposes, the payroll tax year must coincide with the calendar year. Closing the payroll tax
year not only closes the payroll information; it also closes vendor 1099 information. Therefore, all payroll reports, payroll forms,
and 1099 forms must be printed before closing the payroll tax year.

Prepare quarterly payroll reports
Prepare annual payroll reports
When to Close the Payroll Tax Year
Usually there is no need to close a payroll tax year exactly at the end of each calendar year. For example, if 2010 is the first of the
two years, you do not need to close this payroll tax year until the end of 2011. On the other hand, if 2010 is the second of the two
payroll years, you must close the 2009 payroll tax year before you can enter 2011 payroll transactions.

We highly recommend that you wait to close the first payroll tax year until all payroll reports, W-2 data, and 1099 data are
finalized following the first quarter of the second payroll tax year. If there are mistakes in employee earnings or W-2 data, you have
an opportunity to correct them.
If you are unsure as to what two payroll years Sage 50 is operating in, you can quickly find out in the Change Accounting Period
window.

Note: If your company's fiscal year matches the calendar year, you must close the payroll tax year prior to closing the fiscal
year.
To Close the First of Two Open Payroll Tax Years

From the Tasks menu, select System, then choose Year-End Wizard. Sage 50's Year-End wizard prompts you for completion
of any uncompleted year-end tasks. The wizard will remind you to print any journals, reports, payroll checks and forms you may
have neglected to print. It will also prompt you to back up your data if you have not already done so. Tell me more about the
year-end wizard.

Install the Latest Sage 50 Tax Service Update
Before beginning payroll year-end procedures, subscribe to a Sage Business Care plan soon, and install the tax update. The timing
of when to install the tax service update is very important. This update will provide important updates to Sage-maintained payroll
tax tables/formulas, employee W-2, company W-3 forms, vendor 1099 forms, and other maintenance changes for the current and
new payroll tax year.
The latest Sage 50 tax service update must be installed before you perform the following procedure:

Print payroll tax and vendor 1099 forms for the payroll tax year you are ending or about to close. This is
needed to ensure that current Sage 50 941, 940 EZ, W-2, W-3, and 1099 forms (if changed by the IRS) are in compliance with
government regulations. For example, you must install the 2012 tax service update before printing 2011 employee W-2 forms
or vendor 1099 forms.

Calculate Fixed Asset depreciation for the payroll and fiscal year you are about to close. This is needed to
ensure accuracy of depreciation calculations for both the current and new calendar years.

Verify That Your State Unemployment Wage Limit and Percentage Rate Are Correct
It is very important to verify that your company's current employer state unemployment (Sage 50's SUI ER) wage percentage and
limits are accurate before printing annual payroll tax reports and closing the payroll year. This ensures proper tax reporting.
Employer state unemployment (SUI ER) percentage rates and wage limits can depend on your company location or type of
business. Therefore, you maintain the SUI ER tax formulas and must update them each year. Updates in employer state
unemployment rates and wage limits are not covered as part of a Sage Business Care plan.

Note: Some employee-paid state unemployment tax formula updates are included as part of a (missing or bad snippet). The
procedure below is only intended for employer–paid state unemployment tax formulas.
You must subscribe to a Sage Business Care plan in order to update payroll formulas in Sage 50.
To verify that your state unemployment rates are correct, first locate your company's current state unemployment documents or
contact your state unemployment tax authority. To check your state unemployment wage base limit and percent in Sage 50, follow
these steps:

1. From the File menu, select Payroll Formulas, then User-Maintained.
2. Select the current SUI ER formula ID for your state (for example, GASUI ER 01).
3. In Formula box, locate the LIMIT= and PERCENT= lines. Below is an example of how the formula may appear.

LIMIT = 8500;
PERCENT = 3.00000;
TAXABLE_GROSS = YTD_LIMIT (ADJUSTED_GROSS, LIMIT);
ANSWER = -TAXABLE_GROSS * PERCENT%
If your state unemployment wage base limit and percentage are incorrect, you will need to edit the formulas. You may need to
make a General Journal entry to adjust the affected G/L account balances.

Note: When entering a PERCENT value, use at least two decimal places. For example, if your percentage rate is 3%, then enter
PECRENT=3.00 ; if your percentage rate is 2.7%, then enter PERCENT=2.70 .
4. If required, change the limit and percent displayed in the formula.
If you are unsure, check with your state unemployment authority to determine if your area has a new unemployment limit and
percent.

5. Save the formula, and close the window.
What do you want to do next?

Update the Employer State Unemployment (SUI ER) Formula to a New Payroll Year

Employer state unemployment (Sage 50's SUI ER) wage limits and percentage rates can depend on your company location or type
of business. Therefore, you maintain the SUI ER formulas and must update them each year. Updates in employer state
unemployment tax formulas are not included in the Sage Business Care plans.

Note: Some "employee-paid" state unemployment formula updates are included in a (missing or bad snippet). The procedure
below is only intended for employer–paid state unemployment formulas.

Tip: You can also use the following procedure to update other company formulas unique to your business (for example, vacation
accrue, sick accrue, 401K, or employee loan calculations).
You must subscribe to a Sage Business Care plan in order to update payroll formulas in Sage 50.

1. From the File menu, select Payroll Formulas, then choose User-Maintained. Sage 50 displays the User-Maintained Payroll
Formulas window.

2. Select the old SUI ER formula ID for your state in the formula list (for example, GASUI ER 00).
3. In the Formula ID field, add or change the number following the ID.
For example, you might change GASUI2 to GASUI3.

4. In the Name field, change the two-digit year to the current payroll year.
For example, change GASUI ER 11 to GASUI ER 12 (changes 2011 to 2012).
5. In Formula box, locate the LIMIT= and PERCENT= lines. Below is an example of how the formula might appear.

LIMIT = 8500;
PERCENT = 3.00000;
TAXABLE_GROSS = YTD_LIMIT (ADJUSTED_GROSS, LIMIT);
ANSWER = -TAXABLE_GROSS * PERCENT%
If your state unemployment wage base limit and percentage have changed, you will need to edit the formulas. If you are unsure,
check with your state unemployment authority to determine if your area has a new unemployment limit and percent.

Note: When entering a PERCENT value, use at least two decimal places. For example, if your percentage rate is 3%, then enter
PERCENT=3.00 ; if your percentage rate is 2.7%, then enter PERCENT=2.70 .
6. If required, change the limit and percentage displayed in the formula.
7. Select Save.
A new, updated formula is listed alongside the old tax formula.

8. Select Close to exit the window.
What do you want to do next?
l
Print Yearly Earnings report
l
Print Payroll Exception report to correct differences between calculated withholdings and actual withholdings
l
l
l
l
l

Print vendor 1099 forms
Pay employees
Perform other payroll tasks
Review payroll year-end procedures
Read the close fiscal year overview

Print Payroll Reports or Forms Needed for Auditing, Adjusting or Year-End Closing
Purposes
It is important to make any required adjustments before printing employee W-2 forms or closing the current payroll tax year
because it is difficult to correct errors afterward.
Below are some reports or forms you'll want to print:
l

Quarterly and Yearly Earnings Report: This report displays payroll earnings and withholdings by payroll period, payroll
quarters, and payroll tax year. This is a record of all payroll earnings for the selected payroll tax year.

Print Yearly Earnings report

l

Payroll Tax Report: These can be used for paying the payroll taxes for your company. The tax reports that can be printed are:
FICA EE, FICA ER, FUTA, MEDICARE, and XXSUI ER (where XX represents your state code).

l

State Quarterly Forms: Sage 50 provides specific reports for Utah and California, such as the California DE6 and the State
Quarterly Wage Worksheet. These are printed through the .

l

941 and 940 EZ Forms: These forms are used for filing quarterly and annual payroll information with the federal government.
These are printed through the

l

Employee W-2, Company W-3, and Vendor 1099's Forms: You will need to print these forms prior to closing the payroll
or fiscal year. These are printed through the .

Note: To close the payroll tax year, you will use the Sage 50 Year-End Wizard, which will prompt you to print any reports or
forms you have neglected to print.

Obtain preprinted payroll tax and 1099 Forms
Use the Payroll Tax Form Selector to select, view, and print payroll tax forms
Print vendor 1099 forms
What do you want to do next?
Make payroll adjustments after printing reports

l
l
l

Review the payroll year-end checklist
Perform other payroll tasks

Make Payroll Adjustments
If you need to make adjustments after printing payroll reports, you must enter a second adjusting paycheck. This will update the
employee's earnings and W-2 information. When entering an adjusting paycheck, include only the payroll fields or G/L accounts that
you need to change. Other payroll fields will contain zero amounts.
We highly recommend that you never delete an employee payroll transaction after paying an employee. Say you need
to change a deduction or addition amount on a paycheck that has already been distributed. If you delete the payroll transaction to
make these changes, it could affect the check amount (net) and impact account reconciliation. Also, the employee now does not
have an accurate record of his or her earnings.
When you print a second adjusting paycheck, the transaction provides a record for the employee and an audit trail for your
company.

What do you want to do next?
l
Pay employees
l
Enter manual paychecks
l
Review the payroll year-end checklist
l
Perform other payroll tasks
l

Read the year-end overview

Print Payroll Exception Report to Correct Differences between Calculated Withholdings
and Actual Withholdings
Note: You must subscribe to a Sage Business Care plan in order to print this report.
The Payroll Exception report is intended to help you identify and correct employee records that reflect incorrect withholdings.
Incorrect withholdings are often the result of manually calculated paychecks that were figured incorrectly. Also, Sage 50 may make
a rounding error in some cases (usually by a penny). This report shows the actual amount withheld (as entered in Sage 50) as
opposed to the calculated amount withheld.
This report filters differently from other reports. First, you need to select Tax to Check from the drop-down list. This lists all
Employee and Employer payroll fields that use taxable (adjusted) gross in its formula. Additional filters you can select are Employee
ID, Employee Type, and whether the employees are active or inactive.

To print or display the Payroll Exception report

1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Exception report. Then, select the Print button to print the report or the Preview button to display the
report.
Sage 50 displays the Filter window.

3. In the Tax to check box, enter or select the ID of the payroll tax you want to check.
4. Accept the default or choose which quarter to print. Then, select OK to begin displaying or printing the report.
For the tax selected and quarter filtered, the default Exception report displays the following information:
l

Employee ID, Employee Name, Social Security Number, State: employee information found in the General Tab of
Maintain Employees window

l
l
l
l
l

Quarter: the quarter in which the payroll exception took place
Taxable Gross: total taxable gross amount for the quarter
Amount Withheld: total amount actually withheld of filtered payroll field
Calculated Amount: total amount of payroll field recalculated
Difference: the net change from Amount Withheld and Calculated Amount

To adjust payroll taxes using the Exception report
You can elect to have Sage 50 make correcting entries for you. We recommend you first not make corrections and simply display
the report to examine the differences.

5. Once you are comfortable with the differences, select the Prepare Correcting Entries check box in the Filter window.
If the report is displayed on the screen, select the Options button to display the Filter window.

Note: If you use the batch method of posting, and you decide to check the Prepare Correcting Entries box, make sure you
post Payroll before you continue.

6. Next, choose the tax to adjust to from the drop-down list.
This lists all Employee payroll fields available (even if they do not use a calculation). Notice that you cannot adjust to an Employer
payroll field.

7. Select the quarter for which the adjustment will need to be calculated and entered.
8. Optionally select additional filters such as Employee ID, Employee Type, and whether the employees are active or inactive.
9. Select OK to accept the filter and make the correcting entries.
The report will appear just as it did without selecting Prepare Correcting Entries. However, Sage 50 made general ledger
entries in the background adjusting the taxes you selected. You can examine these entries by selecting Payroll Entry from the
Tasks menu. Then, select the List toolbar button. Sage 50 displays an entry for the employee who is being adjusted. The
Reference Number will be something like "ExceptAdj." If there is an error, you can simply delete the transactions.

Print Yearly Earnings Report
The Yearly Earnings report displays all paycheck information for each employee with subtotals for each quarter of the payroll tax
year. Each payroll field is displayed with quarterly and annual totals. These totals are included in the 941 Worksheet, W-2, and other
payroll tax forms if you subscribe to a Sage Business Care plan .

To print the Yearly Earnings report
1. From the Reports & Forms menu, select Payroll. Sage 50 displays the Select a Report or Form window.
2. In the reports list, select the Yearly Earnings report. Then, select the Print button. Sage 50 displays the print Options window.
To display the report on the screen, double-click the report in the report list.

3. In the Options window, accept the default filter (This Year) or choose which quarter to print in the Date drop-down list. Then,
select OK twice to begin printing the report.

Enter After-the-Fact Payroll Information to Print Employee W-2 Forms
Payroll can be a little more complex than just entering payroll checks, printing reports and forms, and closing the payroll tax year.
For example, if an employee needs a W-2 form at the end of 2011 but no payroll checks have been entered for that particular
employee during 2011, you must enter after-the-fact payroll information in order to print the form. The same can be true of 1099

vendors. If you have vendors that need a 1099 form printed but they are not entered in the system and payments have not been
made to the vendors, this is considered after the fact.

Note: Before printing payroll and 1099 forms, install the latest Sage 50 tax service update. This ensures that your forms will be
in compliance with current federal regulations. For example, before printing 2013 forms, you must install the 2013 (December
2012) Sage 50 tax service update.
To enter after-the-fact payroll information for employees

1. Verify the default information for your employee W-2 forms.
l
From the Maintain menu, select Payroll, then Payroll Settings.
l
Select Taxes in the left column. Then, select Assign Tax Fields, which appears just below Taxes.
l
Click the W-2 Fields button.
l

Verify that the appropriate payroll fields are assigned to each box on the W-2 form.

2. Set up the employee's record (if it is not already).
l
From the Maintain menu, select Employees/Sales Reps.
l

Enter the information needed to establish a new employee record. Then, select Save.

l

Repeat the above procedure for each new employee.

3. For each employee who needs an after-the-fact W-2, enter the calendar year payroll balances. This information is to be entered
on the individual's employee record.
l

From the Maintain menu, select Employees/Sales Reps.

l

Enter or select the employee ID. Select the Employee Beginning Balances button on the General tab.

l

l

l

In the Date field of the first vacant column, enter the last date of the current payroll tax year. For example, if you are printing
2011 after-the-fact W-2 forms, enter 12/31/11 in column 1.
In the new year-end column, enter each payroll field's year-to-date total for this one employee. For deductions, include a
negative sign (-) at the beginning of each amount that is to be subtracted from gross pay. To record the W-2 totals, select
Save.
Repeat the above process for each new employee who requires a W-2 form.

Note: Employee beginning balances do not affect Sage 50's general ledger. They are only used to update employee year-todate earnings and print quarterly and annual payroll forms.

4. Print the Yearly Earnings report.
This report will help to verify that correct beginning balance amounts were entered in Maintain Employees/Sales Reps. These
amounts will be printed on employee W-2 forms.

5. If any adjustments need to be made for the employee's year-to-date earnings, return to the employee's record in Maintain
Employees/Sales Reps, and edit the beginning balances.
To print after-the-fact employee W-2 forms
After verifying that the employee's payroll information is entered correctly (see above), you can print W-2 forms through the Payroll
Tax Form Selector.

Note: You must subscribe to one of the Sage Business Care plans in order to print W-2's from within Sage 50.

Print Vendor 1099 Forms
Before closing the payroll year, you must print 1099 forms. Annual 1099 forms are required for independent contractors and
vendors that your company has paid interest to for services on loan. Sage 50 prints 1099 information on preprinted 1099 forms, not
blank paper. Federal 1099 forms can be purchased from Sage 50 Forms, government agencies, or various office supply retailers.

Note: Sage 50 highly recommends that you first print vendor 1099 forms on plain paper to verify vendor payment totals and form
alignment.
You have the choice of printing 1099-MISC to report non-employee compensation of $600 or more a year or 1099-INT to report
those vendors to whom you paid more than $10 in interest a year. When you enter a vendor in Maintain Vendors, there is a field for
1099 Type on the General tab.

Before you print vendor 1099 forms
Before printing the 1099 forms, you must verify that your company information will print correctly the forms and that general
ledger accounts settings are made for various 1099 payments.
From the Maintain menu, select Company Information . In the Maintain Company Information window, ensure that
your company's address and telephone number are entered correctly.
From the Maintain menu, select Default Information , and then Vendors. In the Vendor Defaults window, select 1099
Settings tab. Here you can establish how vendor 1099 calculations will be made for each of the general ledger accounts in
your chart of accounts. You can choose whether 1099 payments made out of a given account will be calculated for
miscellaneous income-type contractors or for interest income-type contractors. You can also choose to have no 1099
calculations made for the given general ledger account. This allows you to write checks to vendors and have them either only
effect one of 1099 accounts or not effect the 1099 calculation.

Printing 1099 forms
You must print your vendor 1099 forms before you close the payroll (calendar) year.

1. Insert blank preprinted 1099 forms into your printer. Sage 50 only prints the 1099 Miscellaneous and the 1099 Interest
forms.

2. From the Reports & Forms menu, select Forms, then Tax Forms . Sage 50 displays the Select A Report or Form window.
3.

Select either the 1099-INT form (for printing 1099 interest income statements for vendors as required by the IRS) or the
1099-MISC form (for printing 1099 miscellaneous income statements for vendors as required by the IRS).

4. Click the Preview and Print button which is located below the sample image on the Select a Report or Form window. Sage 50
displays the .

5. Verify that the payroll year is correct.
6. If you want to manually adjust lower limits, which are established by the federal government, click the Adjust Limits
button.
In the 1099 Lower Limits window, set the limits as desired. Tell me more about this.

7. In the Filter vendors by section, enter or select a vendor ID range or accept the default of all vendors.
In the Payment Method filter, select the type of payments to include when calculating the 1099s.
8. When finished with the settings in the filter window, select Print/E-mail.
9.

In the Print dialog, Sage 50 displays the default printer. If you want to print to a different printer, use the drop-down arrow in
the Name field to select a new one. Otherwise, select OK to begin printing the forms.
If you get a message that there were no forms to print, you may not have vendors set up as 1099-type vendors, or the 1099
vendors do not meet the minimum payment requirement.
To print multiple copies, repeat the above procedure.

Print 1096 Forms for 1099-Type Vendors
Form 1096 provides a summary of the 1099 forms that you are sending to the IRS for your 1099-type vendors. Form 1096 is
required whenever you submit paper 1099 forms.
When you mail 1099s to the IRS, you must group them together and attach a separate 1096 for each group of 1099s. Because the
1096 is a special machine-readable form, it should always be printed on preprinted rather than plain-paper forms.
To print Form 1096, follow these steps:

1. Insert the blank preprinted 1096 form into your printer. Sage 50 supplies a plain and preaddressed version of the form. .
2. From the Reports & Forms menu, select Forms, then Tax Forms. Sage 50 displays the Select A Report or Form window.
3. From the Forms list, select either the Form 1096 - Preprinted or Form 1096 - Preaddressed Preprint. Sage 50 displays the .
4. Verify that the payroll year is correct.
5. Enter the name of the person at your company who acts as contact; this will appear in the "Name of person to contact" box on the
printed 1096.

6. If you want to manually adjust lower limits, which are established by the federal government, click the Adjust Limits button.
In the 1096 Lower Limits window, set the limits as desired. Tell me more about this.
7. In the Payment Method filter, you should select to include the same payment types that you selected when you generated the
1099s.

8. When finished with the settings in the filter window, select Print/E-mail.
9. In the Print dialog, Sage 50 displays the default printer. If you want to print to a different printer, use the drop-down arrow in the
Name field to select a new one. Otherwise, select OK to begin printing the forms.
If you get a message that there were no forms to print, you may not have vendors set up as 1099-type vendors, or the 1099
vendors do not meet the minimum payment requirement.
To print multiple copies, repeat the above procedure.

1099 and 1096 Forms - Lower Limits (Window)
The Lower Limits window lets you manually set the lower limits for all boxes that appear on your 1099 and 1096 forms. These limits
are the lower limits for payments of different types that you made to your 1099 vendors—for example, rent or medical and health
care payments. The lower limits that you can adjust vary by form.

For Form 1099-INT:
You can set the lower limit for only Box 1, interest income.

For Form 1099-MISC:
You can set the limits of the following boxes:
l
l
l
l
l
l
l

Box 1: Rent
Box
Box
Box
Box
Box
Box

2: Royalties
3: Other income
5: Fishing boat proceeds
6: Medical and health care payments
7: Nonemployee compensation
8: Substitute payments in lieu of $5,000 or more of consumer products to buyer (recipient for resale). Note: On the 1099

form, this is a checkbox rather than a dollar amount.
l
l
l

Box 10: Crop insurance proceeds
Box 13: Excess golden parachute payments
Box 14: Gross proceeds paid to an attorney

For Form 1096:
You can set lower limits for all the above 1099-MISC boxes as well as 1099-INT Box 1, interest income.

Set Lower Limits
To change the lower limits for the available boxes, enter a new value in the appropriate field in the Lower Limit column.

Reset Default
To return all the lower limit settings to the default settings (as established by the federal government), select the Reset Default
button.

Enter After-the-Fact Payment Information to Print Vendor 1099 Forms
Before closing the payroll tax year, you must print 1099 forms. 1099 forms are required for independent contractors and vendors
that your company has paid interest for services on loan.
If you have vendors that need a 1099 form printed but the vendors are not entered in Sage 50 and payments have not been made to
them, this is considered "after the fact." The same can be true of employees. For example, if an employee needs a W-2 form at the
end of 2011 but no payroll checks have been entered for that particular employee during 2011, you must enter after-the-fact payroll
information in order to print the form.

Note: Before printing payroll and 1099 forms, install the latest Sage 50 tax service update. This ensures that your forms will be
in compliance with current federal regulations. For example, before printing 2012 forms, you must install the 2013 Sage tax
service update.
To enter after-the-fact payment information for vendors
The following steps will show you how to print after-the-fact 1099 forms for vendors or contractors.

1. Set up the vendor's record (if it is not already set up).
l
From the Maintain menu, select Vendors.
l

Enter the information needed to establish a new vendor record.

l

In the General tab, select the miscellaneous or interest 1099 type.

l

Select Save.

l

Repeat the above procedure for each new 1099 vendor.

2. Next, you will need to enter an after-the-fact payment for the vendor.
l
From the Tasks menu, select Payments.
l

Enter or select the after-the-fact vendor ID, and enter the total amount paid to the vendor for the current fiscalpayroll tax year.
Enter a check date (within the payroll taxfiscal year for which you are printing 1099 forms) and a check number.
It is not necessary to print the disbursement check. Unprinted check totals are included when printing 1099 forms.

Note: If you do not want the payment to affect your General Ledger, use the same account ID in the cash account and
the G/L account (expense account) fields.
l

Select how you are paying this vendor in the Payment Method field.

l

To record the payment transaction to the General Ledger, select Save.

3. Before printing the 1099 forms, you must verify that your company information is set up correctly and that vendor payment totals
are entered correctly.
l

To verify payment information, run the Vendor Ledger report to verify the cash disbursement figures. Payments are listed as
CDJ transaction types in the Vendor Ledger.

To print after-the-fact vendor 1099 forms
After verifying that the vendor's payment information is entered correctly (see above), you can print 1099 forms. To do this, see the
following topic:
l

Print vendor 1099 forms

What do you want to do next?
Enter after-the-fact payroll information to print employee W-2 forms

l

General Ledger Year-End Procedures
Payroll tax solutions for Sage 50
If you work with 1099 vendors, you should subscribe to one of the payroll tax solutions for Sage 50. Before beginning general ledger
year-end procedures, install the latest update. In addition to updates to Sage-maintained payroll tax formulas, the payroll tax
solution includes updated vendor 1099 forms and other maintenance changes that may affect the current and new fiscal year as well
as the payroll tax year.

General Ledger Year-End Checklist
At the end of each fiscal year, it is recommended to do the following:

l

Complete all transactions for the fiscal year you intend to close
Reconcile all G/L accounts for the fiscal year you intend to close
Print reports to keep a historical copy of your accounting information
Audit reports and make adjustments (if needed)
Make a complete backup of your company data onto diskette or tape

l

Close the current fiscal year (may not be required)

l
l
l
l

Close Fiscal Year
Sage 50 refers to the fiscal year as the year in which general ledger transactions take place. Sage 50 keeps two years of general
ledger transaction activity open at one time. Each fiscal year has the same number of accounting periods, which you establish when
initially setting up your company. Normally, you change accounting periods as you enter transactions. Fiscal years do not have to
start at the beginning of the calendar year. For example, some companies may start their fiscal year July 1 and end it June 30.

Sage 50 refers to the payroll tax year as the calendar year in which payroll transactions (earnings) take place. If your fiscal year is
operated based on the calendar year (starts January 1 and ends December 31), then you must close the payroll tax year first
before closing the fiscal year.
After you close the fiscal year, all transactions posted to the General ledger in that year cannot be accessed or edited. However,
ending balances and some limited historic information are available in reports, when requested.

When to Close the Fiscal Year
Usually there is no need to close a fiscal year exactly at the end of the last accounting period. Sage 50 keeps two years of
transaction activity open at one time. For example, if your fiscal year is based on 12 accounting periods, then period 13 is the first
period of the second open fiscal year. Period 24 is the last period of the second fiscal year.
We highly recommend that you wait to close the first fiscal year until near the end of the second fiscal year. You can operate your
company in Sage 50's second open fiscal year (for example, periods 13-24). The first fiscal year (periods 1-12) holds the previous
year's transaction detail and allows you to make adjustments, if necessary. You cannot move forward until you close the first fiscal
year. After closing the first fiscal year, period 13 becomes period 1.

How do I find out what two fiscal years are open in Sage 50?
For example, if 2010 is the second of the two fiscal years, you must close the 2009 fiscal year soon in order to enter 2011
transactions.

Before Closing the Fiscal Year
Usually in the last accounting period of a fiscal year you need to make adjusting entries. These might include the following:
l

Writing off customer bad debts

l

Recording old outstanding checks reentered into the bank account as miscellaneous income

l

Verifying that fixed-asset purchases and dispositions have been properly recorded

l

Recording depreciation expenses

l

Recording a physical inventory count and comparing to Sage 50's quantity on hand

l

Managing outstanding notes payable and receivable items and recording or adjusting interest expense or income

Once the above adjustments have been made (if necessary), you are ready to begin closing the fiscal year.
Before you close the fiscal year, you should perform the following preliminary tasks:
l

If you are using batch posting mode, you need to post and print all journals and the Yearly General Ledger report. This will help
you determine if you are truly ready to close or if you need to work some with your general ledger beforehand.

l

You need to print all open invoices and vendor and payroll checks.

l

You should back up your company data (highly recommended).

To Close the First of Two Open Fiscal Years
From the Tasks menu, select System, then choose Year-End Wizard. Sage 50's Year-End wizard prompts you for completion
of any uncompleted year-end tasks. The wizard will remind you to print any journals, reports, invoices/checks you may have
neglected to print. It will also prompt you to back up your data if you have not already done so. Tell me more about the year-end
wizard.

Purge Unnecessary Data with the Purge Wizard
Purging is the process of removing inactive customers, vendors, employees, jobs, quotes, invoices, purchases, and so on from the
records of a company; typically, you will purge data after closing the fiscal year. Purging reduces the size of the files of a company
and frees valuable disk space for current and active data. This is usually recommended after closing a fiscal year to save disk space.
Purging data is accomplished using the Sage 50 Purge wizard. Tell me more about the purge wizard.

Complete All Transactions for the Fiscal Year You Intend to Close
Before you close a fiscal year, all transactions must be completed for that year. For example, if you intend to close the 2012 fiscal
year, complete all transactions dated 1/1/12 to 12/31/12 (assuming the fiscal year structure matches the calendar year) before
closing the year.

Reconcile All G/L Accounts for the Fiscal Year You Intend to Close
You cannot reconcile accounts (for example, checking or credit card accounts) whose bank statements are dated in a closed fiscal
year. Therefore, it is recommended to reconcile these accounts before closing the fiscal year.

Note: If you choose not to reconcile accounts using previous bank statements, the items will be available to clear in the new fiscal
year. However, the account reconciliation will be difficult to manage and audit.

What do you want to do next?
Reconcile an account (bank statement reconciliation)

l

Print Reports to Keep a Historical Copy of Your Accounting Information
The following is a list of reports we recommend that you print prior to closing the fiscal year. Keep these reports in a secure location.
These reports will act as a hard copy of your historical Sage 50 information; they can be helpful during audits. The following table
lists the reports you can print in each of the Sage 50 program modules:

Accounts
Receivable

Sales Journal
Cash Receipts Journal
Customer Ledgers
Customer Statements
Aged Receivables
Taxable/Exempt Sales

Accounts Payable

Check Register
Aged Payables
1099 Forms

General Ledger

G/L Trial Balance
General Ledger Report

Financial Statements

Balance Sheet
Cash Flow
Income Statement

Payroll

Payroll Check Register
Quarterly Earnings Report
Yearly Earnings Report
Payroll Tax Reports
State Quarterly Report
Forms
Federal Form 940 EZ and
W-3
Federal Form 941
Federal Form W-2

Inventory

Inventory Valuation Report
Item Costing Report
Inventory Unit Activity
Report
Inventory Profitability
Report

Jobs

Job Ledgers
Job Profitability Report
Job Register

Note: To close the payroll tax year, you will use the Sage 50 Year-End wizard, which will prompt you to print any reports you
have neglected to print.

What do you want to do next?

l
l
l

Print a report or financial statement

Print a single form
Print a batch of forms

Audit Reports and Make Adjustments (if Needed)
Usually in the last accounting period of a fiscal year you need to make adjusting entries. These might include the following:
l

Write off customer bad debts

l

Record old outstanding checks reentered into the bank account as miscellaneous income

l

Verify that fixed-asset purchases and dispositions have been properly recorded

l

Record depreciation expenses

l

Record a physical inventory count and compare to Sage 50's quantity on hand

l

Manage outstanding notes payable and receivable items and recording- or adjusting-interest expense or income

Once the above adjustments have been made (if necessary), you are ready to begin closing the fiscal year. The type of adjustment
required depends on where in Sage 50 the correction needs to be made.
l

General ledger adjustments are entered in the General Journal Entries window. How do I record a general journal entry?

l

Inventory adjustments are entered in the Inventory Adjustments window. How do I enter an inventory adjustment?

l

Payroll adjustments can be made through Payroll Entry. How do I make payroll adjustments?

l

Accounts receivable adjustments can be made through Sales/Invoicing or Receive Money. How do I write off customer bad

debt?
l

Accounts payable adjustments can be made through Purchases or Payments.

Note: After you have made the necessary adjustments, reprint any affected reports so that you have a correct copy.

Year-End Wizard - Introduction
The Year-End wizard walks you through the process of closing out your first open fiscal year, payroll tax year, or both. At every
point in the process, the wizard makes your options clear and tells you the consequences of every action you might take.

Before starting the Year-End Wizard...
Before you launch the wizard, there are a number of tasks you should perform. These include
l
l

Printing out any unprinted items such as invoices and payroll checks
Clearing the Waiting on Bill from Vendor check box in the Purchases/Receive Inventory window for any outstanding vendor
purchases. If you start the wizard before performing this task, the wizard will not be able to proceed. You will have to exit the
wizard and clear the check box before you can complete year-end close.

You may also want to purge inactive records before you start the wizard, though this can be done at any time, including after yearend close. Purging records is accomplished with the Sage 50 Purge wizard. Tell me more about the purge wizard.
Also, while the wizard requires that you back up your company data during the close process, you can do so before launching the
wizard if you prefer. In either case, back up of company data is highly recommended. Tell me more about making a backup.

Note: Since the close process may take quite a while to complete, we recommend that you start the process at the end of your
business day, making sure you leave the computer running. Also, make sure that all other applications are closed before you
begin.

Using the Year-End Wizard
The Year-End wizard comprises a series of windows with instructions and options. The first window, the Welcome to the Sage 50
Year-End Wizard window, tells you the date range of your two open fiscal and payroll tax years. Once you've finished reading the
text in this window, you can click the Next button to go to the next window in the series. The windows that make up the wizard are:

Close Options: The Close Options window lets you choose whether to close the first open fiscal year, the first open payroll tax
year, or both. Tell me more about this.
Print Fiscal Year-End Reports: This window displays a list of the year-end reports that you might want to print before
completing the year-end process. For each listed report there is a check box. You can select the check box next to each report that
you want to print. Tell me more about this.

Note: You will see this window only if you are closing a fiscal year or years.
Internal Accounting Review (Sage 50 Premium Accounting and higher only): This window gives you the opportunity
to run an Internal Accounting Review on your company before you close the year. If you would like to run the review now, you can
click one button to do so. .

Back Up Company Data: It's very important that before you close the year, you make a backup of company data and
customized forms; otherwise, this information will be lost. The Back Up Company Data window creates a backup for you. Tell me
more about this.
Archive Company Data: When you archive your company data, you are saving your data and financial statements so you can
have access to that information when you need to refer to it for future use, such as providing your financial information for a tax
audit. .

New Open Fiscal Years: Since Sage 50 automatically adjusts the start and end dates of fiscal year accounting periods, it is
usually not necessary for you to do this for your next open fiscal year. However, if you do want to change accounting period dates
for any reason, The New Open Fiscal Years window gives you the opportunity. Tell me more about this.

Note: You will see this window only if you are closing a fiscal year or years.
Confirm Close: This window tells you the starting and ending dates of the open fiscal and payroll tax years you are about to close.
It also tells you what your two open fiscal and payroll tax years will be after closing. Confirm that the information is right; then click
the Next button to proceed. Tell me more about this.

Begin Close-Year Process: At this point, you are ready to begin the close process. To do so, click the Begin Close button. Tell
me more about this.
Congratulations! The open fiscal and payroll tax years you selected have been successfully closed. Tell me more about this.
Starting the Year-End Wizard
1. From the Tasks menu, select System and then Year-End Wizard.
The Welcome to the Sage 50 Year-End Wizard window appears.

2. Read the introductory information, and note your company's two open fiscal and payroll tax years.
3. To proceed with year-end close process, select the Next button.
Sage 50 displays the Close Options window.
Note: Once you select the year or years you want to close, the wizard will determine if you have any purchases still waiting on
bills from vendors. If so, the Cannot Proceed window will appear, telling you that you must clear the Waiting on Bill from
Vendor check box for each of the purchases before you can continue with year-end close.
If you don't have any outstanding purchases but you do have items such as invoices and payroll checks that haven't been
printed, you will see the Unprinted Items window. It will list all items that still need to be printed. At this point you can select
Cancel to close the wizard and then print out these items, or you can select the Next button to continue without printing the
items.

What do you want to do next?
Read about the Sage 50 Purge wizard

l

The Year-End Wizard Process
l
l
l
l
l
l
l
l

Year-End Wizard - Introduction
Close Options
Print Fiscal-Year End Reports
Back Up Company Data
New Open Fiscal Years
Confirm Year-End Close
Begin Close-Year Process
Congratulations!

Make a Complete Backup of Your Company Data

Before you convert data to a new format, or close either the payroll or fiscal year or both, we recommend that you make a separate,
complete backup of your company data. Store your backup in a safe place for long-term retention.
You can restore the backup and access your company data again if for any reason
l

your computer system lost data, lost power during an operation, or failed in some other manner

l

you closed a payroll or fiscal year by mistake

l

you need to examine old transaction detail for auditing purposes

What do you want to do next?
l
Back up company data
l
Restore company data

Year-End Wizard - Close Options
In this window the wizard offers recommendations about closing your fiscal year. If you are working in the second open fiscal year,
the wizard will note that you are trying to close the first fiscal year and that it's all right to continue closing the year. Select the Next
button to continue year-end close.
However, if you are still working in the first open fiscal year and try to close it, the wizard will recommend (strongly!) that you wait to
close the first fiscal year until you are well into your second open fiscal year. This is true because you need to wait until a fiscal year
is truly over before you can reconcile all your General Ledger accounts and make sure that all other outstanding business for the
year has been properly handled. For more detailed information, be sure to consult the Sage 50 Year-End Guide.
In this window the wizard asks you which open years you want to close. Depending on the available options, you can close either the
displayed fiscal year, the displayed payroll tax year, or both the fiscal and the payroll tax years.

Available Options
The window includes three option buttons:

1. Fiscal and Payroll Tax Years
2. Fiscal Year: The wizard will display the appropriate beginning and closing dates for the year.
3. Payroll Tax Year: The wizard will display the appropriate beginning and closing dates for the year.
Depending on your current accounting period and how your fiscal and payroll tax years are structured, not all of these options
may be available. Sage 50 will always allow you to close only the appropriate year or years based on your accounting structure,
so do not be concerned if all close options are not available to you at one time.

Note: If you have been working in Sage 50 for a number of years and have never closed a payroll tax year, the wizard will
recommend that you close your fiscal and payroll tax years together. This will close more than one payroll tax year and bring
your fiscal and payroll tax years in sync.

Select Close Options
To select the desired close options, do the following:

1. Start the Sage 50 Year-End wizard, and click the option button corresponding to the year or years you want to close.
2. When finished, select the Next button to continue the year-end close process.
l
If you are closing an open fiscal year or years, Sage 50 displays the Print Fiscal Year-End Reports window.
l
If you are closing an open payroll tax year or years, Sage 50 displays the Unprinted Items window.
Note: When you select Next, the wizard will determine if you have any purchases still waiting on bills from vendors. If so, the
Cannot Proceed window will appear, telling you that you must go to the Purchases window and clear the Waiting on Bill from
Vendor check box for each of the purchases before you can continue with year-end close.
If you don't have any outstanding purchases but you do have items such as invoices and payroll checks that haven't been
printed, you will see the Unprinted Items window. It will list all items that still need to be printed. At this point you can select
Cancel to close the wizard and then print out these items, or you can select the Next button to continue without printing the
items.

Year-End Wizard - Cannot Proceed

Once you have chosen a close option , you will see this window if one or more purchases in the fiscal year you want to close are
waiting on a bill from a vendor. Before year-end close can be completed, you will have to remove the flag for all purchases in the
Purchases window. Follow these steps:

1.
2.
3.
4.
5.
6.

To close the Sage 50 Year-End wizard, select the Cancel button.
From the Tasks menu, select Purchases/Purchases-Receive Inventory.
Click the List toolbar button.
In the list, use the Waiting on bill column and select and double-click the first purchase that is awaiting a bill.
In the Purchases/Receive Inventory window, click in the Waiting on Bill check box to remove the check mark.
You must enter an invoice number in the Invoice # field.
l
l

If you have an invoice number from the vendor, enter this number.
If you do not have a number from the vendor, enter "Waiting" or some such text that you can replace with the invoice number
once you receive the invoice.

Note: Be sure to write this number down so that when the bill does come from the vendor, you won't inadvertently post it to two
different invoice numbers and end up paying the same bill twice.

7. Click Save.
8. Now repeat steps 3 to 7 for all other purchases that are waiting on bills.
9. When finished, you can go to Tasks > System and select Year-End Wizard to start the year-end close process again.

Year-End Wizard - Unprinted Items
Once you have chosen a close option , you will see this warning window if there are unprinted items for your company, such as
invoices and payroll checks. The window lists and explains all of these items.

Note: Some forms, such as W-2s, cannot be printed once the year-end-close process is complete and so must be printed
beforehand.

To print the items individually
1. To close the Year-End wizard, select the Cancel button.
2. From the Reports & Forms menu, open the Select a Report or Form window.
3. Print out all unprinted items.
l
How do I print reports?
l
How do I print forms?
4. When finished, you can go to Tasks > System and select Year-End Wizard to start the year-end close process again.
To ignore the warning and proceed with year-end close
Click the Next button at the bottom of the Unprinted Items window.
Sage 50 displays the Print Fiscal Year-End Reports window.

Year-End Wizard - Print Fiscal Year-End Reports
So that you have a proper audit trail for your company, Sage 50 strongly recommends that you print all fiscal year-end reports. You
can print them as part of the year-end process, if you'd like to. The report names and reporting periods for each are listed in the
table appearing at the center of the window.
Check the check boxes in the Print column next to any reports you want to print. Note that you can use the Check All button to
select all check boxes or the Check None button to clear all the check boxes. When finished, select the Next button to proceed.
Sage 50 will display the Back Up Company Data window.

Note: When you click Next, all selected reports will print to your default printer, so you should check paper or change printers, if
desired, before proceeding.

Year-End Wizard - Back Up Company Data

Before closing out the year, you need to make sure there is at least one backup of your company data and customized forms. To
create a backup file, follow these steps:

1. In the Sage 50 Year-End wizard, click the Back Up button. The Back Up Company window appears.
2. If you want to be prompted to back up in a specified number of days, select the Reminder check box.
3. If the specified number of days have elapsed since your last Sage 50 backup, Sage 50 will display a reminder message when you
close the company or exit the program.

4. Select the Include company name check box if you want Sage 50 to incorporate your company name in the name of the
backup file it creates.

5. Click the Back Up Now button to enter or select where you want to save your Sage 50 backup file.
6. In the Save Back Up As window, enter or select the path where you want to save your backup copy.
7. Enter the name for the backup copy. Sage 50 offers a default file name that includes the current system date—for example,
Bellwether Garden Supply-022503.ptb. You can change this if you like. Sage 50 backup files use the *.ptb file extension.
For increased security, avoid backing up data over existing backups.
You do not have to specify the location of your data files. Sage 50 locates these based on the company that is currently open.

8. Click the Save button. Sage 50 displays one of the following:
l
If you are backing up to your hard drive, the estimated size in megabytes (MB) of your backup.
l
If you are backing up to an external source such as diskette or Zip drive, the number of diskettes needed.
9. Click OK. The system displays the progress of the backup until it is complete.

If you are backing up to diskettes, the system will request you to insert the first and subsequent diskettes, as needed. You should
number these diskettes as instructed.

Warning: Depending on the quantity of data, the backup process may take a while to complete. Be patient and do not interrupt
the process. If you interrupt the backup process, you might corrupt the data.

Note: Sage 50 highly recommends that you make two or more company backup files, so be sure to create additional backups. To
do so, just repeat the backup process outlined above.
Keep one file on hand so that you can retrieve old data or perform the year-end close process again in case you've made an
oversight. For added security, store the second copy in a safe off-site location.

Year-End Wizard - New Open Fiscal Years
In this window, the Sage 50 Year-End wizard lets you review the accounting periods in your current open fiscal year and next fiscal
year. If you need to restructure your company's next fiscal year for tax purposes, you can change the date range of the accounting
periods in that year. However, since Sage 50 automatically adjusts the dates of the accounting periods, it is generally not necessary
to make changes to them yourself.

Note: There are rules governing changes to the date range of accounting periods. If in doubt, consult your accountant before
making any changes.

1. To see the date ranges of the current open fiscal year accounting periods, select the Current Fiscal Year option button.
The table at the right side of the window shows the dates of each accounting period in the year. This display is read-only, meaning
you can only review the dates, not change them.

2. To see the date ranges of the next fiscal year accounting periods, select the Next Fiscal Year option button.
The table at the right side of the window shows the dates of each accounting period in the year.

3. To change the end dates of any of the displayed accounting periods, click the accounting period whose date you want to change.
In the To column, the end date appears in the form DD/MM/YY, and a Calendar button appears next to the date.

4. Either type in the new To date or click the Calendar button, and then select the new date from the drop-down calendar that
appears.

When you change the To date, the From date in the next accounting period automatically changes also.
5. When finished, select the Next button to continue the year-end close process.
Sage 50 displays the Confirm Year-End Close window.

Year-End Wizard - Confirm Year-End Close
This window of the Sage 50 Year-End wizard lets you confirm the year or years that you will be closing. The first two boxes in the
window displays the fiscal year and payroll tax year or years that will close. The second two boxes displays the two open fiscal and
payroll tax years that will be open once the close is complete.
l

l

If you have chosen any year-end close options that you think inappropriate, choose the Back button to return to the wizard
window where you want to make changes to chosen options.
If you're satisfied that you are ready to proceed with year-end close, select the Next button. Sage 50 will display the Begin CloseYear Process window.

Year-End Wizard - Begin Close-Year Process
When you see this window, you are ready to start the year-end close.
We recommend that you leave the Run data verification checkbox selected. This allows data verification to run as part of the
close year process. Data verification checks to see any of your data files are missing or possibly damaged and tries to correct any
problems. Running data verification should make your close year process go more smoothly. You must have Full Access under User
Security>Company>File>Data Verification to run data verification.
In the Sage 50 Year-End wizard, click the Begin Close button.
The close process begins. A progress bar appears at the bottom of the window with the legend "Now Closing..." The progress bar
shows in real-time the percent of the process that has been completed. When the process is complete, Sage 50 displays the
Congratulations! window.

Warning: Once the year-end close process starts, it is imperative that you don't cancel the Year-End Wizard. Do not turn off your
computer during the close. Since the close process may take a while to complete, we recommend that you start the process at the
end of your business day, making sure you leave the computer running.

Year-End Wizard - Congratulations!
When you see this window, the year-end close process has been completed successfully. The window displays
l

the fiscal and payroll tax years you have just closed

l

your company's new open fiscal and payroll tax years

l

your company's current accounting period

l

the results of the data verification process (if data verification was run)
To close the Year-End wizard, click the Finish button.

Purge Wizard - Introduction
Purging is the process of removing inactive customers, vendors, employees, jobs, quotes, invoices, purchases, and so on from the
records of a company. Purging reduces the size of the files of a company and frees valuable disk space for current and active data.
In Sage 50, purging can be performed at any time, including after you close the fiscal year and or close the payroll tax year using
the Year-End wizard.
Due to the complexity of the purging process, you will need to provide information to Sage 50 on what needs to be purged and
through what date. To facilitate this process, and reduce the possibility of error, Sage 50 includes a Purge wizard to assist you
through the process. You can cancel at any time while you are using the Purge wizard.
It is extremely important to make a backup before you begin purging. In fact, we recommend that you make two backups, one for
current reference and one to be stored in a secure location for emergency needs. If you haven't already made sufficient backups,
note that the Purge wizard will allow you to make them during the purge process.
The purge process is not intended to remove or fix corrupt data. If you are experiencing problems with your data or suspect it is
corrupt, you must restore a backup of your company data.

Note: Since the purge process may take quite a while to complete, we recommend that you start the process at the end of your
business day, making sure you leave the computer running. Also, make sure that all other applications are closed before you
begin.

Tip: If your company data is extensive, you may want to consider purging the data in sections rather than selecting several options
at one time. This allows you to purge in incremental sessions that you control, saving time and memory resources. For example,
purge only three months worth of data at a time. Or, purge transactions first, then records.

Using the Purge Wizard
The Purge wizard comprises a series of windows with instructions and options. The first window, the Welcome to the Sage 50 Purge
Wizard window, tells you the end date of the most recently closed fiscal and payroll tax years. Once you've finished reading the text
in this window, you can click the Next button to go to the next window in the series. The windows that make up the wizard are:

Back Up Company Data: It's very important that before you close the year, you make a backup of company data and
customized forms; otherwise, this information will be lost. The Back Up Company Data window creates a backup for you. Learn
more .
Old Transactions: This window lets you choose a date on or before which old, unneeded transactions can be purged. Then the
wizard asks you to select the types of transactions you'd like to purge. Learn more .
Account Reconciliation: This window asks whether or not you use Account Reconciliation and need to have certain accounts
reconciled before purging. If so, here you can choose the accounts that need reconciling. Learn more .
Inactive Maintenance Records: This window lets you choose the types of inactive records you want to purge. Inactive
maintenance records can be purged as long as they are not used by a transaction and have zero remaining balances. Learn more .
Summary of Options: Here you will see a summary of all purge options you have chosen in previous windows. You can either
proceed with the purge or use the Back button to return to the earlier windows and make any needed adjustments. Learn more .
In Progress: This window displays progress meters that tell you how much of the purge process has been completed; if needed,
you can cancel at any time. The wizard will notify you when purge is complete. The In Progress window also lets you print a log that
details the purge process. Learn more .

Starting the Purge Wizard
1. From the Tasks menu, select System and then Purge Wizard.
The Welcome to the Sage 50 Purge Wizard window appears.

2. Read the introductory information.
Note: If you want to purge old transactions and payroll/1099 transactions, the most recent fiscal and payroll tax years must be
closed before you continue. The Closed Years section of the Welcome window will tell you the end dates of the last fiscal and
payroll tax years to be closed. If these years are not the most recent ones, use the Year-End wizard to close them.
3. Now, to proceed with the purge process, select the Next button.
Sage 50 displays the Back Up window.

The Purge Wizard Process
l
l
l
l
l
l
l

Purge Wizard - Introduction
Back Up Company Data
Old Transactions
Account Reconciliation
Inactive Maintenance Records
Summary of Options
Purge Is in Progress

Purge Wizard - Back Up Company Data
Before continuing with the purge process, you need to make sure you have one and preferably two backups of company data on
hand. The Purge Wizard - Back Up window lets you back up your data.

1. If you want Sage 50 to incorporate your company name in the name of the backup file it creates, select the Include company
name check box.

2. Click the Back Up button to enter or select where you want to save your Sage 50 backup file.
3. In the Save Back Up As window, the Save in field shows the location where your last backup was saved. You can change this
location by selecting the path where you want to save your backup.

4. Enter the name for the backup copy. Sage 50 offers a default file name that includes the current system date—for example,
Bellwether Garden Supply-022503.ptb. You can change this if you like. Sage 50 backup files use the *.ptb file extension.
For increased security, avoid backing up data over existing backups.

5. Click the Save button. Sage 50 displays one of the following:
l
If you are backing up to your hard drive, the estimated size in megabytes (MB) of your backup.
l
If you are backing up to an external source such as diskette or Zip drive, the number of diskettes needed.
6. Click OK. The system displays the progress of the backup until it is complete.
If you are backing up to diskettes, the system will request you to insert the first and subsequent diskettes, as needed. You should
number these diskettes as instructed.

Warning: Depending on the quantity of data, the backup process may take a while to complete. Be patient and do not interrupt
the process. If you interrupt the backup process, you might corrupt the data.

Note: Sage 50 highly recommends that you make two or more company backup files, so be sure to create additional backups. To
do so, just repeat the backup process outlined above.
Keep one file on hand so that you can retrieve old data in case you've made an oversight. For added security, store the second
copy in a safe off-site location.

Purge Wizard - Old Transactions
This window lets you choose which old, unneeded transactions you want to purge.

1. Enter the date on or before which such transactions can be purged.
2. In the Transactions group box, select the transactions you want to purge.
l
Select Receivables to delete transactions such as quotes, invoices, and receipts.
l
Select Payables to delete transactions such as purchase orders, purchases, and payments.
l
Select Payroll to delete payroll transactions.
l
Select Inventory to delete adjustment and assemblies transactions.
l
Select General Journals to delete journals and their entries.
l
Select Audit Trails to delete company audit trail data (available only in Sage 50 Complete Accounting and higher).
l
Select Used Tickets to delete time and expense tickets used in payroll and sales (available only in Sage 50 Complete
Accounting and higher).
l

Select Unused Tickets to delete time and expense tickets not yet used (available only in Sage 50 Complete Accounting and
higher). Then enter or select a date on or before which such tickets can be purged.

3. When finished, select Next to proceed with the purge process.

Purge Wizard - Account Reconciliation
This window lets you tell the wizard whether or not you use account reconciliation and if you do, which accounts need reconciling
before the purge.

1. Do one of the following:
l
Select No if you do not use account reconciliation.
l

Select Yes if you use account reconciliation.

2. If you choose Yes, in the grid at the bottom of the window, select the accounts that must be reconciled prior to purging. For each
category of account requiring reconciliation, such as Cash or ItemInventory, double-click the arrow to drop down a list of
individual accounts. Any accounts that have been reconciled in the past will be marked by default.

3. Select the check box for each individual account that must be reconciled. If an account is selected here, any transactions that use
the account but aren't reconciled, regardless of date, will not be purged.

4. When finished, select Next to proceed with the purge process.

Purge Wizard - Inactive Maintenance Records
This window lets you select the types of inactive maintenance records you want to purge. You can purge inactives only if they are not
used by any transactions and if they have zero balances.

1. Select the check boxes for each type of inactive maintenance record you want to purge:
l

customers/prospects

l

vendors

l

employees/sales reps

l

general ledger accounts

l

inventory items/attribute sets (attribute sets are available only in Sage 50 Complete Accounting and higher)

l

jobs/phases/cost codes

2. When finished, select Next to proceed with the purge process.
What do you want to do next?
Read about the Sage 50 Year-End wizard

l

Purge Wizard - Summary of Options
This window tells you that your selection of purge options is complete. The window also summarizes chosen options:
l

the date on or before which old, unneeded transactions can be purged

l

the types of transactions you want to purge, such as receivables, and payables, and payroll

l

l

the account reconciliation option you have chosen, that is, whether or not you require account reconciliation on certain G/L
accounts
the types of inactive maintenance records you want to purge, such as customers/prospects, vendors, and
employees/sales reps

If you are satisfied with the displayed options, select the Begin Purge button to start the purge process. However, if you would like
to make adjustments to any of the options, select the Back button to return to the window or windows where changes are needed.
Once the options chosen are as desired, you can return to the Summary of Options window and select Begin Purge.

Purge Wizard - Purge Is in Progress
This window lets you know that the Purge wizard is removing your old company data. At the middle of the window, a pair of progress
meters show you how much of the process has been completed.
l

The first meter shows in percentages how much of the current task, such as purging receivables, has been completed.

l

The second meter shows in percentages how much of the total purge process has been completed.

Purge Is Complete
When the purge process is finished, the window will announce, "Purge Is Complete."
To see a log detailing the purge process, select the Log button.

Get instructions for accessing the purge log after you have closed the Purge wizard.
To close and exit the Purge wizard, select the Close button.
Note: To cancel purge at any time, select the Stop button. If you do, however, not all eligible transactions and maintenance
records will have been purged. To see a log detailing what the purge process has completed, select the Log button.
At a later time, you will probably want to run the Purge wizard again to remove the remaining unneeded transactions and records.

Troubleshooting the Purge Process
If your computer freezes, your computer shuts down, or you run out of disk space during the purge process, you must restore a
backup and begin again.
Below are some tips to follow to ensure that the purge process runs smoothly.
l

If you are on a network, make sure no one else is in Sage 50 at the time you want to purge data.

l

Close all other applications so that you have sufficient memory resources during the purge process.

l

l

l

l

Make sure you have plenty of free disk space available. Your company data can temporarily double in size during the purge
process. After the purge process is complete, your data will return (or reduce) to its original size.
The purge process can take a long time to complete, so we recommend that you begin the process before leaving for the day so it
will not interfere with your regular work day.
If your company data is large, you may want to consider purging the data in sections rather than selecting several options at one
time. This allows you to purge in incremental sessions that you control, saving time and memory resources. For example, purge
only three months of data at a time. Or, purge transactions first, then records.
The purge process is not intended to remove or fix corrupt data. If you are experiencing problems with your data or
suspect it is corrupt, you must restore a backup of your company data.

What Happens if the Purge Process Doesn't Remove Data You Believe Should Have Been Removed?
Sometimes you may think that a particular transaction will be purged, but the Purge wizard did not delete the transaction or record.
Therefore, Sage 50 provides the purge log, an aid to help resolve any questions you may have. The purge log file is a plain text
report file that is automatically generated each time the wizard starts the purge process.
To help you troubleshoot a purge, the Purge wizard gives you a chance to see the log once the purge process is complete. You can
also review the log after you exit the Purge wizard. Learn about reviewing the purge log .

Review the Purge Log
Every time you complete the purge process using the Purge wizard, Sage 50 generates a purge log. The log is a report that details
which transactions and records were removed by the process. It also tells you which ones remain and why; this information can be
very helpful when troubleshooting the purge process.
To review the purge log, do the following:

1. From the Windows Start>Programs menu, select the Windows Explorer option.
2. Locate and open the folder where your company data is located.
3. Double-click the file PURGE.TXT.
The purge log opens in the Windows Notepad.

Using Sage 50 information in other applications
Use Write Letters
Write Letters is available from the Tasks menu and appears on the Select a Report or Form window; you can also create an
individual letter based on a customer, vendor, or employee record. Use the Sage 50 Write Letters feature to create mailings or email messages from existing or custom letter templates using your customer, vendor, and employee information.
You can create mailings such as newsletters, announcements, collection letters, individual letters, e-mail messages, and other types
of mailings. Sage 50 integrates with the Microsoft Word Mail Merge feature, using Word to edit and create custom templates, and
generates your mailings using your selected Sage 50 information.

Learn More
Do you want to create a letter from the Select a Report or Form window (from this location you can create or edit templates)?
Do you want to create a letter from a customer, vendor, or employee maintenance window (you cannot create or edit
templates from maintenance windows)?
Troubleshooting tips for Write Letters

Create a New Letter Template
You can create a new Letter template using the Create a Letter Template Wizard.

1. From the Select a Report or Form window, select the Forms tab.
2. In the Form Types section, select the type of letter you want to create from the drop-down list (for example, select "Customer
Labels and Letters" if you want to create a customer letter).

3. Select a letter template from the list in the Forms section. (This icon
indicates the item is a custom letter template.)

indicates the item is a standard letter template. This icon

4. The New Letter Template link should appear above the Forms section. Select the New Letter Template link to start
creating a new letter template.

What do you want to do next?
l
Edit a Letter Template
l
Copy a Letter template from one company to another

Edit a Letter Template
You can make changes to an existing custom letter template you created. You cannot change sample templates that come with Sage
50. However, you can edit a sample template and then save it as another template name when you are finished.
To edit a Letter template:

1. From the Tasks menu, select Write Letters. Then select the type of letter that you want to edit (Customer, Vendor, or
Employee).
The Select a Report or Form window appears.

2. From the Forms list, select the Letter template that you want to edit.
3. Select the Edit Letter Template button located below the sample form.
An Edit Letter Template window appears with a Select Recipients and E-mail Options tab. The name of the template you are
editing is displayed at the top of the window.

4. Change any letter or recipient settings or if you have e-mail settings, select the E-mail Options tab and change those settings
also; tell me more about changing Recipient and e-mail settings.
5. If you want to continue editing the template text and fields, go to Step 8. If you have completed your changes to the template,
click Save to save the recipient and e-mail setting changes for this letter template and return to the Select a Report or Form
window. Click Save As if you want to save the changes to a new letter template name. From the Save As window enter the new
name for the letter template and then click Save to return to the Select a Report or Form window
6. If you want to edit the template text and fields, click the Edit button to open Word with the template displayed.
7. Make any changes to the template text or variable fields; use the Sage 50 Letter Template Toolbar (that appears in Word
along with your template) to add variable fields to your template. In Word 2007 or 2010, click the Add-Ins tab to see the toolbar.

8. When you have completed your editing, save the template from Word or select Save as in Word to save the template as a new
template name. Any changes you made to the recipient and e-mail settings, along with any changes you made from Word, will be
saved.

Note: Template fields can hold up to 5000 characters. Anything over 5000 characters will not display.
What do you want to do next?
Use Write Letters

Copy a Letter Template
You can copy a Letter template from one company to another company using the Copy button. You can also make a duplicate of a
Letter template in your current company by using the Save As button on the Edit window, or you can copy an existing Letter
template using the
To copy a Letter template from one company to another company:

1. From the Tasks menu, select Write Letters. Then select one of the types of Letters (Customer, Vendor, or Employee).
Sage 50 displays the Select a Report or Form window.

2. Select the Copy button on the toolbar.
The Copy Reports, Financial Statements & Letter Templates window appears.
3. Select a source company from the Select aCompany to Copy from drop-down list or select the Browse button if you want
to search for the company.
This is the company that contains the original template. When you select a source company, Sage 50 displays a list of all reports,
statements, and templates for that company.

4. Select one of the Letter template groups (Customer, Vendor, or Employee) that contains the template you want to copy from the
Report or Financial Statement to Copy drop-down list.
A list of templates displays.

5. Select the template you want to copy.
6. Type a name for the new, copied template in the New Name field. You can also include a description in the New Description
field.

7. Select the Copy button on the toolbar.
The template is copied into your company forms list under the appropriate form type. A message appears at the bottom of the
window indicating the document was successfully copied.

What do you want to do next?
Edit a Letter Template

l

Create a Letter from a Maintenance Window
You can create a letter from a Maintain window for the current open record.
Before you begin, make sure you have letter templates set up. The sample templates provided can only be used if they are first
edited, and Sage 50 fields are added. You can also create a brand new template, copy an existing template, or create a template
from an existing Word document using the Create a Letter Template Creation Wizard, located on the Select a Report or Form
window.
To create a letter from an open record:

1. Click the Letters button on the toolbar.
A Write Letters dialog appears.
2. Select a template from the list.
3. Select the Word button if you want to create a letter using the selected template. Or, select E-mail if you want to create an email letter. The data from the record is merged with the template fields. The specific data used from the record depends on what
type of fields are in the template.
If you chose Word, your letter appears in Word where you can print or edit it. If you chose E-mail, an e-mail message is sent with
your letter included in the message content using the selected template's e-mail formatting.
Before e-mailing your letters, you may want to test the letter using Word first and see how it looks.

Note: You need to have a default e-mail program set up before you can send a letter by e-mail.

Create a Letter from the Select a Report or Form Window
To create a letter from the Select a Report or Form window:

1. From the Tasks menu, select Write Letters. Then select the type of letter that you want to create (Customer, Vendor, or
Employee).
The Select a Report or Form window appears.

2. Select the letter template you want to use from the list in the Forms section. (This icon
template. This icon

indicates the item is a standard letter

indicates the item is a custom letter template.)

Note: Select the New Letter Template link (located above the Forms section) if you want to create a new letter template
instead of using one that already exists.

3. After selecting the template you want to use, click the Send Letter button located under the sample form or double-click the
letter template from the list.
A Write Letters window appears where you can select recipients and e-mail information. This information is based on the type of
template you chose.

Note: Template fields can hold up to 5000 characters. Anything over 5000 characters will not display.
What Do I Want to Do Next
Use the Write Letters Window

Write Letters

When you select a letter template, and then select the Send Letter button on the Select a Report or Form Window, the Write Letters
window appears where you can specify recipient data and e-mail settings.

1. From the Select Recipients tab, accept the Print Order, or select a new print order option.
2. Accept Do not display blank lines or clear the check box if you do want to display blank lines in your letters.
When creating a letter, you may want to remove blank lines from the document if no information is available for that line. For
example, when using addresses there is a second address line that is available for listing additional address information, such as
a suite number. If you don't use that address line, it will be included as a blank line unless you select Do not display blank
lines.

3. Select Include <type> with a zero balance if you want to include customers or vendors with a zero balance.
4. If you are using Customer data and this field is displayed, accept Exclude customers who have purchased the selected
item(s) after <date> (this field displays if you have set the recipient filter type for sold items to a range or to equal to) and
enter or select a date if you want to exclude those customers who have recently purchased an item after a certain date.

5. From the Recipient Filter, accept the default settings or select your filter information for the fields listed. The template settings are
displayed by default, however, you can change the filter settings temporarily for this letter.

6. To process your letter(s) using Word, select the Word button located on the right side of the window. Word opens and begins
processing your letter(s).

7. If you want to send letters through e-mail, select the E-mail Options tab. Enter an E-mail Subject line for your e-mail
message, and select one of the E-mail Delivery Options: HTML, Plain Text, or Attachment. Choose HTML if you want to send
the e-mail with text formatting such as bold or italic included; choose Plain Text if you don't want the message to include any
formatting (or if your e-mail provider doesn't offer text formatting); choose Attachment if you want to e-mail your letter as an
e-mail attachment (.doc file). Click the E-mail button located on the right to begin processing your letters through e-mail. The email addresses located in your customer, vendor, or employee maintenance records are used.

Note: If you are using the Microsoft Exchange Server for e-mail processing and using Microsoft Office XP, a security message
appears for each e-mail letter sent out to which you must respond. This message is created by Microsoft and is not generated by
Sage 50.

What Do I Want to Do Next
l
Create a letter from a maintenance (customer, vendor, or employee) window

Troubleshooting Tips for Write Letters
Below are suggestions for situations that you may encounter when using Write Letters.
The following information provides you with a list of potential situations, error messages, and so on, that you may encounter in the
letter process. The information also includes a description of possible steps to take.

When trying to send a letter using e-mail, you can't create the e-mail message to send.
The e-mail application you are using won't accept the e-mail format you have set up in Write Letters. You must use the Plain Text
Mail e-mail setting to send your letters by e-mail.
Follow these steps to allow Write Letters to use your e-mail application:

1.
2.
3.
4.
5.

From the Tasks menu, select Write Letters. Then select the type of letter you want to send (Customer, Vendor, or Employee).
From the Forms list on the Select a Report or Form window, select the letter template you want to use.
With the template selected, select the Send Letter button (located under the sample form) to open the template's filter window.
Select the appropriate settings, then select the E-mail Options tab.
Select the Plain Text option and then select the E-mail button to send your documents by e-mail.

If using the Plain Text option doesn't work, test your e-mail application from Word by creating a single form letter in Word and from
the Word File menu, select Send To, and then select Mail Recipient. Enter an e-mail address in the To field, and select Send a Copy. If
the E-mail sends, your application is working properly.

When sending a letter using Outlook from an Exchange Server for e-mail processing, you receive a security
warning for each e-mail address you are sending it to.
You receive a security warning for each e-mail address you are sending your letter to and you have to confirm each message. This
warning appears as a result of security settings on the Microsoft Exchange Server, which only the server's administrator can change.

When creating a letter template or letters and you have Office 2000 installed with Word macro security set to
High, an error message appears stating that the Word macros are disabled.
This is an issue with Microsoft Office 2000 only, and occurs if the Word macro security settings are set to High. To resolve this
problem, from the Word tools menu, select Macro and then Security. Set the macro security to Medium. Try creating your letter
template or letters again.

Nothing happens when you try to send a letter by e-mail.
Check to see if your e-mail application is functioning and if it is, set the e-mail application as the default e-mail program. You need to
have a default e-mail program set up before you can send your letter by e-mail.

In Word 2007 or Word 2010, I do not see the Sage 50 Letter Template toolbar that allows me to add fields.
Click the Add-Ins tab to see the Sage 50 Letter Template toolbar when you are using Word 2007 or Word 2010.

Using Sage 50 with Microsoft Word and Microsoft Excel
This feature is available only in Sage 50 Pro Accounting and higher.
If you have Microsoft Word and Microsoft Excel (typically part of Microsoft Office) installed on your computer, you can easily use
Sage 50 data in variety of ways. For example, you can add Sage 50 financial statements or report data to a Microsoft Word
document that could be used for corporate year-end reports. Or, you can add Sage 50 data to a Microsoft Excel spreadsheet, where
you can sort and view data different ways to meet your business needs. For example, you can create charts and graphs based on
your customer sales data.

Tell me about copying Sage 50 report data to Microsoft Word or Excel via the Windows Clipboard.
Tell me about copying Sage 50 report data directly to an Excel spreadsheet.
Tell me about copying an entire Sage 50 report to an Excel spreadsheet.
What do you want to do next?
Copy Sage 50 report data to a Microsoft Excel spreadsheet
l
Copy Sage 50 report data to the Windows Clipboard
l

Create a Mailing Using Your Sage 50 Data
With the Sage 50 Write Letters feature, you can create mailings such as newsletters, announcements, collection letters, individual
letters, e-mail messages, and other types of mailings. Sage 50 integrates with the Microsoft Word Mail Merge tool, using Word to edit
and create custom templates, and generates your mailings using your selected Sage 50 information.
For more information on using Microsoft Word, refer to its online Help or printed documentation.

Sending your cash flow report to Microsoft Excel
When you select the Excel button and send your cash flow information to Microsoft Excel, Sage 50 will create a file with four
individual worksheets in Excel:
l
l
l
l

Summary: This will show the Forecast Totals Summary and the current Cash Flow Settings.
Starting Cash: Includes all of the columns, values, and formulas from the Starting Cash tab.
Expected Incoming Cash : Includes all of the columns, values, and formulas from the Expected Incoming Cash tab.
Expected Outgoing Cash: Includes all of the columns, values, and formulas from the Expected Outgoing Cash tab.

You may see some small green triangles in cells of the Number column of your spreadsheet in Microsoft Excel. These merely indicate
that the numbers in Sage 50 were sent to Microsoft Excel as text rather than as numbers.
Below are sample images of how each worksheet will appear.

Summary

Starting Cash

Expected Incoming Cash

Expected Outgoing Cash

Copy Sage 50 Report Data to a Microsoft Excel Spreadsheet
Use this procedure to copy data from a Sage 50 report or financial statement to a Microsoft Excel spreadsheet.

Note: You must have Microsoft Excel 2003 or a subsequent version installed on your computer for this procedure to work
properly. Copying to Excel may work with earlier versions of Microsoft Excel (for example, Excel 2000), but this ability is not
specifically supported by Sage 50.
For more information on using Excel, refer to Microsoft Excel Help.

1. Do one of the following:
In the Select a Report or Form window, select the report or financial statement that you want to copy from the list, and then
click the Excel toolbar button at the top of the window.
Get detailed instructions on selecting a report.
Display the report or financial statement that you want to copy on the screen, then click the Excel toolbar button.

Get detailed instructions on displaying a report.
The Copy Report to Excel window appears.

2. Select the desired File option :
l
Create a new Microsoft Excel workbook: Select this option to create a new file.
Add a new worksheet to an existing Microsoft workbook: Select this option to append an existing file. Click the
Browse button to choose the desired Microsoft Excel file.
3. Check or uncheck the Excel options check boxes as desired:
l
Use freeze panes (headers and labels are visible): Check the check box if you want the column titles in your Sage 50
report to be treated as freeze panes in the Excel worksheet. When you use freeze panes, the elements within these panes
l

remain visible whenever you scroll up or down in the worksheet.
l

Enable automatic column filtering (Auto-filter): Check the check box if you want to be able to AutoFilter columns of
data in the Excel worksheet. AutoFilter arrows will appear in columns that can be filtered to display a range of data. For
example, if you enable AutoFiltering for the Aged Receivables report, in the Excel worksheet you'll be able to filter the report by
customer ID.

Note: The Enable automatic column filtering option will be available only when you select the Raw data layout option.
4. Select the desired Report header option :
l
Send header to Page Setup in Excel: Select this option if you want the Sage 50 report header information to appear on
the Header/Footer tab of the Excel Page Setup window but not appear in the onscreen version of the worksheet. On the
Header/Footer tab, you can use the Custom Header option to customize the header, if desired, before printing the

worksheet. The header will appear on the printed version of the worksheet. Note that all column header information (column
titles) will be exported to and appear on the Excel worksheet.
l

Show header in Excel worksheet: Select this option if you want the report header to appear in the onscreen version of
the worksheet but not be available for customizing in the Excel Page Setup window. You'll be able to edit the header right on the
worksheet, if desired, before printing. Note that all column header information (column titles) will be exported to and appear
on the Excel worksheet.

Note: These options will not be available if you've chosen to hide the header (title) information on the Sage 50 report.
5. Select the desired Report layout option (Sage 50 Complete Accounting and higher only):
l
Sage 50 report layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows
formatted as in the original Sage 50 report.
l

Raw data layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows unformatted
regardless of the formatting in the original Sage 50 report.

Note: If you select Raw data layout, the Enable automatic column filtering option will be available.
6. When finished making selections, click OK.
Sage 50 will start the Microsoft Excel program, then copy the Sage 50 report data into a blank worksheet. The worksheet name
will be the same as the Sage 50 report name.
To add Microsoft Excel data into Sage 50, use the Import facility.

What do you want to do next?
Copy Sage 50 report data to the Windows Clipboard
l
Print a report or financial statement
l
Perform other report or form tasks
l
Read the Microsoft Office compatibility overview
l

Copy Report to Excel
Use this window to define how you want to copy the Sage 50 report, financial statement, or budget data to a Microsoft Excel
spreadsheet. You must have Microsoft Excel 2003 or a subsequent version installed on your computer for this procedure to work
properly. Copying to Excel may work with earlier versions of Microsoft Excel (for example, Excel 2000), but this ability is not
specifically supported by Sage 50.

A note about formulas: In reports where totals and subtotals are created from data values such as customer balances or check
amounts, copying the report to Excel provides formulas for these amounts. However, in some reports, data values come from
calculations based on information contained in the company database; examples of such values are payroll and sales tax
calculations. In these cases, when you copy a report to Excel, a constant value containing the computed value may be used in part
or whole in the Excel cell formula.
For more information about any of the Excel features mentioned below, refer to Microsoft Excel Help.
Tell me how Sage 50 sends Cash Flow Manager data to Microsoft Excel.

File option
l
Create a new Microsoft Excel workbook: Select this option to create a new file.
l
Add a new worksheet(s) to an existing Microsoft workbook: Select this option to append an existing file. Click the
Browse button to choose the desired Microsoft Excel file.
Excel option(s)
l

Use freeze panes (headers and labels are visible): Check the check box if you want the column header (that is, the titles
of columns) in your Sage 50 report to be treated as freeze panes in the Excel worksheet. When you use freeze panes, the
elements within these panes remain visible whenever you scroll up or down in the worksheet.

l

Enable automatic column filtering (Auto-filter): Check the check box if you want to be able to AutoFilter columns of data
in the Excel worksheet. AutoFilter arrows will appear in columns that can be filtered to display a range of data. For example, if you
enable AutoFiltering for the Aged Receivables report, in the Excel worksheet you'll be able to filter the report by customer ID; use
the AutoFilter arrows at the tops of the columns of data.

Note: The Enable automatic column filtering option will be available only when you select the Raw data layout option.
This feature is NOT available for the Cash Flow Manager.

Report header option
These options will not be available if you've chosen to hide the header (title) information on the Sage 50 report.
l
Send header to Page Setup in Excel: Select this option if you want the Sage 50 report header information to appear on the
Header/Footer tab of the Excel Page Setup window but not appear in the onscreen version of the worksheet. The report header
includes the company name, report name, and date of the report—in other words, the information that typically appears at the
very top of the Sage 50 report. On the Header/Footer tab, you can use the Custom Header option to customize the header, if
desired, before printing the worksheet. The header will appear on the printed version of the worksheet. Note that all column
header information (column titles) will be exported to and appear on the Excel worksheet.
l

Show header in Excel worksheet: Select this option if you want the report header to appear in the onscreen version of the
worksheet but not be available for customizing in the Excel Page Setup window. You'll be able to edit the header right on the
worksheet, if desired, before printing. Note that all column header information (column titles) will be exported to and appear on
the Excel worksheet.

Report layout option (Sage 50 Complete Accounting and higher only)
When you select one of the following options, the graphic box below the option buttons shows an example of how the report will look
once exported to Excel.
l

Sage 50 report layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows
formatted as in the original Sage 50 report.

Raw data layout: Select this option if you want the data to appear in the Excel worksheet with columns and rows unformatted
regardless of the formatting in the original Sage 50 report. If you select Raw data layout, the Enable automatic column
filtering option will be available.
When finished making selections, click OK, and Sage 50 will start the Microsoft Excel program, then copy the Sage 50 report data

l

into a blank worksheet. The worksheet name will be the same as the Sage 50 report name.

What do you want to do next?

l
l
l
l
l
l

Copy Sage 50 report data to a Microsoft Excel spreadsheet
Copy Sage 50 report data to the Windows Clipboard
Print a report or financial statement
Perform other report or form tasks
Read the Microsoft Office compatibility overview
Read how Sage 50 sends Cash Flow Manager information to Microsoft Excel

Copy to Excel
Use this window to define how you want to copy Sage 50 list data to a Microsoft Excel spreadsheet. You must have Microsoft Excel
2002 or a subsequent version installed on your computer for this procedure to work properly. Copying to Excel may work with
earlier versions of Microsoft Excel (for example, Excel 2000), but this ability is not specifically supported by Sage 50.
For more information about any of the Excel features mentioned below, refer to Microsoft Excel Help.

Tell me how Sage 50 sends Cash Flow Manager data to Microsoft Excel.
File option
Create a new Microsoft Excel workbook: Select this option to create a new file.
l
Add a new worksheet to an existing Microsoft Excel workbook: Select this option to append to an existing file. Click the
Browse button to choose the desired Microsoft Excel file.
l

Excel options
l
Use freeze panes (headers and labels are visible): Check the check box if you want the column header (that is, the titles
of columns) in your Sage 50 report to be treated as freeze panes in the Excel worksheet. When you use freeze panes, the
elements within these panes remain visible whenever you scroll up or down in the worksheet.
l

Enable automatic column filtering (Auto-filter): Check the check box if you want to be able to AutoFilter columns of data
in the Excel worksheet. AutoFilter arrows will appear in columns that can be filtered to display a range of data. For example, if you
enable AutoFiltering for the Aged Receivables report, in the Excel worksheet you'll be able to filter the report by customer ID; use
the AutoFilter arrows at the tops of the columns of data.

The Enable automatic column filtering option is not available for the Cash Flow Manager.
Header option
These options will not be available if you've chosen to hide the header (title) information on the Sage 50 list.
l

Send header to Page Setup in Excel: Select this option if you want the Sage 50 list header information to appear on the
Header/Footer tab of the Excel Page Setup window but not appear in the onscreen version of the worksheet. On the
Header/Footer tab, you can use the Custom Header option to customize the header, if desired, before printing the
worksheet. The header will appear on the printed version of the worksheet. Note that all column header information (column titles)
will be exported to and appear on the Excel worksheet.

l

Show header in Excel worksheet: Select this option if you want the list header to appear in the onscreen version of the
worksheet but not be available for customizing in the Excel Page Setup window. You'll be able to edit the header right on the
worksheet, if desired, before printing. Note that all column header information (column titles) will be exported to and appear on
the Excel worksheet.

When finished making selections, click OK, and Sage 50 will start the Microsoft Excel program, then copy the Sage 50 list data into a
blank worksheet. The worksheet name will be the same as the Sage 50 list name.

What do you want to do next?
Read about Lists and how to work with them

l
l
l
l

Print a report or financial statement
Perform other report or form tasks
Read the Microsoft Office compatibility overview

Outlook Sync Overview
This feature is available only in Sage 50 Complete Accountingand higher.

With this feature, you can synchronize your Sage 50 records (customers/customer contacts, vendors, and employees) with contacts
in Microsoft Outlook. You select the folder where you want Sage 50 to export its records and the program will create three subfolders for these records, one for customers, one for vendors, and one for employees. As you modify contacts in Microsoft Outlook
or records in Sage 50, you can resynchronize to update the corresponding program.

Learn More
How do I perform a synchronization?
Getting started with a synchronization is easy.

1. Select Sync to Outlook from the File menu in Sage 50. Or you can click the Outlook button from either the List of
customers, vendors, or employees, or the associated record window.

2. On the Outlook Sync Settings window, click the Browse button next to the Folder to sync with field.
3. Select the folder you want to sync with. When the synchronization is complete, Sage 50 will have created three subfolders in
the folder you selected. These folders will have the following names:

<Your company name> Customers (Sage 50)
<Your company name> Vendors (Sage 50)
<Your company name> Employees (Sage 50)
Data from each corresponding record type in Sage 50 will be placed in the appropriate folder.
Once the initial sync is complete, you may rename these folders in Outlook if necessary.

4. Select the type of Conflict Resolution and the Contact Formatting that you want.
5. Click Ok.
6. On the Outlook Sync window, click Sync now. When the sync is complete, you will see the Outlook Sync Status Report
window.
How do I import my existing Outlook contacts into Sage 50?

1. Set up and perform a sync according to the steps above.
2. In Outlook, copy your existing contacts into the appropriate newly created folders. That is, Outlook contacts who are
customers should be placed in the Customers Outlook folder, and so on.

3. In Sage 50, select File, Sync with Outlook.
4. Click Sync Now. This will create Sage 50 records for those Outlook contacts.
What versions of Outlook will synchronization work with?
Outlook contact synchronization will work with Outlook 2003 and newer. If applicable, Outlook must be configured in Corporate
or Workgroup mode. Internet only mode is not supported, but Internet accounts in Corporate or Workgroup mode are.
Password protected *.pst files are not supported.
Does Outlook have to be running when I perform a synchronization?
No, but it does need to be installed and configured before you will be able to synchronize contacts with Sage 50.
If Outlook is closed, you may be prompted to enter Outlook credentials before proceeding with the sync.
Are there any limitations on using Outlook synchronization?
You cannot perform Sage 50 single user functions while doing a synchronization. Single user functions include backup and
restore, changing accounting periods, posting to the general ledger (batch posting and SmartPosting only), and others. You can
do these tasks when the synchronization is complete.

What do you want to do next?
Use Sage 50 with other Microsoft Office products

l
l
l
l

See a list of vendor fields that are synchronized
See a list of customer fields that are synchronized
See a list of employee fields that are synchronized

Field List for Customers

This feature is available only in Sage 50 Complete Accounting and higher.
Below is a table that shows you the fields that are synchronized. All fields are synchronized between Outlook and the Contacts tab for
the Sage 50 customer, except as noted below.

Sage 50 Field

Outlook Field

Contact

Full Name

Name

Company

Customer ID*

File as

Telephone 1

Business Phone

Telephone 2

Business Phone 2

Fax

Business Fax

Address fields**

Business Address

E-mail

E-mail

Web Site***

Web page address

*This field is located in the header for the customer record.
**The address fields are accessible from the Contacts tab in Maintain Customers/Prospects.
***This field is located on the General tab in Maintain Customers/Prospects

Field List for Employees
This feature is available only in Sage 50 Complete Accounting and higher.
Below is a table that shows you the fields that are synchronized.

Sage 50 Field

Outlook Field

Name

Full Name

Employee ID

File as

Home phone

Home phone

Address fields

Home Address

E-mail

E-mail

Field List for Vendors
This feature is available only in Sage 50 Complete Accounting and higher.
Below is a table that shows you which fields for synchronized.

Sage 50 Field

Outlook Field

Contact

Full Name

Name

Company

Vendor ID

File as

Telephone 1

Business Phone

Telephone 2

Business Phone 2

Fax

Business Fax

Address fields

Business Address

E-mail address

E-mail

Web Site

Web page address
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